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Geosystem License Agreement for WinGLink Software 
The Agreement 
This Geosystem End-User License Agreement is a legal agreement between you (either an individual or a single entity) and Geosystem srl for the 
software product WinGLink®, which includes computer software, associated media, hardware key and printed materials. 
IMPORTANT—READ CAREFULLY 
WinGLink® software will only work at full performance when a hardware key (DONGLE) is installed on the parallel port of your PC. 
By installing and using WinGLink®  in conjunction with its DONGLE, you agree to be bound by the terms of this Agreement. If you do not agree 
to the terms of this Agreement, return the DONGLE(S) to us for a full refund within 10 days from the date you received them. 
WinGLink® LICENSE 
WinGLink® software is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. 
The WinGLink® software is licensed, not sold. 
GEOSYSTEM grants to you a non-transferable and non-exclusive license to 

1. use the WinGLink® Program for your own purposes but only in machine readable 
form by no-more than the number of users stipulated in Schedule 1. Any exceptions 
are noted on Schedule 1. 

2. utilize the Support Materials and test data in support of the authorized use of the 
WinGLink® Program;  

You may not assign this agreement or any part thereof or sub-license the rights granted herein without the prior consent of GEOSYSTEM. 
Title and all intellectual property rights in and to the WinGLink® Program, Support Materials and test data, including, without limitation, 
copyright, trade secrets, and trade marks, shall remain with GEOSYSTEM. You agree to refrain from raising any objection or challenge to such 
intellectual property rights, or from assisting or causing or permitting other(s) to do so, during the term of the Agreement and thereafter. 
Services provided by GEOSYSTEM 
GEOSYSTEM shall supply you with the WinGLink®  Program listed in Schedule 1 at all sites listed in Schedule 1, along with Support Materials 
(as hereinafter defined), hardware keys (dongles) and test data. 
GEOSYSTEM shall perform the services, and grant you a non-transferable, non-exclusive license to use the WinGLink® Program, Support 
Materials, and test data, subject to the Terms and Conditions herein contained. You agree to accept responsibility for the selection, installation, 
and use of the appropriate programs to achieve your intended results, and for the results obtained from use of the WinGLink® Program. You 
therefore accept complete responsibility for any decision made based on your use of the WinGLink® Program. 
Definitions 

In this Agreement the term: means: 
“Agreement”  this Agreement including Schedule 1, included in the shipment of each dongle; 
“Effective Date”  The date when you can legaly start to use the WinGLink® program 
“Fees”  (i) The one-time initial User(s) License Fee, (ii) The User(s) Maintenance Fee, 
“WinGLink® Program” the version of the licensed data processing program listed in Schedule 1, and any modifications, 

improvements, or updates provided to you by GEOSYSTEM, collectively of any of them; 
“User License(s)” the right to use the WinGLink® Program by one user. This includes the use on field computers at temporary 

sites for projects directly subordinate to the Licensed Office. 
“Dongle” the hardware , needed to run the WinGLink® Program. 
“Service charge(s)” GEOSYSTEM’s service charges relating to the services, in accordance with GEOSYSTEM’s current fee 

schedule; 
“Services” the Services described in Section 7 and Schedule 1, collectively or any of them; 
“Support Materials” any machine-readable or printed material describing or embodying the WinGLink® Program provided to you 

by GEOSYSTEM under this agreement, including flow charts and  applications manuals 
“Termination” means the occurrences contemplated by Section Termination. 

Fees and payment 
You agree to pay GEOSYSTEM the Fees as follows: 

1. The initial User License(s) Fees are to be paid upon receipt of GEOSYSTEM’s invoice and subsequent Maintenance Fees are to be paid 
within 30 days of GEOSYSTEM’s invoice 

2. The Fees are subject to change without prior notice. In addition to the Fees due under this Agreement, you agree to pay amounts equal to 
any taxes resulting from this Agreement or any activities hereunder. Interest of 1.5% per month shall be paid on any Fees overdue. All 
payments are to be made payable in US Dollars, or in the currency shown in GEOSYSTEM’s invoices, at the rate of exchange to the US 
Dollars effective at the date of the invoices. 

Term 
The Term of this Agreement shall commence on the Effective Date and terminate upon Termination. 
Maintenance Services 

3. During the first 6 months of this Agreement (from the Effective Date), or up to any later expiry date specified in Schedule 1, GEOSYSTEM 
shall make available to you, without additional Fees, such corrections and improvements to the WinGLink® Program as may be generally 
incorporated into the WinGLink® Program by GEOSYSTEM. 

4. After expiry of this 6 month period, or after any later expiry date specified in Schedule 1, GEOSYSTEM shall make available all generally 
available updates of the WinGLink® Program at the then applicable updated subscription(s) charges. A quotation of the update subscription 
will be provided prior to the expiry date at the then applicable update subscription charge(s). GEOSYSTEM‘s current policy is to maintain 
the cost of a 12-months subscription at about 15% of the software License Fee; 

5. GEOSYSTEM is committed to offer you, subject to the applicable Service Charge(s), continuing support in the form of telephone advice 
and other assistance in problem diagnosis and the correction of errors or faults in the WinGLink® Program during the life of this License. 
When a problem occurs, which you believe is related to the errors or faults in the WinGLink® Program, you may contact GEOSYSTEM at 
the above address and GEOSYSTEM will make an honest effort to solve your problem. However, GEOSYSTEM cannot guarantee service 
results or represent or warrant that all errors or program defects will be corrected. 



 

6. Further, if your request for service relates to modifications of the WinGLink® Program, to meet your particular needs or conform with your 
particular operating environment, GEOSYSTEM may, at its discretion, modify the WinGLink® Program to meet your particular needs at 
your request, subject to Applicable Service charge. However all intellectual property or other rights which may arise from such 
modification, shall reside with GEOSYSTEM. 

Protection and security of the WinGLink® Program and Support Materials 
You acknowledge that all copies of the WinGLink® Program, and the Support Materials provided by GEOSYSTEM or made by you pursuant to 
this Agreement, are proprietary, and the property of GEOSYSTEM, and may not be distributed by you to any other person, without 
GEOSYSTEM’s prior written consent. You will not provide or otherwise make the WinGLink® Program or the Support Materials available to 
anyone in any form without GEOSYSTEM’s prior written consent, except to your employees, or to other persons on your premises for purposes 
specifically related to your authorized use of the WinGLink® Program. 
Termination 
This Agreement may be terminated by you only upon thirty-days prior written notice to GEOSYSTEM. GEOSYSTEM may terminate this 
Agreement upon prior written notice, effective immediately if you fail to comply with any of the terms and conditions of this Agreement. 
Events upon termination 
You shall forthwith discontinue use of the WinGLink® Program, Support Materials and test data on the day Termination shall occur and you 
agree not to resume such use in the future without written authorization from GEOSYSTEM. 
Within 30 days after termination, you shall return to GEOSYSTEM, at your expense, the WinGLink® Program, Dongles, Support Materials, test 
data and other material received from GEOSYSTEM or copies permitted to be made in connection with this Agreement. This obligation relates, 
without limitation, to all copies in any form, including translation, compilation, derivatives and updated materials, whether partial or complete, 
and whether or not modified or merged into other materials, as authorized herein. 
Warranty 
GEOSYSTEM does not warrant that the functions contained in the WinGLink® Program will meet your requirements or that the operations of the 
WinGLink® Program will be uninterrupted or error free, or that all program defects will be corrected. Each WinGLink® Program shall be 
furnished to you in accordance with the terms of this Agreement. 
Limitation of remedies 
In no event shall GEOSYSTEM be liable for any damages arising from performance or non-performance of the WinGLink® Program, or for any 
lost profits, lost savings or other consequential damages, even if GEOSYSTEM has been advised of the possibility of such damages, or for any 
claim against you by any other party. 
General 
You agree that this Agreement is a complete and exclusive statement of the Agreement between you and GEOSYSTEM and can only be modified 
by written instrument executed by both parties. GEOSYSTEM is not responsible for failure to fulfill its obligations under this Agreement due to 
causes beyond its control. 
The relationship between the parties is that of independent contractors. Nothing contained in this Agreement shall be deemed to constitute or 
create between you and GEOSYSTEM a partnership, association, joint-venture, or agency. 
The provision of this Agreement shall be binding upon you and GEOSYSTEM and your respective successors and permitted assigns. 
This Agreement will be governed by the laws of Italy. 
Amendments 
This Agreement together with Schedule 1 constitutes the entire agreement and it supersedes all prior agreements, representation and 
understandings between you and GEOSYSTEM. 
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1:  Introduction 

Overview of the Manual Structure 
This edition of the WinGLink manual differs considerably from previous 
editions. Instead of taking a module-oriented approach, the manual now 
follows the workflow a user might typically follow when working with a 
specific type of data.  

For example, the description for magnetotelluric data guides the user 
from the various quality control elements of data processing and analysis, 
e.g. use of the Time Series program and data editing, to data import, map 
and profile creation, 1D modeling, the creation of pseudo-sections and 
cross-sections, to 2D modeling, 3D modeling, and finally, provides 
information on how to prepare data for presentation. 

As a result of this approach, some modules appear in the manual multiple 
times, once for each specific data type. For example, separate chapters 
are dedicated to MT Soundings and TDEM Soundings. 

Graphical overviews of the typical workflow followed for each type of 
data handled by WinGLink are provided in the “Workflow” chapter of 
this manual. In addition to illustrating a step-by-step approach to working 
with the respective data types, the diagrams also include references to the 
corresponding chapters of the manual. 

Program features which are identical throughout WinGLink, e.g. printing, 
gridding, color ranges, are discussed in the “Common Functions” chapter 
of this manual. 

WinGLink: An Overview 
This section gives a general overview of the main processing steps you 
will go through when using the WinGLink program. At the same time, 
the basic concepts and elements of the application will be introduced. 

WinGLink tools are used to perform quality control, editing and data 
processing of the raw data in order to produce data which are suitable for 
further analysis. MT time series data, for example, can be examined for 
quality in the Time Series program, processed using WinGLink’s 
Cascade Decimation tool, and the results edited with the CrossPower and 
Data Analysis tools 
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WinGLink tools are used for 
preliminary data analysis, 
quality control and data 
processing. 

 

 

A WinGLink database contains the data for all surveys carried out in 
the area of interest. Information on the central meridian, the projection 
used for the station coordinates, and the linear units used for distances 
and depths is stored in the database properties. 

The database area can be as 
wide as desired 

Central Meridian

Area of
exploration

 

WinGLink projects consist of surveys carried out in the database area. 
Stations are added to projects by entering the given station's name, 
coordinates and elevation. This may be performed either manually or by 
importing station data from external files. 

Parameter values, datasets 
and 1D models are 
attached to each station  
for the construction of  
maps and sections. 

 

Proj 3: MT

Proj 1: gravity
Proj 2: towns
Proj 3: MT

Proj 1: gravity
Proj 2: towns

 

 
Maps are produced by gridding station values.  



A guide to using WinGLink Introduction  •  1-3 

 

 

Parameter values can be 
automatically extracted 
from the station datasets or 
models 

 

 
Profile traces are defined as open polygonal lines added to the area. 
Stations are added to the traces to construct sections. 

 

 

Profile traces are used to 
construct sections. The 
same trace can be used for 
all types of surveys. 

Proj 3: MT

Proj 1: gravity
Proj 2: towns
Proj 3: MT

Proj 1: gravity
Proj 2: towns
Proj 3: MT

Proj 1: gravity
Proj 2: towns

 

 
Sections are plotted using station datasets (pseudosections), 1D models, 
2D models (cross sections) or extracted from 3D models. 
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2:  Getting Started with WinGLink 

Minimum Hardware and Software Requirements 
To install and use WinGLink, your system must satisfy the following 
requirements:
Item Minimum requirement 
Machine type IBM PC or compatible 

CPU type Pentium processor 

RAM 512 MB 

Color board SVGA with at least 256 KB memory 

Fixed disk space 100 MB for installation, and an average of 20 
MB for each database 

Non-fixed disk drive CD-ROM drive 

Operating system Recommended: Windows XP; Windows 
98/2000/ NT 4.0 with latest service pack also 
supported. 

Internet connection A high-speed Internet connection is needed to 
download new releases of the software as they 
are made available. 

 
 

Note: The above hardware does not represent the best configuration for 
running WinGLink. Adding more RAM or using a higher speed 
processor will substantially improve WinGLink performance. 
Furthermore, a high-speed Internet connection is recommended for 
downloading new releases as they are made available. 

Contents of the Shipping Package 
To make sure that your package is complete, check its contents against 
the list below: 
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Item Description 
Installation CD-ROM The WinGLink application and its setup program. 

WinGLink dongle 
(one for each license) 

Each license of WinGLink comes with a hardware 
copy protection dongle. The dongle is needed to 
run WinGLink with full performance. 

User’s guide This manual with instructions on how to use 
WinGLink programs and its applications. 

 
 

What’s on the CD 
The CD-ROM provided with each license contains 

Directory Contents 
Winglink\Setup Installation files and setup 

program for WinGLink 

Winglink\Sentinel Installation program for the 
WinGLink dongle driver  

Winglink\Manual\Pdfdocs This manual in Acrobat format 

Winglink\Manual\Acroread Acrobat Reader installation 
program 

 
: 

Installing WinGLink  
This section contains instructions for installing and uninstalling 
WinGLink on a stand-alone computer system. This is the default 
installation mode for WinGLink programs. Should your machine be 
connected to a networked environment, we suggest that you copy all of 
the installation files to a directory on the network server. The same 
installation procedure can then be followed from each connected 
peripheral station, specifying the server directory as the source of 
installation programs.  

Installing WinGLink 
To begin, start your Windows operating system, then: 

 1. Close any application still running. 

 2. Use the Windows Explorer to select the CD-ROM directory, 
then browse to the WinGLink\Setup folder, which contains the 
installation files. 

 3. Double-click the Setup.exe file. 

 4. Follow the instructions on the screen. Should any messages 
appear during this process, click the OK button to 
acknowledge. 
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Uninstalling WinGLink 
To remove WinGLink from your computer. 

 1. Click the   button on the task bar, point to Settings, 
and then select Control Panel. 

 2. Double-click the Add/Remove Programs button. 

 3. Select WinGLink from the listed programs. 

 4. Click the Remove button. 

Note: The uninstall program will remove only those files placed on your 
hard disk by the installation program. It will not remove the databases 
and data files you have created using WinGLink. These are stored as 
permanent files on your computer and can only be removed manually. 

Cleaning Up After an Old Version of WinGLink 
The WinGLink setup routine automatically removes earlier versions prior 
to installing a new release.  

If, for some reason, you must install a WinGLink release (preceding 
1.61.01), you must uninstall WinGLink to remove earlier versions before 
installing. You can check the directory Program Files\WinGLink to 
make sure that all files have been deleted from this directory. If not, 
delete all files manually and then install the new release of the program. 

Note: Should you encounter problems following a new installation, 
contact us at support@winglinksoftware.com 

Installing the WinGLink Dongle 
Each WinGLink license comes with a hardware copy-protection dongle 
which must be plugged into either a USB port or the parallel (printer) 
port of your PC. When installing a parallel port dongle, connect the 
dongle  between the PC and the printer cable.  

Note: Licenses purchased as of mid-December 2002 may be supplied 
with a USB dongle. When installing the USB dongle, proceed following 
the same instructions provided for the parallel port dongle, connecting the 
dongle to the USB port instead of the parallel port. 
 
The USB dongle is NOT supported for the Window NT operating 
system. If you intend to run WinGLink under Windows NT and you have 
been provided with a USB dongle, please contact Geosystem for a 
replacement parallel port dongle. 
 
The USB dongle is supported for the Windows 98, ME, 2000 and XP 
operating systems.  

W/hen installing a USB dongle driver, you must remove the dongle 
prior to running the driver installation program! 

mailto:gsy@geosystem.net
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To Install the Parallel Port Dongle: 
 1. Turn off your computer. 

 2. If a printer or another device is connected to the parallel port, 
turn it off and disconnect it from the computer port. 

 3. If installing a parallel port dongle, connect the dongle. Do not 
connect the USB dongle prior to running the driver installation 
program. 

 4. Reconnect the printer cable to the PC by plugging it into the 
free end of the dongle. 

 5. If installing a parallel port dongle, turn on the printer, otherwise 
the dongle may not be detected.  

 6. Turn on your computer to reboot the system. 

To Install the USB Dongle: 
 1.  Install the dongle driver as described below 

 2. Plug the USB dongle into a free USB port. 

Installing the Dongle Driver 
Open the \Winglink\Sentinel folder on the installation CD ROM and 
double-click the file <Sentinel.exe>. This will install the dongle driver 
and enable your PC to recognize the dongle. 

Note: The dongle does not affect any of the standard operations of the 
system; any device connected to the parallel/USB port via the dongle will 
work as it did before inserting the dongle. 

Downloading and Using the WinGLink Downloader 
WinGLink is under continuous development. New releases, as they are 
made available, are placed on our Web server for downloading. For this 
purpose, Geosystem provides a downloader utility, the WinGLink 
Downloader, which automatically establishes a connection with our 
server, downloads files selected by you to your computer, then gives you 
the option of installing any downloaded software.  

Downloading the WinGLink Downloader: 
The WinGLink Downloader is available for downloading from the 
Geosystem website at: 
 
http://www.geosystem.net -> WinGLink Software -> How to get it 

To download Downloader installer to your computer, right-click the 
“Download the ‘WinGLink installation/update utility’”, and specify the 
download destination. 

After downloaded to your computer, execute the installer to initiate the 
installation process.  
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Using the WinGLink Downloader 
If you are a licensed user, make certain that a dongle is plugged into the 
computer’s parallel or USB port before using the WinGLink Downloader 
to download and install the current release. If you are a non-licensed user, 
you will need to enter a valid download code, which can be requested 
from Geosystem at winglink_support@geosystem.net. 

Start the program from the WinGLink entry in the Windows Start menu: 
 

 
If no dongle is connected or detected, a screen which prompts the entry 
of a download code is displayed: 
 

  
 
If you are not a licensed user and have requested a download code in 
order to evaluate the WinGLink software, enter the supplied code in the 
provided fields.  

Otherwise, the program advances to the Download Location screen. 
Here, specify the folder to which the files are to be downloaded: 
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On the next screen, you are given the option of adjusting Internet 
settings. Unless given specific instructions, do not change the default 
server. If your network is protected by a firewall and you are not able to 
connect to the WinGLink server, you will need to contact your network 
administrator to determine whether the default port allows for a TCP 
connection. If not, the Local TCP Port value must be changed to a port 
which permits this type of communication: 
 

 
 
Click the Next button to establish a connection with the server and 
display a list of available downloads: 
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Note that new releases of the WinGLink Downloader are made available 
for downloading here as well. 

Select the files to be downloaded and click the Next button to begin the 
download process: 
 

 
After downloading has completed, click the Next button to advance to 
the next screen. Here, you can opt to either automatically install the 
downloaded software or exit the Downloader. Clicking the Install button 
starts the WinGLink installation process. If the installer detects a 
WinGLink installation on the computer, the old version is uninstalled 
before the new release is installed: 
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Installation Troubleshooting 

Common Warning Messages 
Warning messages may pop-up during the installation depending on the 
system settings of your PC. Here are the most common messages and the 
correct actions to undertake: 
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Message Action 
"Setup cannot continue 
because some system files are 
out of date on your system. 
Click OK if you would like to 
update these files for you now. 
You will need to restart 
Windows before you can run 
setup again. Click Cancel to 
exit setup without updating 
system files” 

Click ‘OK’ to proceed with the 
installation of WinGLink. This also 
means that the system will have to 
be rebooted. A new message will be 
displayed: 

"Do you want to restart 
Windows now ? If you choose 
‘No’, you will not be able to run 
setup again until after the 
system is rebooted at a later 
time" 

Click ‘YES’; the setup process will 
be terminated and the system will be 
automatically rebooted. You will  
need to restart the setup procedure 

"A file being copied is older 
than the file currently on your 
system. It is recommended that 
you keep your existing file" 

Click ‘YES’ to proceed 

When starting WinGLink, a 
dialog box displaying "You are 
running WinGLink in Demo 
mode" is displayed. 

Make certain that the WinGLink 
dongle is correctly connected and 
that the dongle driver has been 
installed.  
If the dongle is connected and the 
driver has been installed, your 
computer has not detected the 
dongle.  
It is possible that the parallel port on 
your computer has not been enabled 
(a problem frequently reported by 
owners of Toshiba laptops). To 
correct, please refer to section “What 
to do if program will only run in 
demo mode” of this chapter. 

 
 

Optimizing the Graphic System Settings 
These operations are needed to optimize your system for the use of 
WinGLink. 

 1. Click the  button, point to Settings, and then click 
Control Panel. 

 2. Double-click the Display button; select the Settings tab. 

 3. In Color Palette, select High Color (16-bit) or higher. 

 4. In Font Size, select Small fonts. 
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What To Do If Program Will Only Run in Demo 
Mode 
If a message is displayed when launching WinGLink indicating that the 
program is being run in Demo mode, despite having installed the dongle 
driver and having correctly connected the dongle, it is quite likely that 
your computer has not detected the dongle. A common cause of this 
problem is that the parallel port has not been enabled (when using a 
parallel port dongle). This may be the case even if the printer functions!  

To Check Whether Your Parallel Port Dongle Is Enabled: 
 1. Launch C:\Program Files\Rainbow Technologies\Sentinel 

System Driver\SetupSysDriver.exe 

 2. Click “Configure Driver” and make sure you see a physical 
address and port type for the parallel port. If you do not see 
one, the parallel port is not enabled! Follow the instructions 
below to enable the parallel port. Note that Windows XP will 
still allow the printer to work even though the port is not 
enabled. 

 3. Uninstall the Sentinel System Driver using the Add/Remove 
Programs wizard in the Windows Control Panel. 

 4. Reboot your computer and hold down the “ESC” key while 
tapping the “F1” button to enter BIOS. 

 5. Find the parallel port mode setting and enable it. 

 6. Save changes and exit BIOS.  

 7. Reinstall the Sentinel System Driver. 

If, after enabling the parallel port, WinGLink continues to run in demo 
mode only, please contact WinGLink technical support at 
support@winglinksoftware.com. 

What To Do If Using a USB Dongle 
If using a USB dongle, you may need to uninstall the dongle driver if the 
dongle was connected when the driver was installed. In this case, remove 
the dongle, uninstall the driver, then reinstall the driver. 

Starting WinGLink 
After successfully installing WinGLink on your PC, installing the dongle 
driver and plug-in in the dongle, you are ready to start the program.  

To Start WinGLink: 

 1. Click the  button on the Windows Task Bar. 

 2. Select Programs, and then click the WinGLink entry. 

mailto:gsy@geosystem.net
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 3. The following dialog box is displayed:  

 
Select the options listed in the Database frame if you would 
like to use WinGLink in Database Mode, or click "Enter Tools 
Mode" to run WinGLink in Tools Mode. See below for 
information on WinGLink’s two operating modes.  

Using WinGLink in Tools Mode 
The field data collected during a survey often require preliminary 
treatment and must undergo a certain amount of quality control in order 
to produce processed data which are suitable for further analysis. This is 
the case, for instance, of meter readings for gravity surveys or time series 
for MT soundings. 

WinGLink is equipped with a suite of programs (Tools) which handles 
data reduction and quality control (QC). These tools produce output files 
that can be imported into a WinGLink database for further processing and 
interpretation.  

These include programs for 

MT tools Function 
MT field processing Time series display (MT) 

Cascade decimation processing 
Cross-power editing 
Data analysis 

EDI files 
conversion/manipulation 

Conversion to EDI format of 
Stratagem/Imagem z*.* files 
Splitting multi-site EDI files 
Combining EDI files 

 
: 
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GR tools Function 
Gravity reduction Data reduction for Scintrex and 

Lacoste-Romberg g-meters 

Tide corrections Plots of tide corrections and output of 
values at user-assigned time intervals 

 
 

EM tools Function 
TemMerge Import, edit and merge raw data from 

field dump files (Geonics, Zonge, 
Sirotem and text files). 

 
To Use WinGLink in Tools Mode: 
- Select the Enter Tools Mode option in the starting dialog box or 

- When in Database Mode, select the File | Tools menu command on 
the main menu. 

WinGLink then opens in a view from which all tools supplied with your 
license can be selected: 

 
Detailed instructions on the use of the individual Tools programs can be 
found in the respective chapters of this manual. 

Using WinGLink in Database Mode 
The bulk of WinGLink’s power is accessed while in Database Mode. 
Here, databases and projects can be created and managed, data imported 
and the individual program modules opened: 
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To Use WinGLink in Database Mode  
To use the program in Database Mode, select one of the options in the 
Database frame of the initial dialog box, i.e. select either an existing 
databases, the demo database or create a new database. Detailed 
information on working with WinGLink in Database Mode is provided in 
the “WinGLink Shell” chapter of this manual. 

The User’s Guide 
This user’s guide is provided in printed form and as a PDF (Portable 
Documents Format) file which can be viewed and printed using Acrobat 
Reader version 3.0 or later. This is supplied with the installation CD-
ROM.  

Where To Find the Manual 
The Acrobat PDF file with the WinGLink user’s guide can be found in 
the \Winglink\Manual\Pdfdocs directory on the installation CD-ROM. 
Using Acrobat Reader, you can load the file from this directory or you 
can copy it to a directory on a hard disk and load it from there for faster 
access. 

How To Read and Print the Manual 
Use Acrobat Reader 3.0 or higher to open the manual.pdf file. Refer to 
Acrobat’s online help to learn how to view and print the manual. 

Acrobat Reader Installation 
To install Acrobat Reader 3.0 on your Windows 95/98 or NT4.0/2000/XP 
computer: 

 1. Move to the \Winglink\Manual\Acroread directory on the 
WinGLink installation CD-ROM. 
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 2. Double-click the Setup.exe program and follow the 
instructions. 
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3:  Workflow 

Overview 
Presented on the following pages are typical workflows for each of the 
data types supported by WinGLink. There are provided, in particular, for 
users new to WinGLink. Each of the typical work steps includes a 
reference to the corresponding WinGLink module and the chapter in this 
manual where detailed instructions on the given module can be found.  

The information is presented in tabular form, with the flowchart 
information in the left-hand column, the program module in the center 
and the manual reference at the right.  

 

For most data types, the workflow is divided into three main steps: 

- Quality Control 

- Interpretation 

- Presentation 

 

Within each of these steps, two different flowchart elements are used: 

- Parallelogram: Used to indicate the type of data used in the next 
operation, e.g. EDI file or well course. 

- Rectangle: A description of the given operation, e.g. data import or 
MT 2D inversion. 
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4:  Time SeriesMT 

Overview 
 WinGLink’s Time Series tool is generally used as an initial quality 
control step during an MT survey in order to analyze the acquired time 
series. This tool provides a variety of functions which are useful for 
evaluating the data quality in both time and frequency domains as well as 
a number of powerful tools for handling time series such as filtering, 
spectrographs, time shifting, extraction and others. 

Supported Formats 
The Time Series tool provides support for most of the leading acquisition 
systems including: 

- EMI MT-1 

- EMI MT-24 

- EMI MMT-24 

- Metronix ADU-06 

- Phoenix V5 

- Phoenix V5-2000 

- Phoenix V8 

Getting Started with the Time Series Tool 

Opening the Tool 
 After opening WinGLink in Tool Mode, select MT in the left panel of 
the tool form, select Field Processing in the left frame, and click the 

arrow to the left of . 
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Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started With WinGLink” chapter of this manual. 

Equipment Selection 
The Time Series tool opens with a dialog box prompting you to select a 
type of equipment, e.g. E.M.I. MT24. Make the appropriate selection and 
click OK. 

 

 
 
This window is opened automatically when the Time Series tool is started 
and can also be opened by selecting the File | New… menu command. 

Note: It is possible to view time series either as raw data, where only the 
AD conversion factor (mV/digitalized-unit) is applied, or as signal data.  

Band Selection 
After selecting the data type, the program prompts you to select the band 
extension of the acquired time series, i.e. t05 for 50Hz sampling rate. It is 
also possible to select decimated time series by entering the appropriate 
band extension. 
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This window can also be opened with the Settings | Band Selection… 
menu command 

Time Series Selection 
In the Time Series Selection form, use the left combo boxes to select the 
drive and folder containing the time series files to be opened. In the 
middle window, select the check box associated with a specific file. After 
selecting, a brief description (receiver ID, channel type, sampling 
frequency) of the file’s contents appears in the right window. Channels 
for which the check box is selected in the panel at the right are displayed 
after the OK button is pressed. 

 
 
This window can also be opened with the Settings | Plot Selection… 
menu command 

Displaying Time Series 
At this point, the selected time series are displayed in the main window. 
One time series is plotted in each frame. The plotted series reflect the 
number of samples specified by the # of Points drop-down list in the 
upper left part of the main window. By changing the value in this menu, 
it is possible to change the number of plotted samples from a minimum of 
64 to a maximum of 131,072. 
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Click the arrow buttons located in the scroll bar  at the 
bottom of the main window to scroll through the time series, i.e. move 
forwards and backwards along the time axis. 

 
The status bar, located at the bottom of the window, is used to display 
information corresponding to the current cursor location: 
Time:  Number of seconds from the acquisition start time 

Amp:  Amplitude value and specific unit of measure 

Site:  Station/receiver ID 

Channel:  Type(e.g. Ex, Ey,…) 

Date:  Absolute date and time (e.g. 01/May/2006 22:30:05), if available. 

The information bar at the top of the window is used to display two 
general pieces of information regarding the time series: the sampling 
frequency and the band ID. 

Changing the Channels to be Plotted 
Use the mouse to click the frame number at the far left edge of the 
window: 
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The Plot Selection window opens. Enter the necessary information and 
click OK to apply the new selections.  

Working with Frames  

Band & Plot Selection 
  The Band & Plot Selection windows, familiar from Time Series startup, 
can be accessed directly with the Settings | Band Selections… and 
Settings Plot Selections… menu commands, respectively. These two 
functions can be used to add time series to the current display. 

Clearing Frames 
Use the Settings | Clear Selections menu command to clear all currently 
displayed time series from the main window. Prior to clearing the 
display, the Time Series tool displays a confirmation window which must 
be acknowledged before the operation is performed. 

Adding or Removing Frames 
By default, the program makes seven frames available. It is possible, 
however, to add additional frames to the display and compare many 
channels of different time series in the same plot. Likewise, frames can 
also be deleted from the display. 

On the Settings menu, choose Add Frame or Remove Frame.  

All channels must be of the same band and must be synchronized. 

Note: Frames are added or deleted at the bottom of the plot. 
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Info Window 

Click the  icon to open an info window in which the following 
information for each of the time series is displayed: 

 
Site:  Station/receiver ID 

Channel: Data component 

Start Time:  Date and time of the first sample 

End Time:  Date and time of the last sample 

File:  Time-series file name 

AutoScale Function 

Click the Autoscale icon  to enable or disable the autoscale function, 
which automatically sets the range of the vertical scale of each frame to 
include all points from the minimum to the maximum value for the 
displayed samples. 

Note: When auto-scale is off, the vertical scale of each frame can be 
adjusted manually by clicking the two buttons  at the top and bottom 
left of each frame. Use the up and down buttons to increase or decrease 
the value of the scale endpoints. 

# of Points 
Use this drop-down list to select the number of samples currently 
displayed. The number of samples is also used in the spectra and 
correlation computations. 

Exporting Time Series 
Use the File | Export menu command to open the Export Time Series to 
ASCII window, which is used to export the selected files to external text 
files: 
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Printing Time Series 
Select the File | Print… menu command to open WinGLink’s familiar 
Print interface. Details on using this window can be found in the 
“Common Functions” chapter of this manual. 

Time Series Tools 

Filtering 
As described below, the Time Series Tool provides a number of filtering 
functions, including adaptive filtering, wavelet filtering and notch 
filtering. 

Adaptive Filtering 
This tool, accessed with the Tools | Adaptive Filtering… menu 
command, applies an adaptive filter (normalized least mean square filter) 
to the selected signals in order to notch a subset of desired frequencies, 
adopting an approach similar to that of echo cancellation. 
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In the Adaptive Filtering dialog box, shown above, set the parameter 
values in the Filters Settings frame for: 

Filter Order: The number of coefficient used for filtering (>0). 

Forgetting Factor: Weighting factor used in signal power estimation 
between new and current estimate (0< x <1). 

Convergence Parameter: The adaptation step, which controls the 
convergence time and adaptation quality  
(0<= x <1). 

Enter the frequencies to be notched in the upper right frame and click the 
Add button. 

In the Apply To frame, select the signals to be filtered by clicking the 
appropriate check boxes. To run the filter, click the OK button. 

Note: A backup of each original file is created for each filtered channel. 
These backup files are stored in the same folder as the original. A popup 
message appears following the filtering operation indicating the new file 
name. 

Wavelet Filtering 
This tool, accessed with the Tools | Wavelet Filtering… menu 
command, provides a filter that operates in the wavelet domain leaving 
good data sections unchanged. Data in the wavelet domain are analyzed 
through scale levels, allowing separation of noise from signals. Noisy 
elements of impulsive nature, either in time or frequency domain, are 
filtered out. 
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In the Filter Settings frame, select the parameters to be used in the 
filtering: 

Wavelet type:  The wavelet prototype function (e.g. Daubechies) 

Wavelet order:  Number of coefficients used to specify the set of 
wavelets 

Kind of weight: Weight function for anomalous data 
(i.e.Huber/Thomson) 

Threshold: Threshold level for identifying anomalous data 

In the Domain frame, specify the domain for the wavelet filtering by 
clicking the corresponding checkbox. 

In the Apply To frame in the lower left, select the signal to be filtered by 
clicking the corresponding check box. To run the filter, click the OK 
button. Only one channel can be filtered at a time. 

Note: The filtered data are displayed in a new frame as a new time series. 
Select the File | Save menu command to save this time series into a new 
file. The suffix  _sav  is appended to the name of the new time series file, 
but before the file extension. 

Notch Filtering 
This tool, accessed with the Tool | Notch Filtering… menu command, 
provides a recursive (IIR) filter for notch filtering a subset of frequency 
components from the observed data. The filter is applied in the forward 
and reverse direction in order to avoid the application of a phase shift to 
the data. 
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In the Notch Settings frame, enter the bandwidth value of the notch. In 
the right frame, enter a subset of frequency values to be notched. Enter 
the value and then click the Add button. 

In the Apply To frame, select the signals to be filtered by clicking the 
appropriate check box. To run the filter, click the OK button. 

Note: A backup of each original file is created for each filtered channel. 
These backup files are stored in the same folder as the original. A popup 
message appears following the filtering operation indicating the new file 
name. 

Time Shifting 
This tool is useful for synchronizing different signals. To open the Time 
Shifting window, select the Tools | Time Shifting… menu command: 

 
In the Time Shift field, enter a value in seconds (decimal) for the shift 
which is to be applied.  
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Note: The shift value can also be negative; in this case, a random signal 
is added to the beginning of the time series. The random signal samples 
are calculated by adding to the first sample of the time series its own 
value times a pseudo-random number which is uniformly distributed 
between -0.001 and 0.001. 

In the Apply To frame, select the signals to be shifted by clicking the 
appropriate check box. To shift the series, click the OK button. 

Note: A backup of each original file is created for each shifted channel. 
These backup files are stored in the same folder as the original. A popup 
message appears following the shifting operation indicating the new file 
name. 

Extracting Segments 

Extracting Segments from Time Series 
The Extract Segments function, accessed with the Tools | Extract 
Segment… menu command, is used to extract a segment from a time 
series using the number of seconds from the first sample as the limit for 
the extraction: 

 
Enter the start and end times of in the respective fields at the top of the 
window.  

To update the header with the new acquisition times, select the checkbox 
provided for this purpose.  

In the Apply To frame, select the signals from which time series are to be 
extracted by clicking the appropriate check boxes. Click the OK button 
to extract the time series. 

Note: The extracted data are displayed in new frames as new time series. 
Select the File | Save menu command to save the new time series to a 
new file. The suffix  _sav  is appended to the name of the new time series 
file, but before the file extension. 
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Extracting Segment from Date 
This tool differs from the previous one in the format of the limits used in 
the extraction. In this case, the absolute date and time are used as the start 
time and end time.  

To open the tool, select the Tools | Extract Segment from Date… menu 
command: 

 
 

Enter the start and end dates and times of in the respective fields at the 
top of the window. 

To update the header with the new acquisition times, select the checkbox 
provided for this purpose.  

In the Apply To frame, select the signals from which time series are to be 
extracted by clicking the appropriate check boxes. Click the OK button 
to extract the time series. 

Note: The extracted data are displayed in new frames as new time series. 
Select the File | Save menu command to save the new time series to a 
new file. The suffix  _sav  is appended to the name of the new time series 
file, but before the file extension. 

Inverting Polarity 
The Invert Polarity tool, accessed with the Tools | Invert Polarity… 
menu command, changes the sign of the selected data signals, i.e. the 
signal is rotated by 180 degrees: 
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In the Apply To frame, select the signals to be inverted by selecting the 
appropriate check boxes. To invert the time series, click the OK button. 

Note: A backup of each original file is created for each inverted channel. 
These backup files are stored in the same folder as the original. A popup 
message appears following the shifting operation indicating the new file 
name. 

Computing Differences 

Channel Difference 
This tool, accessed with the Tools | Channel Difference… menu 
command, provides a useful function for data quality control for 
homogeneous signals. It is used to compute the difference between two 
channels. The result can be treated like a new time series. 

 
 

In the Apply To frame, select the two signals for which the difference is 
to be calculated by selecting the desired check boxes. To compute the 
difference between the two selected time series, click the OK button. 

Note: The new time series generated with the tool is displayed in the first 
free frame and can be saved by selecting the File | Save menu command. 
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First Difference 
This tool, accessed with the Tools | First Difference… menu command, 
computes the first difference of a channel, subtracting each sample from 
the previous one.  

 
In the Apply To frame, select the signal to be processed by clicking the 
appropriate check boxes. To run the tool, click the OK button 

Note: The new time series generated with the tool is displayed in the first 
free frame and can be saved by selecting the File | Save menu command. 

Correlation 

Raw Correlation 
The Raw Correlation tool provides a powerful function for evaluating 
the information shared by two channels (e.g. it can be used to test the 
synchronization of signals). The correlation function can be applied to a 
single channel (auto-correlation) or to a pair (cross-correlation). 

If the maximum in the cross-correlation between two signals occurs at 
sample number 0, the two signals are perfectly synchronized; the shape 
of the cross-correlation is dependent on their spectral content (e.g. the 
auto-correlation of a white random signal is an impulse). 

Access the Raw Correlation tool with the Tools | Raw Correlation… 
menu command: 

 
The Raw Correlation tool computes the auto- or cross-correlation of the 
selected signals using the number of samples displayed in the main 
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window. In order to compute the raw correlation over a wider range of 
samples, change the value in the # of Points drop-down list in the upper 
left area of the main window. 

In the Apply To frame, select one (auto-correlation) or two (cross-
correlation) signals to be processed by selecting the appropriate check 
boxes. To perform the correlation calculation, click the OK button.  

A new window containing the auto- or cross-correlation curve now 
opens. The value and position of the maximum are displayed in the lower 
right; the value and position at the current mouse position are displayed 
in the lower left. 
 

 

 
 

 

Stacked Correlation 
This tool differs from Raw Correlation in that it computes auto- and 
cross-correlation over the entire signals. The signals are divided into 
windows of size equal to the number of samples set in the # of points 
drop-down list. The correlation is computed for each window and the 
results averaged to output a stacked correlation. 

Access the tool with the Tools | Stacked Correlation function: 
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In the Apply To frame, select one or two signals to be processed by 
enabling the appropriate check boxes. To compute the stacked 
correlation, click the OK button.  

A new window containing the auto- or cross-correlation curve opens. The 
value and position of the maximum is displayed in the lower right area of 
the window; the value and position at the current mouse position are 
displayed in the lower left area of the window. 

Spectra 

Raw Spectra 
Select the Display | Raw Spectra menu command to compute and 
display the frequency domain spectra of the displayed channel samples 
based on the currently displayed data. 

The spectra are calculated using the settings set with the Settings | 
Spectra Options… menu command: 

 
The default spectra settings are 50% overlap and Hanning window. 

Click the scroll buttons  at the of the main window to 
scroll through the time series in the frequency domain in steps equal to 
the value set in the # of Points drop-down list:  
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This tool provides a useful instrument for locating frequency domain 
outliers in MT time series. 

Select the Display | Time Series menu command to visualize the time 
series segment which corresponds to the current raw spectra. 

Note: The spectra are computed using the number of points set in the # of 
Points drop-down list. 

Stacked Spectra 
Select the Display | Stacked Spectra menu command to compute and 
display spectra over the entire time series using the spectra parameters set 
using the Settings | Spectra Settings… menu command: 

To find spectral peaks, the user can move the cursor over the spectra 
curves: Current frequency and amplitude values are displayed in the 
lower left. 
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Spectrogram 
The Spectrogram tool is a powerful utility for checking the temporal 
variations of the spectral content of a signal because, in a spectrogram, 
the horizontal scale is the time axis and the vertical scale is the frequency 
axis. 

The time domain signal is divided into n windows of sample length equal 
to the value set in the # of Points drop-down list; the spectra of all 
windows are computed and displayed side by side.  

Select Tools | Spectrogram to open a new window which displays the 
spectrogram: 
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As explained in the following, the number of points used in each spectra 
computation is, in the frequency domain, equal to one half the number of 
values set in the # of Points drop-down list. This is due to the following: 
Because the time series contains real values, the transformation is even 
(symmetric with respect to the y axis) for the amplitude and odd 
(symmetric with respect to the origin) in phase. Because the spectrogram 
is a representation of the power spectra (i.e. the power of the amplitude), 
only half the number of points are needed - those for the positive axis of 
the frequencies. 

Select the channel to be displayed in the upper left menu of the 
spectrogram window. 

To change the number of points used for each spectrum, select a different 
value in the # of Points drop-down list (the number of samples used in 
the FFT is two times this value). 

Click the  button to edit the color range used in the display. Select 
the check box in the bottom right to reverse the frequency scale. 

The frequency value, and date and time at the current mouse position are 
displayed in the lower left part of the window. 

As with the other spectra options, the window function and overlap used 
in the spectra calculation can be set in the Spectra Settings window, 
opened with the Settings | Spectra Options… menu command.  

Batch Functions 
The Time Series tool offers a number of batch functions which can be 
used to simultaneously perform any of a number of different functions on 
multiple time series. To access the batch functions, close any open times 
series with the File | Close menu command. The Batch menu item then 
appears in the main menu: 
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The arrows to the right of each menu item open a drop-down list from 
which the desired data type can be selected: 

 

Note: Not all functions are available for all data types. 

Decimation 
This tool generates new decimated time series files from the original one. 
A decimation factor of 2 is repeatedly applied to the signal until the 10th 
level of decimation is reached. 

In the left part of the window, select the drive and folder that contains the 
time series files. To the right of the drop-down list for the drive, select 
the time series format of the files that are to be selected in the field in the 
center of the window. Click the OK button to start decimation of the 
selected files. 

 

Extraction 
Use this tool to extract time series segments which cover a given time 
interval from a subset of time series. The limits used for the extraction 
are the absolute date and time. The extracted time series are written to 
new files. 

Select the appropriate equipment type in the Select Equipment frame.  
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In the Select Files frame, choose the drive and folder, then select the 
desired file extension and the list of original files by clicking the 
appropriate check boxes. A brief description (file name, start date and 
time, end date and time) of the selected files is displayed in the upper left 
window. 

In the lower left fields, enter the desired values for start and end times. 
Click the OK button to extract the data. 

 

MultiChannel Time Shift 
Use the Batch File | MultiChannel Time Shift menu command to 
perform a shift operation on selected EMI MT1 and Phoenix V8 time 
series files. 

MultiChannel Extract Segment 
Use the Batch File | MultiChannel Time Shift menu command to 
perform a shift operation on selected EMI MT1 and Phoenix V8 time 
series files. 

MultiChannel Extraction Table 
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5:  Cascade Decimation MT 

Overview 
WinGLink’s Cascade Decimation program uses the cascade decimation 
processing method to generate cross-powers from MT time series files. 
The program also provides an option for using coherence robust 
processing to further improve data quality, though this option 
considerably lengthens processing times. 

Execution of the actual processing routines occurs in batch mode using 
parameter files which are created using a Wizard interface, which is an 
integral part of the Cascade Decimation program. 

Input Data 
The program supports the following time series formats: 

• EMI MT-1, EMI MT-24 

• Metronix (ADU-06) 

• Phoenix (V5)  

Output Data 
Processed data are output both as binary weighted cross-power files 
(*.bxp), which can then be edited using WinGLink’s Cross Power tool, as 
well as standard EDI files, which can be directly imported into 
WinGLink or opened in WinGLink’s Data Analysis tool. 

About Command Files 
A single RCD command file may be used to process a maximum of two 
sites, i.e. local and remote and, depending on the data source, up to three 
different frequency bands. The names of the sites, the corresponding time 
series paths, and the relevant parameters to use are all saved in the text-
based command file. The processing routine, which is implemented as an 
external executable file, accesses the command files during program 
execution. 
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Getting Started with Cascade Decimation 

Opening Cascade Decimation 
After opening WinGLink in tool mode, select MT in the left panel of the 
tool form, select Field Processing in the left frame, and click the arrow 
to the left of . 

 

Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started With WinGLink” chapter of this manual. 

The program opens with a message alerting you to the fact that an RCD  
command must be created for each set of sites: 

 
Confirm with OK to acknowledge the info box and open the main 
program interface: 
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This main program interface is used to select the command files to be 
used for data processing. Use the path navigation controls provided in the 
upper part of the window to select the folders which contain the desired 
command files. Any RCD files found in a given folder are listed in the 
Parameter Files field. Use the arrow button to select a file for 
processing. Files can be removed from the Selected for Batch Run field 
with the Delete key.  

Note: It is not necessary that all RCD files to be processed be located in 
the same folders. To select files from different folders, after selecting one 
RCD file, use the navigation controls to navigate to the folder which 
contains the next. 

Creating a New Command File 
 If working with the Cascade Decimation program for the first time or to 
create a new RCD command file, first use the path navigation controls 
provided in the upper part of the window to specify the folder in which 
the file is to be created. Then click the New button to open the RCD File 
Wizard, which will guide you through the file creation process: 

- Wizard window 1: File type and processing parameters 

- Wizard window 2: Weighting and processing types 

- Wizard window 3: Time series selection 

- Wizard window 4: Channel mapping 
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Wizard Window 1: File Type and Processing Parameters 

 
In the Parameters File field, enter the name of the RCD file which is to 
be created. The selection made in the Time Series Type drop-down list 
determines what other options are displayed on this first window: 

- For E.M.I. MT-1 and MT-24 data, options are provided for 
specifying the number of sites to be processed as well as the number 
of frequency bands as shown above. 

- For Phoenix V5 data, only the number of sites must be specified. 

- For Metronix ADU06 data, in addition to the number of sites to be 
processed and the number of frequency bands, specify whether a 
default set of calibration files should be used if the calibration file 
specified in the file headers is sensor.cal: 

 
According to the system manufacturer, there is generally very little 
difference between sensors. The standard calibration files, which 
were provided by the manufacturer, generally provide accurate 
results for most coils. For maximum accuracy, however, we 
recommend using the calibration files provided with the coils. 

After making the desired selections, click the Next button to advance to 
the second window of the Parameters File Wizard: 
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Wizard Window 2: Weighting and Processing Types 

 
In the Weighting Type frame, specify the type of weighting to be 
performed.  

In the Robust Processing frame, enable or disable robust processing for 
the site(s) being processed.  

The Robust Maximization Type drop-down list offers a number of 
different maximization types for selection: 

 
These maximization types differ as follows: 
  
Type Method 

1)-MCOH local E-local H Combine the weighting factor of scheme 2 
with that of scheme 3 

2)-MCOH local Ex-local H Use MULTIPLE COHERENCE of Ex with 
the total MAGNETIC field 

3)-MCOH local Ex-local H Use MULTIPLE COHERENCE of Ey with 
the total MAGNETIC field 

4)-MCOH local H-remote Use the combined weighting factor of the 
MULTIPLE COHERENCE of Rx with the 
total MAGNETIC field with the 
MULTIPLE COHERENCE of Ry with the 
total MAGNETIC field.  

5)-MCOH local E-remote Use the combined weighting factor of the 
MULTIPLE COHERENCE of Rx with the 
total ELECTRIC field with the MULTIPLE 
COHERENCE of Ry with the total 
ELECTRIC field. 
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6)-PCOH local E-local H Combine the weighting factor of scheme 7 
with that of scheme 8 

Note: If robust processing is enabled for either of the two sites, the time 
series of both sites must be synchronized.  

After setting the weighting type and robust processing options, click the 
Next button to advance to the next window of the wizard: 

Wizard Window 3: Time Series Selection 
The third window of the wizard, which is used to select the data to be 
processed, varies depending on the type of equipment selected in the first 
window. The windows associated with each of the four equipment types 
currently supported are described below: 

EMI MT-1 

 
Click the Add Files… button to open the EMI MT-1 time series selection 
window. Note that when clicking the Add Files… button, you must 
select from the drop-down list which appears the time series set to which 
the data are to be added: 
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Select the time series for each data set and for each band. Select the band 
using the drop-down list in the upper left corner of the time series 
selection window. The path to the sensor calibration files for all coils 
used in the sounding must be specified in the Sensors Path field at the 
bottom of the window. 

 
EMI MT-24 

The main window of the EMI-24 time series selection interface is nearly 
identical to that for EMI-MT1 data shown above. Unlike EMI-MT1 time 
series files, which contain all data associated with a given sounding, each 
component of an MT24 sounding is stored in a separate file. Thus, 
instead of selecting a single time series file, it is necessary to select an 
entire set. This is accomplished using an .SRE (survey) file. An SRE file 
is nothing more than a list of file names with their respective absolute file 
paths. Shown below are the contents of a sample SRE file: 
E:\Survey_01\RX01\rx01_1.t05 

E:\Survey_01\RX01\rx01_2.t05 

E:\Survey_01\RX01\rx01_3.t05 
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E:\Survey_01\RX01\rx01_4.t05 

E:\Survey_01\RX01\rx01_5.t05 

Note: SRE files must be manually created for each set of time series data. 

To select the SRE file for a given time series set and band, select the 
desired band from the Band drop-down list and then click the Add 
Files… button, selecting the desired time series set in the process: 

 
Repeat this process for each band and data set. Specify the sensor path to 
complete the file selection process: 

 
Phoenix V5 

As it is not necessary to specify a frequency band when processing 
Phoenix V5 data, time series selection is limited to the selection of the 
time series files, one file for each site: 
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Metronix ADU06 

Metronix files, like EMI MT24 files, each contain data associated with a 
separate channel. For Metronix files, however, the Cascade Decimation 
program automatically generates a survey file which contains the paths of 
the respective files. As with the other file types, click the Add Files… 
button to open the TS Selector window: 

 
This window contains four frames: 

- Folders: Contains all sites which have been added by the user 

- ADU ID: Station ID of the selected site 

- Run: Run number of the selected site 

- Band: Frequency band of the selected site 

Next, click the Add folder site button to add time series files to the 
selector window: 
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Navigate to the folder which contains the desired time series files. Click 
the OK button to accept the selection and close the window. In the TS 
Selector window, now click the folder which was just added: all time 
series contained in the folder are now listed by station ID, run number 
and frequency band: 

 
Select time series for each site and band. Note that the time series added 
to the TS Selector window are retained for future use until cleared with 
the Delete Selection button. 
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File sets can be removed from the Survey File Set fields by clicking the 
respective field with the right mouse button and selecting the Clear Time 
Series Set shortcut menu. 

After selecting the time series, click the Next button to advance to the 
fourth Wizard window: 

Wizard Window 4: Channel Mapping 
The fourth and final window of the wizard is used define station mapping 
and specify the site names. In the example shown below, the program has 
automatically used the magnetic channels from the 2nd site as the remote 
channels for the 1st site and vice versa.  

 
Channel mapping can be changed by clicking a component name and 
dragging it to the new position in the Reference Fields section of the 
window. Channels can either be selected from the lists located under the 
Time Series Channels heading, or channels which have already been 
assigned a field in the Reference Fields area of the window can be 
moved from one field to another. 

The program responds to unexpected settings, e.g. placing an Hy 
component on an Hz field with, a warming message: 
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Such reference field assignments may be necessary under certain 
circumstances, e.g. when using non-standard field configurations. 

Use the Band drop-down list to switch between the bands which have 
been selected for processing. After assigning the reference fields for each 
band, click the Finish button to complete the Wizard. 

Processing Data 
Upon completion of the Wizard, the Cascade Decimation program 
returns to the main window. The just-created RCD file, as well as any 
other RCD files present in the current folder, are available for selection. 
Use the  button to move the RCD files to be used to process data to the 
Selected for Batch Run frame of the window: 

 
Click the Run button to begin processing of all selected RCD files. 
Depending on the set processing parameters, the size of the time series 
files and the number of bands to be processed, processing time may be 
considerable. During processing, a DOS command window will appear 
on the screen; once processing has completed, the program window 
closes. Closing this window with the mouse will prematurely terminate 
data processing.  

Upon successful completion of processing, an EDI file and a BXP (cross-
power) file are output to the same folder as the RCD file. BXP files can 
be opened in WinGLink’s Cross-Power Editor program; EDI files can 
either be edited in WinGLink’s Data Analysis program or imported 
directly into a WinGLink database. 
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6:  Cross-Power Editor MT 

Overview 
WinGLink’s Cross-Power Editor provides an easy-to-use interface for 
editing the cross powers generated by WinGLink’s Cascade Decimation 
program. The resistivity and phase values at a given frequency typically 
consist of a number of samples. The Cross-Power Editor is used to edit 
the individual samples. Upon completion of editing, the average values at 
each frequency are used to generate an EDI file which can then be 
opening in the Data Analysis tool for MT data or imported directly into 
WinGLink as station data. 

Supported Formats 
The Cross-Power Editor can be used to edit the BXP files generated by 
the Cascade Decimation program. In addition, the program can also edit 
.MT and .AMT files generated by the Phoenix V5 processing software. 

Getting Started with the Cross-Power Editor 

Starting the Cross-Power Editor 
After opening WinGLink in tool mode, select MT in the left panel of the 
tool form, select Field Processing in the left frame, and click the arrow 

to the left of . 
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Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started With WinGLink” chapter of this manual. 

The Cross-Power Editor opens: 

 
The program window is divided into four panels. The two panels on the 
left side are used to display the average rho and phase values at each 
frequency; the two on the right are used to display all samples at a given 
frequency. 

Loading a Cross-Power File 

 1. Click the  button to open the dialog box for selecting the 
cross-power files to be opened. 

 2. Click the  button in the Files of Type dropdown list to 
display the supported input file formats. Make the appropriate 
selection: 

 3. Use the file navigation controls in the left part of the window to 
browse the directory structure until the files you wish to edit are 
displayed in the File | Site frame of the window. 

 4. Select the check box to the left of each file you wish to open. 

 
  Note: The Cross-Power Editor can be used to open more than 

one file at the same time. If you do so, the opened files will be 
merged into a single file when the results are saved. This option 
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should be used only to merge cross-powers for the same station 
contained in different input files. 

 5. If desired, specify an angle for spectra rotation in the 
appropriate field.  
 
Note that the rotation is returned to the principle axis when the 
file is saved regardless of any setting made here. Rotation 
options are provided in the Data Analysis tool, the Soundings 
module and when importing EDI files into a WinGLink 
database. 

 6. Click the Open button to open the cross-power file 
for editing. 

Editing a Cross-Power File 
To begin editing, select a frequency from the left side of the Cross-Power 
Editor by clicking the mouse anywhere in the average resistivity panel of 
the editor, i.e. the upper left panel. The data sample at the frequency 
closest to the mouse location is selected. The currently selected frequency 
is displayed in red in both the resistivity as well as the phase panels; the 
blue bars correspond to the yx component, the green bars to the xy 
component: 

 

Masking/Unmasking Components 
 1. In the left window, use the mouse to click the resistivity or 

phase of the frequency to edit. The color of the error bars for 
the selected frequency changes to red. All components 
associated with a given frequency, i.e. resistivity and phase of 
both xy and yx components, are masked/unmasked together. 

 2. Click the  button on the toolbar to mask/unmask individual 
component in the right window, or 

 3. Click the  button to mask/unmask a group of adjacent 
individual components in the right window. 
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 4. The disabled components are displayed in gray. The results of 
the editing are shown in real time in the left window: 

 

Saving the Edited Results 

Click the  button to save the edits. 

Files can be saved either as BXP or EDI files: 

• BXP files 
Contain all original file information, i.e. information about 
which samples have been disabled. These files can be read 
into the Cross-Powers Editor at a later time for further 
editing. 

• EDI files 
Contain the final averaged results in EDI format. These files 
are used as the input source for the "Data Analysis" program, 
an MT Tools program, and can also be imported directly into 
WinGLink as station data. 
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7:  Data Analysis MT 

Overview 
The Data Analysis program is used to edit and analyze individual stations 
as standalone datasets. The user interface is very similar to that of the MT 
Soundings module, which can be accessed while in Database Mode, and 
offers many of the same functions. Because this program is intended for 
performing quality control and editing operations, however, the menu 
commands available in Tools Mode are somewhat limited, i.e. this tool 
does not include 1D modeling. 

Supported Formats 
The Data Analysis program can only be used to import standard EDI 
files. 

Getting Started With the Data Analysis Program 

Opening the Program 
After opening WinGLink in Tool Mode, select MT in the left panel of 
the tool form, select Field Processing in the left frame, and click the 

arrow to the left of  . 

Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started With WinGLink” chapter of this manual. 

File Selection 
On program startup, the Data Analysis program opens with a dialog box 
prompting you to choose either individual station mode or batch mode. 
This second option, as will be described later, can be used to perform a 
specific function on multiple stations. To get started wit the program, 
select the Open stations option and click the OK button: 
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The program opens the File Selection window. This can be used to select 
any EDI files accessible from the computer: 

 
In the Plot Parameter area of the window, you can specify whether the 
plot parameters should be recalculated, and, if so, whether impedances or 
spectra, if present, are to be used. The options function as follows: 

Plot Param. 
Option 

When to use 

No recalculation To import the plot parameters saved in the EDI file 
without recalculating them from existing impedances 
or spectra 
If plot parameters are missing, the program calculates 
them from existing impedances. 
If impedances also are missing, plot parameters and 
impedances are calculated from existing spectra. 

Recalculate from 
existing 
Impedances 

To compute plot parameters from existing impedances 
without recalculating impedances from spectra. 

Recalculate from 
existing spectra 

To recalculate plot parameters and impedances from 
spectra. 

 
Rotation 

In the Rotation area of the window, specify how impedances and tipper 
are to be rotated upon import. In doing so, note the following: 
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If there is a ZROT block in the EDI file, the data are first “back rotated” 
to 0 degrees. Thus, to match the rotation in the EDI file, you must use the 
User Defined field to specify the angle to which the impedances are to be 
rotated. The angle specified here is used for all frequencies for the given 
file.  
 
When rotating to the principle axis, the program rotates the impedance 
matrix to the maximum and minimum values of Zxy and Zyx, 
respectively.  
 
If there are tipper data present in the EDI file, these data are likewise 
“back rotated” to 0 degrees from the angle specified in the TROT block. 
If there is no TROT block, it is assumed that the data are already at 0 
degrees and no back rotation is performed. The ZROT block is NOT used 
to specify the tipper rotation in the case that no TROT block is present. 

The EDI files of stations which were rotated contain ZROT and TROT 
fields with values corresponding to the station rotations.  

Note: When using the Data Analysis program, tipper should be rotated to 
strike. 

Saving Data 
Edited station data can be saved to EDI files from the main window of 
the Data Analysis program with the File | Save As or File | Save All 
menu commands. To prevent the accidental overwriting of the original 
data files, the Save All command saves files with the extension EDE. 

Data Rotation & Decomposition 
Should it be necessary to rotate a station after the EDI file has been 
opened in the Data Analysis program, the Curves Recalculation window, 
which contains the same rotation options as the File Selection window 
described above, can be opened by selecting the Rotate menu command 
on the main menu: 

 
In addition to standard rotation, this window provides an option for 
performing LaTorraca decomposition.  
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Correcting Spectra 
WinGLink reads and writes stacked spectra from/to EDI files using a 
[Real+Imaginary] spectral conjugation structure. If stacked spectra are 
packed in an EDI file using a different structure, the MT parameters may 
be incorrectly displayed. 

When spectra are packed properly, the phase components are displayed 
by WinGLink in the correct quadrants, i.e. +45° for one component, and -
135° for the other, and predicted coherencies will be consistent. This may 
not be the case when the spectra packing is made using a different 
conjugation structure. 

The Fix Spectra function, accessed with the menu command by the same 
name, allows the user to correct the spectral set by swapping or 
conjugating the spectra packing: 

 
The options in the upper part of the window serve the following function: 

 
Option Result 
Swap changes (A+B) into (-B+A) 

Conjugation changes (A+B) into (  A-B) 

The proper spectra packing is achieved by combining these corrections in 
an appropriate sequence. 

Viewing Data and Plot Parameters 

The Data Analysis View Form 
The following figure shows the Data Analysis view form: 
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TE/TM mode 
selector 

Click this button to change which curve corresponds to 
TE mode. In the above example, the xy curve is selected 
for TE mode (therefore, the yx is for TM mode) 

1D model 
validation 

This text is displayed whenever the 1D model of the 
station needs to be recalculated because a change was 
made on the curve. 

Invariant 
display 

If this option is checked, the invariant curves for 
resistivity and phase are shown. The invariant resistivity 
is calculated as the geometric mean of rhoXY and 
rhoYX; the invariant phase is calculated as the arithmetic 
mean of the two. 

Smooth type Indicates the algorithm used to calculate the smoothed 
curves. 

Current 
rotation 

Indicates the rotation (if any) applied to the impedances. 

XY, YX 
curves 

The original curves are displayed in gray, the edited 
curves in red (the XY) or blue (YX); the continuous 
curves represent the smoothed data. 

Static 
stripping 

If present, this text indicates that the edited curves have 
been static stripped. 

Data Display Options 
  The options available under the View menu can be used to select from 
various displays: 

- Resistivity and phase 

- Resistivity, phase and strike 

- Interpretational quantities 

- Polar diagrams 

- Resistivity, phase and polar diagrams 



 

7-6  •  Data Analysis MT A guide to using WinGLink 

- Resistivity, phase and induction arrows 

- Data quality 

- Tzx and Tzy 

Each of the above selections made under the View menu applies to the 
current window. The selection can be applied to all open windows with 
the View | Update All View menu command. 

View Options 
Display parameters, e.g. ranges, axes, curve types, can be set in the 
Settings window, opened with the View | View Options… menu 
command: 

 
Settings made here are applied not only to all open windows, but are also 
used the next time the Data Analysis program is started. 

Spectral Analysis 
The Spectral Analysis function, which is only available for soundings 
which have spectral data, is opened with the View | Spectral Analysis 
menu command. This function, used to compare a number of spectral 
characteristics between two channels, serves as a tool for gathering 
insight on data quality.  

Upon selection of the menu command, the Spectral Analysis  
Selection window opens. Select the channels to be evaluated in the 
provided drop-down lists. A rotation angle, if desired can be selected in 
the Rotation Angle frame of the window. 
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Transfer function ranges can be set for both amplitude and phase by 
clicking the Settings button. 

Click the OK button to open the Spectral Analysis window for the 
selected channels: 

 

Editing Data 
The interactive Sounding Editing form is opened with the Edit menu 
command while a sounding window is selected: 
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The form includes commands for performing a number of different 
editing functions. After clicking any of the function buttons at the right 
edge of the Edit window, the remaining buttons, with the exception of the 
Cancel button, are disabled. The selected function remains active until 
either the respective function button is pressed again or until the Cancel 
button is pressed.  

Changes made to the curves with the edit functions available here are not 
actually applied to the data until the Close button is used to close the Edit 
window and the user acknowledges the changes in the Exit Editing 
window.  

In addition to the actual curves, the status bar at the bottom of the Edit 
window provides additional information on the curves as well as with 
respect to the current mouse position: 

 
- f = frequency at current cursor position 

- Rho =  resistivity value at current cursor position 

- Shift xy = static shift of xy curve 

- Shift yx = static shift of yx curve 

- Smooth = indicates type of curve smoothing, if any 

- Rot: rotation type and/or value 

Selecting Data Points 

 Single point selection 

Click to select/unselect for editing single data points on the curve. 

 Multiple points selection 

Click to select/unselect for editing all data points included in a user-
defined range: click and drag the mouse to define the area. 

Zooming in on the Curve 

 Zoom in 
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 1. Click a point in the curve diagram and release the button. 

 2. Move the mouse to define the zoom area. 

 3. Click and release the left mouse button. 

  Zoom out 

Click to reset the previous view.  

Note: this button is available only after the Zoom in button has been 
used. It remains available until the original curve size is restored. 

Saving Editing Changes 

 Save button 

Saves the editing changes. These changes must be confirmed when 
closing the station window in the main menu in order to store them in the 
database. 

Editing Data Points 

 Masking data: Using the appropriate buttons, it is 
possible to mask individual modes at each frequency, either across all 
modes or for individual modes. Changes made here are reflected 
throughout the database, i.e. in the 2D Inversion and Pseudo-Section 
modules.  

Note that the Mask Tipper button is enabled only when tipper display is 
enabled using the drop-down list at the top of the screen: 

 
Select the Tzx & Tzy display option to display the two tipper components 
in separate windows.  

The vertical scaling of the tipper magnitude and Tzx/Tzy components can 
be set using the Tipper Vertical Scaling button , which appears 
towards the left end of the tool bar when either Tipper Magnitude or 
Tzx/Tzy are visible. Clicking this button opens the Tipper Scaling dialog 
box: 

 
Settings made here are retained in subsequent WinGLink sessions. 
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The MT masking buttons are used in the same way as the TEM masking 
buttons, see description above. 

 

 
 Shift data points 

 1. Click and select the data points to be shifted by single or 
multiple selection. 

 2. Move the data points to the desired positions and click the left 
mouse button. 

 3. Click the Shift button again to confirm the action. 

  Calculate and display a smoothed curve 

Click the button to display the smoothing options 

 Cancel the current action 

 Undo button 

Undo all the editing changes made since the last time the curve was 
saved. All editing steps can be undone provided the station has not yet 
been saved since editing. 

Swapping 
Swapping allows you to assign a data point of the XY curve to the YX 
curve (at the same frequency) and vice versa. This is useful where 
analytic rotation results in inconsistent mode assignment. 

To Swap the Data Points of Apparent Resistivity or 
Phase Curves: 
 1. Open the station or select its window if already open. 

 2. Select the Edit command from the main menu.  

 3. Click the  button. 

 4. Click the data point(s) you wish to swap with the left mouse 
button. 

 5. Click the  button again. 

To swap the entire curve, use the right mouse button at Step 4. 

Static Stripping 
Static stripping is an analytic technique for eliminating the frequency-
independent offset of one apparent resistivity curve from the other. 

To Perform Static Stripping on an Apparent Resistivity 
Curve: 
 1. Select the Edit command on the main menu.  

 2. Click the  button. 
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 3. Click a data point on the curve and release the mouse button. 

 4. Move the curve to the desired location and click the left mouse 
button. 

 5. Click the  button again. 

Normally, you would select a point at the high-frequency end of the 
curve. Practical experience suggests that most static shift cases result in 
one curve being moved down relative to the other. You therefore move 
the lower curve up to the higher one. 

When the original apparent resistivity curve is dragged to its new 
position, a scalar multiplier of the e-field value is derived. This is applied 
to a recalculation of all the impedances of that sounding. Thus, when you 
click Strip for the second time, you should see the hour-glass symbol, 
indicating that this calculation is taking place. The curves are then 
redrawn. Only the apparent resistivity curves are affected by this 
procedure. 

If the data show a very large static shift, or are strongly 3D at high 
frequencies, the results can sometimes be unstable. You may need to 
repeat the operation several times. 

Static Shifting 
Static shifting allows you to vertically shift all data points of a curve. 

To Statically Shift a Curve: 
 1. Select the window with the sounding to edit 

 2. Select the Edit command on the main menu.  

 3. Click the  button. 

 4. Click one of the curve’s data points and release the button. 

 5. Using the mouse, move the curve to the desired location. The 
amount of static shifting is displayed in the bottom of the 
window: 

 
This number is a scalar factor that multiplies the original 
resistivity values of the curve. If equal to 1, the curve is not 
shifted. 

 6. Click and release the left mouse button. 

The apparent resistivity range changes so that the curves appear centered 
in the display box. 

A useful guide for determining the resistivity level to which a curve 
should be shifted is obtained by displaying the pseudo-MT curve for a 
co-located TDEM station. 

To Reset the Static Shift to Zero: 

 1. Click the  button. 
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 2.  to run Smoothing routines 

 to add/subtract 360° to phase data points 

 to show pseudo-MT curve from TDEM model 

Calculating Smoothed Curves 
Resistivity and phase smoothed curves can be calculated from the edited 
curves using three different techniques. They are automatically updated 
whenever further editing is made on the curves. 

To (Re)calculate a Station’s Smoothed Curves: 
 1. Open the station or select its window if already open. 

 2. Select the Edit command on the main menu. 

 3. Click the  button. 

 4. Select Smooth Options and click the OK button. 

The available smoothing options are described below 

Sutarno Phase Consistent Smoothing 
This is an application of the Hilbert transform to give an apparent 
resistivity curve from the phase curve. (Sutarno, D. and Vozoff, K., 1991, 
Phase-smoothed robust M-estimation of magnetotelluric impedance 
functions: Geophysics, 56, 1999-2007). It is used primarily to confirm 
that apparent resistivity and phase are consistent. 

D+ Smoothing 
D+ relates apparent resistivity and phase of the same component (xy or 
yx) through a D+ function. In essence, this finds the one-dimensional 
earth which best fits both parameters. The procedure has been shown to 
be valid for most 2D data and for some 3D cases. 

The errors attributed to the data can be those estimated by the original 
data processing or can be imposed by the user. In the first case, the two 
parameters (apparent resistivity and phase errors) are left at the default 
value of -1. In the second case, the user can estimate the errors (e.g. 
10%). By appropriately selecting errors, one parameter can be down-
weighted at the expense of the other. Reference: Beamish, D., and 
Travassos, J.M., 1992, The use of the D+ solution in magnetotelluric 
interpretation. Jo. Appl. Geophys., 29, 1-19. 

Numerical Smoothing 
Numerical smoothing is an FFT-based low-pass filter which calculates an 
independent smooth curve for each of the four components. It does not 
have an underlying geophysical process to support it, but may 
nevertheless be useful in certain noisy situations. The user selects a 
smoothing factor which gives an appropriate result. 0 gives no smoothing 
at all, and useful values are typically << (half the number of data points). 
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Reference: Press et al., 1989. Numerical Recipes, pub. Cambridge 
University Press, Section 13.9. 

As is described in the “MT Soundings” and “MT 2D Inversion” chapters 
of this manual, smooth curves created while in Database Mode can be 
used as the data source for 2D MT modeling.  

Adding ± 360° to Phase 
This feature is useful in the case of phase curves which wrap around the 
normal -180 to +180 range: 

To Add 360° to Data Points of a Phase Curve: 
 1. Select the Edit command from the main menu.  

 2. Click the  button. 

 3. Select the data points of the phase curve you want to shift. 

 4. Click the  button again. 

To Subtract 360° from Data Points of a Phase Curve: 
 1. Select the Edit command from the main menu.  

 2. Click the  button. 

 3. Select the data points of the phase curve you want to shift. 

 4. Click the  button again. 

Batch Commands 
Most of the edit commands available in the standard operating mode of 
the Data Analysis program can also be performed as a batch operation on 
a set of EDI files. While it is not possible to achieve the same level of 
accuracy for some commands as is possible in actual Edit mode (e.g. 
masking), batch operation considerably accelerates initial editing. 

The following functions are available in batch mode: 

- Printing 

- Rotating 

- Smoothing 

- Masking 

- Static stripping 

- Static shifting 

To Access the Batch Commands: 
 1. Close all open stations. 

 2. The Batch Tools command appears on the main menu. 

 3. Select the desired operation. 
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 4. Enter the parameters as requested. 

The parameters requested in the dialog windows for the individual batch 
functions are largely self-explanatory. Generally, these require the user to 
specify the files to which the batch function is to be applied and any 
function-specific parameters. Shown below as an example is the window 
for Batch Rotation: 

 

Note: By default, the output path is identical to the input path. If you do 
not wish to overwrite the original data, you must define a different output 
path. 
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8:  EDI Utilities MT 

Overview 
WinGLink provides a number of tools for working with EDI files: 

• Convert to EDI 

• Split multi-site EDI files 

• Combine EDI 

• Dump EDI to text files 

These tools are frequently needed when working with data which have 
been output by system or processing software to a non-EDI format. 

This chapter will cover the use of each of these tools. 

Getting Started With the EDI Tools 

Opening the EDI Tools 
After opening WinGLink in Tool Mode, select MT in the left panel of 
the tool form and select EDI Utilities in the left frame. The individual 
EDI tools can then be selected by clicking the button to the left of each: 

 
 

Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started With WinGLink” chapter of this manual. 
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Convert to EDI  
The Convert to EDI program provides functionality for converting the 
following file types to EDI format: 

• Imagem/Stratagem Z files 

• EMI AVG files (both MT1 and MT24) 

• EMI A01 files (MT 24 HF) 

• Zonge AVG files 

• Egbert Z files 

Converting Files to EDI Format 
After clicking the button to the left of Convert to EDI in the Tools 
window, the program opens with the following window: 

 
Associated with each of the file formats is a dialog window which takes 
into account the specific characteristics of the selected file format, e.g. 
channel mapping. Common to all of the dialog boxes are fields for 
specifying input path and the output path.  

The general procedure for converting to EDI is outlined below using the 
Imagem/Stratagem interface as an example. While there are some 
differences between this dialog and those provided for the other data 
types, they are largely self-explanatory. 

Converting Imagem/Stratagem Files to EDI: 
 1. In the Convert to EDI selection window, select the 

Imagem/Stratagem Z files option from the Select source file 
format drop-down list to open the conversion window: 

 
 2. Use the Browse buttons in the Input Path and Output Path 

fields to set the respective paths for data input and output. As 
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an alternative to specifying the output path, the Same as Input 
path checkbox can be selected. In this case, the output path is 
automatically set to the same path as that used for the input. 

 3. After selecting the input path, all files matching the filter string 
specified in the Selection area of the dialog window are listed 
for selection in the left box under the Source files column. 

 4. Use the mouse to select the z*.* files you wish to convert. For 
multiple selections, hold down the <SHIFT> or the <CTRL> 
keys on the keyboard while clicking the file names with the 
mouse. 

 5. A red symbol appears to the left of the selected file names. 

  The equivalent output files, i.e. with the EDI extension, are 
shown to the right under the Destination files column. The 
names of the destination files can be edited by clicking. After 
editing, confirm the new name with <Enter>. For a global view 
of selected input and output files, click View Table 

 6. In the Settings section, enter the acquisition azimuth. 

 7. In the Fix Wrong Polarization section of the window, select 
any channel that might have incorrect acquisition polarization 
(inverted connectors). Alternatively, you may select the 
Automatic option, and the conversion program will 
automatically correct the polarization if it is incorrect. 
 
Note: The manual option should only be used to fix field 
settings known to be bad.  
 
Note also that options in the Settings area are specific to 
Imagem/Stratagem files. Different settings are provided for 
other file types. 

 8. Click the Run button to start the conversion. 

 9. When finished, exit the program to return to the main Tools 
menu. 

 10. The output EDI files can now be opened in the Data Analysis 
program by selecting the Field Processing | 

 option in MT Tools for a quick check of 
the converted files or imported into a WinGLink database. 

Note: Source files may or may not contain station coordinate 
information, e.g. due to acquisition system, processing software. In this 
case, the output EDI files will not contain any information on the site 
location. Site coordinate information must then be imported or added 
after importing the EDI files by either importing a coordinate file or 
manually editing the coordinate information in the Maps program. 

Split Multi-Site/EDI Files 
This tool is used to split: 

• 9-channel EDI files into two 7-channel EDI files 



 

8-4  •  EDI Utilities MT A guide to using WinGLink 

• Multi-site EDI files into single-site EDI files 

• Multi-site, 9-channel EDI files into single, 7-channel EDI 
files 

Splitting Multi-Site/EDI Files 
After clicking the button to the left of Split Multi-Site/EDI Files in the 
Tools window, the program opens with the following window: 

 
 1. Select the source file and output path in the provided fields 

 2. Click the Split button split the files.  

The output files are assigned the name of the source multi-site file plus a 
numeric suffix in ascending order. 

Example: 

File ASD.EDI, containing 4 sites, will be split into the following 4 EDI 
files: 

ASD_1.EDI, ASD_2.EDI, ASD_3.EDI, ASD_4.EDI 

 

Combine EDI 
The Combine EDI tool merges EDI files containing data at different 
frequencies for the same MT site. Such data may result from data 
acquisition, data decimation or data processing. In this tool, each 
component EDI file can be viewed, edited with frequency masking, and 
eventually merged with other EDI files into output a single, consolidated 
EDI file. The program interface includes functionality for displaying 
coherencies or tipper magnitude. 

Interactive, self-explanatory commands control the inclusion/exclusion of 
each component EDI file from the set of files to be merged. 

Combining EDI Files 
 1. Click the button to the left of Combine EDI in the Tools 

window to open the Combine EDI interface. 
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 2. To begin work with the tool, select the File | Open menu 
command and browse to the directory which contains the files 
which are to be merged: 

 
Use the <SHIFT> and <CONTROL> keys to select the desired 
files. Note that you must select at least two files. All of the files 
to be merged must be selected in a single operation. Each time 
files are selected from the Open EDI Files window, any open 
files are closed. Click Open to open the selected files in the 
Combine EDI interface. 

 3. The selected files are now displayed, both as curves in the main 
window and by file name in the File List window: 

 
 4. Curves associated with the files on the left side of the screen are 

plotted in the main part of the window and can be edited (data 
points masked) using the edit tools provided at the top of the 
main window. Furthermore, files present on the left side of the 
window are included in the merged file. Files on the right are 
neither displayed nor included in the merged file. While editing 
files, it is often useful to move some of the files to the right-
hand column with the arrow buttons to provide a better view of 
the files being edited. 

 5. The file selected in the left-hand window is the file to which 
edit operations are applied. Data points for this file are 
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displayed in color: 

 
 6. To edit, i.e. mask data points, click the Edit button to enter edit 

mode and click any of the data points associated with the 
frequency to be masked. Masked points can be reactivated by 
again clicking a data point at the given frequency. The Mask 
All and Unmask All buttons can be used to mask or unmask all 
data points associated with the current file.  
 
To assist in the editing process, the merged XY and YX curves 
resulting from the files present on the left side of the File List 
window are, by default merged in real time. This function can 
be disabled with the View | Show Stacked Curves menu 
command.  
 
Files, once edited, can be moved to the right side of the File 
List window and unedited files moved to the left.  

 7. After making the desired edits, move all files to be included in 
the merged EDI to the left side of the File List window. 
Execute the File | Save as menu command to save the merged 
file to a new file. 

 

Dump EDI to Text File 
Largely self-explanatory, this tool is used to output impedance values to 
columnar text files. Output includes frequency and real and imaginary 
components of impedance tensors and tipper as well as the respective 
variances. 

Select arrow to the left of the Dump EDI to Text File entry in the Tools 
window to open the program interface: 
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Enter the source and output folders, select the EDI files to be output as 
text files and then click the Write files button to perform the conversion. 
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9:  TemMerge TDEM 

Overview: The TemMerge Program 
The TemMerge program is used to convert raw, time-domain 
electromagnetic data for most standard acquisition systems into a 
common data exchange format. The program also includes basic editing 
functionality and can be used to merge multiple soundings onto a single 
curve. 

TemMerge supports the following input formats: 

- Geonics: PROTEM (TEM58, TEM57,  TEM47 & TEM37 receivers) 

- Sirotem: SIROTEM3 (SIROTEM2 not supported) 

- Zonge: GDP-16/32 

- Amira format 

- Free format (space-, comma-, semicolon- or tab-delimited columnar 
data) 

The imported and merged data can be output to ASCII files in the 
TemMerge format (*.TEM). The output files contain station and system 
information, window times (corrected for system delays), voltage values 
and apparent resistivity values. 

Getting Started 
This section provides an overview of the steps necessary to import a 
standard system dump file into TemMerge and merge multiple soundings 
onto a single curve. 

Starting the Program 
After opening WinGLink in tool mode, select EM in the left panel of the 
tool form, select EM in the left frame, and click the arrow to the left of 

. 
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Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started with WinGLink” chapter of this manual. 

Importing System Dump Files 
 1. After starting TemMerge, the TDEM Data Type dialog box 

opens. Select the appropriate file type and click the Browse 
button: 

 
 

 2. TemMerge now prompts you to select the powerline frequency 
at the acquisition site. The value selected here (50 or 60 Hz) 
affects the repetition rates for Sirotem and Protem data. The 
repetition rate for Zonge data is included in the file header, i.e. 
the value selected here does not affect the resistivity calculation 
for Zonge data. 

 3. Browse the directories in the Open File(s) dialog box and select 
the file to be opened. 

Note: The non-standard Protem format was implemented at the request 
of a small group of users and does not reflect the format output by the 
Protem system. For details, please contact Geosystem.  

Importing Free-Format Text Files 
Text files containing time, voltage and resistivity values in columnar 
form can be imported into TemMerge. The data values on each line of 
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data must be delimited by a space, comma, semicolon or tab character. 
While this import option is a convenient way to import the occasional 
text file into WinGLink (first by converting to a TEM file in TemMerge, 
and then subsequently importing the TEM file into WinGLink), 
processing a large number of text files is time-intensive due to the fact 
that the text files do not contain any system information, e.g. loop 
configuration and sizes, delays etc. This information must be entered 
manually in the Edit window (see below). 

The Data Records Selection Dialog Box 
After selecting a file of any type (with the exception of FreeFormat), the 
Data Records selection dialog box, shown below, opens.  

 
 

This dialog box is the heart of the TemMerge program. Here, you can 
edit system data for individual soundings, select the files to be merged, 
and save and delete merged files. All soundings associated with a file 
remain available for selection as long as the Data Records dialog box is 
open. If the dialog box is closed, the file is removed from memory. Files 
can be selected for import by selecting the File | Import menu command.  

The Data Records dialog box contains three panels and five buttons: 

All soundings contained in the dump file are listed in the Dumped panel. 
 
The Data Records dialog box shown above contains a set of Sirotem data. 
The records in the dump file are listed in the Dumped panel of the dialog 
box. Although in principle the same, the individual data records for the 
various system types are labeled slightly different as outlined below: 
 
Sirotem: Group# Run # Gain Time series 
Geonics: Run# Line* Station Time series 
Zonge: Run# Time** Group# Rep. Rate 
Amira: Run# Line* Station Time series 
 
*Line = logger record # at line start 
**Time = measurement time 

Soundings which have been selected for merging are listed in the 
Selected panel. All soundings listed in the Selected panel are plotted as 
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voltage or resistivity vs. time in the main TemMerge window as blue 
curves. The window supports multiple sounding curves. 

Highlight one of the soundings listed in the Dumped panel and click the 

 button to open the Edit dialog box. Here, receiver, transmitter 
and timing information can be set and individual measurement values 
edited. The Edit dialog box is described in the Editing soundings section 
of this chapter.  

The merged soundings are listed in the Merged panel. Merged soundings 
are plotted in the main TemMerge window as red curves. The window 
supports multiple merged sounding curves. 

The left  and right  arrow buttons are used to move soundings 
between the Dumped and Selected panels. Note that the right button is 
enabled only when soundings are listed in the Selected panel. 

Use the  button to save a merged curve to a *.TEM file 

(TemMerge exchange format) and the  button to remove a 
merged curve from the Merged panel. These two buttons are enabled 
only when merged curves are present in the Merged panel.  

Selecting and Merging Soundings 
Use the left and right arrow buttons as described above to move 
soundings between the Dumped and Selected panels of the Data Records 
dialog box. Soundings listed in the Selected panel are plotted in the main 
TemMerge window.  

Select individual soundings for merging in the Selected panel by clicking 
soundings with the mouse. Multiple soundings can be selected by 
clicking the soundings while holding down the Ctrl key on they 
keyboard. 

Provided the soundings were recorded with the same repetition rate and 
delay, the soundings can be merged into a single curve using either the 
Merge button or the commands available on the Merge menu: 

 
Only if the repetition rates and delays are the same for all selected 
soundings is the Merge button enabled.  

TemMerge does provide special functionality for Geonics/Protem 
soundings, which may be recorded at up to three different sampling rates. 
Soundings sampled at each of the sampling rates can be merged into 
single curves. The delays for each of the soundings must, however, be the 
same.  

Note: Delay times and repetition rates can be edited in the Data Record 
dialog box, described in the “Editing Sounding Records” section of this 
chapter. 
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As seen on the Merge menu above, two merging algorithms are 
available: Average and Polynomial. The selection made on the Merge 
menu applies to merge operations performed with the Merge button. 
Note that when using the polynomial merge function, if a negative 
voltage is present at a given gate time in any of the soundings being 
merged, that point is omitted. 

Different combinations of soundings can be selected and merged in a 
single session. The merged soundings can then each be saved to 
individual TEM files using the Save button, as described below in the 
“Saving Merged Soundings” section of this chapter.  

Saving Merged Soundings 
Merged soundings are saved to TemMerge (TEM) files in a two-step 
process. First, header information is entered in a dialog box, then a path 
and file name are specified.  

After merging a sounding (or multiple soundings for the case of 
Geonics/Protem data), click the Save button in the Data Records dialog 
box to open the Header Info dialog box: 

 
The information entered in the Header area of the window is stored in 
the header block of the TEM file. These fields are intended to provide an 
area for saving station information and, with the exception of the Tem_Id 
field, are not used within WinGLink. The Tem_Id is used as the station 
identifier in WinGLink, and is thus a mandatory field.  

The fields in the Coordinates area of the window are used to specify 
station coordinates after the file has been imported into WinGLink. Note 
that stations coordinates stored in the metric format are imported into 
WinGLink using the central meridian specified for the database. Thus, 
when using metric coordinates, make certain that the central meridian to 
which the station coordinates are mapped is the same as that used in the 
WinGLink database.  
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Header information stored in existing TEM files can be automatically 
inserted into the fields in the Header Info window by selecting a file with 
the Load button.  

After completing the fields, click the OK button to open the standard 
Windows dialog box for saving files.  

 

Display Options 
By default, all soundings, both individual and merged, are displayed 
together in the workspace as Voltage [nV/A] vs. Time [ms]. Using the 
menu items and button shown below, you can toggle the display between 
voltage and resistivity: 
 

 
 

Voltage values displayed as a red square represent negative voltage 
values. The resistivity at negative voltage points is zero. 

Select the Separate Merged Window menu command to display the 
individual curves and merged curve in separate panels: 
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Editing  
TemMerge offers two different functions for editing the raw sounding 
data: acquisition parameters can be edited via a dialog box and data 
points can be masked in the sounding display window.  

Editing Sounding Records 
As already mentioned, click the Edit button located at the bottom of the 
Data Records selection dialog box to open an edit dialog in which all 
sounding parameters can be viewed and edited: 

 

 
On the left half of the dialog box, acquisition system parameters can be 
edited. Changes to parameters which are used in the calculation of the 
resistivity are immediately reflected in the resistivity values displayed in 
the right half of the dialog box. Note that resistivities are calculated using 
the Sirotem late time formula shown below: 

r = 6.32 x 10-12 x A2/3 x b4/3 x (V/I)-2/3 x t-5/3 

where: 

r =  apparent resistivity 
A  =  effective loop area (turns area product) of the  
                          receiver loop or coil 
b  =  transmitter loop side length (meters) 
V/I  =  transient response (volt/amp) 
t  =  delay time from start of transient decay (secs) 
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Note: The time, voltage and resistivity values displayed on the right are 
not editable.  

Editing Sounding Curves 
Once a sounding has been selected and moved to the Selected panel of 
the Data Records dialog box, several masking functions can be used to 
mask/unmask individual data points from the sounding. Masked points 
are not included in either the merged sounding or in the .TEM file output 
by TemMerge. The masking functions can be accessed either via the five 
buttons at the left end of the toolbar or on the Edit menu: 

 
 From left to right, the masking buttons serve the following functions: 

 Mask individual points 

 Mask all points to the end of the curve 

 Mask all points 

 Mask all points to the start of the curve 

 Unmask all points 

Polarity Inversion 
Use the –1 button (or the Edit | Invert menu command) to invert the 
polarity of all points in the active sounding: 

 

Timing 
TemMerge corrects the raw times contained in the system dump files to 
take into account any system, filter, antenna or user delays. As a result, 
the first time in the .TEM files output by TemMerge is that of the first 
window. All other times are adjusted relative to this. TemMerge performs 
this calculation as follows for the respective system types: 

Sirotem: 

t(i) = t0(i) + [USER_DELAY] 

Geonics/Protem: 

# t(i) = [TX turnoff time setting on receiver] + [USER_DELAY] + t0(i) 

Zonge: 
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# t(i) = t0(i) + [T/O time setting on receiver] 

Output Format 
TemMerge outputs merged files in a data exchange format defined by 
Geosystem: TEM. This format contains all information in the original 
dump files which is necessary for modeling in the WinGLink Soundings 
module. A sample .TEM file is shown below: 

 
<HEADER INFO> 
TEM_ID        CD_0023 
PROJECT       Demo 
AREA          B21 
CLIENT        Geosystem 
CONTRACTOR    Geosystem 
OPERATOR      Geosystem 
CONDITIONS    Sunny 

<COORDINATES> 
TYPE          LATLONG 
DATUM          
RXLAT           47°09'11.0000" 
RXLONG          47°09'11.0000" 
TXLAT          -88°45'12.0000" 
TXLONG         -88°45'12.0000" 
ELEVATION     290 

<BLOCK> 
<ACQUISITION PARAMETERS> 

ACQUISITION_DATE            05-05-99 
ACQUISITION_TIME            09:32 
RECEIVER      Sirotem Mk3 
TRANSMITTER   Sirotem 
CONFIGURATION COINCIDENT 
TXAREA        40000.0       # [m2] 
RXAREA        40000.0       # [m2] 
CURRENT       1.0           # [A] 
REPTRATE      2.3           # [Hz] 
TIMESERIES    CT 
TURNOFF       0.0           # [us] 
ANTENNA_DELAY 0.0           # [us] 
FILTER_DELAY  0.0           # [us] 
USER_DELAY    0.0           # [us] 
 

<PROCESSING PARAMETERS> 
FILEDATE      5/5/2005  
PROGRAM       TemMerge Version 1.2.3 
FILEVERSION   TEM 1.2 
 

<INPUT FILE INFO> 
INFILE        E:\_VBProjects\Progs\TemMerge\Data\EGIPT.OUT 

RUNS           2  
# RunNum, GroupNum, Gain 
RUN_1          4 99 0  
RUN_2          5 99 0  

 
<DATA> 

# Reported time is calculated by the following formula: 

# t(i) = t0(i) + [USER_DELAY] 

 *** TIMES RELATIVE TO T(0) *** 

# Time [ms], Voltage [nV/A], Resistivity [Ohmm], Std.Dev. [nV/A] 

5.0000e-2     -1.7963e7     0.00          2.9208e7 

1.0000e-1     6.5872e8      0.21          7.8078e8 
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1.5000e-1     2.6703e8      0.19          3.2793e8 

2.0000e-1     1.5821e8      0.17          1.9690e8 

2.7500e-1     8.8571e7      0.15          1.1277e8 

3.7500e-1     4.7174e7      0.13          6.2310e7 

4.7500e-1     2.8394e7      0.13          3.8721e7 

5.7500e-1     1.8317e7      0.12          2.6025e7 

7.2500e-1     1.0997e7      0.12          1.6273e7 

9.2500e-1     6.1862e6      0.11          9.5540e6 

1.1250e0      3.9933e6      0.11          6.2137e6 

1.3250e0      2.6839e6      0.11          4.3393e6 

1.6250e0      1.7604e6      0.10          2.6907e6 

2.0250e0      1.0022e6      0.10          1.6024e6 

2.4250e0      5.6799e5      0.11          9.6644e5 

2.8250e0      3.7545e5      0.11          6.8625e5 

3.4250e0      2.6578e5      0.10          3.9127e5 

4.2250e0      1.7728e5      0.10          2.1098e5 

5.0250e0      1.2051e5      0.09          1.4074e5 

5.8250e0      7.3940e4      0.10          9.0270e4 

7.0250e0      4.0139e4      0.11          4.9498e4 

8.6250e0      2.3182e4      0.11          1.7494e4 

1.0225e1      2.4420e4      0.08          3.1367e4 

1.1825e1      2.2872e4      0.07          4.7107e4 

1.4225e1      7.4475e2      0.49          2.0181e4 

1.7425e1      5.2660e3      0.10          1.2591e4 

2.0625e1      5.3985e3      0.07          2.2848e4 

2.3825e1      7.8975e3      0.04          9.8473e3 

2.8625e1      3.9615e3      0.05          1.4142e4 

3.5025e1      2.2153e3      0.05          1.8663e4 

4.1425e1      -3.6525e3     0.00          1.0762e4 

4.7825e1      6.9018e3      0.01          8.8008e3 

5.7425e1      -1.9174e3     0.00          1.6514e4 

7.0225e1      6.2065e3      0.01          5.9221e3 

8.3025e1      1.8623e3      0.01          6.2920e3 

9.5825e1      4.8125e2      0.03          1.1549e4 
<END FILE> 

As with an MT EDI file, this format organizes information according to 
blocks. For the most part, the format is self-explanatory. Worthy of 
mention, however, is the <INPUT FILE INFO> block. Here, the system 
dump file is listed as are the number of runs and identification codes for 
the runs which were merged. 

TEM files created using Zonge and Sirotem data may contain only one 
set of sounding data. TEM files created using Geonics data may, 
however, contain up to three sets: one for each of three different sounding 
bands. In this case, all blocks with the exception of <HEADER INFO> 
and <COORDINATES> are included for each of the bands, as different 
system parameters may be used at the various sampling rates. 



 

A guide to using WinGLink TemMerge TDEM  •  9-11 

Using TEM Files 
TEM files exported from TemMerge can be imported into WinGLink 
projects of type EM. To facilitate the exchange of TEM files, they can be 
exported from WinGLink’s EM Soundings module. Planned additions to 
the format include adding model information as well as edits made to 
soundings in WinGLink. 
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10:  Gravity Tools 

Overview 
WinGLink provides two tools for use with gravity data: the Gravity 
Reduction program, which is used to compute observed gravity value at 
each station from instrument readings, and the Tide Correction Plot 
program, used to plot tidal correction at a given location over a user-
defined period of time. 

Getting Started With Gravity Tools 

Opening Gravity Tools 
After opening WinGLink in Tool Mode, select GR in the left panel of the 
tool form and select Gravity in the left frame. The two gravity tools can 
then be selected by clicking the button to the left of each: 

 

Note: For information on starting WinGLink in Tool Mode, refer to the 
“Getting Started with WinGLink” chapter of this manual. 

The Gravity Reduction Program 
As already mentioned, the Gravity Reduction program computes the 
value of the observed gravity at each station from the instrument 
readings. 

Use of this program involves the following steps: 
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 1. Creation of a survey database (note: not a WinGLink database); 
entry of station names and gravity values in database. 

 2. Selection of a meter type 

 3. Creation of loop 

 4. Computation of gravity values 

 5. Export of gravity values for import into WinGLink 

Creating a Survey Database 
The main window of the Gravity Reduction program opens after 
selecting the program from the WinGLink Tools window: 

 
In the Database frame, click New to create a database for your gravity 
survey. Databases are in Microsoft Access format and have the default 
extension *.mdb.  

Note: The filename for the gravity reduction database must not contain 
more than 8 characters. 

Entering Observed Gravity Values for Base 
Stations 
 1. Create or Open the Gravity Reduction database 

 2. In the Area Info section of the Database frame, click 
Properties and complete the field information as appropriate. 
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When finished, choose Save and Exit. The entered values are 
displayed in the frame for review. 

 3. Click the "Edit Base Stations" button: 

 
 

 4. Enter the name and the corresponding observed gravity value 
for each base station. When finished, click the Save and Exit 
button. The program will now recognize each base station by 
name. 

Defining a Set of Available Meters 
 1. Create or Open the Gravity Reduction database 

 2. In the Available Meters frame, select the Type of the gravity 
meter to be added. Choose between Scintrex Autograv and 
Lacoste G-meter. Click New. 

 3. For Scintrex Autograv meters, enter the serial number of the 
meter. 

 4. For LaCoste meters, enter the serial number of the meter, the 
multiplying factor, and the calibration data. Follow the screen 
instructions to complete this input sequence. When finished, 
click Save and Exit to confirm and save the data. 

Creating and Opening Loops 
 1. Create or Open the Gravity Reduction database 

 2. In the Loop frame, click New to add a new loop, then enter the 
loop name and select the gravity meter used for the loop from 
the list of available meters. Alternatively, you can select an 
existing loop. 

 3. Click Properties to edit the loop name and associated meter. 

 4. Click Edit Loop Data to enter or edit the date, time and 
reading for each station. Base stations are automatically 
detected by the program by name, and an X is displayed in the 
Base column for each base station. 

Note: When working with the Scintrex Autograv meter, dump files 
(*.dmp) with raw data can be imported in the Edit Loop Data 
spreadsheet using the Import command on the File menu. 
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Computing Observed Gravity Values 
 1. Create or Open the gravity reduction database. 

 2. In the Loop frame, click the Edit Loop Data button and 
complete the input as appropriate.  

 3. On the main menu, click the Compute command. 
This command updates the contents of the spreadsheet columns 
with the computed data. 

Exporting Observed Gravity Values 
 1. On the File menu, select Export to generate a text file with the 

following data for each station: Name, date, time, drift 
correction, observed gravity. 

 2. The first record of each exported file contains the type and 
serial number of the used meter. These files can then be 
imported into WinGLink. For further information, see the 
“Data Import” chapter of this manual. 

Plotting Tide Corrections 
This simple utility calculates and plots tidal correction at a given location 
over a user-defined period of time.  

Select the Tide Correction Plot item from the WinGLink Tools window 
to open the program: 

 
After entering the requested data, use the buttons at the bottom of the 
window to compute the tide value and view the results: 
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11:  The WinGLink Shell 

Overview 
This chapter is intended to familiarize WinGLink users with the 
WinGLink shell, the central interface used to create and configure 
WinGLink databases, create and manage projects, import data and to 
access all licensed program modules. From the shell, you can also switch 
from Database Mode, which contains the actual program modules, to 
Tool Mode, from which a suite of tools for processing, editing and 
analyzing data can be accessed. 

Topics covered in this chapter include: 

- An overview of databases and projects 

- Starting the program 

- Creating a database 

- Setting database properties 

- Sharing databases 

- Creating projects 

WinGLink Databases and Projects 

WinGLink Databases 
A WinGLink database is typically created for a given area of interest. All 
supported geophysical data, i.e. MT, TDEM, gravity etc., can be 
imported into a single database. Each type of data must be imported into 
a project of the appropriate type. The types of data which can be 
imported into a WinGLink database on a given computer are dependent 
on the license configuration.  

Each database contains all data and information relative to the area of 
interest, including data and settings for the metric and geographic 
coordinate systems and the preferred linear units for distances and depths.  

WinGLink Projects 
A WinGLink project is a collection of stations. Stations may contain 
either observed or synthetic data.  

The type of data acquired at the stations is the data type of the project. 
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Examples of projects: 

• a magnetotelluric survey 

• a gravity survey 

• a collection of wells 

• a group of towns 

Projects are used to store data associated with surveys carried out in the 
database area. In cases where no observed data yet exists, i.e. in the case 
of a feasibility study, synthetic data can be generated in certain program 
modules and then used as observed data.  

Stations are added to projects by entering the station name, coordinates 
and elevation. This may be performed either manually or by importing 
station data from external files.  

As will be described later, WinGLink offers two types of project: single 
and integrated. As the name implies, single projects are handled as 
discrete data sets. Integrated projects, on the other hand, may consist of 
any number of single projects. 

Using WinGLink in Database Mode 
To use WinGLink in Database Mode, check one of the options in the 
Database frame of the initial dialog box, i.e. select either an existing 
databases, the demo database or create a new database. To get started 
with the program, open the demo database: 

 
As soon as a database is loaded, the main Database Shell opens. This is 
divided into three panels: 

Database Properties panel (left): 
This provides information on the database coordinate system. This 
applies to all the stations of the projects contained in the database. 

Project panel (center) 
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Projects available in the database are listed here. The first column lists 
the name given by the user to the project, the other columns provide 
online information for each project. 

Program panel (right) 
Contains icons of the application programs available for the selected 
project. 

The Database Shell, as it appears for an MT project, is shown below: 

 
To select a project, click the project name with the left mouse button. 
Once selected, (see the COMB-MT project in the example above) the 
project becomes the active project. This means that any application 
program launched in the right-hand panel will load the data of that 
project. In addition, only those program icons for the programs which are 
compatible with the respective project type are displayed in the right-
hand panel. 

WinGLink Databases 

Creating Databases 
Databases can be created either by selecting the Create a New Database 
option in the database selection dialog box, which opens when the 
program is first started, or with the File | New Database… menu 
command in the WinGLink shell.  

Regardless of which method for database creation is selected, WinGLink 
opens a the first of a series of windows which guide you through a series 
of steps. 

The Database Creation Wizard 
 1. After executing either of the two options for creating a new 

database, the New WinGLink Database window opens. 
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Specify the file name and path, and click the Open button: 
 

 2. The program now opens a window with three tabs in which all 
information specific to the database location is entered. On the 
first tab, enter the area name, and coordinate and elevation 
units: 

 
 3. Click the Next button to advance to the Projected Coords. tab 

of the window: 
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On this tab, specify the projection, grid, central meridian and 
datum used to project stations for Cartesian coordinates. 
 
Note: The coordinate systems in a database are the same for all 
of the projects in the database. Changing the settings for a 
system will automatically update the coordinates for all of the 
projects in the database. 
 
It is extremely important that the coordinate information, 
including central meridian, be set correctly for the location of 
the stations used within the database. Conversions between 
metric and geographic coordinates may otherwise not be 
accurate.  
 
The UTM zone (and thus central meridian) can be easily set by 
clicking the Select from Coordinate System button to open 
the Coordinate System Selection dialog: 
 

 
 
After making a selection, the central meridian for the given 
zone will automatically be entered in the respective field in the 
Projected Coords tab. 
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 4. After entering the information for the projected coordinates,  
click Next to advance to the Geographic Coords. tab: 
 

 
To make adjustments to the geographic coordinates, click the 
Change button to open the Geographic Coordinates window: 
 

 
A list of all supported datums can be opened by clicking the … 
button at the right side of the Datum field. 

 5. Click the OK button in the Database Properties window to 
complete the creation process. WinGLink displays an info box 
alerting you that a project must first be created before you can 
begin work with the program: 
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Database-Specific Menu Commands 
Databases are created, edited and saved using several commands 
available in the WinGLink Shell. Specifically: 

Command to use for 
File | New Database Creating a new database in a user-

selected disk directory. The properties 
of the new database are entered at this 
stage 

File | Open Database Opening an existing database  

File | Close Closing the open database with its 
original name and directory location 

File | Save As Closing the open database and saving 
it with a different name or directory 
location 

File | Compact Database Compacting the database; should be 
performed occasionally to optimize 
database structure and minimize size 

File | Database Properties Editing the properties of the active 
database 

 
Fixing Wrong Settings in the Coordinate 
Systems 
The geographic and metric coordinates for each station of a database are 
linked to each other based on the respective coordinate system settings. 
Each time a metric (or geographic) coordinate is changed, WinGLink 
appropriately updates the corresponding geographic (or metric) 
coordinates, and vice versa. 

If the settings for one or both coordinate systems are not entered 
correctly, either the metric or the geographic coordinates will not be 
displayed with their correct values. For certain projections, e.g. 
Transverse Mercator, it is particularly important that the Central 
Meridian be set close to the actual station locations. 

To correct errors in the database made in the Coordinate Settings, enter 
the new, correct settings (Central Meridian, Projection, etc.). When 
saving the new settings, WinGLink will offer you the option to use the 
new settings to recalculate the metric (or geographic) coordinates of all 
the stations contained in the database starting from the geographic (or 
metric) coordinates of each station: 
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Database Sharing  
A WinGLink database may be opened and used concurrently by more 
than one user. To prevent inadvertent data loss, however, restrictions on 
how the database may be shared between users are dynamically enforced, 
depending on which WinGLink applications are active. These restrictions 
vary from simple warnings to limiting use of the database to a single 
user.  

The most restrictive state imposed by WinGLink is the “Locked” state. 
This state is enabled in the event that changes to the database will affect 
all projects or could change the structure of any of the projects in certain 
ways. This state is set only in the main WinGLink shell in the following 
cases:  

• when a user is editing the database area properties  

• when a user is importing external data into the database 

In these cases the database is locked and may not be used by any other 
user. It follows that database area properties may be changed and external 
data imported only when no other users are using any WinGLink 
application.  

During database sharing, any operation which would result in a loss of 
data integrity is not permitted.  

In general, a given application will try to lock the active project and all 
associated members, i.e. stations and profiles. While in the locked state, 
that project and all members associated with it cannot be used by any 
other WinGLink application. Should another user attempt to open a 
locked project, or a project which makes use of member marked as 
locked, a warning message appears and the WinGLink application is 
aborted. For example, while one user is using the Maps program to edit 
the stations used on a profile in an MT project, the MT Soundings 
program cannot be used to view any of the stations contained in that 
project.  

The WinGLink applications used for 2D modeling (magnetotelluric (MT 
& CS), gravity (GR) and magnetics (MG)) are slightly less restrictive. 
When a 2D modeling application is opened, the stations used by a model 
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are marked as being “in use”. While in this state, they can be viewed and 
used in other WinGLink applications. For example, while one user is 
running a MT 2D inversion, another user may create a 1D model for one 
of the stations used in the 2D model.  

If an application may be used by a second user, but with restrictions, a 
warning message appears indicating what functions are disabled. 

Note: Every attempt has been made to prevent loss of data integrity and 
loss of data. WinGLink generally prevents any operation which would 
damage the database or result in lost data. Database sharing is, however, 
not without risk. Certain operations which would not result in data loss, 
yet may still result in lost work, are possible. For example, it is possible 
to modify a profile in the Maps program while a user is using the MT2D 
program. When sharing a database, make certain that any actions you 
take do not inadvertently affect the work of other users.  

WinGLink Projects 

Adding Projects to a Database 
Projects are added to the database in the WinGLink Shell using the 
Project | New… menu command. 

In the sub-menu: 

 1. Choose Single… if you want to add a project with new data to 
the database. 

 2. Choose Integrated… if you want to add a project which uses 
data from other projects already contained in the database. 

 3. Enter the data as requested in the Project Properties dialog box: 

 
 4. When finished, click the OK button. 

Deleting Projects from a Database 
To Delete a Project from a Database: 
 1. Open the WinGLink shell. 



 

11-10  •  The WinGLink Shell A guide to using WinGLink 

 2. In the Project panel of the window, use the mouse to select the 
name of the project to be deleted. 

 3. Click either the Delete command from the Project menu or 
press the Del key on your keyboard. 

 4. In the dialog box which appears, confirm that you would really 
like to delete the project. 

Warning: Deleting a project is a permanent action and cannot be 
undone. 

Editing Project Properties 
Select the  Project | Properties menu command in the WinGLink Shell 
or click the Project Properties button located at the bottom of the 
WinGLink Shell. to open the Project Properties dialog box. The 
Summary tab of this window is, by in large, identical to the window 
used when creating a new project. Use of the Attachment tab is 
described below in the “Combining Projects” section. 

Field Meaning 
Date For observed data, the year and month the survey was 

carried out. For magnetic projects, this date is used to 
calculate IGRF values 

Project name This is the code name of the project as it will be 
displayed in the Projects list of the Database window 

Data type From this dropdown list, select the type of data for your 
project (example: gravity, MT, generic, etc.). The data 
type cannot be changed if the project has one or more 
stations. 

Station legend The legend you wish to automatically associate with the 
stations of the project when printing maps and sections.  

Location Survey location 

Company Client name 

Contractor Contractor name 

 
Previewing the Contents of a Project 
Regardless of project type, a project contains stations which are identified 
by name, coordinates, elevations and, usually, values. 

To Review the Station Coordinates, Elevations and 
Values from the Database Window: 
 1. On the Projects menu, click QuickView or click the Preview 

Data button located at the bottom of the WinGLink Shell. 
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 2. Select the values you wish to display: 

 

Note: This function displays station data and values in read-only mode. 
To edit the stations, you must start the MAPS program. 

Setting a Project as the Source for the 
Topography 
The topography of a project is obtained by interpolating the elevations of 
its member stations. When a project has only a few stations, this 
topography may be severely inaccurate.  

To avoid this problem, any project in a database can be set as the source 
of topography for all other projects in that database. When a project is set 
as default topography, the topographic profiles for the sections of all 
other projects in the database are extracted from the gridded elevations of 
this project.  

For maximum accuracy, a DEM (digital elevation) map may be imported 
into a project and this project then used as the default topography for the 
database. For information on importing DEMs, please refer to the 
“Importing External Grids” section of the “Maps” chapter of this manual. 

This way, all sections along the same profile have the same topography, 
regardless of the project to which they belong. 

It is a general practice to use an Integrated project which includes a 
gravity project as source for the area topography. 

Note: The MT 2D Inversion program uses actual station elevations to 
generate the profile, not the values in the project used as default 
topography. 

To Set a Project as the Source for Topography: 
 1. Open the WinGLink Shell. 

 2. On the Project menu, select the Default Topography | Set 
menu command. 



 

11-12  •  The WinGLink Shell A guide to using WinGLink 

 3. Click the name of the project you wish to use as the topography 
source: 

 
 4. Click the OK button. 

 5. A suffix [T] appears next to the project type in the Type 
column. 

Combining Projects 
The projects of a database can be combined in order to produce maps and 
sections using the stations of more than one project. 

There are two ways to combine projects: 

Attaching projects to the current project: 
The resulting maps and sections are computed using only the data of the 
stations contained in the active project. The stations of the attached 
projects are posted on maps and sections, but their datasets are not used 
in the processing. 

Merging projects into an integrated project: 
The resulting maps and sections are computed using all the equivalent 
data of the stations of the combined projects (member projects). The 
stations of the member projects are posted on maps and sections, and 
their datasets are used in the processing. 

For a quick display of attached and member projects, select a project in 
the Project column of the Database Project list. In the example shown 
below, the “Integrated (MT)” project has been selected. The arrow on the 
right-hand side points to the attached and member projects: 

 

 Single projects can only have attached projects. 

Integrated projects can have both attached and member projects 

Attaching a Project to Another Project 
Attached projects are single projects whose stations are “attached” to 
the current project for simultaneous display on maps or sections.  

To attach a project to another project: 
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 1. Open the WinGLink Shell.  

 2. In the Project list panel, click the name of the project to which 
attachments are to be added. 

 3. Select the Project | Properties menu command. The Project 
Properties dialog box opens; click the Attachments tab: 

 
  The left box lists the projects which have already been attached; 

the right box lists the projects available for attachment.  

 4. Use the arrow buttons to move projects in/out the attachments 
list. 

 5. When finished, click the OK button. 

Note: When attaching projects to integrated projects, member projects 
are not listed among the projects available for attachment. 

Combining Projects into an Integrated Project 
An integrated project is a project which has no stations of its own, but 
instead uses the stations of other single projects (members) to produce 
integrated maps and sections. 

 1. Select the Project | New menu command in the WinGLink 
Shell, then select the Integrated option. 
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 2. Click the Members tab to display the following dialog 
box:

 
 3. The left box lists the current members of the project; the right  

box lists the other available projects.  

 4. Use the arrows to add/remove projects from the member list. 

 5. When finished, click the OK button. 
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12:  Data Import 

Overview 
WinGLink can import survey data (station names, coordinates, values 
and/or datasets) from a variety of source files. The imported stations and 
associated datasets are organized and stored in a database project. 

This can be either a new project created with the purpose of containing 
the imported data, or an existing project that already has stations. For 
example, it is possible to first import station IDs and coordinate 
information, and then import the actual station data. In the this case, the 
imported data are added or merged with the existing information.  

Depending on the data type, data can be imported from the following 
sources: 

- From external files 

- From a WinGLink database 

- From another project in a database 

This chapter provides instructions on importing all data types which can 
be imported into a WinGLink database from the WinGLink Shell.  

Getting Started with Data Import 
Regardless of data type, the initial steps in the data import process are 
identical for all data types. The description provided below covers the 
first few steps common to nearly all types of data import. 

Import Steps Common to Most Data Types 
 1. On the File menu in the WinGLink Shell, click the Import…, 

menu command. In the Import window which opens, select the 
source from which you wish to import your data: 
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 2. For importing most types of files, select External files option 

and continue by clicking the Next button to advance to the next 
Import window: 

 
 
Here, the program gives you the option of importing data into 
either a new or an existing project. 

 3. If importing into an existing project, select the appropriate 
option and, on the next screen, select the desired project from 
the list presented. Otherwise, select the In a New Project 
option. WinGLink now displays a message alerting you to the 
fact that a new project will now be created. Acknowledge the 
window and click the Next button to continue.  
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 4. WinGLink now displays the Project Properties dialog box: 

 
Mandatory fields in this window are the Project name and 
Data type. When selecting the data type, make certain to select 
the type which matches the data to be imported. 

The subsequent steps in the import process are, to a certain extent, data-
type dependent. The remaining import process for each of the different 
data types is described in detail in the following sections. 

Importing Station Coordinates 
Station coordinates may be imported either alone or together with the 
actual station data. This may be the case with EDI files, which can 
contain both coordinate information as well as magenetotelluric data. 
Frequently, station coordinates are not included with the actual data files. 
This program option allows you to import the data in two steps, first by 
importing the coordinate information and then importing the actual data 
(or vice versa).  

This section provides a description of the process for importing 
coordinate information which is contained in a separate text file. These 
text files must be organized in columns, whereby the order of the 
columns is immaterial 

To Import Station Coordinates Contained in Text Files: 
WinGLink can import station data (i.e. coordinates and values, sounding 
datasets, well courses, or layered/numerical data) from text files with data 
organized in columns. The process for importing coordinates is illustrated 
below for the case of magnetotelluric data. With the exception of project 
type, the process is very similar for all data types. 

 1. To import station coordinates into a new project, follow steps 
1-3 of section “Getting Started with Data Import”. Otherwise, if 
importing coordinates into an existing project, follow the first 
two steps, selecting the project into which the coordinates are to 
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be imported instead of creating a new project.  
 

 
 

 2.  Click the OK button to advance to the Import MT Data 
window. In the <Files of Type> box, select the type of data to 
be imported: 

 
 
Note that the file types available for selection are dependent on 
the current project type. 

 3. Browse the directories until you find the text file to be 
imported. 

 4. Click the filename of the file to be imported to select it (use the 
Preview command if you would like to quickly check the file 
contents). Click the Next button. 

 5. If the destination project already has stations, choose the 
desired options for updating duplicate stations. Click the Next 
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button. 

 
 6. The first screen of the Data Import wizard opens: 

 
Check the appropriate boxes in the Data type frame at the top 
of the Data Import dialog box . These are used by the import 
wizard to guess the field separation in the text file being 
imported. You can check the data type in the preview window 
at the bottom of the dialog box. 
 
Specify which rows are to be imported in the Rows to import 
section of the dialog box. Use this option to skip header and/or 
footer lines.  
 
In the Preview of file area of the dialog box, check that the 
input file is read correctly. If necessary, use the mouse to 
correct the field separation. Red lines represent field breaks. To 
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CREATE a field break, click the mouse at the desired position; 
to DELETE a field break, double-click the line.  

 7. Click the Next button to display a preview of the file columns: 

 
First, select the units for latitude and longitude in the Lat / Lon 
Unit drop-down list: 

 
 
Then click the header of each column to select the field for each 
column: 

 
   

 8. Alternatively, the option in the Fields Assignment drop-down 
list may include the column configuration: 
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 9. When finished, click the Save button to confirm the import.  

 10. The program displays the final screen of the Import Wizard, a 
screen which provides information on the import process: 

  

Note: Columns marked with <Skip> are ignored during the import.  

 Importing MT Data 
MT data can be imported into WinGLink in a variety of formats: 

- Single-site EDI files 

- Text files 

- WinGLink projects 

- WinGLink databases 

- Geolink projects 

- TGF files 

Furthermore, multi-site EDI files and system files (e.g. Stratagem / 
Imagem) can be converted to standard, single-site EDI files using the 
EDI Tools available in Tool Mode. See Chapter 10, MT Tools for details. 

This section provides instructions on importing  

- Single-site EDI files 

- Text files 

- 2D MT forward responses 

-3D meshes 

Note: Information on importing data from within a WinGLink database, 
TGF files and Geolink projects is provided at the end of this chapter as 
the procedure is nearly identical for all data types 
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Importing Single-Site EDI Files 
The EDI format is the de facto standard for magnetotelluric station data. 
This standard includes data blocks for all typical data associated with a 
sounding. WinGLink can import multiple EDI files at the same time, one 
for each sounding.  

 
 To Import a Single-Site EDI File: 
 1. To import a single-site EDI file into a new project, follow steps 

1-3 of section “Getting Started with Data Import”. Otherwise, if 
importing an EDI file into an existing project, follow the first 
two steps, selecting the MT project into which the EDI file is to 
be imported instead of creating a new project. 

 2. In the <Files of Type> box, select EDI files. 

 
 3. Browse the directories until the EDI files to be imported are 

listed. 

 4. Click the names of the file(s) to be imported; click the All 
button to select all EDI files in the current directory. Click the 
Next button. 
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 5. A warning window appears: 

 
If attempting to import multi-site EDI files, they should first be 
broken down into single-site files using the tools provided in 
the MT Tools . 
 
After acknowledging a warning window with the Next button, 
the first of the EDI import windows opens: 

 
 
Here, you can specify the datum and spheroid of the station 
coordinates in the EDI files. The coordinates in the EDI files 
are then recalculated to the database coordinates. If there are 
either no coordinates in the file or the coordinates in the file and 
the database are the same, continue by clicking the Next button. 
Otherwise, make the appropriate settings in the provides fields 
and then click the Next button to continue. 
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 6.  The next window of the EDI import wizard opens: 

 
 
Here, you can specify whether recalculation of impedances or 
spectra should be performed and whether impedance and/or 
tipper rotation should be performed.  
 
Use the impedance rotation options as 
follows:
Import option When to use 
No Recalculation To import the plot parameters saved in the EDI file 

without recalculating them from existing impedances 
or spectra 
If plot parameters are missing, the program will 
calculate them from existing impedances. 
If impedances also are missing, plot parameters and 
impedances will be calculated from existing spectra. 

Recalculate from 
existing 
Impedances 

To compute plot parameters from existing 
impedances, without recalculating impedances from 
spectra. 

Recalculate from 
existing Spectra 

To recalculate plot parameters and impedances from 
spectra. 
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 7. Click the Start button to execute the import. Import statistics 
are then displayed in the final window of EDI Import Wizard: 

 

Note 1 - Spectra are not saved in the database: For each site, only plot 
parameters and impedances are imported and saved in the database. 
Spectra are read and used to recalculate impedances, but they are not 
saved in the database. 

Note 2 - Site coordinates: The geographic coordinates of each site are 
read in from the REFLAT, REFLON fields of the EDI file, converted 
into metric coordinates according to the area settings of the database, and 
then corrected for the offset of the corresponding E dipoles. To correct 
for missing or incorrect site coordinates, launch the MAPS program and 
edit the site coordinates using the Stations | View Data… command. Site 
coordinates, if using a datum or spheroid different than that used in the 
database, can be converted during import by specifying the 
datum/spheroid used in the EDI files in the first of the EDI import 
windows as shown above. 
 
Note 3 - Rotate to: If there is a ZROT block in the EDI file, the data are 
first “back rotated” to 0 degrees. Thus, to match the rotation in the EDI 
file, you must specify the angle to which the impedances are to be rotated 
in the User Defined field. The angle specified in the Import Wizard is 
used for all frequencies.  
 
When rotating to the principle axis, the program rotates the impedance 
matrix to the maximum and minimum values of Zxy and Zyx, 
respectively.  
 
If there are tipper data present in the EDI file, these data are likewise 
“back rotated” to 0 degrees from the angle specified in the TROT block. 
If there is no TROT block, it is assumed that the data are already at 0 
degrees and no back rotation is performed. The ZROT block is NOT 
used to specify the tipper rotation in the case that no TROT block is 
present. 
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When using the 2D MT inversion module, tipper should be rotated to 
strike. 

Importing Text Files 
The Text File Import Wizard, which is also used to import station 
coordinate files, can be used to import MT data contained in column-
based text files. Files of this type may contain either resistivities and 
phases or impedance values. 

To Import MT Data Contained in Text Files: 
 1. To import MT data into a new project, follow steps 1-3 of 

section “Getting Started with Data Import”. Otherwise, if 
importing MT data into an existing project, follow the first two 
steps, selecting the project into which the data are to be 
imported instead of creating a new project.  
 

 
 

 2.  Click the OK button to advance to the Import MT Data 
window. In the <Files of Type> box, select the type of data to 
be imported: 
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 3. Browse the directories until you find the text file to be 
imported. 

 4. Click the filename(s) of the file(s) to be imported to select (use 
the Preview command if you would like to quickly check the 
file contents). Click the Next button. 

 5. If the destination project already has stations, choose the 
desired options for updating duplicate stations. Click the Next 
button. 

 
 6. An info box appears informing you that a station will be created 

for each input file and given the same name as the input file. 
Acknowledge the info box by clicking the Start button.  
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 7. The first screen of the Data Import wizard opens: 

 
Check the appropriate boxes in the Data type frame at the top 
of the Data Import dialog box . These are used by the import 
wizard to guess the field separation in the text file being 
imported. You can check the data type in the preview window 
at the bottom of the dialog box. 
 
Specify which rows are to be imported in the Rows to import 
section of the dialog box. Use this option to skip header and/or 
footer lines.  
 
In the Preview of file area of the dialog box, check that the 
input file is read correctly. If necessary, use the mouse to 
correct the field separation. Red lines represent field breaks. To 
CREATE a field break, click the mouse at the desired position; 
to DELETE a field break, double-click the line.  

 8. Click the Next button to display a preview of the file columns: 
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First, specify whether the file contains resistivity and phase 
data or impedance data in the MT Data Type area at the top of 
the window. 
 
Note that columns marked with <SKIP> are ignored during the 
import process. 
 
Then click the header of each column to select the field for each 
column: 

 
 9. Column mappings can be saved by clicking the Save button in 

the Column Mapping area at the right edge of the window: 

 
The .MAP files created here can be reloaded the next time a file 
with the same column arrangement is to be imported by 
clicking the Load button. 

 10. When finished, click the Save button at the bottom of the 
window to confirm the import.  

 11. If importing multiple text files, the Import Wizard returns to 
step 7. After the steps outlined above have been completed for 
all of the text files, the program displays the final screen of the 
Import Wizard. Here, the program displays statistics on the 
import process. 

Importing MT 2D Forward Responses 
The stations of an MT profile for which 2D modeling results have been 
calculated and saved in the current database can be imported into a new 
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or an existing MT project. The computed 2D modeling results (i.e. 
computed TE and TM resistivity and phase) are imported as observed 
data for the stations of the profile. 

In this way, an inversion can be run using synthetic 2D MT model results 
as observed data. 

To Import MT 2D Forward Responses 
 1. Select the File | Import… menu command in the WinGLink 

Shell. 

 2. In the Import dialog box which then appears, select: “MT 
response from 2D model”: 

 
 3. Select the destination project. This can be either a new or an 

existing MT project. 

 4. After selecting/creating the project into which the responses are 
to be imported, the program presents a list of available profiles 
for which 2D modeling results have been saved in the database: 

 
 5. Select the desired 2D model and click the Next button. The 

program imports the responses into the selected project and 
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displays the results: 

 

Note: Because the 2D inversion routine returns only the Ty vertical 
component, certain interpretational qualities which require both Tx and 
Ty, i.e. induction arrows, cannot be displayed. 

Importing 3D Meshes 
WinGLink configurations which include the MT-4 module provide 
support for importing 3D meshes in the Randy Mackie format. This 
format is defined at the end of this section. These meshes are MT -
specific and can only be imported into MT projects.  

Once imported into a database, a 3D mesh remains associated with its 
project and can only be accessed from that project. The 3D Mesh 
Importer, which can be accessed from the WinGLink shell as well as 
from the 3D Modeling program, can be used to import 3D meshes from 
external files, the active database and other WinGLink databases. 

Profiles placed on 3D meshes in the Maps program can be used to extract 
mesh sections in both the X-Sections program as well as the MT 2D 
Inversion program. WinGLink generates these sections by interpolating 
between mesh elements. Topographic information is retained during this 
interpolation. Sections extracted from 3D meshes in the MT 2D Inversion 
program can also be used as starting meshes for 2D models. Please refer 
to the “MT 2D Inversion” chapter of this manual for details. 

To Import a 3D Mesh into WinGLink: 
 1. Select the File | Import… menu command in the WinGLink 

Shell. 

 2. In the Import window which opens, select the 3D Model Mesh 
option. 

 3. Select either an existing MT or project or opt to import the 3D 
Mesh into a new project. 

 4. The first of five 3D Mesh Import Wizard windows opens. 
Specify the data source: from file, the current database, or an 
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external database: 

 
  If you choose to import from either the current database or a 

different WinGLink database, additional dialog windows open 
prompting you to select e.g. the database name and the mesh to 
be imported.  

 5. To import a 3D mesh form a file, now select the source file. 
The file must be in the Randy Mackie format specified at the 
end of this section. 

 
 6. In step three of the import process, specify the units in the data 

source: 
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 7. In step four, specify the mesh attributes, including mesh name, 
location of the rear top left corner as well as the angle to which 
the mesh is to be rotated: 
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 8. In step 5, you can enter notes regarding the mesh. Alternatively, 
notes can be imported into the field from an external file: 

 
 9. In the final step, WinGLink performs the import operation. 

Import progress and any encountered errors are displayed on 
screen. 

For details on working with 3D meshes, refer to the following sections in 
the WinGLink manual: 

Chapter Maps, “Displaying 3D MT meshes” 
Chapter Sections, “X-Sections” 
Chapter “MT 3D Modeling” 
 Chapter “MT 2D Inversion” 

Note: In addition to the method described above, 3D meshes can also be 
imported into projects from within the 3D Modeling program. For details, 
please refer to the “3D Modeling” chapter of this manual.  

Randy Mackie 3D mesh specification 
The mesh format is that specified by Randy Mackie plus an additional 
data block, located at the end of the file, which contains georeferencing 
information. 
 
NX, NY, NZ (#’s of blocks) [Nair (layers)], [MAP. 
VAL[UES]] 
X block sizes (NX values in meters)  
Y block sizes (NY values in meters)  
Z block sizes (NZ values in meters)  
1 (layer #)  
NX*NY codes or values in free format: x varies 
fastest  
-----  
-----  
NZ (layer #)  
NX*NY codes or values in free format: x varies 
fastest  
0. resistivity(for code 1) resistivity(for code 
2) ....  
resistivity(for largest code) [resistivity for 
sea water]  
end (optional termination text) 



 

A guide to using WinGLink Data Import  •  12-21 

----- 
----- 
WINGLINK 
ABC (site name) 
I J (block numbers) 
0000.000 0000.000 (real world coordinates) 
0 (rotation) 

Importing TDEM Data 
Like MT data, TDEM data can also be imported into WinGLink in a 
variety of formats: 

- TemMerge files 

- Temix datasets 

- Zonge AVG files 

- Geolink projects 

- TGF files 

- USF files (a data exchange format defined by Phoenix Geophysics for 
the Phoenix V8 system) 

This section provides instructions on importing the file types listed above 
with the exception of TGF files and Geolink projects, which are 
described at the end of this chapter as the import procedure is nearly 
identical for all data types.. 

TemMerge Data Files 
Raw time-domain electromagnetic (TEM) data can be imported into 
WinGLink in a two-step process. The first step involves using 
WinGLink’s TemMerge program to convert system dump files from the 
respective acquisition systems into a standardized format which can then 
be imported into WinGLink. Systems currently supported include: 

- Sirotem 

- Protem 

- Zonge  

- as well as Amira and free-format data) 

The conversion is performed using the TemMerge program, which can be 
accessed in the EM area of the Tools section of WinGLink. For 
instructions on how to use TemMerge, please refer to the TDEM Tools 
chapter of this manual. For instructions on how to use TemMerge, please 
refer to the TDEM Tools section of the WinGLink help system. 

Once the TDEM data have been converted to TemMerge-format data, 
they can be imported into WinGLink using the import wizard. 

To Import TemMerge Data Files into WinGLink: 
 1. To import TemMerge data files into a new project, follow steps 

1-3 of section “Getting Started with Data Import”. Otherwise, if 
importing TemMerge files into an existing project, follow the 
first two steps, selecting the EM project into which the 
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TemMerge files are to be imported instead of creating a new 
project. 

 2. In the <Files of Type> box, select TemMerge files: 

 
 3. Browse the directories until you find the files to be imported. 

 4. Select the name of each file to be imported. 

 5. Click the Next button. The TEM Delay Times window opens: 

 
In the Corrective Time Shift field, enter any time shift which 
was not included in the TemMerge file. This may be the case, 
for example, if the system operator did not enter the turn-off 
time during acquisition. The value entered here can be edited 
later in TDEM Soundings by executing the File | Sounding 
Properties menu command in the Soundings module. 
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 6. Click the Start button to initiate the import process. Once 
completed, WinGLink displays a window with information on 
the number of files which were successfully imported. 

Importing Temix Datasets 
TDEM datasets created with the Interpex Temix software can be 
imported into WinGLink.  

To Import Temix Datasets into WinGLink 
 1. To import Temix datasets into a new project, follow steps 1-3 

of section “Getting Started with Data Import”. Otherwise, if 
importing Temix datasets into an existing project, follow the 
first two steps, selecting the EM project into which the Temix 
datasets are to be imported instead of creating a new project. 

 2. In the <Files of Type> box select Temix. 

 3. Browse the directories until you find the dataset(s) to be 
imported. 

 4. Select the name of each dataset to be imported: 

 
 5. Click the Next button. WinGLink displays a window with 

information on the number of files which were successfully 
imported. 

Importing Zonge AVG Files 
Zonge AVG files, unlike raw Zonge system dump files – which must first 
be converted to TemMerge files, can be imported directly into 
WinGLink.  

To Import Zonge Files into WinGLink: 
 1. To import a Zonge AVG file into a new project, follow steps 1-

3 of section “Getting Started with Data Import”. Otherwise, if 
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importing a Zonge file into an existing project, follow the first 
two steps, selecting the EM project into which the stations 
contained in the AVG files are to be imported instead of 
creating a new project. 

 2. In the <Files of Type> box select Zonge AVG. 

 3. Browse the directories until you find the dataset(s) to be 
imported. 

 4. Select the name of each station to be imported. 

 5. Click the Next button to advance to the next screen of the 
import wizard. Here, select either m or km as the XY units for 
the Zonge data. 

 6. In the next screen, WinGLink prompts you to enter any time 
shift which was not included in the Zonge AVG file. This may 
be the case, for example, if the system operator did not enter the 
turn-off time during acquisition. The value entered here can be 
edited later in TDEM Soundings by executing the File | 
Sounding Properties menu command in the Soundings 
module. 

 
 7. Click the Start button to initiate the import process. Once 

completed, WinGLink then displays a window with 
information on the number of stations which were successfully 
imported. 

Importing USF Files 
TDEM data contained in USF files, a data format defined by Phoenix 
Geophysics for their V8 system, can be directly imported into WinGLink.  

To Import USF Files into WinGLink: 
 1. To import a USF file into a new project, follow steps 1-3 of 

section “Getting Started with Data Import”. Otherwise, if 
importing a USF file into an existing project, follow the first 
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two steps, selecting the EM project into which the stations 
contained in the USF file is to be imported instead of creating a 
new project. 

 2. In the <Files of Type> box select USF TEM Files. 

 3. Browse the directories until you find the file to be imported. 

 4. Select the name of the desired file (only one file can be 
imported at time). 

 5. Click the Next button to advance to the next screen of the 
import wizard. Here, select the stations() which are to be 
imported into the database: 

 
 6. Click the Start button to initiate the import process. Once 

completed, WinGLink then displays a window with 
information on the number of stations which were successfully 
imported. 

Importing Gravity / Magnetic Data 
Gravity and magnetic data are typically imported into WinGLink as 
column-based text files. Files typically contain a station ID, coordinates, 
elevation and a measurement value, e.g. observed gravity or terrain 
correction.  

In addition to the procedure outlined below for text files, gravity and 
magnetic data can also be imported using TGF files or from Geolink 
projects. For information on importing data contained in these last two 
types of files is provided at the end of this chapter as the procedure is 
nearly identical for all data types. 

The description provided below is applicable to both gravity and 
magnetic data, whereby for magnetic data a project of type MG must be 
selected/created, and for gravity data a GR project must be used. 
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To Import Gravity / Magnetic Data into WinGLink 
 1. To import gravity or magnetic data into a new project, follow 

steps 1-3 of section “Getting Started with Data Import”. 
Otherwise, if importing gravity/magnetic data into an existing 
project, follow the first two steps, selecting the project into 
which the data are to be imported instead of creating a new 
project.  

 
 

 2.  Click the OK button to advance to the Import GR/MG Data 
window. In the <Files of Type> box, select the type of data to 
be imported, in this case: Text Files: 

 
 3. Browse the directories until you find the text file to be 

imported. 

 4. Click the filename(s) of the file(s) to be imported to select (use 
the Preview command if you would like to quickly check the 
file contents). Click the Next button. 
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 5. If the destination project already has stations, choose the 
desired options for updating duplicate stations. Click the Next 
button. 

 6. The first screen of the Data Import wizard opens: 

 
Check the appropriate boxes in the Data type frame at the top 
of the Data Import dialog box . These are used by the import 
wizard to guess the field separation in the text file being 
imported. You can check the data type in the preview window 
at the bottom of the dialog box. 
 
Specify which rows are to be imported in the Rows to import 
section of the dialog box. Use this option to skip header and/or 
footer lines.  
 
In the Preview of file area of the dialog box, check that the 
input file is read correctly. If necessary, use the mouse to 
correct the field separation. Red lines represent field breaks. To 
CREATE a field break, click the mouse at the desired position; 
to DELETE a field break, double-click the line.  
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 7. Click the Next button to display a preview of the file columns: 

 
First, specify the units for latitude and longitude in the drop-
down list at the top of the window. 
 
Note that columns marked with <SKIP> are ignored during the 
import process. 
 
Then click the header of each column to select the field for each 
column or open the Field Assignments drop-down list to 
display a list of preset column mapping options: 

 
 8. When finished, click the Save button at the bottom of the 

window to confirm the import. WinGLink then displays a 
window with information on the number of stations which were 
successfully imported. 

Importing Well Data 
All data associated with a given well is not typically contained in a single 
file. Instead, one file might contain coordinate information for one or 
more wells. Another series of files might contain the actual well traces; 
one for each well. Layer data, e.g. lithography or pressure, might be 
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contained in other files. Thus, for optimal workflow with well log data, 
we recommend importing well data in the following order: 

 1. Import coordinate information 

 2. Import well courses 

 3. Import layer data 

What all of these files have in common is that they are column-based text 
files. Thus, they can all be imported using the hopefully now familiar 
Text File import wizard. 

The description shown here utilizes the demo well data provided in the 
WinGLink installation directory, typically:  
C:\Program Files\WinGLink\Demodata\Well Data  

To Import Coordinate Information 
 1. To import well coordinates into a new project, follow steps 1-3 

of section “Getting Started with Data Import”. Otherwise, if 
importing the coordinates into an existing project, follow the 
first two steps, selecting the project into which the coordinates 
are to be imported instead of creating a new project. 

 2. Click the OK button to advance to the Import WL Data 
window. In the <Files of Type> box, select the type of data to 
be imported: 

 
 

 3. The first screen of the Data Import wizard opens. 
 
Check the appropriate boxes in the Data type frame at the top 
of the Data Import dialog box . These are used by the import 
wizard to guess the field separation in the text file being 
imported. You can check the data type in the preview window 
at the bottom of the dialog box. 
 
Specify which rows are to be imported in the Rows to import 
section of the dialog box. Use this option to skip header and/or 
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footer lines.  
 
In the Preview of file area of the dialog box, check that the 
input file is read correctly. If necessary, use the mouse to 
correct the field separation. Red lines represent field breaks. To 
CREATE a field break, click the mouse at the desired position; 
to DELETE a field break, double-click the line.  

 4. Click the Next button to display a preview of the file columns: 

 
First, specify the units for latitude and longitude in the drop-
down list at the top of the window. 
 
Note that columns marked with <SKIP> are ignored during the 
import process. 
 
Then click the header of each column to select the field for each 
column or open the Field Assignments drop-down list to 
display a list of preset column mapping options: 

 
 5. When finished, click the Save button at the bottom of the 

window to confirm the import. WinGLink then displays a 
window with information on the number of stations which were 
successfully imported. 

To Import Well Courses 
 1. Proceed as outlined above for station coordinates, making 

certain to select the same project as was used to import the well 
coordinates. Instead of selecting Station Coordinates, select 
Well Courses in the Import WL Data window and select the 
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desired well course files: 

 
 2. The first screen of the Data Import wizard opens. Make the 

appropriate settings and click the Next button to continue.  

 3. Click Next to display a preview of the file columns: 

 
On the right-hand part of the window, first select the units for 
latitude, longitude and elevation. Then click the heading of 
each column to select the appropriate field designations. 
Latitude, Longitude and Elevation must each be assigned to a 
column. Other columns are to be set to Skip (default): 
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After you have assigned the column headings, click the Save 
button to import the well log file into the database.  
 
Tip: 
If, in Step 3, you selected multiple files, the same column 
headings will automatically be set as the default headings for 
the remaining files in the import session. If, however, you will 
be importing further files with the same mappings at a later 
time, you can save the mappings by clicking the Save button in 
the Column Mappings panel located on the right side of the 
window. The mappings can be restored at a later time by 
clicking the Load button.  

About Layer Data 
Various types of well log data can be imported into WinGLink: 

Layer data: stratigraphic data between two different well depths: 
Well    From(M.D.) To(M.D.) Descr 
AA-1    8.23       250.00   Sand 
AA-1    250        1000.00  Clay 
AA-1    1000       1300.00  Shale 
AA-4    8.23       200.00   Sand 
AA-4    200.00     1200.00  Clay 
AA-4    1200.00    1500.00  Shale 
AA-3    0          350.00   Sand 
AA-3    350.00     400.00   Clay 
AA-3    400.00     1100.00  Sand 
AA-3    1100.00    1400.    Shale 

Numerical data: value data at depth, e.g. temperature or pressure at 
various well depths. The files must contain 3 columns, either fixed width 
or delimited using any standard or user-defined delimiter. 
Name Depth  Value 
AA-1 800.00 20 
AA-1 1000.00 10 
AA-1 1545.00 50 
AA-2 200.00 14 

Depth tags: labels to be assigned along the well trace at specified depths.  
Well    Depth      Descr 
AA-1    750.00     Low 
AA-3    1300.00    High 
AA-4    150.00     Med 
AA-4    750.00     High 

Note: Depth tags can be displayed only in Interpreted Views and 
Montage. They must, however, be imported into WinGLink using the 
import functions provided in the WinGLink database window. 

To Import Layer Data 
As with well coordinates and well courses, layer data are imported into 
WinGLink using the Import Wizard: 

 1. Proceed as outlined above for station coordinates and well 
courses, making certain to select the same project. In the Import 
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WL Data window, select Well Stratigraphy, Logs: 

 
 2. The Choose Data Type window, shown below, opens: 

 
 
This window lists all previously imported data types, e.g. 
lithology, hydrology etc. Every time a file of a specific type is 
imported, each of the descriptive elements in a given file is 
appended to a list associated with the type.  
 
For example, if a file XX contains layer data for lithology 
containing descriptive elements A,B and C, and it is associated 
with a data type called Lithology_1, the elements in the file will 
be linked to this data type. If a file ZZ containing elements D 
and E is imported and also associated with the Lithology_1 data 
type, these elements will also be linked to the Lithology_1 data 
type.  
 
As is discussed in the “Common Functions” chapter of this 
manual, each descriptive element can have associated with it a 
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fill pattern. By using data types, these fill patterns can be easily 
reused throughout a database. 
 
To create a new data type, click the New button to open the 
New Data Type window: 

 
 
When importing numerical data, specify the units to be used 
when displaying the values. Leave this field blank for layer data 
and depth tags.  
 
Confirm your entries with OK. The data type should now be 
listed in the Data Type window. 

 3. Proceed with the Next button to the next Import Wizard screen. 
Use the provided fields and checkboxes to specify the file 
format as you did when importing well courses.  

 4. In the following Import Wizard screen, specify the field 
headings. Note here that options are provided for both elevation 
and measured depth. Select only one of the two options, 
regardless of whether your files contain values for both: 

 
  

Proceed as described above for each of the layer data files to be imported. 
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Generally Applicable Import Methods 

Importing a Project from a WinGLink Database 
It is possible to import a project from another WinGLink database: the 
imported project will be appended to the projects of the destination 
database. 

 1. Create or open the database into which your data are to be 
imported. 

 2. On the File menu in the WinGLink Shell, select the Import…, 
menu command. In the Import window which opens, select the 
source from which you wish to import your data, here 
WinGLink database: 

 
 3. Browse the directories until the desired database is displayed. 

 4. Select the database file (*.wdb). 

 5. Click the Next button. The list of projects found in the selected 
database is displayed: 

 
 6. Select the project(s) to be imported (SHIFT and CTRL keys 

can be used for multiple selection). 
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 7. When finished, click the Start button at the bottom of the 
window to confirm the import. WinGLink then displays a 
window with information on the number of stations which were 
successfully imported. 

Importing TGF Files 
The TGF format is an expandable data format specified by Geosystem for 
the purpose exchanging geophysical data across applications. It is used, 
among other applications, to import vertically distributed data into 
WinGLink. A given TGF file may contain station data for one or more 
stations, e.g. name and coordinates, as well as data values for one or more 
values, e.g. temperature and density. Details on the TGF specification can 
be found in Appendix A, The TGF file format. 

TGF data are imported into WinGLink using the Importing station data 
command in the main Database window. 

To import TGF files into WinGLink:  
 1. On the File menu in the WinGLink Shell, select the Import…, 

menu command. In the Import window which opens, select 
External Files as the data source and click Next to continue 

 2. In the Import dialog box, select TGF files in the <Files of 
Type> drop-down list. 

 3. Browse the directories until you find the file(s) to be imported. 

 4. Select the name of each file to be imported. 

 5. Click the Next button. 

 6. Click each of the stations which are to be imported. 

 7. When finished, click the Start button at the bottom of the 
window to confirm the import. WinGLink then displays a 
window with information on the number of stations which were 
successfully imported. 

Note: If no stations are listed, either no stations are contained in your 
TGF file or your file is not conformant with the TGF specifications 

Importing Data from a Geolink 6.0 Project 
 1. To import Geolink data into a new project, follow steps 1-3 of 

section “Getting Started with Data Import”. Otherwise, if 
importing Geolink data into an existing project, follow the first 
two steps, selecting the project into which the data are to be 
imported instead of creating a new project.  

 2. In the <Files of Type> box, select Geolink 6.0 project.  

 3. Browse the directories until the header of the desired project is 
displayed. 

 4. Select the name of the file to be imported. 

 5. When finished, click the Start button at the bottom of the 
window to confirm the import. WinGLink then displays a 
window with information on the import operation. 
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Importing Stations Referenced to a Different 
Coordinate System 
To import stations with longitude and latitude referenced to a different 
coordinate system: 

 1. Create a temporary database called <Temporary> or similar. 

 2. When prompted for the database properties, enter the 
parameters that match the coordinate system of the stations to 
be imported. 

 3. Import the stations into a new project of the <Temporary> 
database. 

 4. Close the <Temporary> database. 

 5. Open the final destination database. This is the database which 
contains the coordinate system to be used. 

 6. On the File menu, click Importing station data. 

 7. In the Importing station data dialog box, select A Project of 
another WinGLink database. 

 8. Browse the directories until you find the database 
<Temporary.wdb>. 

 9. Select the database <Temporary.wdb> and click Next. 

 10. Select the project in which the stations were previously saved, 
then click Next. 

 11. WinGLink will show a warning to inform you that the source 
and target databases have different coordinate systems, which is 
correct. 

 12. Confirm the import with coordinate conversion. 

 13. The stations will be imported and their coordinates will be 
converted during the import. 
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13:  Common Functions 

Overview 
This chapter contains: 

• An introduction to WinGLink windows and the utilities 
available to the user to organize and use their contents. 

• A description of common features and functions used for 
editing, formatting and setting the display options for maps 
and sections, including colors and line contours. 

• A general overview of printing options for both maps and 
sections 

 

The Display Area 

Zoom and Pan Functions 
Described in this section are two functions common to all WinGLink 
modules which display gridded sections or maps, e.g. the Pseudo-
Sections and Maps modules: zooming and panning. Both functions can 
be accessed from the toolbar located below the menu bar of the program 
modules: 

  

Zooming 

To Zoom In click , then: 

 1. Move the mouse pointer to a spot in the map near the zone into 
which you would like to zoom. 
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 2. Left-click and release the mouse button. 

 3. Move the mouse pointer to drag a rectangle over the area which 
is to be enlarged. 

After zooming in on an area, the zoom out button  is enabled. This 
button can be clicked as many times as the Zoom In button was clicked, 
thereby allowing you to move backwards through the previously 
executed zoom operations. 

Panning the Display 
This function is used to move or “pan” the current display area. Used in 
combination with the Zoom function, the Pan function allows you to 
quickly display specific areas of the active window in detail.  

To Pan a window, click ; then: 

 1. Move the mouse pointer to a spot in the map near the zone into 
which you would like to zoom. 

 2. Move the selection area. 

 3. Left-click in the section or map to set the new window position. 

Setting the View Area 
To set the display area, i.e. the area actually displayed in a given map or 
section window, select the Window | Set View Area…. menu command 
to open the View Area window. This window can also be opened by 
clicking the Set View Area button located in the toolbar. Depending on 
module, this button appears as either: 

 (sections) or  (maps).  

Shown below is a typical View Area window.  
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Note that the fields for defining the view area dimensions vary from 
module to module depending on the data being plotted. 

Managing Color Fill 
This section provides an overview of WinGLink’s color management 
functions. These include functions for enabling/disabling color fill, 
defining color ranges and working with color palettes. 

Enabling Color Fill 

To toggle color filling on and off, click the   button on the toolbar 

- or - 

 1. Select the View | Display Options menu command. 

 2. In the Display Options window, select the Color Fill check 
box; then click the OK. 

Note: The color fill range definition is based on the grid of each map. 
Therefore, color ranges can only be plotted if the map values have been 
interpolated.  

Color Scale 
The range distribution is shown in a color scale which is generally 

displayed at the right edge of each map or section by clicking the  
button. In the 3D Modeling module, the color scale is displayed in its 
own window and includes additional functionality (see the “3D 
Modeling” chapter for details). 
 

The Range Editor 
The interpolated values of a map or a section are organized in adjacent 
ranges. Each range is defined by two numerical bounds (upper and lower 
bound) and is associated with a color. This color is applied to all values 
within the range. 

On the Contours menu, select Color Ranges to open the Range Editor. 

Defining the Number of Ranges 
By default, the Range Editor creates 32 equally spaced intervals based on 
the difference between the maximum and minimum values. The 
maximum allowed number of ranges is 128. 

The number of ranges can be changed at any time by using the 
Automatic button in the Range Editor: 
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Another dialog box opens in which the user can enter the desired number 
of ranges and the criteria to be used for automatically generating range 
bounds: 

When using a logarithmic 
scale, make certain that the 
number of decimals in the 
main form is high enough 
to resolve the definition of 
the bounds. If necessary, 
increase the number of 
decimal in the Range 
Editor dialog 

  

Adding or Deleting a Range 
In the Range Editor, click the mouse on the color box of the range you 
wish to edit. The box is highlighted: 
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Choose Split or Delete from the Ranges frame. 

Editing Range Bounds 
Range bounds can be edited by: 

• Changing the number of ranges 

• Selecting the Normalize button in the Ranges frame. This 
option keeps the number of ranges unchanged, but resets all 
range bounds to achieve an equal distribution of the 
histogram. 

• Manually editing the range bounds. This is done by clicking 
the mouse on the line which separates two ranges: 

 
The bound value is shown in an edit box. 

 
Enter the new value, making sure it is compatible with the adjacent 
bounds. 

Selecting and Calibrating Color Palettes 
Color palettes can be selected in the right-hand frame of the main Range 
Editor: 
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The range of the color table can be modified by clicking the upper or 
lower markers: 

  

and then dragging them to a new position. The color table 
is then restricted to the area between the two markers. 

Editing Color Palettes 
 1. Use the Contour | Color Ranges menu command to open the 

Range Editor. 

 2. In the Color Table frame, click the Edit button to open the 
following window: 
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  Each color can be modified by double clicking and choosing 

the new color from a standard palette or by editing the RGB 
components using the graphic tool on the right-hand side of the 
color table. 

  The colors with a border have been locked by clicking the 
defining box while holding down the Shift key. By clicking the 
Interpolate button, a new color table is generated by 
interpolating the colors between the locked colors. 

 3. To save the new color table, click Save as New, and enter a 
name for the new palette. Note: Default palettes cannot be 
modified and saved with the same name. 

Managing Templates 
Templates are fixed combinations of color palettes and range bounds 
which can be saved in the database for use in other map or section 
presentations. 

The Template frame: 

 

is always available in the Range Editor. Its use is self-explanatory. 
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Contour Lines 

Displaying Contour Lines 

To toggle the display of contour lines on and off, click the  button on 
the tool bar 

or: 

 1. Select the View | Display Options menu command 

 2. In the Display Options dialog box, select the Contour Lines 
check box. 

 3. Click the OK button. 

Setting Contour Lines 
WinGLink has two levels of contour lines which can be formatted 
independently of one another when displaying a map: major contour lines 
and minor contour lines 

To set the number of major and minor contour lines: 

 1. Select the Contours | Contour Lines… menu command. 

 2. Click the Density tab. 

 3. Enter the appropriate density for major and minor lines: 

 

Major Contour Lines 
These are contour lines which are defined with respect to the color ranges 
set for the map. The user chooses how many color ranges should be 
contained between two major contour lines. 

Shown below is a sample display with the value 1 entered for Color 
Ranges/Major Lines: 

  
And this is what is displayed with the value 2 entered for Color 
Ranges/Major Lines: 
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Minor Contour Lines 
These are contour lines which are defined with respect to major lines. 
Use this option to select how many minor contour lines should be present 
between two major contour lines. 

2 minor lines/major line (bold): 

  

Formatting Contour Lines 
To change the format of major or minor contour lines: 

 1. Select the Contours | Contour Lines… menu command. 

 2. Click the Major lines or Minor lines tab, as appropriate: 

 
 3. Select the Annotate check box to display the contour line 

value. 

 4. Choose the font size for the annotation. 

 5. Choose the contour line Width. 

 6. Click either the OK or the Apply to All button. Note: Apply to 
All is available as an option only if multiple windows 
containing contours are displayed on the screen. 

Setting Decimals in Contour Annotation 
The number of decimals shown in the contour lines annotation depends 
on the ranges defined for the map. 

To Change the Number of Decimals: 
 1. Select the Contours | Color Ranges… menu command to open 

the Range Editor. 
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 2. In the Ranges frame, enter in the decimals field the numbers of 
decimals you would like to display (set this number to 0 if you 
do not want to display any decimals). 

 3. Click the OK button. 

Gridding 
In order display contours and gridded colors in maps and sections, station 
values must be interpolated on a regular grid. This operation creates a 
two-dimensional array of values, also referred to as a grid. Each of the 
WinGLink module with gridding functionality includes a Gridding 
window which is displayed the first time a new dataset is to be displayed. 
This window can also be opened by selecting the Gridding | New Grid 
menu command.  

Although the gridding parameters vary according to data type, the 
principle remains the same regardless of in which program the Gridding 
window is opened. 

To Grid Station Data 
 1. Select the section or map to be gridded. 

 2. Select the Gridding | New Grid… menu command. A form 
similar to that shown below this is displayed: 
 

  

 3. The numbers in parenthesis on the gray background show the 
maximum and minimum values of the data. The current value 
to be used to define the grid extent must be entered in the entry 
field adjacent to each number. 

 4. In the Step X field, enter the step size in the specified units. 
This number determines the number of columns in the grid, 
which will be displayed in the center white box. This white area 
represents the section. 
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 5. In the T intervals per decade field, for the case of a pseudo-
section grid, enter the number of grid rows per decade. 

 6. Fill the fields with the values for the interpolation radius, spline 
weight and smoothing factor. 

 7. Click the OK button to generate and draw the grid. 

Note: As the interpolation radius increases (values >5), the gridding 
algorithm attempts to fill any holes present in the data by interpolating 
between relatively distant data points. In some cases, such as when 
creating difference pseudo-sections, we recommend using a low 
interpolation radius (2) to prevent the creation of misleading pseudo-
sections.  

Copying Display Parameters 
The individual application programs which comprise WinGLink 
function by opening multiple windows, each one containing a different 
map or section. For example, in the MT Pseudo-Sections program, a 
number of different sections may be displayed simultaneously, each one 
representing different components of one or more datasets. 

Nearly all WinGLink modules include a number of functions which can 
be used to apply the display settings of one window (e.g. one x-section 
display) to one or more other currently open windows.  For example, if 
the view area of one x-section is set to cover a selected length of a 
profile, say from 2 – 10km, and all other windows currently display the 
entire profile length, the display area of the other windows can be 
adjusted by first selecting the “master” window, then using the Window | 
Copy View Area menu command to activate the function, and then 
clicking each window which is to be adjusted to the view area of the 
“master” window: 

 
WinGLink provides a number of commands which function in an 
identical manner. The available commands vary from module to module, 
but generally include functions such as: 

- Copy Size 

- Copy View Area 

- Copy Grid Parameters 

- Copy Display Options 

- Copy Ranges 
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Copying Screen Contents 
For display and presentation purposes, it is often necessary to capture the 
screen contents. All WinGLink modules provide two functions for this 
purpose: 

- Copy to Clipboard 

and  

- Copy to Bitmap 

The Copy to Clipboard utility, accessed with the Window | Copy to 
Clipboard menu command, copies the current map or section to the 
clipboard for pasting into other Windows-based applications. 

The Copy to Bitmap utility copies the current map or section to an 
external file. After selecting the Window | Copy to Bitmap command, 
you are prompted to enter a file name under which the image is to be 
stored. 

Editing and Formatting Stations 

Setting the Display Options for the Stations of a 
Project 
An ancillary window, called the Projects Window, can be opened to 
control the display and the editing of the stations of each project. 

On the View menu, select Projects Window. 

A  typical Projects Window looks like this: 
 

 
 
For each project: 

Check 
box: 

To apply the corresponding option to all project 
stations: 

N Display names 

S Display symbols 

M Display 1D model (X-Sections only) 

V Post vertical dataset values 



 

A guide to using WinGLink Common Functions  •  13-13 

Note: The new settings are applied to all windows but do not become 
active until a given window is clicked 

Applying the Same Display Options to the 
Stations of All Projects in Maps and X-sections 
Global commands are available to set the same display options for the 
stations of all projects displayed in a map. For example, to show the 
station names for all projects in a map or X-section 

 
Open the Project Window using the View | Project Window menu 
command, then click the heading  N : 

The following dialog box opens: 

 

Formatting the Appearance of the Station 
Names, Symbols and Posted Values for Each 
Project 
Stations can be displayed with different font size, color and symbol by 
saving the settings in the Project Station Properties.  

To Edit the Stations Properties for a Project: 
 1. Select the Stations | Properties command or: 

 2. Open the Project Window using the View | Project Window 
menu command. 

 3. In the Project Window, click the symbol of the project whose 
stations you want to format. The symbol of the active project 
will be displayed with a bold red border 

 4. Double-click the project symbol or select the Stations | 
Properties menu command. 

 5. The Station Properties dialog box opens, similar to the 
following: 
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 6. Select the appropriate tab and set fonts and symbols for the 

project stations as desired. 

The Station Properties window for projects of type Wells (WL) contains 
an additional tab which includes options specific to well courses: 

 
 

The station format used in 
the Maps program can be 
different from the station 
format used in the sections 
programs. 

The format settings saved for the stations of a project in a map are used 
for every map containing the stations of that project. Different settings 
can be saved for displaying sections, but the settings saved for one 
section will be used on all sections. 

The Category and Pattern Editors 
 WinGLink’s Category and Pattern editors are used to create patterns and 
assign them to specific categories. These features are used, for example, 
to associate a specific pattern to a given layer of strata in a well or to 
assign a pattern to a specific region in a map or section in the Interpreted 
Views and Montage (IVM) program.  
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In addition to IVM and the Well Editor, the Category and Pattern editors 
is available in the X-Sections and 2D Inversion modules. The categories 
are centrally stored in the database. Thus, regardless of the program in 
which categories are edited or new categories created, the modifications 
are reflected throughout the database.  

Once categories, or types of layers,  have been created, any time another 
layer of that type is encountered in a section within the database, 
WinGLink automatically performs filling.  

To Assign Fill Patterns to Layer Data: 
 1. Select the Tools | Category Editor menu command to open the 

Category Editor: 

 
 
Displayed in the Category frame are all existing categories. 
Categories are created automatically when importing layer data 
into WinGLink and can also be created using the Add New 
button located at the bottom of the left column.  
 
The elements in the Item frame are the description elements 
contained in layer-data files which were linked to the given 
category type during import. New items can be created using 
the New button located in the upper right corner of the 
Category Editor.  

 2. Select a category and item with the mouse. The current pattern 
type is displayed in the Pattern Type dropdown box.  

 3. Click the arrow at the right end of the Pattern Type dropdown 
box to open a box containing all available fill patterns. Choose 
back color and fore color for the filling using the provided 
drop-down boxes.  

 4. The Pattern Editor, described below, can be used to create new 
patterns. This editor can be opened using either the button 
provided in the Category Editor or by selecting the Tools | 
Pattern Editor command on the main menu. 
 

The Import function, which is called up using the Import button in the 
Category Editor, provides a function for importing entire categories from 
other databases. If you import a duplicate category, the Category Editor 
can be used to merge the two categories together. 
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; 

 
Upon closing the Category Editor, well courses are filled with the 
appropriate fill patterns: 
 

 

The Pattern Editor 
The Pattern editor is used to create and edit fill patterns. Theses patterns 
can be used, for example, to fill shapes used in cultural data layers or as 
fill patterns to describe layers of vertically distributed data, e.g. wells. 
Patterns created in the Pattern Editor are available in the property 
windows of all elements which support fill patterns, both in IVM and in 
other WinGLink modules. In the main WinGLink modules, this feature is 
available only for sections which contain well courses, e.g. X-Sections.  

To open and use the Pattern editor: 

 1. Select the Tools | Pattern Editor menu command to open the 
Pattern Editor: 
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 2. To create a new pattern, position the mouse over the Editing 
window, then click and hold down the left mouse button. Slide 
the mouse across the edit window to create a pattern. You may 
alternatively click individual squares to create a pattern. When 
finished, click the Save button.  

 3. To edit an existing pattern, open the Select Pattern dropdown 
list. Make any changes to the pattern, then click the Save button 
to overwrite the pattern with your changes, or Save As… to 
save your changes to a new pattern.  

Note: The only color available in the pattern editor is red. When using 
patterns as a fill, you may, however, select both foreground and 
background colors when assigning the pattern in the Category Editor. 

 

 

 

Printing 

Overview 
To print the section or map displayed in the active window, select the 
File | Print menu command. This opens another window, the Layout 
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Definition window. Here, the map or section is represented by a white 
rectangular box, surrounded by axis tic marks.  

 
Other boxes are shown representing the: 

• color scale: use the mouse to move or resize this item. 

• legend, info and title box: these items can be moved, resized 
and edited. 

• scale and scale bar: this item can be moved, resized and 
edited. To edit, enter the desired scale and choose from 
different scale bar formats. 

Information on changing display parameters of these elements is 
provided further below.  

A red border            indicates the paper size with respect to the size of 
the items to be printed. To change the paper size, use the Printer button. 
This button is also used to set the printer 

Margins and page orientation are set using the Setup button. 

Each box can be sized and edited interactively until a satisfactory output 
layout has been obtained. The appearance of the final presentation can be 
checked by pressing the Preview button. 

When ready, click the   button to send the map or section to the 
printer. 

Setting the Printer 
On the Layout Definition form, click the  button. 

Setting up the Page 

To set the page margins: 
 1. Click the Setup button. 

 2. Set the margins and the orientation and click the OK button. 

To set the page size: 

 1. Click the  button. 
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 2. From the dropdown list, choose the printer and click the 
Properties button. 

 3. The printer driver dialog box opens; select the paper size. 

 4. Exit the printer driver dialog box. 

Modifying the Print Layout 
For a given map or section, a print layout consists of the position of the 
items to be printed (and whether or not they will be printed) as well as 
their positions on the printout and their sizes. These items are represented 
by either white rectangular boxes in the layout page or, for the smaller 
items, by scaled-down versions the items. These include: 

Map, Title, Legend, Info, Color scale, Map Scale, North Arrow (maps 
only) 

After you have defined a layout, you can save it and apply it to the same 
or other maps at a later time. 

Items included in the layout can be selected by clicking the Display 
button at the top of the window: 

 
Use the mouse to select/deselect the items to be displayed. 

Moving and Resizing Items on the Print Layout 
Any of the print items can be moved with respect to the page margins and 
resized. 

To Move and Resize Objects Using the Mouse: 
 1. Click the item; a white dot appears next to each of the vertices. 

The mouse pointer changes to a four headed arrow. 

 2. To move the item, left-click the item and move the mouse 
while holding down the button; release the button to drop the 
item. 

 3. To resize the item, move to one of its vertices until the mouse 
pointer turns to a double-headed arrow; left click and hold 
down the button; move the mouse to resize the item and release 
the button when the desired size has been reached. 
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To Move and Resize Objects Using the Keyboard: 
 1. Click the item; a white dot appears next to each of the vertices. 

The mouse pointer changes to a four headed arrow. 

 2. To move the item, hold down the CTRL key and press one of 
the cursor keys. 

 3. To resize the item, hold down the SHIFT key and press one of 
the cursor keys. 

 4. To move or resize multiple items, click the items while holding 
down the SHIFT key and follow steps 2 - 3. 

To Change Display Parameters 
Double-click any of the screen items to open a parameter window in 
which the display parameters for the given element can be edited. 

Editing the Textual Print Items 
Each of the Title, Legend and Info items can be subdivided into one or 
more frames in which text can be edited and formatted. Frame text can 
include fields linked to the active database, e.g. area name, equipment 
used, etc. 

To Edit the Contents of the Title, Legend or Info Print 
Items: 
 1. Right click the item frame to be edited. On the shortcut menu, 

select Edit Frame Text…  

 
 2. Edit the frame text. Words enclosed in <> signs are fields taken 

from the database. Additional fields may be added by using the 
Add Field button. 
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 3. You can format the text using the buttons located in the toolbar 
at the top of the window. Click OK. 

  
Frames can be added and removed. Insert frame adds a frame just before 
the frame which was right-clicked; Add frame adds a new frame in the 
last position. 

Changing the Scale 
The map scale can be redefined. If the scale is changed, the size of the 
map on the print pages will be modified accordingly and vice versa. 

To Redefine the Scale: 
 1. Double-click the map scale. 

 2. Enter the desired ratio in the scale field. 

 
 3. Click the OK button. 

The scale also changes if the map item is resized. 

Example 

Before map resizing 

 
After map resizing 
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Splitting the Printout Over Several Pages 
A map or section may be enlarged in such a way that, when sent to the 
printer, it is split and printed on more than one page. 

Whenever you drag an item outside the boundaries of a page or resize an 
item so that it falls outside the page, new pages are added to the layout in 
order to print all the items. 

Saving a Layout 

To Save a Print Layout: 

 1. Click  and select Save as… 

 
 2. Enter the new layout name and click the OK button. 

Loading a Layout 

To Load a Previously Saved Print Layout: 

 1. Click  and select Load… .There can be more than one 
layout for each value type. Note that you may select a layout 
which is associated with a value type different from the one 
being printed: 

 
 2. Select the source and one of the available layouts; click the OK 

button. 

Printing to File 
In addition to the direct output to a selected printer, the Print functionality 
found throughout WinGLink can be used to send printer output to a 
number of file formats: 

• Printer specific (e.g. *prn, *ps). The printer-specific format is 
dependent on the output types supported by the printer 
driver. A PostScript (ps) file can be output by printing to a 
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PostScript printer driver, regardless of whether a PostScript 
printer is actually connected to the computer. 

• EMF 

• CGM 

• PDF 

To Print to Files of Type Other Than PDF: 
 1. Select the File | Print menu command as you would to print to 

a printer. 

 2. Select the Print to File checkbox in the Options section of the 
Printer Setting dialog box.  

 3. Select the desired file format from the dropdown list: 

 
 

Important: 
When printing to EMF of CGM files, note the following: Although 
output is not sent to a physical printer, the paper properties of the printer 
selected in the Printer section of the Printer Settings dialog are used. Each 
output file can be considered to be a page of printer output. Because the 
entire output is sent to a single file, however, you must ensure that the 
paper size selected for the printer is large enough for the entire print area, 
i.e. fits within the red border which defines the first page of output in the 
Print Preview screen. Any information outside of the first page is clipped 
in the output file. 

To Print to PDF Files: 
The driver used to create PDF files, the Acrobat Distiller available from 
Adobe, functions in the same way as a regular printer driver. PDF files 
can be created only if this software has been installed on your system.  

 1. Select the File | Print menu command as you would to print to 
a printer. 

 2. Select the Acrobat Distiller printer from the Printer section of 
the Printer Settings dialog box and set the properties as required 
by clicking the Properties button. 

 3. Do not select the Print to File checkbox in the Options 
section. 
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14:  Maps 

Overview 

 

The primary uses of the Maps program are to: 
- manage stations 
- create profiles 
- create and display contoured and color-filled maps of the different 
values associated with the stations of a project 

In this chapter we will first present an overview of how the program 
creates maps and will then provide general instructions on how to create 
maps, including information on creating and working with profiles as 
well as managing stations. The chapter will conclude with detailed 
information on working with specific data types in the Maps program. 

Getting Started with the Maps Program 
This section provides an overview of basic functions of the Maps 
program, including: 

- Creating a new map 

- Creating a profile 

- Assigning stations to a profile 

This is the bare minimum for preparing a WinGLink project for use with 
section-based modules, such as 2DMT, X-Sections and Pseudo-Sections. 

Detailed information on creating specific map types, managing stations 
and working with specific data types is provided in the sections which 
follow. 

Creating a New Map 
The first time the Maps program is started for a given project which 
already contains stations, the program opens with a dialog box which 
contains options for creating standard map types for the given data type. 
At a minimum, this dialog box contains an option for creating an 
elevation map. When beginning work with a new project, the elevation 
map is a often good place to perform the initial “administrative” work 
which, depending on data type, needs to be taken care of with a new 
project, i.e. profile creation, assignment of stations. 
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Starting the Maps Program and Creating an Elevation 
Map: 
 1. In the WinGLink Shell, use the mouse to select the project for 

which a map is to be created. 

 2. Click the Maps icon. 

 3. The program starts with the Open Map dialog box. Select the 
Elevation checkbox and click the Open button to continue: 

 
 

 4. If creating the elevation map for the first time, the program now 
prompts you to select the gridding options: 

 
The Grid using default parameters option generally provides 
suitable gridding results. Select the second option to set the 
individual gridding parameters. Information on setting these 
parameters can be found further below in the “Map Grids” 
section of this chapter and in the “Common Functions” chapter 
of this manual. 
 
Provided the project contains at least two stations with 
elevation values, the Maps program opens with the elevation 
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map for the data: 

 

Creating and Using Profile Traces 
A profile trace is a polygonal line added to the database area and to 
which individual stations can be associated. A profile trace added to a 
map is available to all projects in the database and can be used for: 

• Constructing sections along the profile by adding stations 
to the trace and using the station datasets to build different 
types of sections (examples: pseudo-sections, imaged 
sections, etc.). 

• Extracting an interpolated value profile from the grid of a 
map (example: interpolated Bouguer anomaly profile). 

• Constructing a value profile by adding stations to the 
trace, and plotting the station values vs. the distance along 
the profile (example: Bouguer anomaly profile using station 
values). 

The use of the same profile trace for all type of sections is the basis for 
the integrated display of interpretive sections. For example, a 2D gravity 
model can be easily superimposed on a resistivity cross section because 
they are referenced to the same profile trace.  

Adding a Profile Trace 
 1. Select the Profiles | Add profile trace menu command. 

 2. Move the mouse pointer to the location at which you would like 
to insert the first node of the trace. 

 3. Click the left mouse button, release it and move the cursor to 
the next node. 

 4. To draw more nodes, repeat the above step; click the right 
mouse button to add the last profile node. 
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 5. Enter a name for the profile trace. 

 6. If you would like to add another profile trace, press the Next 
button and repeat steps 2-5. 

 7. Click the Close button. 

 

Editing the Nodes of a Profile Trace 
 1. Select the Profiles | Edit profile trace menu command. 

 2. Click the profile trace you would like to edit. 

 3. Edit the name and/or the longitude and latitude values of the 
nodes which define the trace: 

 
 4. Click the OK button. 

Adding Stations to a Profile Trace 
This section explains how to associate existing stations to profile traces 
in order to construct value profiles or sections. For help on how to insert 



 

A guide to using WinGLink Maps  •  14-5 

new stations at a regular spacing along a profile trace, see “Inserting New 
Stations Along a Profile Trace” in this chapter. 

The basic commands used to construct a section along a profile trace are 
activated by pressing: 

 To Switch to Profile Mode 

 1. Click the profile trace which to you would like to add stations; 
the profile trace turns red to indicate that is selected. 

 2. If the selected profile trace consists of more than one segment, 
the unselected segments are displayed in light green. 

 To Add One Station at a Time 
 1. Click the arrow button and then click the symbol of each station 

to be added to the profile. 

 2. Added stations turn red. 

 To Add All Stations Located Within a Given 
Distance from the Profile: 
 1. Click the button shown above, then left-click the profile trace 

and hold down the mouse button. 

 2. Resize the band by moving the mouse pointer away from the 
profile trace 

 3. Release the mouse button when band has reached the desired 
size. 

 4. Selected stations turn red  

 To Select Another Profile or Profile Segment 
 1. To activate another profile, click the button shown above, then 

click the new profile trace. For multi-segment profiles, each 
segment is edited separately and should be edited as a separate 
profile 

 To Return to Station Mode (or select Profiles | 
goto Station Mode) 
 1. Click the button shown above to return to station mode. 

Alternatively, you may use the Profiles | goto Station Mode 
menu command to return to station mode.  

Shown below is a selected profile in profile mode with attached 
stations: 
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Note: The program can handle over 32,000 stations on a single profile. 

Creating Maps 
Each time the Maps program is launched, the stations of the project 
which is currently highlighted in the WinGLink Shell are loaded. For 
multiple projects, i.e. integrated projects, the stations of all member 
projects are loaded. 

When running the Maps program, you may open many maps at the same 
time, one for each type of value. For example, for gravity data, maps may 
be open for elevation, observed gravity, terrain correction – among 
others. New maps can also be created by importing, computing or 
extracting new values. The resulting maps can then be saved and 
reopened during subsequent sessions.  

The user is presented with a list of all maps which have been saved 
during previous sessions when the Maps program is launched as well as 
given the option of creating standard maps available for the given data 
type. 

Items Displayed in a Map 
Maps are displayed by combining the display of different items, which 
the user can interactively modify by editing the respective data and 
properties. The items represented in a WinGLink map 
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are:
Item Meaning 
Stations The stations contained in the current project and those 

of any attached project. Each project can be assigned a 
different symbol to identify its stations. Stations are 
plotted with their names, values and symbols. 

Color 
Ranges 

For each map, the value distribution is organized in 
ranges of different colors. Default color palettes are 
available. The user may also create new or modify 
existing palettes. 

Contour 
Lines 

Annotated contour lines are drawn based on the 
defined value ranges. The user can define the contour 
interval and the line thickness. 

Profiles 
Traces 

Polygonal lines can be added to the area to serve as a 
base for profile and section construction. Profiles are 
elements of a map which are shared by any other maps 
contained in the database. 

3D MT 
Meshes 

3D MT meshes, in the Randy Mackie format, which 
have been imported into a WinGLink database, can be 
superimposed onto MT project maps. 

 

Parameter Values Used to Generate Maps 
Each map contained in a WinGLink database is defined by the name of 
the displayed parameter, e.g. elevation or observed gravity. The values 
used to build each map are: 

 1. The values of the parameter at each station of the project  

 2. The interpolated values of the same parameter  

whereby interpolated values are added to the maps by one of the 
following methods: 

- interpolating the parameter values at each station 

- importing an external grid 

- transforming an external grid 

Creating Standard Maps 
As will be described in more detail, each project type has associated with 
it certain standard maps. These maps are available for all projects of a 
given type. For example, the standard maps available to gravity projects 
include elevation, observed gravity and terrain correction. They represent 
fixed, measured values. The standard maps available with a given project 
type are listed in the Open Map dialog box which appears when the Maps 
program is started. This dialog box can also be opened with the File | 
Open Map menu command.  
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Creating New Map Definitions 

About Map Definitions 
In addition to the standard maps mentioned above, it is possible to 
generate maps using values extracted from a given data set. With MT 
data, for example, it is possible to extract a resistivity map for a specific 
tensor component at a given frequency. The number of possible maps is, 
therefore, limitless. Each time a new map is created in a project, the 
definition of the parameter values used to generate the map is saved in 
the database and made available to all other projects. The same map can 
then be created using the data contained in any other project, if available.  

Assume, for example, that we have a database which contains two 
different MT projects: 

Prj_1 and Prj_2 

We create the map of “Apparent resistivity at T=100 sec” by extracting it 
from the station datasets of Prj_1: 

 
This map definition will then be available in the list of existing map 
definitions when the Maps program is started for the Prj_2 project, or any 
other MT project: 

 
Thus, the same map definition (“Apparent resistivity at T=10 sec” ) can 
be used to extract equivalent values from any other MT project without 
needing to recreate the map definition.. 

Types of Map Definitions 
Different project types have associated with them different data types 
from which data can be extracted to generate new maps. In the example 
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used above, we created an apparent resistivity map for the XY 
component at a period of 10 seconds. 

Associated with the various project types are also map types which can 
be generated on the basis of user-defined parameters, e.g. induction 
arrows at a specific frequency for MT data: 

 
Options for generating new map definitions can be accessed with the File 
| New Map menu command. The figure below shows the options 
available for an MT project: 

 
 

Creating a New Map 
In addition to the standard map types associated with a given project 
type, the Maps program provides a number of different methods for 
creating new maps. New maps can be created using station values, either 
imported or entered in the Maps program via the keyboard or by 
combining two existing maps. 

The options for creating new maps can be accessed with two options 
available with the File | New Map menu command: 

• Enter Values from Keyboard/File 

• Combine Maps… 

Entering Values from the Keyboard/File 
 1. Select the File | New Map menu command and click the Enter 

Values from Keyboard/File option. The Maps program 
displays the following window, instructing you to open the 
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View Data window: 

 

 2. On the Stations menu, click View Data… or click  in the 
toolbar. 

 3. The data sheet form for the new value type appears. Listed in 
the first five columns (from left to right) are the station names, 
states, latitudes, longitudes and elevations. The sixth column is 
empty and will be used to enter the values. 

 4. Enter the station values in the data sheet. You may leave some 
values blank.  

   
 5. Alternatively, you may import the data from an external file by 

executing the File | Import menu command. The file must 
contain at least the station ID and the value to be imported, 
though may also contain coordinate and elevation information. 
The program guides you through the import process using the 
Import Wizard described in the “Data Import” chapter of this 
manual.  

 6. After entering/importing the data, select the File | Exit menu 
command; confirm changes by clicking the Yes button. 

 7. Enter the Name, Unit and # of decimals for the new value type. 
Click the OK button: 

 
When selecting this option, a new map definition is created with a default 
name Value ( ). The map properties can be accessed and modified at a 
later time by selecting Map Properties from the File menu. 

Adding or Subtracting Map Values 
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New maps can also be created by combining (adding or subtracting) the 
values of two existing maps. 

 1. Select the File | New Map menu command and click the 
Combine Maps option. 

 2. Select the source map and click the Next button. 

 3. Select the operator (Add Map or Subtract Map) and click the 
Next button. 

 4. Select the second map and click the Next button. 

 5. Enter the name for the computed map and click the Finish 
button. 

Creating Maps by Merging Data from Different 
Projects 
The data source for a given map is dependent on the project type. As 
described in the “WinGLink Shell” chapter of this manual, WinGLink 
gives the user the option of creating two different types of projects: single 
and integrated. 

If an integrated project, containing for example two projects named Prj_1 
and Prj_2, is created grouping the two projects, any created map will 
include station data from both projects. 

Separate maps can be generated for each project by opening the single 
projects, i.e. the projects which are members of the integrated projects, in 
the Maps program. Gridding is performed on basis of the stations 
contained in each project. 

Loading an Existing Map 

To Open a Map: 
 1. Select the File | Open Map menu command. 

 2. Select the map by clicking the check box located to the left of 
each map name. 

 3. Click the Open button. 

Each map opens in a separate window. Use the options provided on the 
Window menu to switch between or tile the windows  

Map Grids 

Gridding a Map 
To display map contours and color fill ranges, the station values  must be 
interpolated on a regular grid. This operation creates a two-dimensional 
array of values, also referred to as the map grid. 
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Regridding a Map Using Different Parameters 
This option lets you create a new grid by resampling the current map 
grid: 

 1. Select the window containing the map you would like to regrid. 

 2. Select the Grid Tools | Resampling menu command: 

 
 3. Enter the new grid step and the grid endpoints 

 4. Click the Compute button. 

A window is opened for the new map with the new grid. Use the File | 
Save menu command to save this map. Station values can be extracted 
from this new map using the Extract Value command described below. 

To Interpolate the Parameter Values: 
 1. Open the map which contains the values to be interpreted. 

 2. Select the Gridding menu | New Grid… menu command 

 3. The numbers in parenthesis show the coordinates of the stations 
having maximum and minimum Northing and Easting. The new 
grid boundaries can be entered in the fields located above each 
of these numbers. 

 
 4. Choose the preferred Gridding Option (Normal / Logarithmic); 

 5. Complete the fields with the values for the Interpolation 
Radius, Spline Weight and Smoothing Factor. 

 6. Click the Compute button. 

When the station data are changed as the result of subsequent editing, a 
new map grid must be created in order to show an updated map. 

To Regrid the Map Using the Previous Grid Settings: 
 1. Select the window containing the value you would like to 

regrid. 

 2. Select the Gridding | Regrid menu command. 
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To Enable the Gridding of Masked Nodes: 
 1. Select the View | Display Options menu command. In the 

Display Options dialog, select the Grid masked nodes 
checkbox on the General tab: 

 

Extracting Station Values From Grids 
This option assigns to each station the value calculated by interpolating 
from the grid nodes the value at each station’s location, as defined by the 
station coordinates. 

 1. Select the window which contains the map. 

 2. Select the Stations | View Data menu command or click the 

 button. 

 3. Click the Value column header. 

 4. Choose Operators | Extract Value from the Grid menu. 

 5. Select the File | Exit menu command and confirm the changes. 

Importing External Grids 
External grids can be imported into WinGLink and added to the current 
project. All standard grid formats are supported, e.g. USGS, Surfer, 
Geopack, LCT. 

To Import an External Grid into the Current Project: 
 1. Load the map into which you wish to import the grid, or 

 2. Create a new map which will correspond to the imported grid. 
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 3. Select the File | Import Grid menu command. WinGLink 
supports the standard formats shown below: 

 
 4. Select the appropriate format for the grid which is to be 

imported from the “Files of type” list. 

 5. In the Grid Import window, select the XY units of the grid. If 
the grid is very large, you can reduce the number of data points 
which are imported by making the appropriate selections in the 
Read every fields. 

 
 6. If necessary, use the Grid Tools | Resampling menu command 

to resample the grid using user-defined values. 

Exporting grids 
Map grids created in WinGLink can be exported to external files in a 
number of different formats for use in other applications or for importing 
into another WinGLink project. 

To Export a Grid to an External File: 
 1. Create or open the map for which the grid is to be exported 

 2. Select the File | Export Grid menu command and select the 
desired file format: 
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Adding and Editing stations 

Importing Stations From a Text File 
Station coordinates, elevations and values can be imported from external 
text files (columnar data). Station data can only be imported into single 
projects. When the current project is an integrated project, the import 
function is disabled. 

To Import Stations From a Text File: 
 1. Load the map into which you would like to import the value or 

 2. Select File | New Map | Enter Values from Keyboard/File to 
create a new map using the imported data. 

 3. On the Stations menu, click View Data or click the  button 
on the toolbar. 

 4. The Maps datasheet form appears. Listed in the first five 
columns (from left to right) are the station name, states, 
latitudes, longitudes and elevations. If you selected a map other 
than elevations, two additional columns appear on the right 
side: a column for the value and a column for the value status. 

 5. Select the File | Import menu command on the datasheet menu. 

 6. Browse the directories to select the file to be imported and click 
Open. 

 7. The WinGLink Text File Import Wizard starts. Refer to the 
instructions provided in the “Data Import” chapter of this 
manual for more details. 

 8. When finished, use the File | Exit menu command on the 
datasheet menu to exit the datasheet. Click Yes to confirm the 
import. 

 9. If the data have been imported into a new map, the Map 
Properties form will open. Assign the map a name, a 
measurement unit (used only in legends) and the number of 
decimals to be saved for each imported value. Click OK. 

The file containing the data which are to be imported must be a text file 
organized in columns where one of the columns contains station names 
and the other three columns contain the station longitude, latitude and 
elevation. Another optional column may contain a value to be imported. 

Warning: The WinGLink import function identifies stations by name. 
This may cause the program to overwrite existing data if the import 
options are not set correctly. 
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Importing New Values for Existing Stations 
The import stations function can also be used to import new values for 
existing project stations or to update them by importing revised data from 
a text file. 

Note: This procedure is only enabled for single projects. 

To import new values for existing stations: 

Make sure that the file to be imported has at least two columns: 

• one column containing the values to be imported 

• one column containing the corresponding station name 

Load the map into which the file containing the new or updated data are 
to be imported.  

Refer to “Importing Stations From a Text File” above for detailed 
instructions. 

When selecting the fields in the file to be imported, skip any field that 
should not be imported or updated. 

At the end of the import process, a window opens which contains 
information regarding the number of stations contained in the imported 
file which were merged, skipped or appended..  

A station is merged if a station with the same name is found in the 
destination project. In this case the existing station takes the value 
imported from the file as well as the values, if any, of other fields not 
tagged with the Skip keyword. 

A station is skipped if no station with the same name is found in the 
destination project and no field of the imported file is assigned to be 
latitude or longitude for the station. 

A station is appended if no station with the same name is found in the 
destination project: the station is added to the current project and is 
assigned the values of any field not tagged with the Skip keyword. 

Using the Datasheet to Add, Delete or Edit 
Stations 
The Maps program has a built-in datasheet which can be used to add, 
delete and edit the station information used when building a map. To 
open the datasheet, select the Stations  | View Data menu command or 

click the  button on the toolbar. 

Adding Stations 
 1. Click the left-most cell of the first empty row: 

 
 2. Enter the fields described in the column headers. If unedited, 

the Active and Value Status fields are automatically filled with 
the YES and NO values, respectively. 
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Deleting Stations 
 1. In the datasheet, highlight the rows of the stations which are to 

be deleted (use the Shift and Ctrl keys for multiple selection.) 

 2. Press the Delete key, and confirm the delete command by 
clicking the OK button. 

Editing Stations 
 1. Click the cell which contains the field to be edited. 

 2. Edit the data. 

Applying Operators to Station Values 

 1. Click the  button to open the datasheet. 

 2. Select Operators from the menu in the datasheet window, then 
choose the desired operator and enter the requested parameters. 

 3. Warning: When saving the map, choose the Save As 
command if you do not want to overwrite the original data. 

Extracting Elevations from Grids 

 1. Click the  button to open the datasheet. 

 2. Select any element in the Elevation column (i.e. the column 
heading or an elevation value). 

 3. Select Operators from the menu in the datasheet window, then 
choose the Extract Elevation from Grid menu command. 
Here, select either the Using project topography or Using 
Area topography option. 

 4. The program then automatically extracts the elevation values 
from the specified source and uses these values in the elevation 
grid. 

Updating Extracted Values After Editing Stations 
If editing is performed on stations after parameter values have been 
extracted, the corresponding map can be updated with the new values 
using the File | Update Map command. 

Using the Interactive Graphic Editor to Add, 
Delete and Edit Stations 
Station editing can be performed using an interactive graphic feature of 
the Maps program.  

Note: When working with integrated stations, the operations listed below 
apply to the project currently selected in the Project window. It is only 
possible to delete, move or edit stations belonging to that project. 
Likewise, new stations are added to the current project. 

Adding Stations 
 1. Select the Stations | Insert Station menu command. 
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 2. Move the mouse pointer to the location on the map at which 
you would like to place the station then click. 

 3. Fill the Insert Station window with the appropriate field values. 

 4. Continue adding all desired stations. 

 5. Right-click the mouse or press the Esc key to stop adding 
stations. 

Deleting Stations 
 1. Select the Stations | Delete station menu command. 

 2. Move the mouse pointer over the station you wish to delete and 
click. 

 3. In the window which then opens, place a check mark to the left 
of the stations to delete the station, then click Delete. 

 4. Right-click the mouse or press the Esc key to stop deleting 
stations. 

Editing Stations 
 1. Select the Stations | Edit station menu command. 

 2. Move the mouse pointer over the station you wish to delete and 
click. 

 3. Edit the value field and select the value status (ON/OFF). 

 4. Click the OK button. 

 5. Right-click the mouse or press the Esc key to stop editing 
stations. 

Moving Stations 
 1. Select the Stations | Move station menu command. 

 2. Move the mouse pointer over the station you wish to move and 
left-click. 

 3. Move the mouse pointer to the location on the map where you 
would like to place the station to be moved and click. 

 4. The Move Station window opens. In the ID field, enter the 
name of the new station; fill the elev field with the elevation 
and edit the x and y fields if necessary. If you selected a map 
other than elevations, you can supply the value for the new 
station and its ON/OFF status as well. 

 5. Click the OK button. 

Inserting New Stations Along a Profile Trace 
This interactive operation is used to automatically insert stations along a 
profile trace at regular distances: 

 1. Make sure the desired profile trace is on your map. If not, add a 
new profile trace. 

 2. Select the Stations | Insert stations along profile… menu 
command. 
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 3. Move the cross-shaped mouse pointer to a location on the 
desired profile trace and click it to select the profile. 

 4. The Insert Stations dialog box opens: 

 
 5. Fill the fields as appropriate. 

 6. Click the OK button to insert the stations. 

Note: The program can handle over 32,000 stations on a single profile. 

Profile Traces and Value Profiles 
The general procedure for creating profiles and assigning stations to them 
is described in the “Getting Started with the Maps Program” section of 
this chapter. The description here is limited to: 

- Viewing profile values 

- Working with sections 

- Exporting profiles 

Viewing Profile Values and Displaying the 
Frequency Spectrum 
To display a sectional view of the profile in a separate window:  
 1. Select the Profiles | goto Profile Mode menu command or 

click  the  button. This enables you to select the profile 
trace. 

 2. Select the Profiles | Select Profile menu command. 

 3. Click the profile to be displayed as a section. 
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 4. Select the View | Profile Graph menu command to display the 
profile window: 

 
This window displays one of two different graphs, depending which 
button is enabled.  

 XY Graph 

The observed values of the stations attached to the profile are plotted as 
red dots. 

The interpolated values extracted from the map grid along the profile 
trace are displayed as a continuous gray line. The y-axis of the graph 
represents the values along the profile, while the x-axis represents the 
distances along the profile trace. 

 Spectra 

Spectra calculated along the profile are plotted vs. frequency. 

Constructing Sections Along Profile Traces 
As described in brief in the “Getting Started with the Maps Program” 
section of this chapter, before 2D sections can be created in other 
WinGLink modules, the following steps must be performed: 

 1. Add a profile to the database area 

  When a profile trace is added to a map, the trace is saved in the 
database and can be used in any other map of any project 
contained in the database. Profile traces are elements of the area 
to which the database refers. 

 5. Add stations to the profile 

  These stations provide, in the case of vertical soundings or 
wells, the datasets needed to build the section. In the case of 
gravity and magnetic projects, the observed anomaly values are 
extracted along the profile trace from the gridded map, and the 
stations associated to the profile provide the information on the 
measured values . 

When Maps is launched on a single project, the stations contained in the 
project can be added to a profile trace to construct the project sections.  

When Maps is launched on an integrated project, the stations of each 
member project can be added to a profile trace, if not yet associated. 

Note: A station added to a profile trace in an integrated project is also 
added in its original project. 
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Stations from many different projects can be added to a given profile 
trace. As a result, integrated sections can be obtained by using, for 
example, equivalent datasets from MT, EM and DC projects (i.e. imaged 
sections, 1D models, cross sections). 

Exporting Profiles 
Use the Profiles | Export Profiles menu command to export all profiles 
visible from within either the current project or all profiles in the 
database to an external text file. By default, only the visible profiles are 
exported; to export all profiles in the database, select the Export hidden 
profiles checkbox. 

 
 

MT Maps 

Mapping MT Parameters 

To Plot Resistivity and Phase Curves 
 1. On the File menu, select the New Map | Miniature Curves 

menu command: 

 
 2. Make the desired settings and click the OK button. The  

resistivity and phase curves for each sounding of the project are 
calculated and plotted in a box centered on the station locations 
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to give a global view of the curves in the survey area: 

 

To Plot Polar Diagrams 
 1. On the File menu, select the New Map | Polar Diagrams menu 

command: 

 
 2. Enter the central frequency for which the polar diagrams should 

be calculated, as well as the other parameters requested in the 
dialog window. 

 3. Click the OK button to display the polar diagrams for that 
frequency. 

 4. Repeat the steps described above to display maps of polar 
diagrams for other frequencies. 

 5. On the View menu, select the Display Option menu command 
to edit the size of the polar diagram on both monitor and 
printer.  

To Plot Induction Arrows 
 1. On the File menu, select the New Map | Induction Arrows 

menu command: 
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 2. Enter the central frequency for which the induction arrows 
should be calculated, as well as the other parameters requested 
in the dialog window. 

 3. Click the OK button to display the induction arrows for that 
frequency. 

 4. Repeat the steps described above to display maps of induction 
arrows for other frequencies. 

 5. On the View menu, select Display Option to edit the size of 
the real and imaginary arrows on both monitor and printer. 

 6. On the View menu, check Legend to display the unit-length 
reference segments. 

Note: In WinGLink, induction arrows (real and imaginary) always refer 
to geographical North. 

Extracting Parameter Values from Station 
Datasets or Models 
In addition to creating maps for the MT parameters as described above, 
maps can also be created for a number of different MT parameters at a 
given period/frequency or depth/elevation. Using available options, it is 
possible to generate maps for any standard MT component, measured or 
derived, at a specific period or frequency. Maps can be extracted at a 
given depth or elevation using values resulting from 1D, 2D or even 3D 
modeling. 

Extracting Parameter Values 
 1. On the File menu, select the New Map | Extract Parameter 

Values menu command. 

 2. Select the desired extraction key from the list of available 
options: At constant period/frequency…, At constant 
depth…, or At fixed elevation... Shown below is the dialog 
which for extracting at a constant period or frequency: 
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 3. Select the parameter value to be extracted from the drop-down 
list. 

 4. Specify whether to extract by period or frequency. 

 5. Click the OK button; a window for the new map opens. 

 6. On the Gridding menu, select New Grid…; set the gridding 
parameters as necessary. 

Updating Extracted Values after Editing Stations 
If editing is performed on stations after parameter values have been 
extracted, the corresponding map can be updated with the new values 
using the File | Update Map command. 

Extracting a Map from 3D Meshes 
If one or more 3D MT meshes have been imported into a WinGLink 
database, it is possible to extract maps at any specified depth or elevation. 
Note that this option is available only in MT projects. 

To Extract a Map from a 3D Mesh: 
 1. On the File menu, select the New Map | Extract Map from 3D 

Model menu command; select from the available options: At 
constant depth or At fixed elevation. 

 2. In the Extract map dialog box which opens, select the source 
3D mesh, value (resistivity, conductance or transverse 
resistance) and depth or elevation: 
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 3. After clicking the OK button to confirm, a gridding window 
appears. Accept the default values or make any desired changes 
and click the Compute button to extract the map. 

Displaying 3D Meshes 
3D meshes which have been imported into WinGLink can be 
superimposed onto MT projects maps. Profiles projected onto a 3D mesh 
can be used in the 2D MT and X-Sections programs to extract sections 
from a mesh.  

To Display a 3D mesh: 
 1. Open an MT project 

 2. On the Maps toolbar, click the 3D Model selection button: 

  
 3. The 3D Model selection window opens, listing all models 

contained in all MT projects in the database. Select the desired 
model with the mouse and click the OK button: 

 
 

 4. Depending on the current view area settings and the geographic 
coordinates for the 3D mesh, the mesh may or may not be 
displayed on the map after selecting the mesh. You can force 
the mesh to be displayed by altering the view settings. To do 
this, open the View Area window with the Window | Set View 
Area… menu command: 
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The two mesh-specific options in the Auto Range area of the 
window, Grid Area and 3D Mesh will force the mesh to be 
displayed on screen. The Grid Area option attempts to fit the 
entire grid area onto the map, whereas the 3D mesh option 
zooms in on the map far enough to display the entire mesh on 
the map. By selecting all of the options in the Auto Range area 
of the window, you can ensure that all map elements are visible 
on the map.  

 5. The 3D mesh can be toggled on and off by selecting the Hide 
Model / Show Model commands, which can be accessed by 
clicking the 3D Model selection button: 

 
 

Note: For details on importing 3D meshes, refer to section “Importing 
3D Meshes” in the “Data Import” chapter of this manual.  

TDEM Maps 

Extracting Parameter Values From Station 
Datasets or Models 
As with MT data, maps can also created for a number of different TDEM 
parameters at a given period/frequency or depth/elevation. Using 
available options, it is possible to generate maps from observed or 
modeled resistivity or voltage at a given time, resistivity or conductance 
at a given depth/elevation from a smooth or layered model. 

Extracting Parameter Values 
 1. On the File menu, select the New Map | Extract Parameter 

Values menu command. 
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 2. Select the desired extraction key from the list of available 
options: At constant period/frequency…, At constant 
depth…, or At fixed elevation... Shown below is the dialog 
which for extracting at a constant period or frequency: 

 
 

 3. Select the parameter value to be extracted from the drop-down 
list. 

 4. Depending on the section made above, specify the 
time/frequency or depth/elevation for the extraction operation. 

 5. Click the OK button; a window for the new map opens. 

 6. On the Gridding menu, click New Grid…; set the gridding 
parameters as necessary. 

Updating Extracted Values After Editing Stations 
If editing is performed on stations after parameter values have been 
extracted, the corresponding map can be updated with the new values 
using the File | Update Map menu command. 

Gravity and Magnetic Maps 

Gravity and Magnetic Station Anomalies 

Computing the Free Air Anomaly 
A map of the free air anomaly can be calculated by selecting the File | 
New Map | Free Air Anomaly (FAA) menu command. 

Computing the Bouguer Anomaly 
The Maps program can calculate the simplified (no terrain correction) or 
complete Bouguer anomaly for the stations of a gravity project, assuming 
that the observed gravity and terrain correction values have been entered 
for each station. For details on how to calculate the terrain correction, 
please refer to the next section, “Terrain Correction Maps”.  

For stations with missing observed gravity values, the Bouguer anomaly 
computation will return an empty value. 

Observed gravity values can be imported from text files using the 
WinGLink text files import wizard, as detailed in section “Importing 
Stations From a Text File” in this chapter. 
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Computing IGRF (Magnetic Projects) 
This command calculates the international geomagnetic reference field 
(IGRF) at each magnetic project station. 

 1. With the Maps program launched from a magnetic project, 
select the File | Compute IGRF menu command. 

 2. A window appears informing you which reference field will be 
used to calculate IGRF. To continue, click the OK button. 

A new map named IGRF is created. 

Note: The IGRF is computed using the project date entered in the project 
properties when the project was created. To correct this date, exit Maps 
and modify the project date using the menu command Project | 
Properties or pressing the Project Properties button in the main 
Database window: 

The IGRF-10 model data are used for the IGRF calculation. 

Removing IGRF (Magnetic Projects) 
With this option you can subtract the IGRF from the magnetic field map. 

 1. Load the magnetic field map. 

 2. Select the View | Stations Data menu command or click the 

 button. 

 3. Click the Value column header. 

 4. From the datasheet menu, select Operators | Remove IGRF. 

 5. Select the File | Exit menu command and confirm the changes. 

 6. Save the new map with an appropriate name. 

Aeromag (Magnetic Projects) 
The magnetic anomaly values for aeromag maps are calculated at the 
observation point. The observation point is one of the following: 

1) Ground survey: Data are collected at ground level 

2) Drape survey: Data are collected at a constant positive distance from 
the ground level 

3) Constant altitude survey: Data are collected at a constant elevation 
above the ground level 

To select the observation point property: 

 1. Open the magnetic (MG) project in Maps. 

 2. Load the value "AeroMag". 

 3. Select the File | Map Properties menu command. For cases 2 
and 3 a flight altitude must be specified, where 0 is the ground. 
A drape survey with a fight altitude=0 is equivalent to a ground 
survey. 
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Gravity and Magnetic Field Transformation 

Filtering (Low-, High- or Band-Pass Filters) 
Use this option to low/high/band-pass filter 2D data grids. 

Note that, following conventional terminology, the terms “low” and 
“high” pass refer to spatial frequency, i.e. 1/wavelength. To eliminate 
short-wavelength noise, therefore, a low pass filter is used, and vice-
versa. 

LOW PASS the minimum wavelength to be passed is requested. 

HIGH PASS the maximum wavelength to be passed is requested. 

BAND PASS wavelengths in the entered range are passed. 

Several filters are available for minimizing the effects of ringing (i.e. 
leakage of unwanted frequencies into the desired output): square, Bartlett 
and Hamming-Tukey. The anti-ringing factor is the narrowness of this 
filter: a value of 0 minimizes its width in the frequency domain, while a 
value of 10 is so broad that the effects of filtering are minimal. 

To filter a grid: 

 1. Select the Grid Tools | Filtering menu command. 

 2. Enter the filtering parameters and click the OK button. 

 3. If you wish to have station values extracted from the new grid, 
select Yes when prompted. 

The filtered grid is assigned to a new map. 

Polynomial Fitting 
With this option, you can obtain the regional and residual field of a 
selected map. 

The regional field is approximated with an nth order polynomial surface. 

The residual field is the difference between the polynomial surface and 
the selected map’s grid. 

Both the regional and the residual fields are obtained as maps. 

To obtain the regional and residual field of a map: 

 1. Select the Grid Tools | Polynomial fitting menu command. 

 2. Enter the name for the map that is to contain the regional field. 

 3. Enter the name for the map that will contain the residual field 

 4. Enter the degree of the polynomial surface and click the OK 
button. 

 5. If you wish to have station values extracted from the new grid, 
select Yes when prompted. 

Derivatives 
This option can be used to calculate the 1st horizontal and vertical, and 
the 2nd vertical derivatives. This transformation makes use of the fact that 
nearby disturbing sources have a greater effect on gradient maps than on 
anomaly maps. 
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The 1st horizontal derivative is calculated directly in the space domain 
(see Blakeley and Simpson, 1986). The remaining two are calculated by 
conventional Fourier transformation. As usual, the use of derivatives is 
limited by their tendency to emphasize noise. 

To calculate the derivative of a grid: 

 1. Select the Grid Tools | Derivatives menu command and the 
type of derivative you wish to apply. 

 2. Select the map containing the input grid (the current map is the 
default). 

 3. Enter the name for the new map that will contain the output 
grid. 

 4. Click the OK button. 

 5. If you wish to have station values extracted from the new grid, 
select Yes when prompted. 

Up/Down Continuation 
This option allows one to compute anomalies as they would be observed 
on a surface parallel to but below the observation surface 
(DOWNWARD) or above the observation surface (UPWARD). The user 
must enter the level of continuation in kilometers. 

DOWNWARD CONTINUATION emphasizes the effect of local shallow 
anomalies. This may lead to very noisy maps if the level of continuation 
is too large (a maximum continuation level of 2*grid step is 
recommended). 

UPWARD CONTINUATION will produce smoothing of the anomalies. 

To carry out an upward/downward continuation: 

 1. Select the Grid Tools | Up/Down Continuation… menu 
command 

 2. Select the map containing the input grid (the current map is the 
default). 

 3. Enter the name for the new map that will contain the output 
grid. 

 4. Enter the continuation parameters and click the OK button. 

Computing Pseudo-Gravity Anomalies 
This operator applies only to magnetic project data. It functions by 
reducing the magnetic field to the pole (assuming that remanence effects 
are negligible) and filtering with the appropriate frequency-domain 
operator. The output requires scaling by a factor equal to  

|ma| / Gρ 
where: 

ma  apparent magnetization (susceptibility x field strength) 

ρ the corresponding assumed density contrast 

G is the gravitational constant and does not need to be 
entered 
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You will also have to enter the values for the inclination and declination 
of geomagnetic field at the survey location. 

This is a useful method for viewing complex magnetic data as it tends to 
eliminate much of the “clutter” caused by dipolar fields. 

To compute the pseudo-gravity anomaly: 

 1. Select the Grid Tools | Pseudo Gravity…menu command. 

 2. Select the map containing the input grid. 

 3. Enter the name of the output grid (or accept the default name). 

 4. Fill the remaining fields and click the OK button. 

 5. A new map is created. If you wish to have station values 
extracted from the new grid, select Yes when prompted. 

Computing Pseudo-Magnetic Anomalies 
This operator applies only to gravity project data, and is used to compute 
the pseudo-magnetic anomaly from the gravity anomaly. The output 
requires scaling by a factor equal to  

Gρ / |ma| 
where 

ma apparent magnetization (susceptibility x field strength) 

ρ the corresponding assumed density contrast 

G is the gravitational constant and does not need to be entered 

You will also have to enter the values for the inclination and declination 
of geomagnetic field at the survey location, assuming that the desired 
result is to be comparable with observed magnetic data. When the field is 
calculated at the magnetic pole, it is (except for the scaling factor) 
equivalent to the first vertical derivative of the gravity field. 

For example, suppose that the intensity of the geomagnetic field is 
47000nT; assume that the source magnetic susceptibility is 1000mcgs 
and we wish to replace this with rock of “density” contrast 1.0gm.cm-3. 
The magnetization to be entered is then 47000 x 1000 x 10-6 = 47 nT 

To compute the pseudo-magnetic anomaly from a gravity anomaly: 

 1. Select the Grid Tools | Pseudo Magnetics…menu command. 

 2. Select the map containing the input grid (which should be the 
gravity anomaly). 

 3. Enter the name of the output grid (or accept the default name). 

 4. Fill the remaining fields and click the OK button. 

 5. A new map is created. If you wish to have station values 
extracted from the new grid, select Yes when prompted. 

Reduction to the Pole 
This function converts magnetic data which have been recorded in the 
inclined earth’s magnetic field to data which would have been produced 
by a vertical geomagnetic field (see Baranov, 1957; Gunn, 1975, p.306). 
The primary use of this function is to simplify magnetic maps obtained in 
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areas with low magnetic latitudes. Symmetric anomalies then result from 
simple vertical bodies, with the maximum located above the source. The 
assumption is made that all magnetic anomalies in the survey area are 
caused by magnetization in the direction of the current geomagnetic field. 

The following parameters must be entered: 

- Inclination of geomagnetic field 

- Declination of geomagnetic field 

To perform a reduction: 

 1. Select the Grid Tools | Reduction to the Pole… menu 
command: 

 
 2. Select the map containing the grid to be reduced. 

 3. Enter the name of the output grid (or accept the default name). 

 4. Enter the inclination and declination of the geomagnetic field. 
Click the Suggest button, and the program will calculated 
recommended values. 

 5. If you would like to have the mean value of the input grid be 
removed from the output grid, select Remove Mean Value. 

 6. A new map is created. If you wish to have station values 
extracted from the new grid, select Yes when prompted. 

Vertical to Total Field Transformation 
If data obtained with a vertical-field fluxgate magnetometer need to be 
compared with more modern total-field measurements, they can be 
transformed using this module.  

The theoretical background for this is given by Gunn (1975, pp 306-307). 

The user is required to enter the following parameters: 

- Inclination of geomagnetic field 

- Declination of geomagnetic field 

To transform the vertical field to total field: 

 1. Select the Grid Tools | Vertical to Total field… menu 
command 

 2. Select the map containing the vertical field data;. 

 3. Enter the name of the output grid, which will contain the total 
field data (or accept the default name). 
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 4. Enter the inclination and declination of the geomagnetic field. 

 5. If you would like to have the mean value of the input grid be 
removed from the output grid, select Remove Mean Value. 

 6. A new map is created. If you wish to have station values 
extracted from the new grid, select Yes when prompted. 

Terrain Correction Maps (Gravity) 
The WinGLink Maps program provides functionality for calculating 
terrain corrections to take into account local and distant topographic 
features. These corrections can then be used in the calculation of 
complete Bouguer anomalies for stations contained in WinGLink gravity 
projects.  

The approach used involves combining the inner terrain correction (ITC) 
and outer terrain correction (OTC) to calculate the total terrain correction. 
The ITC, which corrects for local topographic features, is performed 
using the Hammer methods. The OTC, which corrects for more distant 
topographic features, is performed using one or more external grids 
containing digital elevation models (DEM) for the area of interest.  

Terrain correction data can also be imported from external text files 
directly into the Maps program for both new as well as existing stations.  

As with other map types, calculated terrain correction values can be 
exported to external text files. These external files contain station ID, 
coordinates, elevation and data value, in this case terrain correction. 
External files can then used to import station and terrain correction data 
into other projects, providing a convenient tool for combining project 
data. 

The total terrain correction is the sum of the outer and inner terrain 
corrections. The order in which the individual correction values are 
calculated is irrelevant. The following discussion describes first how to 
create a terrain correction map, followed by how to calculate the inner, 
and then the outer terrain correction.  

Creating a Terrain Correction Map 
Among the default map types available for Gravity projects within the 
WinGLink Map program is the Terrain Correction map. The values 
contained in this map are used in the calculation of the complete Bouguer 
anomaly map. 

To Create a Terrain Correction Map: 
 1. Open WinGLink, and in the main database window, select a 

project of type Gravity [GR]; in the right-hand panel, click the 
Maps application icon. 



 

14-34  •  Maps A guide to using WinGLink 

 2. The Open Map dialog box opens. Select the Terrain 
Correction map: 

 
 3. After clicking the Open button, the Maps program prompts you 

to select the type of gridding to be used for the map. If opening 
the map for the first time, opt to continue without gridding, as 
two or more stations with values are required in order to 
calculate a grid.  

Calculating the Inner Terrain Correction 
The calculation of the inner terrain correction calculation is based on the 
Hammer method (Geophysics, v. 4, pp. 184-194, 1939.). This method 
involves creating a set of concentric rings, or zones as they are referred to 
here, each of which is divided into a specified number of equal-sized 
segments. The average elevation for each of these segments is entered 
relative to the elevation specified for a given station. In this way, the 
topography immediately surrounding each station can be defined and the 
inner terrain correction calculated.  

To Calculate the Inner Terrain Correction for a Station: 
 1. Continuing with the terrain correction map created above, open 

the Data Sheet window by either selecting the Stations | View 

Data… menu command or by clicking the  button on the 
toolbar.  

 2. The data sheet window for terrain correction maps contains, in 
addition to geographic coordinates, columns for ITC, OTC and 
Value. The value column in this case represents the total terrain 
correction and, unless the value has been edited manually 
updated during a file import, is equal to the sum of ITC and 
OTC.  
To set the ITC value for a station, position the mouse over the 
cell in the ITC column for the station in question and click. 
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Now click the arrow which appears at the right edge of the cell: 

 
 3. Click the arrow to open the Inner Terrain Correction window in 

which the set of zones is defined and relative elevation values 
are entered.: 

 
The Inner Terrain Correction window, shown above, is divided 
into three areas. The set of zones is defined in the ITC Structure 
frame, located in the upper-left corner of the window. This 
frame contains a spreadsheet with four columns. The first 
column, Z, designates the zone name, Min and Max specify the 
respective minimum and maximum radii of the circles which 
define each zone, and Div. specifies the number of segments 
into which the zone is to be divided.  
 
Zones can be added and removed using the buttons provided at 
bottom of the ITC Structure frame. The program allows the 
creation of up to 5 zones, each of which may be divided into up 
to 12 sections. In addition, the program forces zone continuity, 
i.e. the Max and Min values of two adjacent zones must be 
identical.  
 
The current zone configuration is shown in the display panel to 
the right of the ITC Structure frame. Changes made to the 
number of zones and the zone definitions are reflected 
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immediately in this display panel. 
 
The elevation values for each of the segments are entered in the 
Zones frame of the Inner Terrain Correction window. The 
upper area of this frame contains a frame with option buttons 
for meters, degrees, and %. When using the meters option 
(default), the values are entered as elevation values relative to 
the actual station elevation, i.e. if the average elevation of 
Section 2 of Zone C is determined to be 1000 m and the actual 
station elevation is 900m, a value of 100 m would be entered 
for this section. 
 
Depending on how the average elevation values are determined 
for the individual sections, it may be more convenient to use 
the degrees or % options. When using degrees, specify the 
number of degrees relative to the horizontal plane projected 
from the station location to a representative point in the given 
zone. When using the percent option, specify elevation 
difference between the station location and the zone section as a 
percentage. As the observation may not necessarily be made at 
the station elevation, specify in the Observation Height field 
the height above the station elevation from which the 
measurement of the zone elevation was made, i.e. if a transit of 
height 1.7 m was used to make the measurements, enter 1.7 in 
this field.  
 
After specifying how the zone values are to be entered, enter 
the relative elevation values for each segment in the 
spreadsheet-like table.  

 4. Click OK after entering values for all of the sections. The 
values can be edited at a later time by reopening the Inner 
Terrain Correction window for the station.  

The inner terrain correction value is calculated immediately after closing 
the Inner Terrain Correction window: 

 
The inner terrain correction value for each station is to be calculated 
using the procedure outlined above. ITC values cannot be manually 
entered in the ITC column of the Data Sheet window. 

Calculating the Outer Terrain Correction 
Unlike the inner terrain correction, which must be performed separately 
for each station, the outer terrain correction makes use of one or more 
digital elevation models to calculate the effect which non-local 
topographic features have on each station contained in the map.  
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To Calculate the Outer Terrain Correction: 
 1. Continuing with the terrain correction map used above in the 

description of the inner terrain correction, open the OTC Grid 
Selection window by selecting the File | OTC Grid Settings… 
menu command: 

 
 2. To add a grid, position the mouse over a line in the Grid 

filename column and click. Now click the arrow which appears 
at the right edge of the field to open the Import Grid window. 
Browse the directories until the desired grid has been found; 
click the Open button. All standard grids are supported: e.g. 
Geolink, USGS, Surfer, Geopack, Geosoft, LCT). 

 3. Set the parameters for each grid as necessary. The Max Dist. 
value specifies the correction distance from each station. Select 
the Show Extent checkbox to display the area covered by he 
given DEM. Select the units used in the DEM in the two 
columns to the right.  
 
The Station elevation projection drop-down list contains three 
options for the station elevation: None, Inv. distance linear, 
and Inv. distance square. Select None to use the actual station 
elevation in the calculation of the OTC. The Inv. distance 
linear and Inv. distance square options extrapolate station 
elevations from the given DEM using either a linear or 
quadratic algorithm, respectively, based on the mesh values and 
the geographic coordinates of the stations.  
 
To view the physical parameters which define a grid, click the 
grid name in the Grid Filename column to select the grid, and 
then click the Grid Info… button located in the bottom part of 
the screen. The Grid Info window opens, displaying the grid 
name and type, min. and max. X and Y values, X and Y step 
sizes and numbers of rows and columns.  

 4. After setting the digital elevation models, select the Compute 
TC command on the File menu to calculate the terrain 
correction. Computation progress is indicated by a progress bar 
in the status bar. Upon conclusion of the calculation, a log 
window is displayed which lists any encountered problems.  

Total Terrain Correction 
The total terrain correction is the sum of the outer and inner terrain 
corrections. Thus, a value for the total terrain correction exists for a given 
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station provided one of the two terrain correction values has been 
determined.  

To view the values in tabular form, open the Data Sheet window by 
either selecting the Stations | View Data… menu command or by 

clicking the  button on the toolbar: 

 
Neither the ITC nor OTC values can be edited manually. It is however, 
possible to change the total terrain correction value by selecting the field 
with the mouse and overwriting the value. Any changes are retained until 
the terrain correction is recalculated using the Compute TC command on 
the File menu, in which case the total terrain correction is again set equal 
to the sum of the ITC and OTC, or until terrain correction data are 
imported from an external file. 

To update the map grid, or if no grid yet exists for the terrain correction, 
click the Regrid command on the Gridding menu.  

 

Importing and Exporting Terrain Correction Data 
As with other types of value data, it is possible to import and export 
terrain correction data from/into the Maps program. In this way, terrain 
correction data, including station coordinates, can be passed from one 
project to another as well as to and from other applications.  

Terrain correction data are imported into the Maps program in the same 
way as other types of value data. The data must be in text format and 
organized by column. The files should include station ID, geographic 
coordinates, elevation and the values for total terrain correction.  

To Import Terrain Correction Data: 
 1. Open a terrain correction map, then open the Data Sheet 

window by either selecting the Stations | View Data… menu 

command or by clicking the  button on the toolbar. 

 2. On the File menu of the Data Sheet window, select the Import 
command. 

 3. In the File Import dialog box which opens, browse the 
directories until you have found the file to be imported; select 
and click the Open button. 

 4. The File Import wizard opens. This Wizard guides you through 
the import process, step by step, prompting you for details 
regarding the file structure and the assignment of the column 
headings and units. For further details on how to use this 
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Wizard, please refer to the “Data Import” chapter of this 
manual. For further details on how to use this Wizard, please 
refer to the “Data Import” topic in the of the WinGLink help 
system. 

 5. After specifying file format in the Import Wizard and clicking 
the Finish button, the Maps program imports the file. A status 
report is then displayed in an info box, indicating the number of 
stations merged, appended or skipped: 

 
Click the OK button to conclude the import process.  

 6. To update the map grid, or if no grid yet exists for the terrain 
correction, click the Regrid command on the Gridding menu. 

Terrain correction data can be exported from the Maps program as text 
files with fixed-width columns. These files can be imported into maps in 
other WinGLink projects with no difficulty. 

To Export Terrain Correction Data 
 1. Open a terrain correction map, then open the Data Sheet 

window by either clicking the Stations | View Data… menu 

command or by clicking the  button on the toolbar. 

 2. On the File menu of the Data Sheet window, click the Export 
command to open the Export Data dialog box: 

 
 3. In the XY Coordinates area of the dialog box, select the format 

in which the data are to be exported. The format specified here 
does not have to be identical to the current format, i.e. any 
required conversions are performed by the Maps program 
during file export. Likewise, specify the order of the X and Y 
coordinate values in the Options area of the dialog box. After 
specifying a file name, click the OK button.  
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Well Maps 

Creating a New Map from Numeric Well Data 
As with other value types, it is possible to create maps at specific depths 
using numeric values imported for well stations. (For details on importing 
well courses and well layer data, please refer to the “Data Import” 
chapter of this manual.)  

To Create a New Map from Numeric Well Data: 
 1. On the File menu, select the New Map | Extract Parameter 

Values menu command. 

 2. Select the desired extraction key from the list of available 
options: At constant depth…,or At fixed elevation... Shown 
below is the dialog which for extracting at constant depth: 

 
 

 3. All of the numeric data imported to the active wells project 
should be listed in the Extract drop-down list. Select an item 
and enter a depth.  

 4. The program displays the number of stations extracted and 
number skipped during extraction. 

 5. If data were extracted for at least two stations, you will be able 
to grid the map (specify how you would like the map gridded in 
the Gridding Window which opens following extraction). 

Note: When extracting parameter values from well maps, note that the 
position of the point at the specified depth or elevation may not 
necessarily be coincident with the station coordinates. The position is 
instead that at the specified depth along the well trace. This location is 
indicated by a dot on the new map.   
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15:  Wells 

Overview 
This chapter focuses on the use of the Well Data Editor. Following a 
detailed description of how to use the program, an overview is provided 
on how to work effectively with well data within WinGLink. There, 
references to the appropriate locations of the manual can be found for 
instructions on how to use wells in the respective WinGLink modules. 

Using the Well Data Editor 

 

The Well Data Editor provides a powerful interface for working with well 
courses, including tools for editing and displaying well traces as well as 
for editing and assigning display properties to layered and numerical data. 
Note that layered and numerical data can be edited and saved only if the 
WinGLink license includes the WL_2 module.  

Note: While well traces can be imported directly into the Well Data 
Editor (as well as into the WinGLink Shell), layered/numerical data, such 
as lithologic data or measured values, cannot. These data types must 
instead be imported into the database in the main WinGLink shell. For 
details, please refer to the “Data Import” chapter of this manual. 

To Start the Well Data Editor: 
 1. In the main Database window, use the mouse to select the 

Wells project (WL) which contains the well trace(s) and 
layered/numerical data to be edited. 

 2. Click the Well Data Editor icon  in the applications panel 
of the WinGLink Shell to open the Well Data Editor. In 
addition to all wells contained in the project, the Open Well 
dialog box lists the available data types, which include the well 
course and any imported layered or numerical data types, e.g. 
lithology, pressure, temperature: 
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The upper left panel of the dialog box lists all well traces 
contained in the current project. To the right are the well course 
and data types available for the well selected in the upper left 
panel. The lower left panel displays information about the 
selected well. Shown in the right is an overview map; the 
currently selected station is displayed in red. 
 
Note that after making a selection and opening a well window, 
the Open Well dialog box closes. This can be reopened by 
selecting the File | Open menu command. 

To View and Edit Well Courses 
 1. To open the well course for a specific well, select the well in 

the upper left panel, then select the Well Course checkbox. 
Click the Open button to display the Well Course spreadsheet:  

 
 2. Each field can be edited manually. Note that when editing the 

elevation, the program automatically calculates the vertical 
depth and vice versa. Note, as well, that that elevations must be 
in decreasing order, though several identical elevation values in 
succession are possible (horizontal traces). 
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 3. After either editing a well course point or entering a new point, 
click the green check button on the toolbar: 

 
Only after this button has been clicked are the changes 
acknowledged by the program. Any elevation values which are 
not in decreasing order will trigger a warning message:  

 
 

 4. To delete a row, press the “Delete” key on the keyboard.  

 5. The delete operation as well as any other action performed in 
the datasheet windows can be undone using the Undo / Redo 
buttons on the toolbar: 

 
 6. To save changes made to a well course, either click the x box in 

the upper right corner of the spreadsheet, which will open a 
dialog box prompting you to save the changes, or use the File | 
Save menu command.  

To Import Well Courses 
Well courses can be imported into an existing well using the File | 
Import menu command. It is not possible to import new wells into a 
database from the Well Data Editor. This can only be performed in the 
WinGLink Shell. For details, please refer to the “Data Import” chapter of 
this manual. 

To Import Well Course Data Into an Existing Well: 
 1. In the Well Data Editor, open the well course into which well 

course data are to be imported. 

 2. Use the File | Import menu command to open a standard 
Windows dialog box for selecting the file which contains the 
well course data.  

 3. After selecting the file, the Data Import Wizard for text files 
opens: 
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Make the appropriate settings for the given data file and 
continue with Next. 

 4. In the next screen, specify the units for coordinates and 
elevation and the column headings: 

 
 5. Click the Next button to execute the import. 

To View and Edit Layered Data 
 1. As with well courses, first select a well in the left frame of the 

Open Well dialog box, then select a checkbox next to a layered 
data type. Note that only those data types which have been 
imported for the given well and are not currently open are 
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available for selection: 

 
 2. The From and To measured depths, which define the layers, 

can be edited. New layers can be appended in the bottom field. 
While layers may overlap, the bottom layer takes priority. 
Layers need not be in order of depth.  

 3. Each layer can be assigned an item type by placing  the mouse 
pointer in the respective field in the Item column and then 
clicking the arrow button to display the drop-down list: 

 
All layer types associated with the current category are listed 
and are available for selection. The appearance associated with 
the selected item is automatically displayed after selecting an 
item.  
 
Categories, the associated layer types, and the appearances of 
each layer type can be defined with the Category and Pattern 
Editors, which can be opened with the Tools | Category Editor 
menu command. This command is available in the Well Data 
Editor only when a layered data window is open.  
 
For information on how to use the Category and Pattern 
Editors, please refer to the description in the “Common 
Functions” chapter of this manual. 

 4. To save changes you have made, either click the x box in the 
upper right corner of the spreadsheet, which will open a dialog 
box prompting you to save the changes, or use the File | Save 
menu command.  

To View and Edit Numerical Data 
 1. Use the Open Well dialog box to open the edit window for the 

desired numerical data type: 
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Make changes or add new layers as with layered data. Layers 
do not need to be in order of depth.  

 2.  To save changes you have made, either click the x box in the 
upper right corner of the spreadsheet, which will open a dialog 
box prompting you to save the changes, or use the File | Save 
menu command. 

To Display Sectional Views of Well Data 
A sectional view can be displayed for the active spreadsheet window by 
clicking the Sectional View button on the toolbar:  

 
Depending on which spreadsheet type is active, the sectional view 
window displays the well course with the respective layer types, e.g. 
lithology, layered data or numerical data. Shown below is the sectional 
view of well POZO 1: 

 
The slide bar in the bottom right part of the screen can be used to change 
the user’s perspective of the well course, allowing the user to view the 
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well course from all angles. The blue and red dots at the top of the 
sectional view correspond to the blue and red dots on the compass view 
in the bottom left corner of the window to provide a frame of reference.  

 

Working with Well Data in WinGLink: An Overview 
Provided below are references to the chapters of the manual which 
include information on working with well data, including both well 
courses and layer information, e.g. lithologic information.  

Please refer to the chapters referenced in parenthesis for detailed 
instructions on working with wells in the respective WinGLink programs. 

• WinGLink Shell: used to import well courses and layer data. 
(Data Import) 

• Maps: used to assign wells to profiles (Maps) 

• Well Data Editor: used to edit and display well courses (Wells) 

• X-Sections: used to create cross sections of well log data (X-
Sections) 

• Sections: wells, both well courses and, in certain cases, layer 
data, can be viewed in all WinGLink modules which support 
sections, e.g. 2D Inversion and X-Sections. (2D MT, X-Sections) 

• Interpreted Views and Montage: used to prepare documents for 
presentation. (Requires WinGLink license option WG-2, see 
www.geosystem.net for details.) (Interpreted Views and 
Montage) 

http://www.geosystem.net/
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16:  MT Soundings 

Overview 
 

 

The Soundings icon is displayed in the program menu whenever a 
sounding project is selected. 

When a sounding project (MT, TEM, DC, etc.) is selected and the 
program launched, the stations of the selected project are loaded 
together with their original datasets.  

The discussion in this chapter is limited to the MT Soundings program. 

For each station, this program can be used to: 

• Compute and display the parameter curves and a number of 
MT parameters 

• Import/export sounding data 

• Edit sounding data 

• Compute a 1D smooth and layered inversion model 

As described at the end of this chapter, many of the functions available 
for individual soundings can also be performed in batch mode on any 
number of soundings contained in the current project. 

About Editing 
Edits performed on sounding data are saved in the "edited data" section 
of the database. The original data are not overwritten and can always be 
restored using the File | Reload Original Data menu command. 

The edited data which are saved by the MT Soundings program are used 
by other WinGLink programs: 

• Edited resistivity curves, as well as phase and tipper, are used 
to calculate resistivity pseudosections. 

• Smooth and layered 1D models are used to calculate imaged 
sections and cross sections, respectively. 

• Curves and 1D models are also used to extract parameter 
maps in the Maps program.  



 

16-2  •  MT Soundings A guide to using WinGLink 

Sounding Data Which are Saved in the Database 
For each station of the current project, the following datasets are saved in 
the WinGLink database: 

Original Data 
Apparent resistivity and phase as imported from external files or entered 
by keyboard. Original curves can always be recovered to restart the 
editing process using the Soundings menu command File | Reload 
Originals. 

Impedances: 

Impedances (if available) are saved in the database. If impedances are not 
saved in the database, editing functions such as decomposition or static 
stripping are not enabled. 

Power spectra: 

Power spectra are read during the import from EDI files and are used to 
compute impedances, if requested, but are not saved in the database. 

Edited Data 
Edited curves are initially constructed by assigning to each data point the 
same value of the original curves. At the end of each editing session, the 
edited values are saved in the database, separately from the original 
values. 

Edited curves are used by default to construct pseudosections along 
profiles. 

Smoothed Curves 
These are calculated from the edited curves using the selected smoothing 
routine. These curves may optionally be used instead of the edited curves 
to construct pseudosections along profiles. 

Smooth 1D Model  
One smooth model is saved for each sounding. This provides a 
preliminary guess model for the layered inversion routine and is also used 
to produce imaged sections along profiles. 

Both Bostick and Occam models are calculated and saved, one for each 
sounding. For each sounding, the user must specify whether the TE or 
TM curve is to be considered the 1D curve and used by the inversion 
program. 

Layered 1D Model 
One layered model is saved for each sounding. These models can be 
displayed along profiles in WinGLink’s section programs and used to 
generate gridded sections the X-Sections program. The 1D curve used to 
calculate the layered model is the same curve used for the smooth model. 
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Opening, Saving and Printing Sounding Data 

To Open Soundings from the Station List 
 1. Select the File | Open from List menu command 

 2. Select the station(s) you wish to open: 

   
 3. If you want to display only the active stations, select the Active 

Station check box. 

 4. Click the Open button. 

To Open Soundings on the Station Map 
Select the File | Open from Map menu command; a simplified location 
map for the project station is displayed: 

 

Opening Soundings by Clicking Individual Stations: 

 1. Click the   button. 
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 2. Click the stations you wish to open; the selected stations turn to 
red: 

 

 3. Click the  button. 

Opening All Soundings Within a Given Area: 

 1. Click the  button. 

 2. Left-click the mouse on a corner of the area of interest and drag 
it to define a rectangle on the map. When releasing the mouse 
button, all stations in the rectangle will turn to red. 

 3. Click the  button. 

Open All Soundings Associated with a Profile Trace: 

 1. Click the  button. 

 2. Left-click the mouse on the profile or on a segment of the 
profile trace of interest. All stations previously added to that 
profile trace turn red, indicating selection. 

 3. Click the  button. 

Viewing Parameter Curves 
Each window can be set to show the parameter curves or the 1D model 
for each sounding. 

On the View menu, select from the available display options: 

  

Note on MT ellipticity: 
Ellipticity is calculated using the definition given by Ranganayaki 
(1984, Geophysics, 49;1730-48): 
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where the ‘ denotes rotated impedance tensor. 
 
Ranganayaki points out that this quantity is limited as a 
dimensionality indicator because even at places where Z’xx = Z’yy, 
the fields could be influenced by an anomaly and require 3D 
resistivity structure in order to describe their variation. This has 
been shown to be especially true at low frequencies. This 
deficiency can be offset by calculating skew, which increases at 
low frequencies where the impedance tensor is affected by a 
larger volume of the earth. 

Note on induction arrows 
In the MT Soundings program, induction arrows are displayed with 
the arrows pointing away from the conductor, i.e. the Weise or 
Schmucker convention. The display properties of the arrows, i.e. 
length and convention cannot be changed in the Soundings 
program. They can, however, be altered in the Maps program 
which also provides functionality for displaying induction arrows. 
Please refer to the "Maps” chapter of this manual for details.  

Setting Diagram Ranges and Scale 

To Set the Ranges and Scale for the Plot Diagrams: 
 1. Select the View | View Options menu command: 

 
 

 2. For each parameter, set the automatic range option or enter the 
max. and min. values to be plotted. The axis scale can be set to 
linear or logarithmic for many plots. 

 3. The settings made here apply to all window. 

Printing Curves and 1D Models 

To Print Station Curves 
 1. Select the station by clicking on its window; 
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 2. Select the File | Print menu command. 

 3. Select the printing options and click the Print button: 

 

Importing Sounding Data 
In general, sounding data are imported into WinGLink using the import 
functionality provided in the WinGLink shell (see the “Data Import” 
chapter of this manual for details).The MT Soundings module includes an 
option, however, for importing new data into an existing sounding.  

Import functions are available for: 

- EDI files 

- Text files 

- Keyboard entry 

Note: This function cannot be used to import new stations into the 
current project. 

To Import MT Data from an EDI File 
 1. Open the sounding into which the data are to be imported 

 2. Select the File | Import new data| From EDI File…menu 
command 

 3. Browse the directories and select the file you wish to import. 
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 4. In the Plot Parameters frame, select the desired options: 

 
 
If you select the Recalculate from existing spectra option, the 
program uses the spectra contained in the EDI file. 
 
If the file does NOT contain spectra, the program uses 
impedances. 
 
If the file does not contain impedances, the program uses the 
plot parameters contained in the file. 
 
Impedances are rotated back to 0 degrees regardless of the 
values in the ZROT block in the EDI file. The impedances are 
then rotated to the value specified in the Rotate to section of 
the import window.  
 
The tipper rotation is specified in the TROT block in the EDI 
file. If this block is not present, it is assumed that the tipper is 
rotated to 0 degrees and no “back rotation” is performed during 
import, regardless of the values present in the ZROT block. 
Following the “back rotation”, the tipper values are rotated to 
the value specified in the Rotate to section of the import 
window. 

Note: Any previously saved sounding data are lost when new data are 
imported. 

To Import Datasets from Text Files: 
 1. Open the sounding into which the data are to be imported 

 2. Select the File | Import new data | From Text File…menu 
command 

 3. Follow the instructions given by the Import Wizard (refer to the 
“Data Import” chapter of this manual for details.) 

Note: Any previously saved sounding data are lost when new data are 
imported. 



 

16-8  •  MT Soundings A guide to using WinGLink 

To Enter Data from the Keyboard: 
 1. Open the sounding into which the data are to be imported 

 2. Select the File | Import new data | From Keyboard…menu 
command 

 3. The program alerts you that any existing data will be lost. 

 4. A dialog window opens prompting you to select what type of 
data are to be entered: 

 
 5. In the next window, specify whether the frequency or period 

data are to be entered: 

 
 6. In the Data Import window, enter the data in the appropriate 

columns: 
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When finished, use the File | Save menu command to store the 
data in the database 

To Export MT Data to an EDI File 
 1. Select the station by clicking on its window. 

 2. Select the File | Export EDI File menu command: 

 
 3. Click the Options button to open a dialog window in which the 

parameters to be written to the EDI file can be selected: 
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Make the desired selections and click the OK button when 
finished  

 4. Enter a name for the EDI file to be created. 

 5. Click the Save button. 

Activating / Deactivating Stations 
The checkbox located in the upper area of each sounding display window 
can be used to activate and deactivate the current station. The 
active/inactive status applies to the station in all WinGLink modules, i.e. 
sounding data associated with deactivated stations are not included in 
2DMT inversions. 

 

Analyzing MT Data 

The MT Soundings View Form 
The following figure shows the MT sounding data form: 
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TE/TM mode 
selector 

Click this button to change which curve corresponds to 
TE mode. In the above example, the xy curve is selected 
for TE mode (therefore, the yx is for TM mode) 

1D model 
validation 

This text is displayed whenever the 1D model of the 
station needs to be recalculated because a change was 
made on the curve. 

Invariant 
display 

If this option is checked, the invariant curves for 
resistivity and phase are shown. The invariant resistivity 
is calculated as the geometric mean of rhoXY and 
rhoYX; the invariant phase is calculated as the arithmetic 
mean of the two. 

Smooth type Indicates the algorithm used to calculate the smoothed 
curves. 

Current 
rotation 

Indicates the rotation (if any) applied to the impedances. 

XY, YX 
curves 

The original curves are displayed in gray, the edited 
curves in red (XY) or blue (YX); the continuous curves 
represent the smoothed data. 

Static 
stripping 

If present, this text indicates that the edited curves have 
been static stripped. 

To Rotate Station Impedances and Tipper 
 1. Select the station by clicking on its window. 

 2. Select the Rotate command from the menu to open the Curves 
Recalculation dialog box: 
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 3. In the Rotate to frame, select the rotation type and rotation 
angle. 

 4. To rotate tipper, specify the rotation type and angle in the fields 
to the right of the Hz label. 

 5. In the Apply To frame, select whether the rotation is to be 
applied to all stations or to the active station only. 

 6. Click OK. 

 

To Perform a Decomposition on the Active Station 
 1. Select the station by clicking on its window. 

 2. Select Rotate. 

 3. In the Impedances Rotation frame, select the decomposition 
type. 

 4. In the Apply To frame, select whether the rotation is to be 
applied to all stations or to the active station only. 

 5. Click OK. 

To View a Polar Diagram Map 
 1. Close all open stations. The Special command is now displayed 

on the main menu. 

 2. Select Special | Polarization Maps. 

 3. If you are already in polarization maps mode, select File | New. 

 4. Enter the values for central frequency, sampling frequency and 
tolerance; the frequency range is determined using these values. 

 5. Click OK. 
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 6. To switch back to station view mode, select File | Close All and 
then Special | Soundings. 

To Display a Miniature Map of Resistivity and Phase 
Curves 
 1. Close all open stations. The Special command is displayed on 

the main menu. 

 2. Select Special | Miniature curves. 

 3. To switch back to station view mode, select File | Close All and 
then Special | Soundings. 

Editing Sounding Data 

The Edited Curve 
When sounding data are entered or imported by the Soundings program, 
they are saved as “original data” in a reserved area of the database and 
are never modified unless new data are imported or synthetic data are 
saved as original data (see the “2DMT Modeling” chapter of this manual 
for details). At the same time, a duplicate dataset is generated and saved 
in a different area of the database for use by editing functions. When an 
editing session is carried out on the sounding data, it is carried out on this 
second dataset, which is referred to as the “edited curve” of the sounding. 

Saving changes following an editing session means saving an edited 
curve. This curve is used by default in calculating 1D inversion models 
and pseudosections. 

Sounding data can be edited by: 

 1. Opening the data spreadsheet and entering new edited values. 

 2. Starting the graphic interactive Edit form by selecting the Edit 
command. 

Editing Sounding Data in the Spreadsheet 
Sounding data can be viewed and edited using a spreadsheet which shows 
original and edited data together in a common window. 

To Open the Data Spreadsheet: 
 1. Select the File | Edit Data menu command. 

 2. The soundings data are displayed in columns. Columns with 
original data are gray and the header has a suffix (o) indicating 
that the data of the column are original data. Original data 
cannot be edited. 

 3. On the Data menu, use: 

• Arrange columns to select the type of sounding data to be 
displayed 

• Format to set a fixed format for each data column 

• Operators to apply arithmetical operators to a column 
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• Sort to sort a selected data column 

 4. On the File menu, select: 

• Save Data to store any editing changes 

• Exit to return to the sounding View form 

• Export to file to export the displayed data to a text file 

Interactive Sounding Editing Form 
The interactive Sounding Editing form is opened by selecting the Edit 
command from the menu when a sounding window is selected: 

 
The form includes commands for performing various editing functions: 

Selecting Data Points 

 Single point selection 

Click to select/unselect for editing single data points on the curve. 

 Multiple points selection 

Click to select/unselect for editing all data points included in a user-
defined range: click and drag the mouse to define the area. 

Zooming in on the Curve 

 Zoom in 

 1. Click a point in the curve diagram and release the button. 

 2. Move the mouse to define the zoom area. 

 3. Click and release the left mouse button. 

  Zoom out 

Click to reset the previous view.  
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Note: this button is available only after the Zoom in button has been 
used. It remains available until the original curve size is restored. 

Saving Editing Changes 

 Save button 

Saves the editing changes. These changes must be confirmed when 
closing the station window in the main menu in order to store them in the 
database. 

Editing Data Points 

 Masking data: Using the appropriate buttons, it is 
possible to mask individual modes at each frequency, either across all 
modes or for individual modes. Changes made here are reflected 
throughout the database, i.e. in the 2D Inversion and Pseudosection 
modules.  

Note that the Mask Tipper button is enabled only when tipper display is 
enabled using the dropdown list at the top of the screen: 

 
Select the Tzx & Tzy display option to display the two tipper components 
in separate windows.  

The vertical scaling of the tipper magnitude and Tzx/Tzy components can 
be set using the Tipper Vertical Scaling button , which appears 
towards the left end of the tool bar when either Tipper Magnitude or 
Tzx/Tzy are visible. Clicking this button opens the Tipper Scaling dialog 
box: 

 
Settings made here are retained in subsequent WinGLink sessions. 

 
 Shift data points 

 1. Click and select the data points to be shifted by single or 
multiple selection. 

 2. Move the data points to the desired positions and click the left 
mouse button. 

 3. Click the Shift button again to confirm the action. 
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  Calculate and display a smoothed curve 

Click the button to display the smoothing options 

 Cancel the current action 

 Undo button 

Undo all the editing changes made since the last time the curve was 
saved. All editing steps can be undone provided the station has not yet 
been saved since editing. 

Swapping 
Swapping allows you to assign a data point of the XY curve to the YX 
curve (at the same frequency) and vice versa. This is useful where 
analytic rotation results in inconsistent mode assignment. 

To swap the data points of apparent resistivity or phase curves: 

 1. Open the station or select its window if already open. 

 2. Select the Edit command from the main menu.  

 3. Click the  button. 

 4. Click the data point(s) you wish to swap with the left mouse 
button. 

 5. Click the  button again. 

Note: To swap the entire curve, use the right mouse button at Step 4. 

Static Stripping 
Static stripping is an analytic technique for eliminating the frequency-
independent offset of one apparent resistivity curve from the other. 

To perform static stripping on an apparent resistivity curve: 

 1. Select the Edit command on the main menu.  

 2. Click the  button. 

 3. Click a data point on the curve and release the mouse button. 

 4. Move the curve to the desired location and click the left mouse 
button. 

 5. Click the  button again. 

Normally, you would select a point at the high-frequency end of the 
curve. Practical experience suggests that most static shift cases result in 
one curve being moved down relative to the other. You therefore move 
the lower curve up to the higher one. 

When the original apparent resistivity curve is dragged to its new 
position, a scalar multiplier of the e-field value is derived. This is applied 
to a recalculation of all the impedances of that sounding. Thus, when you 
click Strip for the second time, you should see the hour-glass symbol, 
indicating that this calculation is taking place. The curves are then 
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redrawn. Only the apparent resistivity curves are affected by this 
procedure. 

If the data show a very large static shift, or are strongly 3D at high 
frequencies, the results can sometimes be unstable. You may need to 
repeat the operation several times. 

Static Shifting 
Static shifting allows you to vertically shift all data points of a curve. 

To statically shift a curve: 

 1. Select the window with the sounding to edit 

 2. Select the Edit command on the main menu.  

 3. Click the  button. 

 4. Click one of the curve’s data points and release the button. 

 5. Using the mouse, move the curve to the desired location. The 
amount of static shifting is displayed in the bottom of the 
window: 

 
This number is a scalar factor that multiplies the original 
resistivity values of the curve. If equal to 1, the curve is not 
shifted. 

 6. Click and release the left mouse button. 

The apparent resistivity range changes so that the curves appear centered 
in the display box. 

A useful guide for determining the resistivity level to which a curve 
should be shifted is obtained by displaying the pseudo-MT curve for a 
co-located TDEM station. 

To reset the static shift to zero: 

 1. Click the  button. 

 2.  to run Smoothing routines 

 to add/subtract 360° to phase data points 

 to show pseudo-MT curve from TDEM model 

Calculating Smoothed Curves 
Resistivity and phase smoothed curves can be calculated from the edited 
curves using three different techniques. They are automatically updated 
whenever further editing is made on the curves. 

To (re)calculate a station’s smoothed curves: 

 1. Open the station or select its window if already open. 

 2. Select the Edit command on the main menu. 

 3. Click the  button. 
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 4. Select Smooth Options and click the OK button. 

The available smoothing options are described below 

Sutarno phase consistent smoothing 

This is an application of the Hilbert transform to give an apparent 
resistivity curve from the phase curve. (Sutarno, D. and Vozoff, K., 1991, 
Phase-smoothed robust M-estimation of magnetotelluric impedance 
functions: Geophysics, 56, 1999-2007). It is used primarily to confirm 
that apparent resistivity and phase are consistent. 

D+ smoothing 

D+ relates apparent resistivity and phase of the same component (xy or 
yx) through a D+ function. In essence, this finds the one-dimensional 
earth which best fits both parameters. The procedure has been shown to 
be valid for most 2D data and for some 3D cases. 

The errors attributed to the data can be those estimated by the original 
data processing or can be imposed by the user. In the first case, the two 
parameters (apparent resistivity and phase errors) are left at the default 
value of -1. In the second case, the user can estimate the errors (e.g. 
10%). By appropriately selecting errors, one parameter can be down-
weighted at the expense of the other. Reference: Beamish, D., and 
Travassos, J.M., 1992, The use of the D+ solution in magnetotelluric 
interpretation. Jo. Appl. Geophys., 29, 1-19. 

Numerical smoothing 

Numerical smoothing is an FFT-based low-pass filter which calculates an 
independent smooth curve for each of the four components. It does not 
have an underlying geophysical process to support it, but may 
nevertheless be useful in certain noisy situations. The user selects a 
smoothing factor which gives an appropriate result. 0 gives no smoothing 
at all, and useful values are typically << (half the number of data points). 
Reference: Press et al., 1989. Numerical Recipes, pub. Cambridge 
University Press, Section 13.9. 

Adding ± 360° to Phase 
This feature is useful in the case of phase curves which wrap around the 
normal -180 to +180 range: 

To add 360° to data points of a phase curve: 

 1. Select the Edit command from the main menu.  

 2. Click the  button. 

 3. Select the data points of the phase curve you want to shift. 

 4. Click the  button again. 

To subtract 360° from  data points of a phase curve: 

 1. Select the Edit command from the main menu.  

 2. Click the  button. 

 3. Select the data points of the phase curve you want to shift. 

 4. Click the  button again. 
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Computing Pseudo-MT Curve from Co-Located TDEM, 
Schlumberger Sounding Model or DC Model 
Displaying the pseudo-MT curve for a co-located TDEM or DC station 

A well-established procedure in MT surveys is to use co-located time-
domain EM (TDEM) or DC soundings to correct for static shift 
(Sternberg, B. K., Washburne, J. C. and Pellerin, L., 1988, Correction for 
the static shift in magnetotelluric using transient electromagnetic 
soundings: Geophysics, 53, 1459-1468; Pellerin, L. and Hohmann, G. 
W., 1990, Transient electromagnetic inversion: A remedy for 
magnetotelluric static shifts: Geophysics, 55, 1242-1250.). In WinGLink, 
we assume that central or coincident loop TEM or DC soundings have 
been edited and inverted, either in WinGLink or using TEMIX/RESIX 
(Interpex products for TEM and DC data, respectively) and then imported 
into WinGLink. 

The appropriate sounding is selected using the procedure shown below. 
The imported 1D model is used to calculate a forward MT response. 
Using static shift, the observed apparent resistivity curves can then be 
shifted along the resistivity axis to coincide with the values suggested by 
the TDEM or DC response. 

To display the MT curve calculated from a TDEM or DC model: 

 1. Select the Edit command from the main menu.  

 2. Click the  button. 

 3. Select the EM or DC Project containing the EM/DC station. 
The project must contained in the current database: 

 
select the EM or DC station located at the MT station being 
edited. 

 
 
Note: Either EM Station or DC Station is displayed to the left 
of the dropdown list depending on the type of station selected. 

Common Problems in MT sounding Editing 
There are some problems which can occur while editing MT soundings. 
A list of the most common problems is given below, together with the 
solution: 

Problem: Strip button is disabled in the Edit form 

This may happen for one of the following reasons: 

 1. You did not rotate the impedances after importing the EDI file. 
Solution: exit Edit and rotate impedances. 

 2. You ran a La Torraca or Torquil Smith decomposition. 
Solution: exit Edit and reload original curves. 
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 3. The station comes from the import of an EDI file which had 
neither impedances nor spectra. 

Problem: Calculated smooth curves are no longer displayed 

This happened because: 

 1. You reloaded the original curves. Solution: calculate the 
smoothed curves again. 

Problem: Smoothed curves are not recalculated after shifting data 
points 

This may happen because: 

 1. The smoothed curves were calculated using the Sutarno 
option. With this option, the smoothed curves are recalculated 
from impedances and not from the plot parameters. 

Problem: When running D+ smoothing, an “invalid command” 
message is shown 

This may happen because: 

 1. A La Torraca or Torquil Smith decomposition has been 
previously applied, and 

 2. You did not specify the Rho Err % and Ph Err %. Normally, 
these parameters are initialized with the default value of -1, 
which means that the variances found in the EDI file will be 
used. However, since the La Torraca decomposition eliminates 
these variances, they can no longer be used. Solution: try D+ 
smoothing again, and specify a value (in the 1-100% range) for 
both Rho Err and Ph Err. 

Reloading Original Curves 
This action overwrites the edited curves of a station with the original 
curves. 

To reload original curves: 
 1. Select the station by clicking its window. 

 2. Select the File |Re-Load Original menu command. 

After reloading, the smoothed curves and the 1D models need to be 
recalculated. 

1D Inversion 

1D Inversion: Overview 
The 1D Model menu command starts the inversion program for the 
station whose window is currently active.  

The main steps involved in the inversion process are: 

 
Set curves to use 
for inversion 

The inversion can be run using the edited or 
smoothed curve. The curve selection button, 



 

A guide to using WinGLink MT Soundings  •  16-21 

located on the bottom bar, allows the user to 
change the selected curve at any time. The 
models must be recalculated when the curve 
to be used is changed. 
For each sounding, the TE, TM or invariant 
curve (i.e. one of the three) can be used to 
calculate an inversion model. A mode 
selection button allows the user to change 
the selected curve at any time. The models 
must be recalculated when the mode to be 
used is changed. 
 

Calculate the 
smooth inversion 
model 

For each station, one smooth model is 
calculated and stored in the database. This 
model will be used to produce imaged 
sections for the project. 
Two types of smooth models can be 
calculated and saved separately: the Bostick 
model and the Occam model (the respective 
Bostick and Occam imaged sections will be 
calculated). 
 

Guess the layered 
inversion model 
from the smooth 
model 

A layered model can be guessed from the 
calculated smooth models. The number of 
layers is entered by the user by editing the 
inversion settings or by editing the model 
with interactive graphic commands. 
Only one layered model is saved for each 
station. A guess model selection button 
allows the user to change which smooth 
model is to be used for the guess routine. 

Edit the initial 
model using the 
graphic model 
editor (optional) 

An interactive graphic editor allows the 
editing of layers thicknesses and resistivities. 
The response is displayed in real time. 

Run the inversion 
and save the model 

The inversion process can be run with a 
given number of iterations and predefined 
RMS fitting degree. Resistivity and/or 
thickness values of one or more layers can 
be kept fixed. 
 

The 1D Inversion Window 
The following figure shows the 1D inversion window: 
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To Select the Curve to be Used for Inversion 
 1. Select the 1D Model menu command to enter the inversion 

mode for the active sounding. 

 2. Click the  button, located at the bottom of the 
form, to select the edited or smoothed curve for inversion. 

 3. Click the  button, located at the bottom of the form, 
to switch between TE/TM and invariant curve to be used as the 
1D curve. 

 4. Recalculate the model whenever you change the selected curve. 

To Calculate the Occam Model for the Current Sounding 
Curve: 

 1. Click the   button, then fill the fields in the Start 
Model frame and specify the max. number of iterations: 

 
The Occam model and the corresponding curve are displayed with 
magenta lines. 
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The Bostick MT model is automatically computed for the selected 1D 
curve. 

The Bostick model and the corresponding curve are displayed with blue 
lines. 

To Guess the Layered Model from the Smooth Model 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Calculate the smooth model (magenta lines), if you have not 
already done so. 

 3. Click the  button: 

 
 4. The layered model will be guessed (green lines). 

Click the  button on the bottom bar to switch between 
Bostick and Occam as guess models. 
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To Import a Model Created for a Different Station: 
 1. In 1D Modeling mode, click the Edit button to open the 1D 

Model Parameters dialog: 

 
 2. Here, click the Import button to open a dialog box which 

contains all available stations: 

. 

 3. Select the desired station and click Import. Note that any 
changes to the imported model are not reflected in the original 
model. 

To Run a Layered Model Inversion: 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Click the  button. 

 3. The inversion is started using the model shown with green lines 
as the starting model and the inversion parameters set for the 
sounding. 
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Graphic Editor for 1D Layered Models 
The layered model can be edited graphically using drag-and-drop 
operations.  

The resulting resistivity curve is updated in real-time, allowing you to 
compare the fit with the observed curve. 

To Graphically Change the Resistivity of a Layer: 
 1. Click the vertical line which denotes the layer’s resistivity. Two 

black dots appear on its edges indicating that this line can be 
moved: 

 
 2. Release the mouse. 

 3. Move the mouse pointer to the selected line; the arrow pointer 
changes to a double-headed arrow. 

 4. Left click and hold down the button; drag the line to the new 
layer resistivity delimiter position. 

 5. Release the mouse button. The resistivity curve coming from 
the layered model is recalculated and redrawn. 

To Graphically Change a Layer’s Thickness 
 1. Repeat the procedure used to change a layer’s resistivity, but 

instead select one of the horizontal lines which delimits the 
layer and move it to the desired position. 

Batch Commands 
A group of batch procedures are available for performing selected 
operations on a set of user-selected stations.  To start a batch procedure: 

 1. Close all open stations. 
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 2. The Batch Tools command will appear on the main menu: 

 
 3. Select the desired operation. 

 4. Enter the parameters as requested. 

Operations available in batch mode include: 

• Curve smoothing 

• 1D inversion modeling 

• Printing 

• Impedance rotation  

• Tipper rotation  

• Exporting edited curves as EDI files  

• Masking/ unmasking parameter values 

• Static stripping 

• Static shifting  

• Swapping modes for a specific frequency range 

• EDI export; this function also includes options for exporting 
static shift values to an external text file. File format for the 
static shift file is: station name, xy shift, yx shift. 

• Batch 1D forward: Enables the selection of an existing 1D 
model and the computation of the MT forward response for 
all selected stations. In addition, the user can specify whether 
synthetic data should overwrite the observed data. 

Special Menu Commands 
The Special menu, which is available on the menu bar when no 
soundings windows are open, contains a number of special display and 
edit functions: 

- Quick View 
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- Quick Edit 

- Miniature Curves 

- Polarization Maps 

Quick View 
The Quick View function provides a way to display multiple soundings 
in the same Window. To open the Quick View window, select the 
Special | Quick View menu command: 

 
Use the check boxes at the top of the window to select the components to 
be displayed. 

The Stations Map window, which can be toggled on and off with the 
corresponding check box in the upper right corner of the window, 
indicates the positions of the stations which are currently open (black 
squares) as well as the position of the active station (red square). 

Quick Edit 
The Quick Edit function, accessed with the Special | Quick Edit menu 
command, opens the MT Soundings edit window without requiring that 
individual stations be opened. To select a station for editing, using the 
Station drop-down list at the top of the screen. Limitation of this function 
is that only editing can be performed; in order to model and perform 
inversions, the stations must either be opened individually or a batch 
operation performed. 

Miniature Curves 
Select the Special | Miniature Curves menu command to display a 
miniature curve map with all stations in the current projects: 
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Polarization Maps 
Similar to the Miniature Curves function, the Polarization Maps option 
on the Special menu can be used to display polarization maps for a 
specific frequency. After selecting the menu command, a dialog box 
appears prompting you to specify a central frequency, in addition to 
several other parameters, for the polarization maps: 

 
Click the OK button to generate the specified polarization map: 
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17:  MT Pseudo-Sections 

Overview 

   

The Pseudo-Sections program reads the apparent resistivity vs. 
measuring parameter values for each station associated with a profile, 
then interpolates them to display a section showing the lateral variation 
along the profile. 

Pseudo-sections can be generated not only for station data, but also for 
2D model responses calculated using the 2D MT module. In addition, it 
is also possible to calculate difference pseudo-sections for sections of the 
same type on the same profile. Comparisons can, thus, easily be made 
between 2D models created along a given profile.  

Each pseudo-section is defined by a profile trace and its associated 
stations, which supply the datasets with the corresponding data. 

With the Pseudo-Sections program, multiple sections can be open at any 
time. Pseudo-sections may also be opened along multiple profiles. Each 
section is displayed in a separate window.  

Apparent resistivity and apparent phase are displayed as pseudo-sections 
in a single window. Tipper pseudo-sections are displayed in a separate 
window. 

The curves used to generate the pseudo-sections can be viewed and 
edited, one at a time, by clicking the vertical dotted line below each 
station on the section. 

A limited amount of station editing is possible in the Pseudo-Sections 
program: data points can be masked and stations can be 
activated/deactivated. Edit operations are stored in the database and apply 
throughout WinGLink, i.e. in Maps and MT 2D Inversion. 

Creating a New Pseudo-Section 
To create a new MT pseudo-section 

 1. Construct a new profile, as described in the “Maps” chapter of 
this manual. 

 2. Make sure you have imported or entered the field data for each 
station of the new section. You can use the MT Soundings 
program to check that the stations have data. The MT 
Soundings program uses the edited data, if available, or the 
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smoothed data, if requested. Alternatively, the original field 
data can be recalled. 

 3. Start the Pseudo-Sections program. 

 4. In the PseudoSection Selections window, which opens 
immediately after starting the program, select from the existing 
pseudo-sections. If no pseudo-sections have yet been created 
for the current project, the selection window is empty.  

 
 5 After selecting the “Create new pseudosection” option and 

clicking the OK button in the PseudoSection Selection window, 
the Profile and Value Selection window, shown below, opens: 

 
 
In the Data Source section of the window, specify whether you 
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would like to use station or synthetic data for the pseudo-
section. If using station data, the program uses smoothed 
curves, if available, by default.  
 
Synthetic data, the model response returned by the 2D 
Inversion program can be used as the data source by making the 
appropriate selection in the Data Source frame, then selecting 
the model to be used.  
 
Note that when making a selection, you must be consistent with 
the data source, i.e. it is not possible to open station and 
synthetic data without first closing and reopening the Profile 
and Value Selection window.  
 
Pseudo-sections which are already open are not available for 
selection in the Available Values frame.  

 6. The section is displayed and can now be edited and saved in the 
database for future modifications or printing. 

Gridding the Profile Data 
The data of the stations used to generate each pseudo-section must be 
gridded in order to display contours and color ranges. 

To Grid the Profile Station Data 
 1. Select the section you want to grid. 

 2. Select the Gridding | New Grid… menu command. A form 
similar to that shown below this is displayed: 
 

  

 3. The numbers in parenthesis on the gray background show the 
maximum and minimum values of the data; the current value to 
be used to define the grid extent must be entered in the field-
box close to each number. 
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 4. In the Step X field, enter the step in the specified units. This 
number determines the number of columns in the grid, which 
will be shown in the center white box, representing the section. 

   
 5. In the T intervals per decade field, enter the number of grid 

rows per decade. 

 6. Fill the fields with the values for the interpolation radius, spline 
weight and smoothing factor. 

 7. Click the OK button. 

Note: As the interpolation radius increases (values >5), the gridding 
algorithm attempts to fill any holes present in the data by interpolating 
between relatively distant data points. When creating difference pseudo-
sections (see below), we therefore recommend using a low interpolation 
radius (2) to prevent the creation of misleading differences.  

To Display Color Ranges and Contour Lines 

Click the  button to display/hide color ranges. 

Click the  button to display/hide contour lines. 

Displaying Station Dataset Values 
On the View menu, select the Projects Window, if not already 
displayed: 

  
Select the V box to display the values of the dataset at each station. 

To update the display of the section, click the section with the mouse. 

Displaying Profile Intersections 
If any other profiles in the database intersect the current profile, the point 
of intersection can be displayed by enabling the View | Crossing Traces 
menu option: 

 

Note: This display option applies only to the current window. 



 

A guide to using WinGLink MT Pseudo-Sections  •  17-5 

Deleting Pseudo-Sections 
 Any unopened pseudo-section contained in the current project can be 
deleted by selecting the File | Delete Pseudo-Section menu command: 

 

Exporting Grids 
 Grids associated with the TE/TM modes of amplitude and phase pseudo-
sections can be exported to an external file in a number of different 
formats. To export, select the Export Grid menu command on the File 
menu. 

Editing Data Points 
A number of edit operations can be performed on the data associated with 
each station. These include masking samples, static shift and station state, 
i.e. active or inactive.  

Edits made here affect the stations elsewhere in the database. Thus, a 
station disabled in the Pseudo-Sections program is not available in the 
MT 2D Inversion program. 

To Mask or Unmask Station Samples: 
 1. Click the dataset you wish to edit in the section (the data are 

shown as dots below each station. This will bring up the data 
window for the station to be edited). 

 2. Click the  button on the station data window. 

 3. Click the  button. 
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 4. Click the point(s) to be masked. The solid squares become 
empty squares after masking: 

 
 5. Click the masked point(s) to be unmasked. 

 6. Click the  button again to confirm your edit changes. 

 7. Exit the station window, or click another station to edit its data. 

 8.  Use the  button to switch modes. 

To Adjust the Static Shift of a Curve 
The static shift applied to the apparent resistivity curves can be edited 
from within the pseudo-sections program: 

 1. Bring up the editing window for the desired station by double 
clicking on the symbol of the station along the pseudo-section. 

 2. Click the  button on the station data window. 

 3. Click the  button to select the curve you would like to shift; 
the unselected curve is displayed in gray. 

 4. Click the  button. 
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 5. Move the mouse pointer next to the curve and single-click. 

 
 6. Shift the curve by moving the pointer; when the curve is 

positioned, single-click. 

The amount of the static shifting is displayed in the box labeled S-Shift: 

 
This number is a factor that multiplies the original resistivity values of 
the curve. If equal to 1, the curve is not shifted. 

To Change the State of a Station 
 1. Select the Station | Edit Status menu command. 

 2. Click the station symbols at the top of the profile to toggle the 
current state. When disabled, the stations are displayed in light 
gray. 

Station states may only be altered if the current project is a single project, 
i.e. this function cannot be applied to stations contained in an integrated 
project. 

To Change the TE/TM Sounding in a Pseudo-Section 
For each profile, both the TE and the TM pseudo-sections are 
constructed. It is possible to specify whether the XY or YX resistivity 
curve of a station be used for a TE or TM pseudo-section. 

 1. Select the Edit | Stations Mode menu command; the station 
symbols and names in the active window turn red or blue in 
color. If a station is red, it means that the XY curve is used; if it 
is blue, the YX curve is used instead. 

 2. Click the symbol of the station(s) for which you would like to 
change the mode. If you change the mode of stations in a TE 
(TM) section, the mode of those stations is automatically 
changed in the TM (TE) section. 
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This function can only be used if the current project is a single project, 
i.e. it cannot be applied to stations contained in an integrated project. 

Note: In order to see the effects of changes or edits made to the stations 
on the section, you must select the Gridding | Regrid menu command. 

Note: Data points for the tipper component can also be masked using 
the same technique as is used for the TE and TM components. 

Creating a New Difference Pseudo-Section 
Difference pseudo-sections can be created for any two pseudo-sections of 
the same type, i.e. TE, TM or tipper, which are contained in the same 
project. Difference pseudo-sections are displayed as a percentage and 
provide a useful tool for determining the differences between models. 

The PseudoSections program creates pseudo-sections by copying the 
gridding parameters of the first pseudo-section into the second pseudo-
section. Both sections are internally regridded, i.e. the data are 
reimported from the database, whereby any editing changes remain in 
effect. The second pseudo-section is then subtracted from the first, i.e. the 
grids not the data sources. This difference is then divided by the first, and 
the result multiplied by 100%: ((P1 - P2) /P1) * 100% 

The same gridding parameters as were used for both P1 and P2 are used 
to regrid the resulting difference.  

To Create a Difference Pseudo-Section: 
 1. If not yet created, create two pseudo-sections of the same type 

along the same profile as described above. 

 2. Select the File | Create Difference Pseudo-Section menu 
command to open the Difference Pseudosections selection 
window: 
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All pseudo-sections which have been created on the selected 
profile and which may be used for difference pseudo-sections 
are listed.  
 
Note: only TE, TM and tipper pseudo-sections created from 
either station or synthetic data may be used to create difference 
sections. Difference pseudosections themselves may not be 
used.  

 3. Select two pseudo-sections, one in each of the Pseudosection 
frames. Only if the pseudo-sections are of the same type, yet 
not identical, is the OK button enabled. The difference pseudo-
section is calculated and displayed after clicking the OK 
button: 
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 4. Make changes to the ranges as necessary using the Contours | 
Ranges commands. 

The various Copy commands on the Window menu are available for 
difference pseudosections and can be used to copy gridding and window 
parameters between both difference and standard pseudosections. Please 
refer to the “Common Functions” chapter of this manual for further 
details. 
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18:  MT 2D Inversion 

Overview 

 

The MT 2D Inversion program contains two different routines for 
running inversions: 

1. A smooth model inversion routine 
Developed by Randy Mackie, this routine finds regularized solutions 
(Tikhonov Regularization) to the two-dimensional inverse problem for 
magnetotelluric data using the method of nonlinear conjugate gradients. 
The forward model simulations are computed using finite difference 
equations generated by network analogs to Maxwell's equations. The 
program inverts for a user-defined 2D mesh of resistivity blocks, 
extending laterally and downwards beyond the central detailed zone, and 
incorporating topography. 

2.  A sharp boundary model inversion routine 
Also developed by Randy Mackie, this routine is based on the inversion 
of 2D MT data for discrete interfaces and the resistivities of the layers 
between those interfaces. The interfaces are described by a series of 
nodes, whose horizontal positions are fixed, but whose vertical positions 
can vary in the inversion. The interfaces are assumed to transect the 
entire model, i.e., there are no closed bodies. The interface varies linearly 
between each interface node. The resistivity of each layer is also 
described by a set of nodes at fixed horizontal positions within each 
layer. The resistivity is assumed to vary linearly between nodes. The 
interface and resistivity information is projected onto a finite-difference 
mesh for computation, and the inversion calculates the best fitting 
interface node locations and resistivity nodal values in order to fit the 
observed data.  

An assumption common to both routines is that the profile to be 
inverted is perpendicular to the electrical strike. 

Preparing the Input for the MT 2D Inversion 
Program 
The preparation of the input for the 2D MT inversion program requires 
the use of other programs to edit the data and construct each section. 
Refer to the “Maps” chapter of this manual or the WinGLink Help 
System for more details: 

 MT Soundings 
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• Edit and save observed MT curves. 

• Assign TE/TM mode for each sounding. 

 Maps 

• Construct sections by adding MT stations to a profile trace. 

 Pseudo-sections 

• Further editing of data and mode assignment of MT curves. 

• Masking bad data in each separate TE/TM curve. (The 
editing carried out in the Soundings module will mask 
frequencies but not individual samples for each separate 
TE/TM component) 

Creating and Loading Models 

Elements of a Model 
A typical 2D inversion model consists of: 

  A Mesh 
This is a finite-difference mesh, which must have at least one column for 
each station of the profile. Each cell of the mesh is assigned a user-
defined resistivity value. The model mesh is the input model for the 
smooth inversion routine. 

The program allows two types of automatic mesh generation  

 1. Coarse mesh generation, where the thickness of the rows 
increases with depth according to a fixed, pre-assigned scheme 
(suitable for most MT data).  

 2. Fine mesh generation, where the thickness of the rows 
increases with depth based on the initial resistivity set for the 
model and the frequencies involved (more suitable for high-
frequency data). 

  Resistivity Interfaces 
Resistivity interfaces are elements of the model used only by the sharp 
boundary inversion routine. The interfaces are polygonal lines added to 
the model to create layers of different resistivity, hence assuming a sharp 
variation of the resistivity within the mesh. 

Model validation criteria: To run a sharp boundary inversion, you need 
to define a valid initial model. This is a model with: 

 1. at least 1 resistivity interface in addition to the default interface 
corresponding to the air-earth interface (topography). 

 2. at least 1 resistivity node on each interface (including the air-
earth interface). 

An error message appears when trying to run a sharp boundary inversion 
on models which do not meet the above criteria.  
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  Resistivity Nodes 
Resistivity nodes are elements of the model used only by the Sharp 
Boundary inversion routine. 

The nodes are markers put on the interfaces to define the lateral variation 
of the resistivity below the interface. At least one node for each interface 
must be set, including the topography which is considered by the 
program as the top interface. 

Creating and Loading Models 
Each profile having stations may have many models associated with it. 
To display the list of models associated with a profile, select the File | 
Open Model menu command and select the desired profile from the 
Profiles box: 

 
In the Models box, select the model name, then click the OK button. 

To create a new model, select the New item, then click the OK button. 

Each model is based on a finite difference mesh. Whenever a new model 
is added, a new mesh is generated with: 

• at least one column for each station. 

• the same resistivity for all cells.  

• a predefined number of rows and columns. 

If the Use Topography checkbox is selected, the model incorporates the 
topography along the profile according to the following rules: 

 1. From the area topography grid as defined in the WinGLink 
shell. 

 2. From the project topography grid. 

 3. From the elevations of the stations attached to the profile. 
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You can then use the Edit Model commands to modify the current 
model. The Edit Model commands are made available when you click 
one of the following two icons: 

 This button starts Edit Mesh mode. The mesh can be edited by:  

• Adding rows or columns 

• Deleting rows or columns 

• Changing the size of a row or a column 

• Changing the resistivity of the cells 

• Locking/unlocking cell resistivity values 

 This button starts the Edit Resistivity Interfaces mode. 

This is used to build or edit a sharp boundary inversion model. The 
model can be edited by: 

• Adding model interfaces  

• Adding resistivity nodes to the interfaces  

 This button starts the Edit Tears mode. 

This is used to define tear areas on a model (use of this function is 
described further below).   

To exit the edit modes, reclick the same button used to enter the 
respective edit mode: the program will ask if you wish to confirm the 
changes you made. Use of the edit functions is described further below. 

Creating Marine / Amphibious Models 
 Marine or amphibious models can be created for profiles along which at 
least some of the stations have elevations less than 0m. The default 
resistivity of cells located between sea level and the sea floor for sections 
of submarine profile is 0.33 Ohm.m. This resistivity value remains fixed 
during model inversion. Marine/amphibious models are inverted in the 
same way as standard terrestrial models. 

To Create a Marine (or Amphibious) Model: 
 1. Select the File | Open Model menu command. The Profile and 

Model Selection dialog box opens: 
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Select the <New> item, and select the Create Marine Model 
check box; the Use Topography check box is then 
automatically activated. 

 2. The mesh can be regridded using user-defined block-width 
parameters and the water resistivity and default mesh resistivity 
values set using the Edit | Reset Marine Mesh menu 
command: 

 
 
Note: All non-water cells are set to the resistivity value set in 
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the second field; it is not possible to reset only the water 
resistivity value.  

Default Mesh Generation 
Whenever a new model is created, a coarse gridding default mesh is 
generated. To set a new default for mesh generation, select the Edit | 
Reset Mesh to Default menu command, then choose either Coarse or 
Fine according to your needs.  

Warning: Resetting the mesh to default will reset the current model. 

For more detailed control over mesh generation, select the Edit | Reset 
Mesh to Default | User Defined… menu command to open the mesh 
generation dialog box: 

 
 
The value set in the Resistivity Value field is used as the value 
throughout the mesh. Existing values are overwritten.  

Either or both block widths can be reset. You may optionally set the 
horizontal and vertical block widths in two separate operations by calling 
the User Defined menu command twice. Note, however, that the mesh 
resistivity values are reset to the specified value each time the block 
widths are reset. 
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Extracting a Mesh from an Existing Resistivity 
Section 
 1. If not already in Edit Mesh mode, switch to this mode by 

clicking the   button. 

 2. Select the Edit | Background menu command and choose the 
Set background grid option. Select the background resistivity 
grid to display: 

 
Note: The selected background grid will NOT be displayed 
immediately on the screen. 

 3. Again select the Edit | Background menu command, and now 
choose the Show background grid command 

 4. Select the Edit | Background menu command, and choose the 
Extract Mesh from background grid command 

For each mesh cell where a grid value is available, a mesh resistivity 
value is extracted. Remaining cell values are extrapolated 

Filling a Mesh with Values Extracted from a 3D 
MT Mesh 
Meshes can be extracted from any 3D MT mesh in the current database 
along the active profile and the resistivity values contained therein used 
as fill values for the current mesh.  

To Fill a Mesh with 3D MT Mesh Values: 
 1. Select the Edit | Fill Mesh with 3D Mesh Values menu 

command. A warning message appears indicating that, 
depending on 3D model dimensions, the time to extract the 
mesh may be on the order of minutes. This is particularly true if 
the original 2D mesh contains topography information.  

 2. After acknowledging the warning, the 3D Models selection box 
opens: 
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Select the project and desired mesh and click the OK button to 
initiate extraction and the subsequent filling of mesh cells. 
 

During this process, 3D mesh cells located along the profile are extracted 
from the 3D MT mesh and used as fill for the current mesh. Thus, if the 
mesh is not coincident with any part of the profile, no resistivity values 
are replaced in the original mesh.  

2D meshes generated by the MT 2D Inversion program generally contain 
mesh columns which extend well beyond the profile as well as below the 
expected maximum depth of penetration to allow the inversion to 
incorporate the effects of nearby structures on the predicted impedances. 
The 2D meshes extracted from the 3D MT meshes, however, are limited 
to values along the profile. Thus, resistivity values of the original mesh 
which lie outside of profile are not extracted from the 3D mesh and 
remain unchanged.  

In addition, if the resolution of the 3D mesh is exceedingly coarse 
relative to the original 2D mesh, it is possible that no values can be 
extracted from the upper layers of the 3D mesh. In this case, the original 
mesh values are retained.  

Editing a Mesh 
The MT 2D program includes a powerful interface for editing meshes. To 

access this interface, either click the  button in the toolbar or select 
the Edit | Goto Edit Mesh menu command. This places the program in 
the Mesh Edit mode. 

Upon entering this mode, both the toolbar and the Edit menu commands 
change and now include a number of commands and functions for 
performing mesh edit operations. 

To exit Mesh Edit mode, select the Edit | Exit Edit Mesh menu 
command or reclick the now depressed Edit Mesh button. If any changes 
were made to the mesh while in Mesh Edit mode, the program prompts 
you to save the changes before returning to the standard program mode.  

The individual mesh edit commands are described below. 

Adding Rows or Columns to a Mesh 
After entering Mesh Edit mode:  
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 1. Click the  button and select Add Row or Add Column; the 
pointer changes to a cross hair. 

 2. In the model window, click the location in the mesh where the 
upper bound of the new row [left bound of the new column] is 
to be placed. This function effectively splits a row or column 
into two; the resistivity values on either side of the new row or 
column are identical. 

Deleting Rows or Columns from a Mesh 

 1. Click the  button and select Delete Row or Delete Column; 
the pointer changes to a cross hair; 

 2. In the model window, point in proximity of the upper bound of 
the row [left bound of the column] to delete and then click the 
mouse left button. When deleting rows, the current row is 
deleted and the area previously occupied by the deleted row is 
assigned the resistivity value of the next lower row. When 
deleting columns, the current column is deleted and the area 
previously occupied by the deleted column is assigned the 
resistivity value of the column to the right. 

Sizing Rows or Columns 

 1. Click the  button and select Row Height or Column 
Width; the pointer changes to a cross hair. 

 2. In the model window, point in proximity of one of the 
row/column boundaries. 

 3. Click and hold down the button; drag the boundary to the new 
position and release the button. 

Changing Cell Resistivities 
While in Mesh Edit mode, click the box in the Rho window which 
contains the new resistivity value you wish to assign to one or more mesh 
cells: 

 
Then click: 

 to change the resistivity of one cell at a time.  

Click each cell to change the resistivity value. 

 to change the resistivity of a group of adjacent cells. 

Click the mesh and drag the mouse to include all cells you wish to edit 
the resistivity of 
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 to change the resistivity of a row/column (or half row/half 
column): 

 1. select Row/Column selection 

 2. click the mesh, then click the row/column you want to change 
the resistivity of. To change a half row/column resistivity, click 
the cell the change should start from in the row or column. 

 to change the resistivity of all the cells below a given row: 

 1. select Bottom Space Selection; 

 2. click the mesh, then click in proximity of the lower boundary of 
the row. 

 to change the resistivity of all the cells left (or right) of a column: 

 1. select Left/Right Space Selection; 

 2. click the mesh, then click in proximity of the left/right 
boundary of the column. 

When setting resistivity values, you are not limited to the values listed in 
the Rho window. To set a specific resistivity value, enter a value in the 
field provided at the bottom of the window. The appropriate cell color is 
selected automatically based on the resistivity values of the next higher 
and next lower color ranges.  

Note: Changing the resistivity value associated with a color does not 
change the values of any cells in the mesh already assigned that color.  

Locking/Unlocking Cell Resistivity 
The resistivity of cells can be locked so that during the inversion process 
their resistivities are not changed. 

To Lock Cell Resistivities: 

 1. Click the  button and select Lock or select Edit |Lock Rho 
Value to enable locking mode. While in this mode, the lock 
button remains depressed.  
 

 2. To lock cells, either select from the options which are listed 
when the mouse is positioned over the Edit |Lock Rho Value 
command: 
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then click the mesh with the mouse to lock cell values 
 
or 
 
use the buttons shown below to access the same commands: 

 
From left to right, the buttons are used for cell selection, 
row/column selection, band selection, bottom/left/right space 
selection, undo locking operation, and terminate/enable 
locking.  
 
Note: The first five buttons function as described above only 
when the locking button is depressed. Their function is 
otherwise dependent on the active edit mode, e.g. edit 
resistivities. 

Locked items appear with a halftone screening.  

To Unlock Cell Resistivities: 

 1. Click the  button and select Unlock or select Edit | Unlock 
Rho Value to enable unlocking mode. While in this mode, the 
lock button remains depressed. 

 2. Cells can be locked and unlocked using commands analogous 
to those used to lock cells. Likewise, the buttons described 
above can be used to unlock cells.  

After either locking or unlocking cells in Edit Mesh mode and returning 
to inversion mode, the locked cells are displayed in the mesh with 
halftone screening and the inversion parameters are set to take into 
account any locked cells.  

To Enable/Disable Cell Locking for a Model: 
 1. Select the Inversion | Settings… menu command. 

 2. The Parameter Settings dialog box opens. Select the Fixed 
Parms tab. 
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 3. Select the Fixed Parameters check box. 
 
Note: Halftone screening is used to display locked cells only 
when the Fixed Parameters check box is selected. 

Defining Tear Areas 
WinGLink includes functionality for specifying up to eight tear areas 
within a model. Using these zones, the user can define tears in the 
smoothing function, i.e. turn off smoothing across a boundary.  

To Create a Tear Area: 
 1. After creating a model, select the Edit | Goto Edit Tear menu 

command to enter Edit Tear mode or click the  button. 

 2. Next, choose a selection mode on the Edit | Set Tear Area 
menu: 

 
Selection options are similar to those used elsewhere in the 
2DMT module, e.g. for setting resistivities or locking cell 
values. Alternatively, you may use the selection buttons on the 
toolbar. 

 3. After choosing a selection option, the tear area menu options 
appear (Edit | Set Tear Pattern…) and the corresponding 
buttons on the tool bar are enabled: 

 
Each of the patterns corresponds to one of the eight different 
tear areas. 
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 4. Using the mouse, select the cells to be included in the tear area: 

 
Although the function supports up to 8 different tear areas, a 
given cell can be associated with only one tear area. 

 5. After defining tear areas, exit Edit Tear mode with the Edit | 
Exit Edit Tear menu command or by again clicking the Tear 
button. Display of tear areas can then be toggled on and off 
with the View | Tear menu command.  

Tear areas present in a model are included in any smooth inversion 
performed on the model. 

 

Editing a Sharp Boundary Model 

Editing Sharp Boundary Interfaces 
Select the Edit | go to Edit Resistivity Interfaces menu command or 

click the  button to enter Edit Resistivity Interfaces mode. 

The Edit Interfaces command buttons appear. 

Click: 

 to add an interface 

Going from left to right, click with the mouse left button wherever you 
want a vertex of the polygonal interface to be added. When finished, 
right-click the last vertex you wish to add: the program automatically 
completes the right bound of the interface. 

 to delete an interface 

Left-click a segment of the interface to delete.  

 to insert a vertex 

Left-click the interface at the location where you want to insert a vertex. 

 to delete a vertex 

Left-click the vertex to delete.  

 to move a vertex 
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Left-click the vertex to move and drag it to the new location along the 
interface. 

Setting Interface Resistivity Nodes 
Select the Edit | go to Edit Resistivity Interfaces menu command or 

click the  button to enter Edit Resistivity Interfaces mode. 

The Edit Interfaces command buttons appear. 

Click: 

 to add a resistivity node 

Left-click an interface where you wish to insert a node. A node will be 
inserted with a value of resistivity equal to the value currently selected in 
the Rho editor box. 

 to delete a resistivity node 

Left-click the node to be deleted.  

 to move a resistivity node 

Left-click on the node to be moved and move it along the interface. 

 to edit the value of resistivity for a node 

 1. Left-click on the Rho editor box and select the value for the 
new resistivity. 

 2. Left-click each node to which you wish to assign the new 
resistivity. 

Note: Each interface must contain at least one resistivity node. 

Locking Interface Vertices and Resistivity Nodes 
The positions of interface vertices and the values of resistivity nodes can 
be locked by selecting the Edit | Lock menu command while in Edit 
Resistivity Interface mode in the MT 2D program. After selecting the 
command, click each vertex or node to be fixed. Locked vertices are 
indicated by a red cross, locked nodes are indicated by a black circle 
around the node.  

Be aware that locked vertices and nodes are not necessarily truly 
“locked”. Depending on the values of the Tau for Resistivities and Tau 
for Interfaces parameters, vertex and node values may actually be quite 
variant. These two parameters, which are set in the Sharp Inv. tab of the 
Parameters Setting dialog (Inversion | Settings…) control the stickiness 
of each of these values. A high value, e.g. 1E8, ensures relatively little 
change per iteration, whereas a low value, e.g. 10, restricts only slightly.  

Locked vertices and nodes can be unlocked using the command provided 
under the Edit | Unlock menu command. 
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Inversion Settings 

Overview 
As described below the MT 2D provides a multi-paneled dialog window 
which provides extensive options for controlling the inversion process 
including, among others, the selection of modes and frequency ranges.  

In addition to the options provided here, however, note also that the 
masking functions available in the MT Soundings and MT Pseudo-
Section programs can be used to hide individual data points from the 
inversion routine. This provides an additional level of control over which 
data points are used in model inversions. Please refer to the respective 
chapters of manual for additional details. 

Main Inversion Parameters 
Select the Inversion | Settings... menu command to open the Parameter 
Settings dialog box: 

 
Click the Main Parms tab, and select the desired options. Available for 
selection are: 

_ Invert TM rho and phase data 

_ Invert TE rho and phase data 

_ Invert Hz transfer function (*) 

(*) The program is written assuming an e^{-iωt} time dependence. Many 
processing routines assume e^{+iωt}. If this is the case, then the data will 
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need to be conjugated to be consistent with the program. Check the "Take 
conjugate of Hz data" box to do so.  

Note: While in the Main Parameters dialog box, it is possible to enter an 
error value that will terminate the inversion. This last option is only 
available for the Sharp Boundary inversion routine. 

In the Min/Max Resistivity Values (calculated) area of the Main Parms 
window, select the Use Minimum and Maximum resistivity values 
checkbox to force the smooth inversion code to restrict the resistivity 
values calculated by the code to values between the specified minimum 
and maximum values: 

 

Specifying the Data for Which the Inversion is to 
be Performed 
Select the Data Select. tab of the Parameter Settings window and make 
the appropriate settings: 
Min 
Frequency 

Specifies the lower bound of the observed curve’s 
frequency range over which fitting is tried. If you want 
to fit all frequencies of the observed curve, specify a 
very low value, e.g. 10 E^-5 

Decades Specifies the upper bound of the observed curve’s 
frequency range on which fitting is tried; it is equal to 
Min Frequency * 10 ^(Decades). Values can be set 
independently for each of the modes.  

Use Station 
Data 

Will force the program to use the observed curve data 
samples. This could lead to a long calculation time 
when the data points of the observed curves are not 
ordered in the frequency domain. In this case, you may 
want to select Use Interpolated Data to cut the 
inversion time considerably. 

Interpolated 
Data 

Uses a resampling of the observed curves. The #Freqs 
in Decade parameter specifies how many samples per 
decade must result from the interpolation. This option 
is useful for shortening the inversion time when the 
data points of the observed curves are not ordered in 
the frequency domain and/or when dealing with curves 
with many data points. 

Use 
Smoothed 
Curves 

By default, the observed curves used for the inversion 
are the edited curves saved by the Soundings program. 
Selecting this option will force the program to use the 
smoothed curves instead of the edited curves. 
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Smooth Inversion Parameters 
The NLCG algorithm attempts to minimize an objective function that is 
the sum of the normalized data misfits and the smoothness of the model. 
The tradeoff between data misfits and model smoothness is controlled by 
the regularization parameter tau. The NLCG algorithm does not try to 
automatically determine tau to reach a target misfit. Rather, the user must 
run several inversions using different values of tau, and then run the 
algorithm until convergence to determine what value of tau will give the 
smoothest model and the target misfit. It is possible with real field data 
that one would never be able to reach the desired target misfit. In this 
case, one would want the tau that gives the smaller RMS error and the 
smoothest model. The following parameters are available to the user for 
inversion control: 

Select the Smooth Inv. tab of the Parameter Settings window and make 
the appropriate settings: 
Smoothest 
model or 
variations 

The program can solve for the smoothest model or 
the smoothest variations away from the apriori 
(starting) model. Choosing smoothest variations is 
a useful way to do hypothesis testing for different 
model parameters or features. 

Regularization 
Laplacian 

It is possible to specify either a uniform grid 
Laplacian (which assumes for the purposes of 
computing the regularization function that the 
dimensions of the model are all equal) or standard 
Laplacian on the actual model mesh. The uniform 
grid Laplacian may produce smoother models, but 
at the expense of smearing features both vertically 
and horizontally. The standard Laplacian may 
produce a rougher-looking model, but the 
definition of smoothness is consistent with the 
model dimensions. Unless there are reasons to do 
otherwise, we recommend using the standard 
Laplacian. 

Regularization 
Order 

Option to minimize the gradients ( )of the 
model, or the Laplacian ( ) of the model. 
Variations of this parameter, equal or unequal grid 
Laplacian, and the smoothest model or the 
smoothest variations give the user a great deal of 
flexibility for generating different types of 
constraints on the inversion. It is recommended that 
you use Laplacian smoothing as the default. 
Smoother models can also be obtained with 
increasing tau 

Tau for 
Smoothing 
operator 

This is the regularization parameter that controls 
the tradeoff between fitting the data and adhering 
to the model constraint. Larger values cause a 
smoother model at the expense of a worse data fit. 
The value of tau should optimally be chosen such 
that the RMS error for the inversion is between 1.0 
and 1.5. A few inversion runs may be necessary to 
determine the best tau for each inverse problem. 
Additionally, noise in the data and non-2D data 
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may prohibit the program from reaching the target 
RMS error values. This is especially true for TE 
mode data. If you find that the rms does not drop 
below 1.5 for any value of tau, you should increase 
tau until the rms is 1.5 (or perhaps 1.2) times the 
smallest rms you can achieve. Alternatively, you 
can increase the error floors until you can achieve a 
minimum rms of 1.0 and then increase tau until the 
rms is 1.5. Values between 3 and 300 seem to be 
typical for most MT inversions and are good 
starting points. 

Weighting 
function 

The first option specifies the  factor to multiply 
horizontal derivatives. A value of 1.0 is 
recommended unless you want to increase the 
horizontal smoothness. 
The second line specifies  in the weighting 
function. A value of 3.0 is recommended if 
minimizing  and a value of 1.0 is 
recommended if minimizing . If you set the 
value to zero, then no weighting is applied to the 
regularization term. 
The third line specifies the minimum block 
dimensions to be used for computing the weighting 
function. These are specified in meters. These are 
useful for setting a transition from a depth-
independent regularization in the shallow part of 
the model to a depth-dependent regularization in 
the deeper part of the model. Values of 500 – 1000 
meters are recommended as good starting points. If 
values of 0.0 are specified, then the model will be 
overly rough in the shallow part if using a standard 
grid Laplacian , or overly smooth if using uniform 
grid Laplacian.  
The weighting parameters entered here are sent to 
the inversion code only if the Weighting enabled 
check box is selected. Otherwise, alpha = 1.0, beta 
= 0.0 and min block dimensions =0.0 are sent to the 
inversion program. . 

Output 
sensitivity 
map 

When selected, the sensitivity map is output by the 
inversion routine at the final iteration, regardless of 
the preconditioner used. The diagonal part of 

ARA dd
T 1−

 is output for each model parameter. This 
information can be used to determine those parts of 
the model that have the greatest sensitivity to that 
data and which parts of the model are relatively 
unimportant. This information is in the same 
format as the model files and can be viewed as a 
mesh by selecting the Display | Sensitivity Map 
command. Note: Depending on the input 
parameters, the calculation of the sensitivity map 
may be time intensive.  

Save When selected, the resistivity values calculated for 
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intermediate 
models 

each model iteration by the inversion code are 
stored in the database. Upon completion of the 
inversion, you can view the meshes for any or all 
of the iterations by selecting the Display | Model 
Development command. The mesh at a given 
iteration number can be saved as a model by right-
clicking the model and specifying a new model 
name. The intermediate models remain stored in 
the database for a given model until a new 
inversion is performed on the model  

Error Floor 
Select the Error Floor tab of the Parameter Settings window. 

This is the error floor for the data. Input errors that are below this value 
will be reset to this value. Values greater than 1.0 for TM and TE mode 
data are recommended. (For small values, percents are equivalent to 
natural logarithm errors). The error floor for the phase should be entered 
in rho equivalent percent. For example, 1% in rho is equal to 0.29 
degrees in phase. 

For Hz data, the error floor is an absolute magnitude that should 
optimally be chosen relative to the quality of the Hz estimates. A 
reasonable starting point might be 0.01 or greater 

Static Shift 
Select the Static Shift tab of the Parameter Settings window. 

Select Stations to Invert for Static Shifts 
In this version of the program, the user can specify which data are to be 
included in the inversion for static shifts. In other words, you can invert 
for static shifts for just the TE mode data, TM mode data, or any 
combination for each station. If you want to invert for static shifts for all 
data, just select the Invert for Static Shift check box. However, to 
specify any combination of data, on the Inversion Menu, select the  Edit 
Static Shift command. While this command is active, double-click on 
each station one at a time to select the static shift option for the selected 
station (TE only, TM only, TE&TM). The name of the station on the 
topography (normally black color) will change color according to the 
static shift settings: 
- None BLACK 
- TE only RED 
- TM only BLUE 
- TE & TM PURPLE 

To exit the static-shift edit mode, select the Inversion Menu | Lock 
Static Shift menu command.  

The static shift values returned by the inversion routine are stored for 
each station in the database. Thus, these static shift values will be used in 
any subsequent inversions or forward calculations performed on the 
model, provided the static shifts are enabled for the respective mode.  
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Resetting Static Shift Values 
The static shift values of all station used in a model can be reset to 1 
using the Tools | Reset Static Shift command to open the Static Shift 
reset dialog box. The values are otherwise retained, i.e when editing 
meshes and when restarting inversions: 

 
 

Static Shift Settings 
Invert for 
static shift 

The program can optionally invert for static shifts 
of the TM and TE mode apparent resistivities. The 
static shift values are included as parameters in the 
inversion, and the datum is that the sum of the ln 
of the static shifts should sum to zero. 
Check the Use screen settings for static shift box 
to apply the static shift type for each station. 
When this box is not checked, static shifts apply to 
all stations for both TE and TM modes.  
Note: After manually setting the static shift of 
individual stations, both the Invert for static shift 
and Use screen settings for static shift check 
boxes are automatically selected.  

Variance 
for 
constraint 

IF you choose to invert for static shifts, you are 
also asked to input a variance and a damping 
value. The variance is the variance in the 
requirement that the log of the statics sum to zero. 
Enter values in percent, like 5.0 or 10.0. Larger 
values mean the zero sum constraint is less 
important. 

Damping 
for 
constraint 

The other parameter you'll have to enter if 
inverting for static shifts is the damping term. 
Basically, this damps the inversion so that large 
changes are not made to the static shifts on the 
first few iterations. In other words, you might 
want to try to fit the data as good as possible 
before allowing changes to the static shifts. Every 
three inversion iterations, the program reduces the 
damping value by a third. Thus, the static shift 
parameters gain in influence as the inversion 
progresses. If you want the statics to remain fixed 
until later iterations, enter a large value here, like 
1000 or 10000. If you want the statics to 
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immediately be changeable, enter smaller values. 
A value of zero for the damping means that the 
statics are completely free to be changed.  

Exporting Static Shift Values 
Static shift values can be exported to external files after running an 
inversion by selecting the Tools | Export | Import Files Used for 
Inversion command. The static shift values are output to the files 
statics_vals.te and statics_vals.tm for the te and tm modes, respectively. 

Data Errors 
Select the Data Errors tab of the Parameter Settings window. 
Use Data 
Errors if 
existing 

Check this to use the errors of the observed 
curves. 

(TE/TM) 
Rho, 
Phase 

If the above option is not checked or the observed 
curves have no errors, these are the default 
standard deviation errors to use. 

Fixed Parameters 
If the resistivities of some model cells have been locked, use the options 
provided on the Fixed Parms tab to specify whether or not cell locking is 
to be used, and the parameter which specifies the amount which the fixed 
parameters may change over the course of the inversion.  
Fixed 
Parameters 

Certain model parameters can optionally be 
forced to remain fixed through the inversion. Do 
not mark this checkbox if you want to override 
all the locking performed on elements. 

Tau for 
clamping 
fixed 
parameters 

If the above option is chosen, then a tau value 
for keeping the parameters fixed must be input 
(1e5 is recommended - The smaller the value, 
the less damping). 

Use Tears Select this check box to enable  tear 
functionality.  

Note: After either locking or unlocking cells, the Fixed Parameters 
check box is automatically selected and Tau is set to a default value of 
10. 

Sharp Boundary Inversion Parameters 
Select the Sharp Inv. Parms tab of the Parameter Settings window. 
Damping 
Factor 

This controls how damped the locked elements 
will be. The lower the value, the less the 
damping. 

Tau for 
Resistivities/ 
Interfaces 

This is the regularization parameter that 
controls the tradeoff between fitting the data 
and adhering to the model constraint. Larger tau 
values will result in smoother variations 
amongst the parameters, at the expense of a 
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higher data misfits. Higher tau values mean that 
the interfaces have less variation, and the 
resistivity of each layer is more smoothly 
varying. 

Running the Inversion 

Running a Smooth Inversion 

To Run a 2D Smooth Inversion on the Current Model: 
 1. As described in the previous section, select the Inversion | 

Settings menu command to open the Parameter Settings 
window and enter the appropriate inversion parameters. 

 2. Select the Inversion | Run Smooth Inversion menu command. 

 3. Enter the Max  of iterations. 

 
 

Enter Max  of iterations = 0  to run a forward computation and see the 
response of the current model. 

Once the inversion is started, the algorithm iterates until the maximum 
number of iterations specified by the user has been reached or the 
program can reduce the RMS no further. 

During the inversion, the progress can be monitored via the updated RMS 
error shown for each iteration in the Running Smooth Inversion 
progress window. Also displayed in this window is the expected time 
remaining for the inversion. In addition, the resistivity values for the 
mesh cells are updated following each iteration with the new values.  

When the inversion is completed, the inverted model is shown as a mesh. 
Saving this model will overwrite the initial input model. If you wish to 
save the starting model, you should save it as a separate model before 
starting the inversion. 

Running a Sharp Boundary Inversion 

To Run a 2D Sharp Boundary Inversion on the Current 
Model: 
 1. As described in the previous section, select the Inversion | 

Settings menu command to open the Parameter Settings 
window and enter the appropriate inversion parameters, 
including the target RMS error. 
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 2. On the Inversion menu, select Run Sharp Bounds Inversion. 

 3. Enter the Max # of iterations. 

 
 

To run a forward computation and see the response of the current model, 
set Max  of iterations = 0. 

Once the inversion is started, the algorithm iterates until the target RMS 
error is reached or the user-entered maximum number of iterations is 
reached. 

During the inversion, the progress can be monitored via the updated RMS 
error shown for each iteration. 

When the inversion is completed, the inverted model is shown as a mesh. 
The resulting resistivity interfaces and resistivity nodes are superimposed 
upon this mesh. 

Saving the output model overwrites the initial input model. If you wish to 
save the starting model, you should save it as a separate model before 
starting the inversion. 

Running an Inversion Using CS/AMT Data 
The inversion parameters are, by in large, the same as those used for 
regular MT data, though the options are somewhat limited. Note that only 
smooth inversions may be performed for CS/AMT data and that the 
inversion routine predates that used for regular MT data.   

The MT 2D inversion module is plane-wave only, i.e. it is far-field as far 
as CSAMT is concerned. The bipole separations are, therefore, not used 
in the 2D calculations. Bipole separations are, however, used in the 
calculation of 1D models in the Soundings module. 

Computing Synthetic Forward Modeling Results 
Forward modeling results, corresponding to a given 2D model, can be 
calculated at any time by running an inversion with zero iterations. When 
the 2D model is saved, the results are saved as calculated data for the 
stations added to the model profile. 

If no stations with observed data are available for a given profile, 
synthetic 2D forward modeling results can be calculated by: 

 1. Using the Maps program to insert new stations along the 
profile. 

 2. Editing a 2D model for the profile using the 2D Inversion 
program.  
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 3. Running a forward calculation by entering zero iterations for 
the inversion.  

The computed results are saved as calculated 2D data for the stations of 
the profile. At this stage, the stations will still miss the observed data.  

To store the forward response as station data, select the Tools | Save 
model responses as station data menu command in the 2D MT 
inversion program. . 

Note: If using the Save model responses as station data command, any 
existing station data are overwritten. A warning message to this effect is 
displayed and must be acknowledged before the data are saved as station 
data. 

 

Presentation of Results 

Displaying Models as Sections 
The 2D Models are normally shown as a mesh showing the cell 
geometries and resistivity values.  

Each mesh can be gridded to obtain a section, which can be plotted or 
used as a background in other modeling programs. 

On the Display menu: 

• Select Mesh, to display the model as mesh (default). 

• Select Section, to grid the mesh and display the model as a 
contoured section. Choose Gridding to interpolate the 
resistivity values the first time you select this display mode. 
For details on setting the gridding options, please refer to the 
“General Functions” chapter of this manual 

Displaying Response Curves 
Response curves can be displayed for each station used in a model by 
double-clicking the column directly under a station name:  
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Provided data are available, curves can be displayed for the real and 
imaginary parts of TE, TM and HZ. For HZ data, the tipper can also be 
displayed. Error bars can be toggled on and off by selecting the Err 
check box. The drop-down list box can be used to open the response 
curve for a specific station without closing the window.  

The three buttons in the upper right corner of the response curve 
windows are used to control print functions: 

 print the current response curve to the default printer. 

 open a selection dialog box from which you may select for 
printing any or all response curves for stations contained in the current 
model. Up to six response curves may be printed on a single sheet.  

 open the printer settings dialog box.  

The status bar in the response curve window contains the RMS and static 
shift values for the model, provided an inversion has been run. In 
addition, the position of the mouse along the time axis is also displayed.  

Displaying Pseudo-Sections 
One way to compare the inversion fitting is by displaying the pseudo-
sections of the observed data together with the pseudo-sections of the 
calculated data. The MT 2D Inversion program assumes that the observed 
pseudo-sections have already been calculated by gridding the observed 
data in the Pseudo-Sections program (accessible via the WinGLink 
Shell). 

To display the pseudo-sections, select the Display | Pseudo-Sections 
menu command. 
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The observed section is displayed above the calculated section. The 
calculated section is gridded using the same parameters as the observed 
section. 

Displaying Multiple Models for Comparison 

To Simultaneously Display Multiple Models: 
 1. Close the active model. 

 2. Select the Special | Multiple Windows menu command. 

 3. Select the models to be displayed for each profile. 

 4. Use the Display | Mesh and Section menu commands to toggle 
between the two different views. 

Displaying and Exporting Sensitivity Maps 
Provided the Output sensitivity map option was selected in the Smooth 
Inv. tab of the Parameter Settings dialog box prior to inversion, the 
sensitivity map generated by the inversion code can either be displayed 
on the screen or output (in the same format as a regular model) for use 
outside of WinGLink. 

To display the sensitivity map, after running an inversion, select the 
Display | Sensitivity Map menu command. To return to the model view, 
select the Display | Restore Model command. 

To export the sensitivity map, select the Tools | Export | Input Files 
Used for Inversion menu command. The sensitivity map will be 
exported to a file named [Profile Name]_[Model Name].sens. 

Displaying Model Roughness 
After running an inversion, the model roughness can be displayed by 
selecting the Display | Model Roughness menu command. 

 

Displaying Model Development 
 The MT 2D Inversion program provides the option of storing and 
displaying model meshes at each iteration of an inversion. To enable and 
use this function: 

 1. Select the Inversion | Settings menu command to open the 
Parameter Settings dialog box. 

 2. Select the Smooth Inv. tab. At the bottom of the tab, select the 
Save intermediate models check box. 

 3. Set the other inversion parameters as you normally would, then 
perform the smooth inversion.  
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 4. Upon completion of the inversion, select Display | Model 
Development to open the selection window: 

. 

 5. A given iteration can be saved as a model by right-clicking the 
model window: 

 
Models saved in this way are assigned the same inversion 
parameters as the original model  

 6. To return to the model, select Display | Restore Model. 

Note: The model development function is available only for smooth 
models. 

Displaying 1D Models for Stations 
On the View menu, position the mouse over the 1D Models command, 
then choose the most appropriate size for the model: small, medium, 
large. 
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Displaying Well Courses 
The traces of any wells associated with the current profile can be 
superimposed on the current mesh by selecting the View | Wells menu 
command. When enabled, the Well Layer Data window appears. This can 
be used to toggle the display of any layer data associated with the wells: 

 

Displaying Inversion Reports 
 In addition to the graphic display of inversion results, the parameters 
used in the inversion, inversion errors and calculated TE, TM and HZ 
values for each station and period can be viewed and stored as text files. 
The inversion reports for a given model remain available until another 
inversion is performed on the same model.  

To view the parameters used in the inversion and the inversion errors, 
select the View | Inversion Log menu command. 

To view the observed and calculated TE, TM and HZ values for all 
stations used in the model, select the View | Output Data menu 
command. 

Note: For users of the stand-alone version of the inversion code, the data 
presented in the Output Data window are essentially the same as those 
output to output_*.dat files.  

Taking Notes 
 Each model has associated with it a note pad, the contents of which are 
stored in the database together with the model. To open, select the View | 
Notes menu command. Notes stored here may optionally be saved to an 
external file by using the File | Save (As) command in the Notes window.  
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Batch inversion 

Executing Batch Inversions 
The MT 2D Inversion module can be used to successively execute 
inversions on a set of models. Inversions executed in this way make use 
of the inversion parameters set for each model in the Parameter Settings 
dialog box. All of the inversions to be performed must, however, be of 
the same type, i.e. either smooth or sharp, and they must have the same 
maximum number of iterations.  

To Perform a Batch Execution: 
 1. Close any open models. 

 2. Select the Special | Batch Execution menu command 

 3. In the Batch Execution Selection window which opens, select 
the models to be inverted and specify the type of inversion and 
the maximum number of iterations to be performed (the last 
two parameters apply to all models): 

 
 
Select the models to be displayed for each profile and click OK 
to begin the inversions. 

 4. Unlike single inversions, the resistivity meshes are neither 
updated nor displayed during the inversion process. The current 
iteration numbers and RMS values are however, displayed on 
the screen. After all inversions have been completed, a 
summary window appears, listing the RMS values computed 
for each model and any problems encountered.  

 5. To view the inverted models, use the File | Open Model menu 
command as you would to open any model.  

Exporting and Importing Models and Interfaces 

Exporting Models and Interfaces 
Models created and used within WinGLink can also be exported to 
external files. In addition to the models themselves, all files necessary for 
running an inversion using the stand-alone version of the inversion code, 
including the command file for either version 5.0 or 6.7+ of the stand-
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alone code, are output. Models can optionally be output in GEMCOM 
format.  

To Export a Model:  
 1. Select the Tools | Export menu command. Position the mouse 

over the menu command and select either Input Files used for 
Inversion or Model in GEMCOM Format… 

 2. When saving the files used for inversion, specify the directory 
to which the files should be output as well as the version of the 
inversion code with which the files are to be compliant.  
 
Instead of outputting all files used for the inversion, you may, 
for the case of sharp boundary models, instead output only 
resistivity interfaces by selecting the Resistivity Interface only 
check box. This function is useful for transferring complex 
resistivity interfaces from one model to another 

 
When exporting models in the 6.7+ compliant format, the static shift 
values are exported to the files statics_vals.te and statics_vals.tm for the 
te and tm modes, respectively. 

Importing Models and Interfaces 
Models may be created or modified outside of WinGLink and imported 
into the MT 2D Inversion module. In order to import a model, both a 
command file (*.CMD) and a like-named model file (*.MOD) are 
required. The remaining parameter files, which are used by the stand-
alone version of the inversion code and control parameters such as fixed 
cells, static shifts and weighting are optional. Command files must be 
compatible with either version 5.0 or newer of Randy Mackie’s 2D 
inversion code. Either smooth or sharp models may be imported.  

To Import a Model: 
 1. Select the Tools | Inversion Model from External Files… 

menu command. 

 2. The Import Model window opens. Browse the directories and 
select the desired .MOD file; click the OK button. 

To Import an Interface:  
When working with sharp boundary models, it is possible to export and 
import resistivity interfaces – a convenient function when working with 
various models along the same profile (or profiles with similar structure).  

 1. Select the Tools | Resistivity Interfaces… menu command. 
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 2. Before the import commences, the MT 2D Inversion module 
alerts you that any existing interfaces will be lost.  

 3. If you acknowledged the warning mentioned in step 2 with Yes, 
continue by selecting the interface file (*.PAR).  
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19:  MT 3D Modeling 

Overview 

 

The 3D Modeling program is used to: 

• Import, create, edit, print and export 3D meshes 

• Create views, or slices, of 3D meshes 

• Calculate the forward response of 3D meshes 

• Export EDI files calculated for stations positioned on the mesh 
using field information returned following the forward 
calculation. 

Used together with the Maps program for positioning stations and 
defining profiles and the X-Sections program, the 3D Modeling program 
is the cornerstone of WinGLink’s 3D modeling functionality.  

3D meshes are used in both the MT 3D modeling program. Though the 
functionality is similar in both, there are enough differences that a 
separate chapter is dedicated to each. This chapter is the MT 3D 
Modeling chapter. 

Note: The 3D Modeling program is available with the MT_4 license 
option. For details on license options, please refer to the Modules page of 
the Geosystem website: http://www.geosystem.net. Prices available upon 
request. 

How WinGLink Handles 3D Models 
3D models are intended to add another dimension, so to speak, to 
WinGLink’s palette of MT interpretation tools. The suite of 3D-specific 
functions included in several of the WinGLink modules provides the 
tools necessary for 3D MT modeling including mesh generation, 3D 
forward calculation and EDI export.  

The 3D forward modeling code developed by Randy Mackie, 
MTD3FWD, is implemented in the 3D Modeling program. This forward 
modeling code computes magnetic and electric fields at the surface of a 
3D electrical resistivity model illuminated by electromagnetic plane 
waves. Used as input are a 3D mesh in the format specified at the end of 
this chapter and several model parameters, which are also described in 
this chapter. 

http://www.geosystem.net/
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The fields computed by the forward modeling code are automatically 
converted to magnetotelluric impedances and tipper upon conclusion of 
the forward calculation. These can in turn be used to generate EDI files 
for stations contained in the mesh area.  

Field values are generated for each column of data. Thus, EDI files can 
be generated for any cell in the mesh provided a station, synthetic or real,  
is positioned on the cell. The MT impedance and tipper values can be 
stored in the active database as well as stored in an external file and 
reused to generate EDI files should stations be added to the project at a 
later time. 

These EDI files, once imported into a WinGLink database, can be 
assigned to map profiles and used elsewhere in WinGLink as station data, 
i.e. in the MT 2D module.  

About 3D Meshes 

The 3D Mesh Definition 
In order to be conformant with the forward modeling code, the 3D MT 
meshes must be in the slightly modified Randy Mackie format as defined 
at the end of this chapter. The aforementioned modification refers to the 
addition of georeferencing information, which is used to correctly 
position the mesh in the survey area.  

The coordinate system of 3D MT meshes within WinGLink is illustrated 
below: 

 
Note that the origin, or pivot point, of 3D MT meshes in WinGLink is the 
center of the top, left, rear mesh cell. Positive mesh rotation is performed 
counterclockwise about this point. For details on mesh rotation, refer to 
the Mesh Properties section of this chapter. 

3D Meshes in WinGLink 
3D meshes are specific to MT projects in WinGLink and may thus only 
be imported into projects of type MT. Once imported into a database, a 
3D mesh remains associated with its project. The 3D Mesh Importer, 
which can be accessed both in the main WinGLink shell as well as in the 
MT 3D Modeling program, can be used to import 3D meshes from 
external files, the active database and other WinGLink databases. 
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In addition to its forward calculation feature, the MT 3D Modeling 
program also provides functionality for mesh creation, editing, importing, 
exporting and visualizing. 

Once in a project, 3D meshes can be displayed in the Maps program. 
Here, stations can be positioned and profiles defined (refer to Chapter 5, 
Maps, for details). Map profiles defined on meshes can be used to extract 
vertical 2D sections in the X-Section program (refer to Chapter 7, 
Sections, for details). In the Maps program, it is also possible to extract 
from a 3D mesh maps at constant depth or elevation for 
resistivity/conductance. Meshes can be extracted along a profile in the 
MT 2D program and used as starting models for 2D inversions (refer to 
Chapter 8 for details).  

Using the MT 3D Modeling Program 

 

The 3D Modeling icon, shown to the right, is displayed in the WinGLink 
database shell whenever the project selected in the Project panel of the 
database shell is of type MT.  

Selecting a Mesh  
 1. After clicking the 3D Modeling icon, the following dialog 

window opens, listing all 3D meshes available for the current 
project: 

 
If no 3D meshes have yet been imported using either the 
WinGLink database shell or the MT 3D Modeling program or 
created within the MT 3D Modeling program, the table is 
empty. For details on importing 3D meshes into WinGLink, 
please refer to the next section or section “Importing 3D MT 
meshes” in Chapter 3 of the WinGLink manual. Instructions on 
how to create a mesh in the MT 3D Modeling program are 
provided later in this chapter. 

 2. Select the desired mesh with the mouse, then click the OK 
button to continue. 
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Importing Meshes 
In addition to the mesh import function available in the WinGLink 
database shell, meshes can also be imported directly into the MT 3D 
Modeling program.  

To import a mesh into an existing MT project from within the 3D 
Modeling program: 

 1. On the Tools menu, select the Import 3D Mesh Model … 
command. 

 2. The first of the 3D MT Mesh Import Wizard windows opens. 
Specify the data source: from file, the current database, or an 
external database. 
 
If you choose to import from either the current database or a 
different WinGLink database, additional dialog windows open 
prompting you to select the database name (if you selected 
external database) and to select the mesh to be imported. 

 3. In Import Step 2, select the source file. The file must be in the 
Randy Mackie format specified at the end of this chapter. 

 4. In step three of the import process, specify the units of the data 
source: 

 
 

 5. In Import Step 4, specify the mesh attributes, including mesh 
description – which also functions as the mesh name, location 
of the rear top left corner as well as the angle to which the mesh 
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is to be rotated: 

 
 6. After specifying the mesh properties, a window opens with a 

text entry box into which you can enter any notes you would 
like make regarding the mesh. These notes can be viewed and 
modified later in the mesh properties window (File | 3D Model 
Mesh Properties). 

 7. In the final step, WinGLink performs the import operation. 
Import progress and any encountered errors are displayed on 
screen. 

Creating Meshes 
The MT 3D Modeling program also provides functionality for creating 
meshes within WinGLink. The mesh generation wizard can be started 
with the File | New menu command or by actuating the New Mesh 
button, located at the far left end of the toolbar. As described below, this 
wizard presents several dialog windows for entering the parameters 
necessary for mesh creation. 

In the first of the mesh creation dialogs, you are prompted to enter a mesh 
description, which is also used as the mesh name throughout the 
database. A notes field is provided in which any information relevant to 
the mesh can be entered. 

Click the Next button to open the second of the dialog windows. Here, 
location-specific parameters and values for basic mesh properties can be 
entered: 
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X,Y,Z: mesh coordinates on the project datum  

dx, dy: initial block dimensions in the x and y directions, respectively. 
The actual block dimensions will be set on the fourth and fifth wizard 
dialog screens using a padding factor.  

Rotation: positive degrees of counterclockwise rotation about the top 
left, rear column  

Rho Value: starting resistivity of the model. We suggest looking at the 
high-frequency apparent resistivities from several soundings in the 
project and using a representative value. 

Air layers: number of air layers on top of the mesh (minimum: 7, ideal: 
10) 

Click the Next button after entering the parameter values to open the 
third wizard dialog window. 
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First Thickness: Note that this is actually be the first layer under the 
topography, which is added later. First, compute the skin depth for the 
model at the highest frequency. This can be computed by entering the 
value of the highest frequency in the First Freq. field Recall that skin 
depth = 500*SQRT(rho/freq). If we take 100Hz to be the highest 
frequency, and rho to be 10 ohm-m, then the skin depth is 158 m. With a 
flat earth, we recommend a value of 1/10 the skin depth for the thickness 
of the first layer (which would be 15 m in this case). When you add 
topography, you will be adding several layers of the same thickness on 
top, and, depending on the amount of topography, you will need to use a 
larger value in order to keep the model size at a reasonable level. A value 
as large as 1/5 of skin depth (maybe 1/3 if there is a lot of topography) 
may be best. In the example shown above, the thickness of the first layer 
is set to 50 m, which is 1/3 of skin depth. If the number of layers of 
topography is large, you may need to compromise to reduce the number 
of layers to reduce processing time. 

Vertical Factor and Layers: You can try various vertical factors to get a 
reasonable number of layers and a reasonable depth range. We 
recommend starting with a vertical factor of 1.2 and using 25-30 layers, 
as additional topography layers will be added later. We recommend that 
the thickness of the last layer to be approximately the same as the width 
of the first and last horizontal blocks. You can determine those widths by 
advancing to the next wizard dialog screen and entering the horizontal 
block size as the starting thickness and a padding factor of 1.5. After 
determining the width of these blocks, use the Back button to return to 
this wizard dialog screen. The number of layers to be contained in the 
mesh is set in the Layers field. Each of these layers is displayed with the 
corresponding layer thickness and the total thickness at each layer in 
green in the lower part of the window. 
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After entering the parameter values, click the Next button to open the 
fourth wizard dialog window, which is used to enter the parameters for 
determining the horizontal (x) block size: 

 
dx: Initial block dimension along the x axis. This value was entered in 
the first of the wizard dialogs and cannot be edited here. 

Last Layer Thickness: Thickness of the last layer used in the model. 
This value corresponds to the thickness of the layer specified in the 
Layers field on the previous wizard dialog and cannot be edited here. 

Padding & Padding Factor: The number specified in the Padding field 
determines the number of  padding mesh cells on either side of the first 
and last stations, respectively, along the x axis. The padding factor 
specifies the factor by which the width of the padding cells is increased 
as you move away from the mesh center.  
 
You need to look at the minimum and maximum cell dimensions, and 
determine what block dimensions will allow you to have a block for each 
site (or most of the sites), and still give a reasonable sized model. In some 
cases, the block size will be such that two or more sites will fall on the 
same block. In that case, you’ll have to eliminate all but one site. We 
recommend making the block size the same in both the x and y directions 
if possible.  

After entering the parameter values for the mesh size in the x direction, 
click Next to open the fifth wizard dialog window. Here, the parameters 
for the mesh size in the y direction are entered. As mentioned above, we 
recommend making the block size the same in both the x and y 
directions. 

Click Next to advance to the sixth wizard dialog. Here, the parameters 
related to topography are entered: 
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The Topography Max. and Min. values correspond to the maximum and 
minimum station elevations. The Dz Max. and Min. values are the 
minimum and maximum possible values which can be entered in the dz 
field. All four of these values are fixed and cannot be edited. 

Model Top: Sets the elevation of the upper-most block. If the value is set 
equal to the Max. elevation specified in the Topography frame, the 
topography will include the actual topography of all stations. If the value 
entered for model top is less than the max. topography value, the mesh 
will extend upward only to this value, effectively slicing off the top of the 
mesh. 

dz: Thickness of each of the topography layers. The min. and max. 
values are the values listed in the Dz Values frame of this dialog. Note 
that a small value will result in more layers and, therefore, additional 
processing time. 

After entering these values, click Next to display the seventh screen of 
the dialog wizard. Here, a display of the mesh is presented from above: 
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Click Next to proceed to the final wizard screen. Here, you are given the 
option of removing any isolated cells: 

 

 
An isolated cell is any top-level cell which is surrounded on all sides by 
air. This cells must be removed in order for the forward calculation to be 
completed properly. 

Click Finish to complete the mesh creation wizard. 

Exporting Meshes 
Meshes can be exported from the MT 3D Modeling program to files in 
the modified Randy Mackie format. Files exported in this way can be 
reimported into WinGLink. In addition to the 3D MT mesh file, two 
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additional files are also exported. A *.LCK file contains information 
about cell locking. This file is used by the stand-alone version of the 
forward calculation program. A file prefixed with SITES_ and post fixed 
with .DAT contains the mesh coordinates of each station, i.e. cell number 
and row number. This last file is currently used only for test purposes.  

To export a 3D MT mesh, select the Tools | Export 3D Mesh Model 
command to open the 3D Model Mesh Export window. Specify a file 
name and click the Save button. 

The Mesh Navigator 
After selecting a 3D mesh, the Mesh Navigator opens in its minimized 
state, as shown below. The Mesh Navigator is used to extract and display 
planes from the mesh along any of the principle axes. These planes are 
referred to as Views within WinGLink.  

 
Once one or more views have been created, the MT 3D Modeling 
program’s suite of mesh editing functions are enabled. For details on 
mesh editing, please refer to the “Editing meshes” section of this chapter. 

As mentioned above, the Mesh Navigator is initially displayed in its 
minimized state. Click the Maximize button to include a 3D display of 
the mesh in the Mesh Navigator: 
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The Mesh Navigator serves to extract sectional views of meshes. The red 
slice displayed in the mesh corresponds to the currently selected plane. A 
specific plane can be selected for a given axial view by entering the 
appropriate value in the Plane Number field. Alternatively, the arrow 
buttons can be used to cycle through the planes along a given axis, 
whereby the double arrows (<< >>) position the selected plane at the 
respective outer mesh edge. The slider bar located at the base of the 
Selected Plane section of the window, which includes the width/height of 
the current plane, functions in a manner similar to the arrow bars with the 
added feature that the arrow buttons on the keyboard can be used to cycle 
through the layers. If the Immediate Update checkbox is selected, the 
view is updated immediately following a plane change. If this checkbox 
is not selected, the Update View button must be clicked to initiate the 
update.  

As an alternative to the arrow buttons on the Mesh navigator, “Next 
Plane” and “Previous Plane” buttons located on the toolbar can be used to 
display each of the planes along a given axis:   

Mesh views may also include topography. To include the elevation data, 
select the Warped Sections checkbox. The section views created when 
this checkbox is selected are warped to fit the mesh to the topography.   

To extract a planar view from a mesh: 
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 1. Planar views can be extracted for the selected plane by clicking 
the Create View button: 

 
 2. Multiple views can be opened along any axis by pressing the 

Create View button multiple times. You may also change the 
mesh displayed in a given view window by first selecting the 
window to be updated, selecting a new plane in the Mesh 
Navigator, then clicking the Update View button.  

It is possible to zoom in on a particular area of the mesh displayed in the 
Mesh Navigator by repeatedly clicking the area of interest on the mesh. 
Click the Reset View button in the Mesh View area of the Mesh 
Navigator to restore the mesh to its original size. 

The compass displayed in the upper right corner of the view windows 
serves to provide a frame of reference for better user orientation. In the 
view window shown above, the mesh has been rotated +40 degrees as is 
indicated by the fine, red arrow. The compass display can be toggled on 
and off with the compass button on the toolbar: 

 
Once closed, the Mesh Navigator can be reopened by selecting the Mesh 
Navigator button from the 3D Modeling toolbar:  

 

About Views 
As mentioned above, views are planes extracted along one of the three 
principle axes. As is described in the Editing Meshes section of this 
chapter, editing operations on the mesh can be performed in these views, 
i.e. rows and columns can be added and deleted and resistivity values 
modified.  

The MT 3D Modeling program provides several display options for view 
windows. These options, which are accessible via the toolbar and/or the 
menu bar or shortcut menu, are described below. 
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A miniature version of the 3D mesh, called the Navigator Preview icon, 
is displayed in the toolbar and helps in mentally visualizing the relative 
location of the active view in the mesh:  

Button operations only apply to the currently active view window. A 
given button operation remains associated with a view window, even 
when simultaneously working with multiple windows, i.e. selecting the 
Split Row button in one view window does not enable the Split Row 
button for all other open view windows.  

The vertical axis may be displayed with either a linear or logarithmic 
depth scale. To switch between the two scales for either x or y plane view 
windows, right click on the view window to open the shortcut menu and 
select the desired depth scale: 

 

Show Rho Values 

 
Use this button to open and close the Select Rho Value window, which is 
similar to the range window found in the other WinGLink modules. This 
window is used when editing to select the active resistivity value. The 
active resistivity range is indicated in the Select Rho Value window by an 
arrow in the left-hand column. A range may be selected by either clicking 
a line in the Select Rho Value window or by entering a value in the 
Value field. Note that when selecting a value with the mouse, the lower 
range value is used as the active resistivity value when editing. The 
number of decimals shown in the display can be set in the Decimals field 
at the top of the window: 

 
The Rho Values window can also be toggled on and off using the View | 
Show Rho Values menu command.  

Select View 
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Use the Select View button to open the View Area window, which is 
used to define the bounding rectangle of the mesh displayed in the view: 

 
Changes made to the bounding rectangle in this window are reflected 
immediately in the Preview area. To fit the entire mesh within the 
window, click the Apply button next to the Fit To All Mesh label in the 
AutoRange area of the window . 

Fit Mesh 

 
The Fit Mesh button serves the same function as the Apply button in the 
View Area window: Click the button to fit the entire mesh to the active 
window.  

The fit mesh function, as well as many of the functions described in this 
section, can also be accessed via the shortcut menu, which can be opened 
by right-clicking a View Area window: 

 

Hide Mesh Lines 

 

Hide Fill Colors 

 

Zoom In/Out 
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When the Magnifying Glass button is selected, the degree of zooming 
can be controlled by clicking the left and right mouse buttons: left click 
to zoom in, right click to zoom out. 

User Zoom 

 
When the Crosshair button is selected, use the mouse to select an area of 
the view window. This selected area is then magnified to fill the entire 
window.  

Numerical Zoom 

 
To exit the User Zoom mode, click the Magnifying Glass button. Click 
this button again to exit Zoom In/Out mode. You can now select 
predefined numerical zoom values from the dropdown list. Selecting the 
User Zoom option disables the numerical zoom function and 
automatically selects the Crosshair button.  

All Zoom functions can also be selected using the View | Zoom View 
menu command. 

Pan View 

 
Use the Pan View button to move the area of the mesh which is 
displayed in the active View window. While in this mode, the cursor is 
displayed as a hand. The cursor returns to an arrow after the mouse has 
been used to shift the mesh position once, another toolbar button has been 
clicked, or another shortcut menu command selected. 

Editing Meshes 
Mesh editing can be performed in the MT 3D Modeling program 
provided one or more views are open. For details on creating views, 
please refer to the Mesh Navigator section of this chapter. 

Certain edit operations affect the entire mesh. For example, if a row is 
added in the X plane, the Y plane, if displayed, is automatically updated 
to reflect the addition. Other operations, such as edits to the resistivity 
values, affect only the current view. 

In MT 3D Modeling, edit operations are initiated by clicking the edit 
buttons and shortcut menu commands described below. Note that most 
edit functions do not have a corresponding command in the main menu. 

Undo/Redo 

 
The Undo button, the arrow button at the far left, remains disabled until 
an edit operation is performed. Once enabled, it can be used to stepwise 
reverse all actions performed with any of the edit functions. For example, 
if the Set Value function was used to change the resistivity values of five 
cells, then columns were deleted, the Undo button can be used to undo 
each of changes.  



 

A guide to using WinGLink MT 3D Modeling  •  19-17 

The Redo button, located to the right of the Undo button, remains 
disabled until the Undo button has been used at least once. It can be 
actuated to reverse the effect of the Undo function. Thus, it can only be 
actuated as many times as was the Undo button.  

The Undo and Redo functions can also be executed with the commands 
available on the Edit menu.  

Move 

 
The Move button is used to reposition the mesh relative to the real world 
coordinates. Because this function operates on the horizontal plane, the 
button is enabled only when a Z-plane is the active view window. To 
move the mesh, click the button; the cursor changes to a cross hair with a 
diagonal red arrow. Click the mouse anywhere in the mesh area and drag 
the mesh to the desired location: 

 
Deactivate the move function by again clicking the Move button. The 
new mesh coordinates are reflected in the mesh properties window (File | 
3D Mesh Properties) as well as any open Z-plane view window.  

Rotate 

 
Like the Move button, the Rotate button is use to reposition the mesh 
relative to the rear world coordinates. Here, however, the mesh is rotated 
around the pivot point of the mesh, the rear, left corner in the Z-plane. To 
rotate the mesh, click the button; the cursor changes to a cross hair 
surrounded by a circular arrow. Click the mouse anywhere in the mesh 
area and drag the mesh around the pivot point to the desired rotation 
angle: 
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Deactivate the move function by again clicking the Rotate button. The 
angle of rotation is reflected by the compass symbol, if activated, in the 
upper right corner of the view windows, in the mesh properties window  
as well as any open view window. 

Flag 

 
Using the flag option, rows or columns in any plane can be marked for 
easy reference. Once a flag has been set, a marker appears in all view 
windows which contain the given row or column 

To use, click the Flag button and select from either of the two displayed 
options: 

 
Then click the mouse on the row or column to set the flag: 

 
Flags can be toggled on and off by successively clicking the respective 
row or column.  

Whereas the Flag button in the toolbar can be used to mark rows or 
columns in all view windows containing the selected rows or columns, 
the Add/Remove Mark command, accessed in the shortcut menu (right-
click), serves the same function as the toolbar button.  

Compass 

 
As mentioned earlier in this chapter, the compass displayed in the upper 
right corner of the view windows serves to provide a frame of reference 
for better user orientation. In the view window shown above, the mesh 
has been rotated +40 degrees as is indicated by the fine, red arrow.  

Lock/Unlock 

 
The Lock button is used to lock and unlock resistivity values. Note, 
however, that the locked/unlocked status of cells is not used during the 
forward calculation performed within WinGLink. Locked cells are used 
only by the standalone version of the forward code.  

Users of the standalone version of Randy Mackie’s 3D forward code can 
make use of this feature by locking cells as described below, then 
exporting the 3D mesh model to an external file. The export function 
actually exports three files: a file which contains the mesh model (*.out) 
a file which contains the lock state of each cell (*.lck) and a third file 
(sites_*.dat), currently used only for test purposes, which contains the 
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names of the stations located on the mesh. To export the mesh model and 
lock file, select the Tools | Export 3D Mesh Model command. 

The resistivity values of locked cells remain fixed during the forward 
calculation only when using the standalone version of the code.  

Locked cells are displayed in the view windows with a dotted grid. To 
lock/unlock cells, click the Lock button to enter locking/unlocking mode. 
Immediately after clicking the button into the down state, a shortcut 
menu appears with two menu commands: Lock and Unlock. Click the 
appropriate command. The four buttons to the right of the Lock button, 
which are described below, can now be used to lock/unlock individual 
cells, rows, columns and regions on the mesh. 

Note that the locking/unlocking functions apply only to the current view 
in the active view window. You cannot, therefore, lock all cells in a given 
column by, for example, locking a cell in the top Z plane.  

Cut on Topography 

 
The Cut on Topography function is used to set the resistivity of cells 
positioned above the topography to the fixed resistivity value for air. 

Set Value 

 
To set the resistivity values of individual cells, select the Arrow button. 
Cells clicked while the Arrow button is down are assigned the resistivity 
value active in the Rho Value window. Similarly, if locking/unlocking is 
enabled (Lock button down), use the Arrow button to lock cell values.  

Mesh ranges can be edited as elsewhere in WinGLink by using the Range 
Editor, which can be opened by selecting the Edit Ranges command on 
the Range menu. Refer to the Common Functions chapter of this manual 
for details. 

Row/Column Selection 

 
Click the Row/Column button to open a shortcut menu which lists 
several selection options. As long as the button is in the selected state, 
cell locking/unlocking or setting of resistivities is performed by row or 
column. 

Wide Selection 

 
The Wide Selection button is used to lock/unlock cells or set resistivities 
for all cells to the left, right or below the selection point on the view 
window. The behavior of the Wide Selection button is dependent on the 
menu option selected from the shortcut menu which appears when the 
button is clicked. 

Band Selection 
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The band selection locks/unlocks cells or sets cell resistivities for a 
region of the mesh defined by a rectangle created by clicking and 
dragging the mouse across the view window. 

Split Row/Column 

 
Click the Split button to open a shortcut menu which lists options for 
rows and columns. After making the appropriate selection, move the 
mouse over the active view window. Position the mouse pointer, which is 
now displayed as a pair of scissors with a miniature crosshair, at the point 
where the row or column to be split and click. After clicking, the row or 
column is split in two at the crosshair. Both halves retain the resistivity 
values of the original row or column. 

Delete Row/Column 

 
As with the Split button, after clicking the Delete button, a shortcut menu 
opens which lists options for rows and columns. Make the appropriate 
selection and position the mouse over the active window. Place the 
mouse pointer, which is now displayed as a box with a red cross and a 
miniature crosshair, on the row or column to be deleted. The row or 
column under the crosshair is deleted after clicking the mouse.  

When deleting rows, the row directly under the deleted row is extended 
upward. When deleting columns, the column to the immediate right of 
the deleted column is extended towards the left. The exception to these 
rules are the deletion of the bottom row or right-most column. In these 
cases the row above the bottom row is extended downward or the column 
to the left of the right-most row is extended rightward. 

Redim Row/Column 

 
Row and column dimensions can be modified by clicking the Redim 
button. As with the Split and Delete buttons, a shortcut menu opens 
which lists row and column options. After selecting an option, position 
the mouse over the active view window. The mouse pointer changes to 
either a horizontal or vertical double-ended arrow when positioned on a 
mesh line. By redimensioning the right-most column and bottom-most 
row in a view window, it is possible to resize the mesh.  

Value shifting 

 
The mesh values displayed in a given view window can be shifted to 
either the left or right using the horizontal shift buttons at the right end of 
the toolbar. The Shift Left and Shift Right buttons, located at either side 
of the Shift Values (horizontal) button with the double arrows, move all 
cells by one column to the left or right, respectively. When shifting to the 
left, the far-right column retains its values. Likewise, when shifting to the 
right, the far-left column remains unchanged. The Shift Up and Shift 
down buttons on either side of the Shift Values (vertical) button at the far 
end of the toolbar can be used to shift values up and down, respectively. 
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The horizontal and vertical Shift Values buttons can be used to shift the 
mesh by any number of columns to either the left or right / up or down: 

 
The Shift Values windows can also be accessed on the shortcut menu by 
right-clicking and positioning the mouse over the Value Editing option. 

Note that values are shifted only on the selected plane. To shift  
resistivity values for all planes, the operation must be repeated 
throughout the model.  

Value Editing 
The Copy Rho Values and Copy Lock Values commands can be used to 
copy all rho or lock values from one view window to another view of the 
same plane, to a range of planes or for the entire model. These commands 
are accessed on the View Window shortcut menu, which is opened by 
right-clicking a view window,  then positioning the mouse over the 
Value Editing command: 

 
To copy either rho or lock values from one view window to another, 
select the respective command, open a new view window of the same 
type, i.e. X, Y or Z plane, then select the Paste Values command from 
the shortcut menu in the target window. The copied rho or locked values 
can be copied to all like-type planes in the model by selecting the Fill 
Model with Values command. Use the Bounded Filling command to 
specify a range of planes over which the fill command is to apply: 
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View Area Editing 
The view area displayed in one view window can be copied to another 
with the View Area Editing commands. Resistivity and lock values are 
not copied when using this command, rather the actual mesh view area is 
copied from one view to another of the same type.  

The Copy View Area command can be accessed on the View Window 
shortcut menu by positioning the mouse over the View Area Editing 
command to open a submenu. To copy the view area from one window to 
another, select the Copy View Area command in one window, then 
select the Paste View Area command from the shortcut menu in the 
target window.  

Anchor Function  
The anchor button, which is enabled for Z-plane and map views, is used 
to control how the mesh position is recalculated when deleting rows and 
columns. If, for example, an anchor is placed on a column with index i 
and the you use the Destroy Column function to delete a column with an 
index > i, the locations of the columns with an index < i remain fixed. 
Thus, this tool gives the user control in how columns and rows are 
deleted. Note that this function is not available for the X- and Y-planes.  

Editing Meshes: Differences Between the MT 2D 
Inversion and MT 3D Modeling Programs 
The edit functions in the MT 3D Modeling program are similar, however 
not identical, to those available in WinGLink’s 2D Inversion program. 
The principle difference is the way in which rows and columns are added 
and deleted.   

Adding rows/columns:  
In the 2D Inversion program, rows and columns are actually added. New 
rows and columns are assigned the resistivity value currently selected in 
the Rho window. In MT 3D Modeling, on the other hand, rows and 
columns are not added, but rather split. A given row or column is divided 
into two: both halves retain the resistivity value(s) of the original 
row/column. 

Deleting rows/columns: 
To delete a column in MT 2D Inversion, you must click the line which defines a 
given row or column. In MT 3D Modeling, you instead position the crosshair on 
the row or column which is to be deleted.  

Destroying rows/columns 

Unlike the Delete rows/columns function, which effectively  merges two adjacent 
rows or columns, the Destroy functions actually remove the selected row or 
column from the mesh. Thus, execution of the Destroy commands, results in a 
change in the mesh dimensions. To execute the commands, press the Row / 
Column Destroy button (10th button from right in the toolbar) and then select  
appropriate function (Row or Column): 
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Additional edit functions: the Edit menu 
A number of additional edit functions can be accessed via the Edit menu: 

 

Replace Values 
Use Replace Values to swap all cells with a given resistivity value with a 
specified resistivity value: 

 
The number of replaced resistivity values is displayed in the Replaced 
field. 

Replace Range 
This function is similar to the Replace Values function, the difference 
being that min. and max. values are specified. Resistivity values between 
and including these two limits values are replaced by the specified 
replacement value: 
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Note that the min. value cannot be less than and the max. value cannot be 
greater than the respective min. and max. resistivity values in the model. 
These values are displayed to the right of the Min. and Max. fields in 
parenthesis.  

Remove Isolated Cells 
In order for the forward modeling code to function properly, there must 
not be any isolated mesh cells, i.e. cells without neighbors, which 
protrude from the top of the mesh. These can occur during the creation of 
relatively coarse meshes when using topography. To remove all such 
cells from the model, select the Remove Isolated Cells command. 

Show Air Check 
This function runs a check to ensure that there are no air cells located 
below the model topography. 

Show Station Check 
After running a forward calculation, it is possible to generate an EDI file which 
contains the forward response at a given cell. While it is possible to position more 
than one station on a given cell, the EDI files generated for all stations on a 
particular cell will be identical. To ensure that there is not more than one station 
on any cell, execute the Station Check command: 

 
All cells which contain multiple stations are listed. Either individual stations or 
all stations on a given cell can be deactivated.  

Exported site files can be read into the MT 3D Modeling program via the Run 
Site File button. By working with various site files, it is possible to quickly 
change the stations which are used with a given forward calculation.  
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Station states can be exported to so-called site files with the Tools -> Export Site 
File menu command. 

Station Decimator 
This function gives you the option of extracting a subset of soundings 
from all available soundings. Use the X and Y direction fields to specify 
the decimation factor along the respective axes. Every nth sounding is 
extracted according to the values specified here: 

 

Show Station Status Editor 
Unlike the Station Check window, which can be used to edit stations in cells 
which contain multiple stations, the Station Status editor can be used to edit the 
states of all stations: 

 
Station states can be exported to so-called site files with the Tools -> Export Site 
File menu command and reimported into WinGLink in the Station Check window 
as described under Station Check. 

Remove Air Layers 
Use the Edit | Remove Air Layers command to remove all planes which contain 
only air. 
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Remove Isolated Values 
The Edit | Remove Isolated Values command is used to remove cells with 
isolate values (with respect to the surrounding cell values). 

Station Data Options 
1D models for MT stations as well as layered/numerical data may be 
superimposed on vertical sections, i.e. X and Y views.  

To Display 1D Models for MT stations 
 1. In order to display 1D models, first open the Project Window 

(View | Show Project Window) and check the “S” checkbox 
of any projects for which the 1D models are to be displayed. To 
display station names and resistivity values, check the “N” and 
“V” checkboxes, respectively: 

 
 2. Display the 1D models by selecting the Show 1D Layer Data 

command from the View | Station Data Options menu 
extension: 

 
  When the Show 1D Layer Data option is enabled, the 1D 

model of any MT station for which a model has been created is 
superimposed on the 3D mesh, provided the station is located in 
the current view window: 

 
 3. To toggle between the colored resistivity values in the 1D 

models and a vertical line with simple tic marks which indicate 
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changes in resistivity value, select the Change 1D Layer Style 
option from the Station Data Options menu extension. 

To Display Wells, Layered Data and Numerical Data 
 1. As with 1D models, in order to view the well data, the “S” 

checkbox in the Project Window  (View | Show Project 
Window) must first be selected for the project which contains 
the well data. Well traces can be toggled on and off by 
selecting/unselecting  the “S” checkbox; well station names and 
values can be toggled on and off with the “N” and “V” 
checkboxes, respectively. 

 2. Next, make the appropriate selection from the View | Station 
Data Options menu extension. After selecting either Show 
Well Layer Data Window or Show Well Numerical Data 
Window, the respective data window opens which lists the 
available data types: 

 
  The selection is immediately reflected in the view window. 

To Export Data in txrx Format 
Stations can be exported in the Randy Mackie txrx format: by executing 
the Tools | Export rx and tx files menu command: 

Additional Display Functions 
Several other display functions are available under the View menu item 
in addition to those listed above: 

Select Interface Grid 
  The View | Select Interface Grid menu command is used to 
superimpose a profile extracted from a selected elevation grids. Upon 
selection of the menu command, the following dialog box opens: 
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Here, you can the projects from which the elevation grid is to be 
extracted as well as the color with which the extracted elevation profile is 
to be displayed on the mesh. Extracted profiles are displayed only on 
vertical sections. 

Mesh Properties 
Mesh properties, including name, position and number of air layers can 
be edited in the Mesh Properties window. To open this window, select 
the File | 3D Model Mesh Properties command: 

 
Description: Mesh name 

Mesh position (x,y,z): Coordinates on the project datum  

Rotation: Positive degrees of counterclockwise rotation about the top 
left, rear column  
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Air layers: Number of air layers on top of the mesh (minimum: 7, ideal: 
10) 

lx, ly, lz: Actual mesh dimensions 

Notes: Any information you would like stored together with the database 

Swap Mesh Function 
With the Swap Mesh function, which is located on the File menu, you 
can change the corner which is used as the pivot point for the model i.e. 
change which corner be used as the upper left corner of the model. When 
applied to a mesh, a copy of the mesh is translated in such a way that the 
area covered by the final mesh is the same as that covered by the original 
mesh. 

To Swap a Mesh: 
 1. Select the Swap Mesh function on the File menu. If a mesh is 

currently open, the program prompts you to close the mesh.  

 2. In the Mesh Swapping window which opens, select the mesh to 
which the Swap Mesh function is to be applied: 

 
 3. With the mouse, click the corner which is to be defined as the 

new pivot point. When selected, a red square appears on the 
corner: 

 
 4. After selecting the new pivot point, enter a new mesh name in 

the Description field. 

 5. To translate the mesh to the new pivot point, click the OK 
button. A progress window appears in the status bar of the main 
window. Once the translation process has completed, the Mesh 
Swapping window closes. 
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 6. The translated mesh covers the exact same area as the original. 
The only difference is the position of the pivot point. This is 
indicated by the a corresponding change to the compass 
direction. Any rotation operations now performed on the mesh 
now rotate around the new pivot point.  

Printing Mesh Views 
The MT 3D Modeling print form is called up with the File | Print 
command: 

 
Individual or ranges of mesh planes can be printed. In addition to the 
meshes themselves, legends, text boxes and other relevant information 
can also be printed. 

Before printing, specify the planes to be printed as well as the area of the 
mesh to be printed. The view area to be printed can be set either manually 
in the Set View Area section of the window, or using the Fit All, User 
Zoom and Pan View buttons located in the lower-right corner of the 
window. If desired, horizontal and vertical scaling factors may be set in 
the Scale Factors section of the window.  

Mesh lines and fill colors are printed by default. To disable these, or 
enable mesh warping, make the appropriate selections in the Drawing 
Options section at the bottom of the window. 

On the Page Layout tab of the Print Form window, you can select and 
position various display elements including, among others, mesh, color 
ranges and text descriptions. The number of units printed on each page 
can also be selected here.  

Even though up to four meshes can be printed per page, you can quickly 
generate more printouts than intended if the planes to be printed are not 
selected correctly on the 3D Model tab of the dialog box. 
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Forward Model Calculation 

Overview 
The forward model calculation performed in the MT 3D Modeling 
program makes use of the MT3FWD code written by Randy Mackie: 
Developed in 1999, MT3FWD is a program to compute magnetic and electric fields at the 
surface of a 3D electrical resistivity model illuminated by electromagnetic plane waves. It 
is a modified version of D3MTFWD2 released by Mackie and Madden in 1997. The MT 
3D modeling algorithm uses the integral form of Maxwell’s equations to derive a finite 
difference approximation for the magnetic field that is second order. Non-divergence of 
the magnetic field is enforced by evaluating the magnetic and electric fields on grids that 
are staggered relative to one another. The resulting linear system is solved by pre-
conditioned conjugate gradient relaxation. Convergence is considerably enhanced by 
explicit correction of residual failure of the non-divergence condition. The algorithm is 
discussed in Mackie, Smith & Madden* (1994). However, the program does not employ 
the coordinate transformation that converts an isotropic model on a non-uniform grid to 
an anisotropic model on a uniform grid.  

The program assumes that 2D structure parallel to each edge continues uniformly to 
infinity in the direction normal to the edge. The tangential magnetic fields are assigned 
using 2D calculations for each edge. The edges parallel to the source magnetic field will 
have electric current flowing normal to them and so TE mode calculations are done. The 
edges perpendicular to the source magnetic field will have current flowing parallel to 
them. In these cases, the tangential magnetic fields are zero. 

Relaxation is faster if a good estimate of the solution is provided at the start. The program 
interpolates the vertical boundary fields to form the initial guess in such a way that the 
fields should already be a solution to the interior fields if the model is 2D rather than 3D.  

*[Mackie, R.L., Smith, J.T. and Madden, T.R., Three-dimensional electromagnetic 
modeling using finite difference equations: the magnetotelluric example. Radio Science, 
29, 923-935, 1994.] 

Forward Calculation 
Required for input is a 3D MT mesh in the slightly modified Randy 
Mackie defined at the end of this chapter. All 3D MT meshes which are 
imported into or created in WinGLink fulfill this requirement.  

To set the parameters for the forward calculation for the loaded 3D MT 
mesh, select the Tools | Forward 3D Model Mesh menu command. The 
3D Forward Process dialog box opens: 
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3D Forward Parameters 
Min. Error: Error level at which the forward calculation is stopped.  
(1E-4  - 1E-6 recommended) 

Relaxations: 50-100 recommended 

Air layers: Min. 7, 10 recommended 

Convergence factor: Provides control over the speed at which 
conversion is reached. A higher value, e.g. 8, *may* reduce the number 
of iterations required for convergence at the expense of requiring 
additional memory.  

Periods: 

Min Period: Specifies upper bound of frequency range over which 
fitting is tried 

#Decades: Number of decades to be used. Maximum period used is thus 
equal to the minimum period *10^number of decades 

#Periods per Decade: Number of periods per decade 

1D Basal Model: 
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The 1D basal model is used to set the bottom impedance condition that 
relates the E and H fields at the bottom of the model. It can be a 
homogeneous half-space model or a layered 1D model. 

Thickness: Layer thickness in meters 

Resistivity: Layer resistivity in ohm.m 

Save Output 
The forward calculation returns field values which are then transformed 
into MT impedances for the purpose of generating EDI files. The field 
values are automatically stored in the database when the mesh is saved. 
The values may also be written to an external file.  

Save to File: Saves the field values to an external file (*.rslt). When 
saving to a file, click the browse button to specify the name and path of 
the file to which the fields are to be written. Files stored using this option 
can be opened in the EDI Export window and used to export EDI files for 
any MT station located on the mesh.  

Time Requirements 
The time required to perform the forward calculation varies dramatically 
(approximately cubically) depending on the mesh size. During testing, a 
forward calculation performed on a sample 20x20x20 mesh using 1 
decade and 3 periods on a 1.4GHz, 512MB RAM computer required 2 
minutes. A 35x35x35 mesh, on the other hand, required nearly 20 
minutes. A progress bar and message box in the 3D Forward Process 
window provides information on the status of the calculation. 

Starting the Forward Calculation 
To start the forward calculation, click the Start button in the 3D Forward 
Process window. If the Save to File checkbox is selected, the Start 
button is not enabled until a file has been selected using the Browse 
button. 

The error of each iteration is displayed in the text box in the lower area of 
the 3D Response window. 

The Stop button can be used to terminate the calculation. 

Exporting EDI Files 
The MT impedance and tipper values calculated from the field values 
returned by the forward calculation can be used to generate EDI files. 
These impedance and tipper values, located either in memory or in an 
external file, can be used, in principle, to generate EDI files for any mesh 
column. The EDI export is, however, limited to columns containing at 
least one MT station. The EDI files of stations associated with the same 
column are identical except for the station names.  

Stations can be added and removed, as well as activated and deactivated, 
in the Maps program. (Refer to Chapter 4, Maps, for details.) Note that 
stations do not need to be active or even exist when calculating the 
forward model, i.e. they can be added after performing the forward 
calculation.  
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To export EDI files for stations associated with a mesh: 

 1. On the Tools menu, select the Export EDI File command. 

 2. The EDI Export window opens: 

 
 3. In the Data Input area of the window, specify the location of the 

impedance/tipper values. 
 
If you have performed a forward calculation during the current 
MT 3D Modeling session or if a forward calculation has been 
performed using the current mesh and the impedance values 
were stored in the database, the from Memory option is active 
in the Data Input area of the window. If not, only the from File 
option is available. External files must be files containing 
impedance values generated by the MT 3D Modeling program, 
i.e. result files generated by the stand alone version of the 3D 
forward program cannot be used. 
 
If the from File option is selected, the EDI export cannot be 
started until the file has been specified.  

 4. Click the Locate button in the Data Input area of the window to 
open the Locator window: 
 

  
 
Use the X and Y fields to adjust the position of the mesh 
relative to the stations. The Rotation field may be used to 
change mesh rotation. Changes made here are not permanent 
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and are thus not reflected in the mesh properties window or 
elsewhere in WinGLink. 

 5. Displayed in left portion of the window is a view of the top 
plane of the 3D mesh including all stations contained in the 
project. Use the two checkboxes Draw Wired Frame and 
Draw Shade, located at the base of the window, to change the 
mesh display.  

  The current position of the mouse pointer on the mesh is 
indicated in the X and Y fields at the bottom of the window. 

 6. Select the Include Attached Project Stations checkbox to 
export EDI files for all MT stations positioned on the mesh 
which are contained in projects attached to the current project 
in addition to those contained in the current project.  
 
For details on attaching one project to another project, please 
refer to section “Attaching a Project to another Project” in 
Chapter “Getting Started”. 

 7. After specifying a destination folder for the EDI files in the 
Output Folder field, click the Start button to begin the export 
process. The export status is indicated by a progress bar.  

Exporting 3D Grid Files 
Not only can 3D MT meshes be output to mesh files which conform to 
the Randy Mackie 3D MT mesh specification, but they can also be output 
to uniform 3D grid files in either the Slicer format or as Dataset files. To 
export a 3D mesh to a uniform 3D grid, select the Tools | Export 3D 
Grid File menu command to open the 3D Grid File Export dialog box: 

 
Specify the planes to be included in the file and the spacing to be used in 
each of the planes. After specifying the file type and an output file name 
in the Output section of the dialog box, click OK to export the file.  

Note: 3D Grid files exported using the Export 3D Grid File command 
cannot be reimported into WinGLink.  
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Randy Mackie 3D Mesh Specification 
The mesh format is that specified by Randy Mackie plus an additional 
data block, located at the end of the file, which contains georeferencing 
information. 
 
NX, NY, NZ (#’s of blocks) [Nair (layers)], [MAP. 
VAL[UES]] 
X block sizes (NX values in meters)  
Y block sizes (NY values in meters)  
Z block sizes (NZ values in meters)  
1 (layer #)  
NX*NY codes or values in free format: x varies 
fastest  
-----  
-----  
NZ (layer #)  
NX*NY codes or values in free format: x varies 
fastest  
0. resistivity(for code 1) resistivity(for code 
2) ....  
resistivity(for largest code) [resistivity for 
sea water]  
end (optional termination text) 
----- 
----- 
WINGLINK 
ABC (site name) 
I J (block numbers) 
0000.000 0000.000 (real world coordinates) 
0 (rotation) 
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20:  TDEM Soundings 

Overview 
 

 

The Soundings icon is displayed in the program menu whenever a 
sounding project is selected. 

When a sounding project (MT, TEM, DC, etc.) is selected and the 
program launched, the stations of the selected project are loaded 
together with their original datasets.  

The discussion in this chapter is limited to the TDEM Soundings 
program. 

For each station, this program can be used to: 

• Display sounding curves, either as resistivity or voltage 
values vs. time 

• Edit sounding data 

• Compute a 1D smooth and layered inversion model 

• Export data (TEM format) 

As described at the end of this chapter, many of the functions available 
for individual soundings can also be performed in batch mode on any 
number of soundings contained in the current project. 

About Editing 
The results of any editing on sounding data will be saved in the "edited 
data" section of the database. Original data will not be overwritten and 
can always be restored using the menu command: File | Reload Original 
Data. 

The edited data saved by the Soundings program are used by other 
WinGLink programs: 

• Smooth and layered 1D models are used to calculate imaged 
sections and cross sections, respectively. 

• Curves and 1D models are also used to extract parameter 
maps by the Maps program.  
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Sounding Data Which are Saved in the Database 
For each station of the current project, the following datasets are saved in 
a WinGLink database: 

Original Data 
Apparent resistivity as imported from external files. Original curves can 
always be recovered to restart the editing process using the Soundings 
menu command File | Reload Originals. 

Edited Data 
Edited curves are initially constructed by assigning to each datapoint the 
same value of the original curves. At the end of each editing session, the 
edited values are saved in the database, separately from the original 
values. 

Smooth 1D Model  
One smooth model is saved for each sounding. This provides a 
preliminary guess model for the layered inversion routine and is also used 
to produce imaged sections along profiles. 

Layered 1D Model 
One layered model is saved for each sounding. These models are 
displayed along profiles by the Cross Sections program. The 1D curve 
used to calculate the layered model is the same curve used for the smooth 
model. 

Opening, Saving and Printing Sounding Data 

To Open Soundings from the Station List 
 1. Select the File | Open from List menu command. 

 2. Select the station(s) you wish to open: 

   
 3. If you want to display only the active stations, select the Active 

Station check box. 

 4. Click the Open button. 
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To Open Soundings on the Station Map 
Select the File|Open from Map menu command; a simplified location 
map for the project station is displayed: 

 

Open Soundings by Clicking Individual Stations: 

 1. Click the  button. 

 2. Click the stations you wish to open; the selected stations turn to 
red: 

 

 3. Click the  button. 

Open All Soundings Within a Given Area: 

 1. Click the  button. 

 2. Left-click the mouse on a corner of the area of interest and drag 
it to define a rectangle on the map. When releasing the mouse 
button, all stations in the rectangle will turn to red. 

 3. Click the  button. 

Open All Soundings Associated with a Profile Trace: 

 1. Click the  button. 

 2. Left-click the mouse on the profile or on a segment of the 
profile trace of interest. All stations previously added to that 
profile trace will turn red, indicating selection. 

 3. Click the  button. 
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Display Options 
Each window can be set to show the resistivity/voltage curves or the 1D 
model for each sounding. 

On the View menu, select from the available display options: 

 

Setting Diagram Ranges and Scale 

To Set the Ranges and Scale for the Plot Diagrams: 
 1. On the View menu, select View Options: 

 
 2. For each parameter, set the automatic range option or enter the 

max. and min. values to be plotted. The axis scale can be set to 
linear or logarithmic for many plots. 

 3. The settings made here apply to all window. 

Sounding Properties 
An overview of the sounding properties can be displayed by selecting the 
File | Sounding Properties menu command: 
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With the exception of the Corrective Time Shift field, all fields 
displayed here are read only. The Corrective Time Shift field can be 
used to enter a corrective time shift, e.g. in the event that the value was 
entered incorrectly during data acquisition.  

Printing Curves and 1D Models 

To Print Station Curves 
 1. Select the station by clicking on its window; 

 2. Select the File | Print menu command. 

 3. Select the printing options and click the Print button. 

Exporting TEM-Format Files 
To facilitate the exchange of TEM soundings between projects and users, 
station soundings can be exported to TEM-format files. The TEM format 
is a text-based format specified by Geosystem originally created for the 
purpose of simplifying the import of TEM data into WinGLink, 
regardless of data type, e.g. Sirotem, Geonics or Zonge.  

To export a TEM sounding to a TEM-format file, select the File | Export 
command from the Soundings menu. 

TEM files, created either using the TemMerge program or exported form 
the Soundings module, can be imported into WinGLink as described in 
the “Data Import” chapter of this manual. 

Note regarding inconsistencies between input and output TEM files:  
Due to data normalization procedures, exported TEM files may not 
necessarily be identical to the TEM files used for input. This is 
particularly true of Geonics soundings which may contain up to three 
curves. In this case, the second and third curves are normalized to the 
current, TX area, and RX area of the first curve.  
In addition, as not all descriptive information contained in the input TEM 
file is stored in the database it is not included in the output TEM file.  
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Editing Sounding Data 

The Edited Curve 
When sounding data are imported into a WinGLink database, they are 
saved as “original data” in a reserved area of the database and are never 
modified unless new data are imported. At the same time, a duplicate 
dataset is generated and saved in a different area of the database for use 
by editing functions. When an editing session is carried out on the 
sounding data, it is carried out on this second dataset, which is referred to 
as the “edited curve” of the sounding. 

Saving changes following an editing session means saving an edited 
curve. This curve is used by default in calculating 1D inversion models 
and pseudosections. 

Interactive Sounding Editing Form 
TDEM sounding data can be edited in the interactive sounding editing 
form, which is opened with the Edit menu command: 

 
The form includes commands for performing various editing functions: 

Selecting Data Points 

 Single point selection 

Click to select/unselect for editing single data points on the curve. 

 Multiple points selection 

Click to select/unselect for editing all data points included in a user-
defined range: click and drag the mouse to define the area. 

Zooming in on the Curve 

 Zoom in 

 1. Click a point in the curve diagram and release the button. 
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 2. Move the mouse to define the zoom area. 

 3. Click and release the left mouse button. 

  Zoom out 

Click to reset the previous view.  

Note: this button is available only after the Zoom in button has been 
used. It remains available until the original curve size is restored. 

Saving Editing Changes 

 Save button 

Saves the editing changes. These changes must be confirmed when 
closing the station window in the main menu in order to store them in the 
database. 

Editing Data Points 

 Masking data  

 1. Click and select the points by single or multiple selection (the 
masked points will turn gray). 

 2. Click the Mask button again to confirm the changes. 

 3. The points will be hidden from the display 

 4. Click the Mask button again to restart the masking/unmasking 
process. 

 
 Shift data points 

 1. Click and select the data points to be shifted by single or 
multiple selection. 

 2. Move the data points to the desired positions and click the left 
mouse button. 

 3. Click the Shift button again to confirm the action. 

Note: The Shift button is enabled only if the sounding curve is plotted as 
voltage vs. time. Use the View button at the bottom of the Edit window 
to toggle between resisitivity and voltage views. 

 Cancel the current action 

 Undo button 

Undo all the editing changes made since the last time the curve was 
saved. All editing steps can be undone provided the station has not yet 
been saved since editing. 

Reloading Original Curves 
This action overwrites the edited curves of a station with the original 
curves. 
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To reload original curves: 

 1. Select the station by clicking its window. 

 2. Select the File |Re-Load Original command. 

After reloading, the smoothed curves and the 1D models need to be 
recalculated. 

1D Inversion 

1D Inversion: Overview 
The 1D Model command starts the inversion program for the station 
whose window is currently active.  

The main steps involved in the inversion process are: 

 
Set curves to use 
for inversion 

The inversion can be run using the edited or 
smoothed curve. The curve selection button, 
located on the bottom bar, allows the user to 
change the selected curve at any time. The 
models must be recalculated when the curve 
to be used is changed. 

Calculate the 
smooth inversion 
model 

For each station, one smooth model is 
calculated and stored in the database. This 
model will be used to produce imaged 
sections for the project. 

Guess the layered 
inversion model 
from the smooth 
model 

A layered model can be guessed from the 
calculated smooth models. The number of 
layers is entered by the user by editing the 
inversion settings or by editing the model 
with interactive graphic commands. 

Edit the initial 
model using the 
graphic model 
editor (optional) 

An interactive graphic editor allows the 
editing of layers thicknesses and resistivities. 
The response is displayed in real time. 

Run the inversion 
and save the model 

The inversion process can be run with a 
given number of iterations and predefined 
RMS fitting degree. Resistivity and/or 
thickness values of one or more layers can 
be kept fixed. 
 

 
 

The 1D Inversion Window 
The following figure shows the 1D inversion window: 
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Curve Selection 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Use the   button, located at the bottom of the form, to 
display the apparent resistivity or voltage curve. 

To Calculate Smooth Models 
 1. Use the 1D Model command to enter inversion mode for the 

active sounding. 

 2. Use the  button to compute a smooth model: 

 

To Guess the Layered Model from the Smooth Model: 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Calculate the smooth model (magenta lines), if you have not 
already done so. 

 3. Click the  button. 
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 4. The layered model is guessed (green lines). 

To Import a Model Created for a Different Station 
 1. In 1D Modeling mode, click the Edit button to open the 1D 

Model Parameters dialog: 

 
 2. Here, click the Import button to open a dialog box which 

contains all available stations: 

. 

 3. Select the desired station and click Import. Note that any 
changes to the imported model are not reflected in the original 
model. 

To Run the Layered Inversion: 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Click the  button. 

 3. The inversion is started using the model shown with green lines 
as the starting model and the inversion parameters set for the 
sounding. 
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Graphic Editor for 1D Layered Models 
The layered model can be edited graphically using drag-and-drop 
operations.  

The resulting resistivity curve is updated in real-time, allowing you to 
compare the fit with the observed curve. 

To Graphically Change the Resistivity of a Layer: 
 1. Click the vertical line which denotes the layer’s resistivity. Two 

black dots appear on its edges indicating that this line can be 
moved: 

 
 2. Release the mouse. 

 3. Move the mouse pointer to the selected line; the arrow pointer 
changes to a double-headed arrow. 

 4. Left click and hold down the button; drag the line to the new 
layer resistivity delimiter position. 

 5. Release the mouse button. The resistivity curve coming from 
the layered model is recalculated and redrawn. 

To Graphically Change a Layer’s Thickness 
 1. Repeat the procedure used to change a layer’s resistivity, but 

instead select one of the horizontal lines which delimits the 
layer and move it to the desired position. 

Batch Commands & Quick View 

Running Operations in Batch Mode 
A group of batch procedures are available for performing selected 
operations on a set of user-selected stations.  To start a batch procedure: 

 1. Close all open stations. 

 2. The Batch Tools command will appear on the main menu: 

 
 3. Select the desired operation. 
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 4. Enter the parameters as requested. 

Operations available in batch mode include: 

• Printing 

• 1D inversion modeling 

• Data export; batch window includes the 1D model worksheet 
function. 

Quick View 
The Quick View option, which is available on the Special menu item 
when no soundings windows are open, can be used to display multiple 
soundings in a single window. To open the Quick View window, select 
the Special | Quick View menu command: 

 
The Stations Map window, which can be toggled on and off with the 
corresponding check box in the upper right corner of the window, 
indicates the positions of the stations which are currently open (black 
squares) as well as the position of the active station (red square). 
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21:  DC Soundings 

Overview 
 

 

The Soundings icon is displayed in the program menu whenever a 
sounding project is selected. 

When a sounding project (MT, TEM, DC, etc.) is selected and the 
program launched, the stations of the selected project are loaded 
together with their original datasets.  

The discussion in this chapter is limited to the DC Soundings program. 

For each station, this program can be used to: 

• Display sounding curves as resistivity vs. AB/2 

• Edit sounding data 

• Compute a 1D smooth and layered inversion model 

• Import sounding data 

As described at the end of this chapter, many of the functions available 
for individual soundings can also be performed in batch mode on any 
number of soundings contained in the current project. 

About Editing 
The results of any editing on sounding data will be saved in the "edited 
data" section of the database. Original data will not be overwritten and 
can always be restored using the menu command: File | Reload Original 
Data. 

The edited data saved by the Soundings program are used by other 
WinGLink programs: 

• Smooth and layered 1D models are used to calculate imaged 
sections and cross sections, respectively. 

• Curves and 1D models are also used to extract parameter 
maps by the Maps program.  
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Sounding Data Which are Saved in the Database 
For each station of the current project, the following datasets are saved in 
a WinGLink database: 

Original Data 
Apparent resistivity as imported from external files. Original curves can 
always be recovered to restart the editing process using the Soundings 
menu command File | Reload Originals. 

Edited Data 
Edited curves are initially constructed by assigning to each datapoint the 
same value of the original curves. At the end of each editing session, the 
edited values are saved in the database, separately from the original 
values. 

Smooth 1D Model  
One smooth model is saved for each sounding. This provides a 
preliminary guess model for the layered inversion routine and is also used 
to produce imaged sections along profiles. 

Layered 1D Model 
One layered model is saved for each sounding. These models are 
displayed along profiles by the Cross Sections program. The 1D curve 
used to calculate the layered model is the same curve used for the smooth 
model. 

Opening, Saving and Printing Sounding Data 

To Open Soundings from the Station List 
 1. Select the File | Open from List menu command. 

 2. Select the station(s) you wish to open: 
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 3. If you want to display only the active stations, select the Active 
Only check box. 

 4. Click the Open button. 

To Open Soundings on the Station Map 
Select the File|Open from Map menu command; a simplified location 
map for the project station is displayed: 

 

Open Soundings by Clicking Individual Stations: 

 1. Click the  button. 

 2. Click the stations you wish to open; the selected stations turn to 
red: 

 

 3. Click the  button. 

Open All Soundings Within a Given Area: 

 1. Click the  button. 

 2. Left-click the mouse on a corner of the area of interest and drag 
it to define a rectangle on the map. When releasing the mouse 
button, all stations in the rectangle will turn to red. 

 3. Click the  button. 

Open All Soundings Associated with a Profile Trace: 

 1. Click the  button. 

 2. Left-click the mouse on the profile or on a segment of the 
profile trace of interest. All stations previously added to that 
profile trace will turn red, indicating selection. 
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 3. Click the  button. 

Display Options 
Each window can be set to show the resistivity/voltage curves or the 1D 
model for each sounding. 

On the View menu, select from the available display options: 

 

Setting Diagram Ranges and Scale 

To Set the Ranges and Scale for the Plot Diagrams: 
 1. On the View menu, select View Options: 

 
 

 2. For each parameter, set the automatic range option or enter the 
max. and min. values to be plotted. The axis scale can be set to 
linear or logarithmic for many plots. 

 3. The settings made here apply to all window. 

Printing Curves and 1D Models 

To Print Station Curves 
 1. Select the station by clicking on its window; 

 2. Select the File | Print menu command. 

 3. Select the printing options and click the Print button. 
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Importing Sounding Data 
In general, sounding data are imported into WinGLink using the import 
functionality provided in the WinGLink shell (see the “Data Import” 
chapter of this manual for details).The DC Soundings module includes an 
option, however, for importing new data into an existing sounding.  

Import functions are available for: 

- Text files 

- Keyboard entry 

Note: This function cannot be used to import new stations into the 
current project. 

To Import Datasets from Text Files: 
 1. Open the sounding into which the data are to be imported 

 2. Select the File | Import new data | From Text File…menu 
command 

 3. Follow the instructions given by the Import Wizard (refer to the 
“Data Import” chapter of this manual for details.) 

Note: Any previously saved sounding data are lost when new data are 
imported. 

To Enter Data From the Keyboard: 
 1. Open the sounding into which the data are to be imported 

 2. Select the File | Import new data | From Keyboard…menu 
command 

 3. The program alerts you that any existing data will be lost. 

 4. In the Data Import window, enter the data in the appropriate 
columns:| 
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When finished, use the File | Save menu command to store the 
data in the database 

Editing Sounding Data 

The Edited Curve 
When sounding data are imported into a WinGLink database, they are 
saved as “original data” in a reserved area of the database and are never 
modified unless new data are imported. At the same time, a duplicate 
dataset is generated and saved in a different area of the database for use 
by editing functions. When an editing session is carried out on the 
sounding data, it is carried out on this second dataset, which is referred to 
as the “edited curve” of the sounding. 

Saving changes following an editing session means saving an edited 
curve. This curve is used by default in calculating 1D inversion models 
and pseudosections. 

Interactive Sounding Editing Form 
DC sounding data can be edited in the interactive sounding editing form, 
which is opened with the Edit menu command: 
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The form includes commands for performing various editing functions: 

Selecting Data Points 

 Single point selection 

Click to select/unselect for editing single data points on the curve. 

 Multiple points selection 

Click to select/unselect for editing all data points included in a user-
defined range: click and drag the mouse to define the area. 

Zooming in on the Curve 

 Zoom in 

 1. Click a point in the curve diagram and release the button. 

 2. Move the mouse to define the zoom area. 

 3. Click and release the left mouse button. 

  Zoom out 

Click to reset the previous view.  

Note: this button is available only after the Zoom in button has been 
used. It remains available until the original curve size is restored. 

Saving Editing Changes 

 Save button 

Saves the editing changes. These changes must be confirmed when 
closing the station window in the main menu in order to store them in the 
database. 
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Editing Data Points 

 Masking data  

 1. Click and select the points by single or multiple selection (the 
masked points will turn gray). 

 2. Click the Mask button again to confirm the changes. 

 3. The points will be hidden from the display 

 4. Click the Mask button again to restart the masking/unmasking 
process. 

 
 Shift data points 

 1. Click and select the data points to be shifted by single or 
multiple selection. 

 2. Move the data points to the desired positions and click the left 
mouse button. 

 3. Click the Shift button again to confirm the action. 

s  Calculate and display a smoothed curve 

Click the button to display the smoothing options 

 Cancel the current action 

 Undo button 

Undo all the editing changes made since the last time the curve was 
saved. All editing steps can be undone provided the station has not yet 
been saved since editing. 

Reloading Original Curves 
This action overwrites the edited curves of a station with the original 
curves. 

To reload original curves: 

 1. Select the station by clicking its window. 

 2. Select the File |Re-Load Original command. 

After reloading, the smoothed curves and the 1D models need to be 
recalculated. 

1D Inversion 

1D Inversion: Overview 
The 1D Model command starts the inversion program for the station 
whose window is currently active.  

The main steps involved in the inversion process are: 
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Set curves to use 
for inversion 

The inversion can be run using the edited or 
smoothed curve. The curve selection button, 
located on the bottom bar, allows the user to 
change the selected curve at any time. The 
models must be recalculated when the curve 
to be used is changed. 

Calculate the 
smooth inversion 
model 

For each station, one smooth model is 
calculated and stored in the database. This 
model will be used to produce imaged 
sections for the project. 

Guess the layered 
inversion model 
from the smooth 
model 

A layered model can be guessed from the 
calculated smooth models. The number of 
layers is entered by the user by editing the 
inversion settings or by editing the model 
with interactive graphic commands. 

Edit the initial 
model using the 
graphic model 
editor (optional) 

An interactive graphic editor allows the 
editing of layers thicknesses and resistivities. 
The response is displayed in real time. 

Run the inversion 
and save the model 

The inversion process can be run with a 
given number of iterations and predefined 
RMS fitting degree. Resistivity and/or 
thickness values of one or more layers can 
be kept fixed. 
 

 
 

The 1D Inversion Window 
The following figure shows the 1D inversion window: 
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To Calculate Smooth Models 
 1. Use the 1D Model command to enter inversion mode for the 

active sounding. 

 2. Use the  button to compute a smooth model: 

 
 

To Guess the Layered Model from the Smooth Model: 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Calculate the smooth model (magenta lines), if you have not 
already done so. 

 3. Click the  button. 

 4. The layered model is guessed (green lines). 

To Import a Model Created for a Different Station 
 1. In 1D Modeling mode, click the Edit button to open the 1D 

Model Parameters dialog: 
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 2. Here, click the Import button to open a dialog box which 
contains all available stations: 

. 

 3. Select the desired station and click Import. Note that any 
changes to the imported model are not reflected in the original 
model. 

To Run the Layered Inversion: 
 1. Use the 1D Model command to enter the inversion mode for 

the active sounding. 

 2. Click the  button. 

 3. The inversion is started using the model shown with green lines 
as the starting model and the inversion parameters set for the 
sounding. 

Graphic Editor for 1D Layered Models 
The layered model can be edited graphically using drag-and-drop 
operations.  

The resulting resistivity curve is updated in real-time, allowing you to 
compare the fit with the observed curve. 

To Graphically Change the Resistivity of a Layer: 
 1. Click the vertical line which denotes the layer’s resistivity. Two 

black dots appear on its edges indicating that this line can be 
moved: 

 
 2. Release the mouse. 

 3. Move the mouse pointer to the selected line; the arrow pointer 
changes to a double-headed arrow. 
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 4. Left click and hold down the button; drag the line to the new 
layer resistivity delimiter position. 

 5. Release the mouse button. The resistivity curve coming from 
the layered model is recalculated and redrawn. 

To Graphically Change a Layer’s Thickness 
 1. Repeat the procedure used to change a layer’s resistivity, but 

instead select one of the horizontal lines which delimits the 
layer and move it to the desired position. 

Batch Commands & Quick View 

Running Operations in Batch Mode 
A group of batch procedures are available for performing selected 
operations on a set of user-selected stations.  To start a batch procedure: 

 1. Close all open stations. 

 2. The Batch Tools command will appear on the main menu: 

 
 3. Select the desired operation. 

 4. Enter the parameters as requested. 

Operations available in batch mode include: 

• Printing 

• Smooth curve calculation 

• 1D inversion models 

Quick View 
The Quick View option, which is available on the Special menu item 
when no soundings windows are open, can be used to display multiple 
soundings in a single window. To open the Quick View window, select 
the Special | Quick View menu command: 
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The Stations Map window, which can be toggled on and off with the 
corresponding check box in the upper right corner of the window, 
indicates the positions of the stations which are currently open (black 
squares) as well as the position of the active station (red square). 
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22:  EM/DC Pseudo-Sections 

Overview 

   

The Pseudo-Sections program reads the apparent resistivity vs. 
measuring parameter values for each station associated with a profile, 
then interpolates them to display a section showing the lateral variation 
along the profile. 

Each pseudo-section is defined by a profile trace and its associated 
stations, which supply the datasets with the apparent resistivity values vs. 
the measured parameter (i.e.: AB/2, time, or frequency, depending on the 
data type of the project). 

With the Pseudo-Sections program, multiple sections can be open at any 
time. Pseudo-sections may also be opened along multiple profiles. Each 
section is displayed in a separate window.  

The curves used to generate the pseudo-sections can be viewed and 
edited, one at a time, by clicking the vertical dotted line below each 
station on the section. 

Creating a New EM or DC Pseudo-Section 
To create a new EM or DC pseudo-section: 

 1. Construct a new profile, as described in the “Maps” chapter of 
this manual. 

 2. Make sure you have imported or entered the field data for each 
station of the new section. You can use the Soundings program 
to check that the stations have data. The Soundings program 
will use the edited data, if available, or the smoothed data, if 
requested. Alternatively, the original field data can be recalled. 

 3. Start the Pseudo-Sections program. 

 4. In the Profile Selections window, which opens immediately 
after starting the program, select the profile created in the Maps 
program for which the section is to be created.  

 5. On the Gridding menu, select New Grid and enter the 
appropriate parameters.  
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 6. The section is displayed. The section can now be edited, printed 
and stored in the database for future use: 

 

Gridding the Profile Data 
The data of the stations used to generate each pseudo-section must be 
gridded in order to display contours and color ranges. 

To Grid the Profile Station Data 
 1. Select the section you want to grid. 

 2. Select the Gridding | New Grid… menu command. A form 
similar to that shown below this is displayed: 

  

 3. The numbers in parenthesis on the gray background show the 
maximum and minimum values of the data; the current value to 
be used to define the grid extent must be entered in the field-
box close to each number. 
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 4. In the Step X field, enter the step in the specified units. This 
number determines the number of columns in the grid, which 
will be shown in the center white box, representing the section. 

   
 5. In the T intervals per decade field, enter the number of grid 

rows per decade. 

 6. Fill the fields with the values for the interpolation radius, spline 
weight and smoothing factor. 

 7. Click the OK button. 

Note: As the interpolation radius increases (values >5), the gridding 
algorithm attempts to fill any holes present in the data by interpolating 
between relatively distant data points. When creating difference pseudo-
sections (see below), we therefore recommend using a low interpolation 
radius (2) to prevent the creation of misleading differences.  

To Display Color Ranges and Contour Lines 

Click the icon  to display/hide color ranges. 

Click the icon  to display/hide contour lines. 

Displaying Station Dataset Values 
On the View menu, select the Projects Window, if not already 
displayed: 

 
Check the V box to display the values of the dataset at each station. 

To update the display of the section, click the section with the mouse. 

Editing Data Points 
A number of edit operations can be performed on the data associated with 
each station. These include masking samples, static shift and station state.  

Edits made here affect the stations elsewhere in the database. Thus, a 
station disabled in the Pseudo-Sections program is not available in the 
MT 2D Inversion program. 

To Edit Data Points: 
 1. Double-click the dataset of the sounding you wish to edit in the 

section (the data are shown as dots below each station). This 
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opens the sounding window: 

 

 2. To enter edit mode, click the  button. Depending on 

whether the  button or the  is enabled, data points can be 
masked either individually or as groups.  

 3. Click the  button again to terminate masking.  

 4. The masking operation just performed can be undone by 

clicking the  button. 

 5. Other stations can be selected for editing from the dropdown 
list at the top of the editing window. 

  

To Change the State of a Station 
 1. Select the Station | Edit Status menu command. 

 2.  Click the station symbols to toggle the current state. When 
disabled, the stations are displayed in light gray. 

Station states may only be altered if the current project is a single project, 
i.e. this function cannot be applied to stations contained in an integrated 
project. 

Note: In order to see the effects of changes or edits made to the stations 
on the section, you must select the Gridding | Regrid menu command. 
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23:  X-Sections 

X Sections 

Overview 
The X-Sections program provides a tool for displaying multiple sections 
for a specific type of geophysical data side-by-side. Using this program, 
it is possible, for example, to display in a single application sections 
created for 1D, 2D and 3D models on separate (or the same) profiles.  

In order to use this program for a given project, the project must contain a 
profile and there must be stations associated with that profile. Sections 
can only be generated if the corresponding data have been prepared using 
the appropriate modules in WinGLink, e.g. Soundings, MT 2D Inversion, 
etc. For further information on creating profiles, please refer to the 
“Maps” chapter of this manual.  

Well courses and layer data belonging to stations assigned to the active 
profile can be displayed in a section, regardless of project type.  

Before starting, note the data sources for the various section types: 

• 1D models: these can be created from DC, EM or MT 
projects. Before creating sections from 1D models, make 
sure you have used the respective Soundings program to 
calculate the smooth and layered resistivity models. 
 
For MT projects, sections can be created using Bostick and 
Occam 1D models. Layered 1D models can be superimposed 
upon both of these. Note that sections cannot be created for 
layered 1D MT models.  
 
2D models: these can be created from MT or CS projects. 
The models used in creating this type of section are those 
created and used in the 2D Inversion programs. Sections can 
be extracted from both standard terrestrial 2D models as well 
as from marine models. 

• 3D models: these models can be created from MT projects 
which contain 3D meshes. X-Sections generates sections of 
this type by interpolating along a profile which transects an 
area of a 3D mesh. Before a section of this type can be 
created, it is necessary to first create one or more profiles in 
the MT project which contains the 3D mesh. As sections  
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produced for 3D meshes are generated by interpolating cell 
values along the profile using the resistivity values stored in 
the mesh – and not station values, it is not necessary to 
assign stations to this profile.  

• Wells: this type of section is created using the layer data 
imported for each well station. It is possible, for example, to 
import layer data containing temperature or pressure at 
various depths along a well course. X-Sections interpolates 
these values to generate sections. In addition to creating 
sections using layer data in the form of numerical values, X-
Sections can also display well courses and lithologic 
information, displayed as user-defined fill patterns along the 
well courses.  

• Vertical data: values measured at depth not associated with 
well courses can be used to create sections provided the 
stations have been assigned to a profile.  

Creating a New X-Section 
Described in the following is the general procedure for creating sections 
of all project types in the X-Section program. It is assumed here that a 
profile has been created and that stations which  the corresponding data 
have been associated with the profiles and that models have been 
prepared. 

To Create a New Section: 
 1. Select the desired project in the WinGLink Shell and start the X 

Sections program by clicking the  icon in the program 
window. 

 2. The first window displayed by X-Sections after the program 
has been started is the Profile Selection form: 

 
Listed in the Profiles section of the window, in the upper left 
corner, are the profiles available for the selected project and the 
number of stations assigned to each.  
 
Below this, for projects of type DC, EM or MT, is a drop-down 
list containing the model types available for the given project 
type, i.e. 1D, 2D and 3D. In the window below the drop-down 
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are the models available in the database for the selected type on 
the profile selected for opening.  
 
For projects of type WL (wells), this drop-down list lists all 
types of numerical data which have been imported for the all 
well stations in the database, i.e. all types of numerical data in 
all well projects. Note that sections can be created using 
numerical values only if data exist for at least two stations on 
the selected profile.  
 
When creating sections extracted from 3D models (MT), the 
Source Project drop-down list in the Profile Selection dialog 
lists all projects in the database. Select any of the projects to 
display the 3D models contained in the given project. As there 
is no direct relationship in a WinGLink database between 
projects and 3D models, sections extracted from 3D models can 
be opened even if the 3D model is not present in the current 
project. For informative purposes, however, 3D models present 
in the active project are indicated by an asterisk. If the model is 
present in a different project, the name of that project listed 
next to the 3D model name. If the 3D model is not present in 
any project in the database,  there is no additional information 
displayed.  
 
Sections can be extracted along profiles on 3D models not 
containing any stations. 
 
Make the desired selections and proceed to the X-Section 
workspace by clicking the OK button. 

 3. The section is displayed with both smooth and layered models, 
if available.  

 4. If viewing a section for which no grid has yet been created, a 
window is displayed prompting you to select the gridding 
options. 

Gridding the Station Datasets 
Each time a modification is made to the station’s data or status, the 
section must be re-gridded to update the display and show the latest 
changes.  

To Grid the Station Data: 
 1. Select the window containing the section. 

 2. Select the Gridding | New Grid…menu command 

 3. Enter the grid boundaries and steps: 
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 4. Enter the interpolation radius, spline weight and smoothing 

factor. 

 5. Click the OK button. 

 6. Click the  button to display color ranges 

 7. Click the  button for contour lines. 

To Export a Grid 
To export a grid created in the X-Sections program, select the File | 
Export Grid menu command. Grids can be exported in most standard 
grid formats, including Geolink USGS, Surfer and others. 

Activating/Deactivating Stations 
The data of any station on the section profile can be excluded from the 
processing by the user.  

This is done by editing the status of the station. To do this, select the 
Stations | Edit Status menu command, then click the station symbol on 
the section. By clicking the symbol on the station, the user can change its 
status from On or Off and vice versa.  

When a station is disabled, its name and symbol are displayed in gray, no 
data points are shown below the station on the section, and the station 
data are not used when a new grid is calculated. 

Note: This function is available in the Pseudo-Sections and X-Sections 
programs. Stations enabled /disabled in any Sections module are 
enabled/disabled in all section programs, including 2D Inversion. 

Station states may only be altered if the current project is a single project, 
i.e. this function cannot be applied to stations contained in an integrated 
project. 

To toggle the enabled / disabled status of a station: 

 1. Select Stations | Edit Status. 
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 2. Click the symbol of the station(s) you wish to disable (if not 
shown in gray) or re-enable (if shown in gray). 

 3. When finished, select Gridding | Regrid to update the display 
according to the new station settings on the section. 

Displaying Features and Parameter Values 
On the View menu, open the projects window if not already visible: 

 
Check the corresponding box to display stations 

N = Names 

S = Symbols 

M = Layered models 

V = Parameter values 

The buttons located at the top of each column can be used to toggle all 
station values for the respective column on and off. After clicking a 
button, a dialog window appears prompting you to specify whether the 
respective value should be displayed or hidden. 

To update the display of the section after selecting or deselecting 
checkboxes, click the section with the mouse. 

Displaying the Profile Location Map 
A window can be opened in the X-Sections program (or any section 
program) which contains a map with the locations of all profiles and the 
stations associated with the profile in the current project. The active 
profile (on which the section currently being edited is located) is 
displayed in red. The locations of stations associated with the active 
profile are also shown. 

To open the ancillary location map window, select the View | Profile 
Map menu command: 
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Profile Intersections 
The points at which profiles intersect one another can be displayed on 
pseudo-sections with the Profile Intersections function, which is enabled 
using the View | Crossing Traces menu command. Profile intersections 
are indicated with red labels along the top of the section. 

Section Topography 
Section topography is extracted according to the following rules: 

 1. From the area topography grid as defined in the WinGLink 
shell. 

 2. From the project topography grid. 

 3. From the elevations of the stations attached to the profile. 

Viewing Well Courses and Well Layer Data in X-
Sections 

Well courses and associated layer data can be displayed in section 
programs X-Sections and 2D Inversion. Any well station assigned to the 
active profile is automatically displayed when the section is opened: 
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Depending on program settings, the well courses may or may not be 
displayed initially. 

In the X-Sections program, well traces and layer data can be toggled on 
and off using the Projects Window and the Well Layer Data window.  

If layer data have been imported, e.g. lithologic data, you may use the 
Well Layer Data window to toggle the display of the layer data on and 
off. As is described in the “Common Functions” chapter of this manual, 
layer data can be superimposed onto well courses and represented as 
user-specified fill patterns using WinGLink’s Category Editor.  

Working with Vertically Distributed Data in  
X-Sections 

After importing vertically distributed data, as described in the “Data 
Import” chapter of this manual, and assigning the stations to a profile 
using the Maps program, X-Sections can be used to grid the values. 

To Work with Vertically Distributed Data in X-Sections: 
 1. Select a project of type Vertical Data [VD]. 
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 2. Click the X-Sections program icon. The Profile selection dialog 
box opens. Select the profiles and values to be opened: 

 
 3. If the grids have not yet been created for the value you have 

selected, you will be prompted to select the type of gridding to 
be used: 

 
 4. Make the appropriate selection and click the OK button. 

Regardless of which option is chosen here, the grid parameters 
can be modified after the grid window has opened. 

In addition to the functions available throughout WinGLink, e.g. color 
ranges and contours, and those generally available for sections, e.g. 
gridding, area selection etc, the X-Section program offers functionality 
for performing arithmetic operations on a given set of values to create a 
new value. 

To Create a New Value: 
 1. Select the File | New Value menu command. 

 2. The New Value dialog box opens. Select the value to be used as 
the source from the drop down list, which contains all of the 
values available for the profile. Make the appropriate selections 
in the remaining fields and click the OK button. 

 3. To open a grid window for the new value, select the File | 
Open menu command to open the Profile and Value Selection 
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dialog box.  
 

 4 The properties for a new value or those for an existing value 
can be modified by selecting the File | Value Properties menu 
command.  

   
  Edit the Unit and # of decimals fields appropriately and click 

OK. The Name field cannot be modified. 
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24:  Gravity and Magnetic 2.75D 
Modeling 

Overview 

 

The Gravity and Magnetic Modeling program is used to create, edit and 
manage 2.75 D models of rock density (gravity projects) or rock 
susceptibility (magnetic projects ). 

Each model is attached to a profile of the database. One or more models 
can be attached to each profile. The profiles must have been previously 
defined using the Maps program. The observed anomaly values to be 
fitted are automatically associated to each defined profile. 

Several models can be displayed simultaneously, each one in a separate 
window. An example is shown below: 

 
The upper frame shows the observed anomaly curve (red) and the 
calculated anomaly curve (green). The lower frame is used to display and 
interactively edit the model. As the editing goes on, the calculated curve 
is updated automatically in order to show in real time how the changes 
affect the calculated curve and check the fitting of the model. 
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The values for the observed anomaly curve can be chosen from any of the 
values of the project stations. A selection window, which lists all values 
available for the selected projects, is available for value selection: 

  
Choosing NONE will allow a forward modeling to be performed with no 
anomaly value. 

Finally, it is possible to display a background section from any project 
(imaged or cross section), thus integrating gravity with any other 
information available in the area. 

In the example shown below, the deep high resistivity complex is 
modeled as the source for the gravity high. 

 

Observed Anomaly Values 
The observed anomaly curve can be represented in two ways: 

Anomaly Curve with Measured Values 
This curve is obtained by using the observed value associated with each 
station of the profile.  

For each model, the values used to construct the curve can be selected 
from the values available for the stations of the project. These can be raw, 
edited or processed values (i.e.: measured, filtered, etc.). 

Anomaly Curve with Interpolated Values 
This curve is obtained by extracting the values along the profile from a 
map grid, using a fixed sampling step. The resulting curve is a smooth 
curve that may show values in no-data areas, due to the interpolation 
process. 
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The above picture shows an example of observed anomaly curves, with 
both station values and interpolated values. The red crosses are the values 
of the stations attached to the profile. 

The continuous red line is the line extracted from the map of the same 
values, sampling the grid at a regular step. The shape of the curve 
depends on the gridding parameters that were used in the Maps program. 
This curve will not be displayed if the selected station values have not 
been gridded in the Maps program.  

Selecting the Anomaly 
This option lets you change the source of the observed curve. 

 1. Select the window containing the model. 

 2. Select the File | Load Anomaly Values menu command. 

 3 Select the desired value type. 

   
 

The new observed anomaly curve is displayed. If you cannot see the 
calculated curve, do the following: 

 1. Select the Tools | Set Vertical Shift menu command. 

 2. Select the Automatic check box and click the OK button. 

 

Changing the Vertical Shift 
The vertical shift brings the calculated anomaly curve into the observed 
anomaly range by applying a constant value to the whole calculated 
anomaly curve. 

 1. Select the Tools | Set Vertical Shift…menu command 
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 2. Select the Automatic check box or enter the value and click the 
OK button. 

 

Displaying a Section in the Background 
With this option, a gridded section from any other project of the database 
or bitmap image can be set as the  background of the 2.5D gravity model. 

 1. Create or open a model for your profile. 

 2. Select the Tools | Set Background menu command. 

 3. Select the type of section you want to display: 

 
 4. Select the project from which the section is to be taken and 

click the OK button. 

 

Creating and Defining Models 

Creating a New Model 
 1. Select the File | Open Model menu command.  

 2. Select the profile with which the new model is to be associated: 

 
 3. In the models frame, click << New >>, then click the OK 

button: 
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 4. Enter the model name and choose the observed anomaly from 
the values list, then click the OK button: 

 
 5. The listed anomaly values are the values available for the 

stations of the current Project. The anomaly values can be 
selected and changed anytime. 

 6. When creating a new model, an open reference body, which lies 
directly underneath the topography, is automatically added to 
the model. This body represents an uniform earth, prior to 
adding other bodies to the model. Enter the density (and any 
other parameters) for this body in the Edit Body form, then 
click the OK button.  

   
 7. Drag the reference body label to the desired location and drop it 

by clicking the left mouse button: 

    
 8. Other bodies can now be added to the model. 
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Opening a Model 
Select the File | Open Model menu command: a window opens, listing 
the available profiles, a simplified profile location map, and an optional 
preview of associated models: 

  

Select the profile by clicking its name: 

 
Select the model by clicking on its name; select the Model Preview check 
box to display a simplified sketch of each model. 

 
Click OK. 

Deleting a Model 
 1. If the model you want to delete is open, close its window. 

 2. Select the File | Delete Models menu command. 

 3. Select the model you wish to delete. 
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Editing Models 

Editing Commands and Icons 
Models can be edited using menu commands or edit icons: 

• To edit a model using commands, on the Model menu, the 
select Body, Vertex, or Label menu command to display the 
corresponding editing commands, or 

• Click the  button on the toolbar to display the Editing 
Icon Bar. 

Important warning: When an editing command (for example: Add 
Vertex) is started, this command remains active after executing the 
action, allowing the same command to be applied repeatedly. To 
terminate the editing command, click the mouse right button or press the 
Esc key. 

The currently active action command is indicated in the bottom right 
corner of the program window: 

  

Adding Bodies to a Model 
• Select the Model | Body menu command and then choose the 

type of body to be added or 

• Click the  button to display the editing icons. Click: 

 to add a body open on both sides 

 to add a body open on the left-hand side 

 to add a body open on the right-hand side 

 to add a closed body 

To define the polygonal section of the added body: 
 1. Move the mouse pointer into the model window, then left-click 

where you want the first vertex of the body to appear. 

 2. Repeat the above step to add at least two more vertices. 

 3. When finished, right-click the mouse: the program will 
complete the body geometry according to the initial body 
definition. 
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 4. The Edit Body form appears. 

 5. Edit the body as detailed in paragraph Editing body properties. 

 6. Right-click or press <Esc> to stop adding bodies. 

Deleting Bodies 
• Select the Model | Body menu command, and then Delete, 

or 

• Click the  button on the Editing toolbar: 

When the mouse pointer becomes cross-shaped: left-click inside of the 
body to delete the body. Confirmation is requested before the body is 
deleted. 

Right-click or press <Esc> to stop deleting bodies 

Moving Bodies 
• Select the Model | Body menu command, and then Move, or 

• Click the  button on the Editing toolbar. 

When the mouse pointer becomes cross-shaped: left-click inside of the 
body. To move the body, drag it to the new position and left-click to drop 
it. 

Right-click or press <Esc> to stop moving bodies. 

While moving the body, all clipped vertices remain fixed. 

Important: Before moving the body, make sure the Automatic Vertical 
Shift option is turned off, otherwise it is calculated and applied at every 
move. 

Splitting a Body 
• Select the Model | Body | Split menu command, or 

• Click the .button on the Editing toolbar. 

To define the polygonal section of the new resulting body: 

 1. Move the mouse pointer into the model window, then left-click 
on a vertex of the source body (where you wish to start splitting 
it). 

 2. Continue to left-click to add vertices inside the source body. 

 3. Right-click the mouse on another vertex of the source body 
(where you wish to stop splitting it). 

 4. The Edit Body form for the new resulting body is then shown. 

 5. Edit the body as detailed in paragraph Editing body properties  

 6. Right-click or press <Esc> to stop splitting bodies. 

Notes: 
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• Both closed and open bodies can be split, including the 
reference body. 

• When splitting a body, the common vertices are 
automatically clipped and displayed in red. 

• When splitting the reference body, a new body is added to 
the model. Vertices on the topography are clipped to the 
topographic profile. 

Editing Bodies in a Model 

To Add Vertices to a Body: 
 1. Select the Model | Vertex | Add menu command, or 

click the  button on the Editing toolbar. 

 2. When the mouse pointer becomes cross-shaped, left-click near 
the line where the vertex is to be added. 

 3. Move the mouse pointer to drag the new vertex and left-click to 
drop it. 

 4. Continue adding vertices as desired. The anomaly curve is 
updated accordingly. 

 5. Right-click to stop adding vertices. 

 

• Select the Model | Vertex | Add menu command, or 

• Click the  button on the Editing toolbar. 

To Delete Vertices from a Body 
 1. Select the Model | Vertex | Delete menu command, or 

click the  button on the Editing toolbar 

 2. When the mouse pointer becomes cross-shaped, left-click on 
each vertex to delete. 

 3. Right-click to stop deleting vertices. 

To Move the Vertices of a Body: 
 1. Select the Model | Vertex | Move menu command, or 

 2. Click the  button on the Editing toolbar. 

 3. When the mouse pointer becomes cross-shaped, left-click on 
the vertex to move 

 4. Move the mouse pointer to drag the vertex and left-click to 
drop it. 

 5. Right-click to stop picking vertices to move 
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Important: Before moving the vertex, you may want to make sure the 
Automatic Vertical Shift option is turned off, otherwise it is calculated 
and applied at every move. 

To Clip Two or More Vertices: 
 1. Select the Model | Vertex | Clip menu command, or 

click on the Editing toolbar. 

 2. When the mouse pointer becomes cross-shaped, left-click the 
vertex to clip. 

 3. Move the mouse pointer to drag the vertex on the partner 
vertex, and left-click to drop it. 

 4. The clipped vertices turn red. 

Setting the Properties of a Body 
To edit the properties of a body: 

 1. Select the Model | Body | Properties menu command, or 

click the  button on the Editing toolbar. 

 2. Double-click with the mouse inside the body to be edited. 

 3. The Edit Body form opens. Select the desired property tab, and 
enter the settings as appropriate: 
 

Wh
en body properties are entered or edited, check the box beside each 
property to display it in the label attached to the body. 

For example, if you wish to display the strike length and offset of a body, 
select the check box <Show in Legend> in the Edit Body form: 
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The label for a new body is automatically created by the program when 
closing the Edit Body form  

Each time the body properties are edited, the contents of the Body Labels 
are automatically updated. 

Moving Body Labels 

 1. Click the  button on the Editing toolbar, then click the label 
and drag it to its new position or simply on the label and move 
it. 

 2. A straight line will connect the label to its old position. To edit 
the line, click on one edge, and drag it to the desired location. 

Formatting Body Labels 
 1. Select the Model | Format Labels menu command or right-

click on one label (the format settings are applied to all labels). 

 2. Enter the desired format setting. 
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25:  Interpreted Views and 
Montage 

Overview 
The Interpreted Views and Montage (IVM) program provides a tool for 
displaying multiple layers of geophysical data in a single document. As a 
set of medical transparencies might be used to display skin over muscles 
over bones, IVM is used to superimpose various types of geophysical 
data onto one another, e.g. cultural data and well logs over a 2D model of 
magnetotelluric data acquired along the same profile. 

IVM is designed to prepare for presentation data which have been 
processed and modeled using the various interpretation modules 
contained within WinGLink. In addition to displaying raw and processed 
data, the program contains several sets of tools for annotating documents. 
IVM itself contains no data analysis functionality.  

Document Types 
The IVM program can be used to create two types of documents: 

• Maps: these documents may contain, among other features, 
maps created in the Maps program in WinGLink, cultural 
data, stations, profiles and interpretation areas: 

 
• Sections: these documents may contain sections created in 

WinGLink, e.g. grids and meshes created in the 1D Sections 
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and 2D MT Inversion modules, as well as cultural data, 
station data, profiles and interpretation areas: 

 
In both types of documents, the different features are placed on separate 
layers. Each layer is treated as an independent object and has associated 
with it an independent set of display properties, i.e. symbol name, font 
size, contour colors, etc. Layers can be shown or hidden, and, to use the 
medical transparency analogy again, can be moved above or below other 
layers. 

Both of these document types are stored in the active WinGLink database 
as enclosed objects.  

Plate Mode 
Documents stored in the database can be opened in IVM plate mode, 
which provides you with an interface for positioning and annotating 
documents with legends, scales, text boxes, and other features on a single 
plate. Plates can then be sent to an available printer or to EMF or CGM 
files. Plates are stored in the active WinGLink database and, like map and 
section documents, can be opened and edited at a later time in IVM. 
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Figure 1 Example of a plate containing a section document, scale box, title box and color 
scale. 

Getting Started with IVM 
Note: IVM can be started only if your WinGLink license agreement 
includes the Interpreted Views and Montage option and your dongle has 
been correctly configured. Please contact Geosystem for further details. 

To open IVM, click the Interpreted Views and Montage button located 
at the right side of the main database window in WinGLink:  

 
The program opens with the Document Editor dialog box: 
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Recently opened IVM documents, if any, contained in the active 
database, their types, and the profiles with which they are associated are 
listed in the box in the bottom half of the dialog box. To view a list of all 
IVM documents contained in the database, click the More Files… label 
in the text box. This opens an additional dialog box which lists for 
selection all IVM documents contained in the database. 

Note: Documents are stored within the WinGLink database, not as 
external files.  

To continue, either select an existing document or create a new document 
by clicking the Create a New Document option button and either the 
Map or Section option button.  

If you choose to open a section document, you will be prompted to select 
a profile from the profiles contained in the WinGLink database:  
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After clicking OK for section documents, or immediately if you are 
creating a new map, the document window opens with the following 
message: 

 
After clicking OK, IVM opens either the Map or Section editor, both of 
which are described below.  

Understanding How IVM Works 
Regardless of whether you are working with a map or a section 
document, the core functionality is, in principle, the same. Although the 
types of layers which can be added to each document type differ, how 
they are added to a document, most menu options and dialog boxes 
available to the two document types are the same.  

Using a section document as an example, this section will introduce the 
IVM features and functions common to both document types.  

Shown below is a section window which contains a multilayer document, 
the toolbars and legends associated with those layers, the Layer 
Navigator window, and the Mouse Locator window:  

 

The Document Window 
This is the principle area of both the Map and Section editors. Layers, as 
they are added, are displayed here in the specified Z-order, the order in 
which the layers are stacked on top of one another.  

The menu options contained in the View menu item and the 
corresponding buttons in the main toolbar can be used to adjust the area 
of the document displayed on the screen as in other WinGLink modules. 
Document can be enlarged, reduced, panned, or a specific area selected. 
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Changes in the view area are immediately reflected in the scales 
displayed along document window. 

The entire area of the document window is mouse sensitive. When the 
right mouse button is clicked anywhere on this window, a shortcut menu 
similar to the following appears: 

 
Which menu commands are listed in the shortcut menu is dependent on 
the type of document, the layers contained in the document, if any, as 
well as which layer is currently active. The functions listed in this 
shortcut menu can, for the most part, also be accessed in either the main 
menu bar or from the toolbar. As the submenu command names imply, 
these commands are used to add new layers and change the display 
characteristics of the individual layers in the document. The function of 
each of these and other submenu commands are described in detail later 
in this chapter.  

Layer Navigator: 

 
The Layer Navigator window is used to manage the layers contained in 
the document. The first layer listed below the document name (in this 
example Document1), is the top-most layer in the document, i.e. has the 
lowest Z-order. In the example shown above, the layer Prod Wells 
precedes the layer C Loop EM. If the Z-order of these two layers was 
reversed, the wells layer would be all but hidden by the grid. To change 
to the Z-order of a document, click the name of the layer which is to be 
repositioned with the left mouse button, and drag to the new position in 
the Layer Navigator. After repositioning a layer, double-click the layer 
name to activate the layer and redraw the window. 

The currently active layer is displayed in red. A layer can be activated by 
either double-clicking the layer name with the mouse or by clicking the 
right mouse button anywhere within the Layer Navigator window to open 
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the Layer Navigator shortcut menu and selecting the Edit menu 
command: 

 

Note: Although the available commands vary depending on what type of 
layer is active, the four active menu commands shown above are 
available for all layer types. When a layer is active, the Edit command 
changes to Exit Edit; when a layer is hidden from view, the Hide 
command changes to Show. Before a layer can be activated, it must be 
visible.  

Menu commands Show current only, Copy and Paste are not available 
for all layer types. 

The document name, the top item in the Layer Navigator, has associated 
with it a different shortcut menu: 

 
This shortcut menu can be used to add new layers to the document or to 
assign the document a new name.  

The toolbars, legends and available menu commands change depending 
on what type of layer is active. For example, when the active layer is of 
type grid, the display window shortcut menu contains commands for 
changing the color ranges and contour lines whereas for a layer of type 
station containing well data, this menu might contain, among others, a 
command for editing well logs.  

The Layer Navigator window is reduced to a title bar by clicking the title 
bar with the left mouse button. When the mouse pointer is positioned 
over the title bar, the window is automatically restored to its original size. 
Likewise, when the mouse pointer is moved off of the Layer Navigator, 
the window is again reduced to a title bar. To switch off this auto-close 
functionality, click anywhere within the Layer Navigator window, and 

the window will remain open. Use the  button, located in the main 
toolbar, to toggle the Layer Navigator window on and off. 
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Mouse Locator 

 
The Mouse Locator window displays the mouse position on the on the 
map or section. This window can be toggled on and off using the  
button located in the main toolbar. 

Zoom 
IVM provides several zoom functions, all of which are available for both 
map and section documents: 

Zoom In/Out 
When in this mode, click the left mouse button to zoom in on the 
document area below the mouse, click the right mouse button to zoom 
out. To enter Zoom In/Out mode, click the magnifying glass button to put 
the button into the down state: 

 
While in this mode, the mouse pointer is displayed as a magnifying glass. 
IVM remains in zoom in/out mode until the magnifying glass button or 
another toolbar button is clicked.  

Other Zoom Options 
Open the dropdown list box to the right of the magnifying glass to list 
several zoom options: 

 
Use the numerical options to specify a zoom size.  

The Fit option fits the entire document onto the window. 

The User zoom option is used to zoom in on a selected area of the 
document. To use, select the User option. Immediately after selecting, 
the mouse pointer changes to a crosshair with a small rectangle in the 
lower right corner of the crosshair. Click the mouse at the desired 
location on the document and, keeping the mouse button depressed, draw 
a rectangle over an area of the document. This area of the document is 
then enlarged to fill the screen.  

Note: while the Zoom In/Out button is depressed, only the zoom in/out 
functions are available. 
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Vertical Exaggeration 
Use the vertical exaggeration option, available in section documents, to 
change the scaling of the vertical axis relative to horizontal axis. For 
example, with a vertical exaggeration of 10, one unit length on the 
horizontal axis is equivalent to ten unit lengths on the vertical axis. 

To set the vertical exaggeration, either set a numerical value in the 
vertical exaggeration box, located in the toolbar, or use the scroll bars to 
adjust the exaggeration to a desired value: 

 

Crossing Traces 
Use the View | Crossing Traces menu command to display the points at 
which the current profile intersects any other profiles (sections only). 

Toolbars 
As discussed above in the Layer Navigator section, different layer types 
have associated with them different toolbars. These toolbars are floating 
windows, each of which contains a set of controls or legends specific to 
the given layer.  

For example, layers containing station data have associated with them a 
Projects Window toolbar, which is used to control the display properties 
of the stations contained in a given layer. Depending on the station type, 
other toolbars may also be available. Well log stations may have 
associated with them toolbars for layer data (lithologic data) – which can 
be used to toggle on and off stratigraphic features, as well as additional 
toolbars for controlling the display of numerical data and depth tags, and 
legends which provide details about the patterns used to describe the 
stratigraphy.  

To Hide and Display the Toolbars Associated with a 
Given Layer: 
 1. Activate the layer associated with the toolbar by double-

clicking the layer name in the Layer Navigator with the mouse. 

 2. Right click the mouse anywhere on the display window. 

 3. In the shortcut menu which opens, select the Toolbars 
command. All toolbars, if any, associated with the layer are 
listed in a secondary menu. Those currently displayed in the 
document have next to them a light gray button. 

 4. To toggle a toolbar on or off, click the toolbar name in the 
shortcut menu. 

Each of the toolbars is described below: 

Projects Window toolbar: 
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Layers containing station or profile data have associated with them a 
Projects window which can be used to change how the station data are 
displayed in the document. The Projects window serves the same 
function in IVM as the Project panel in the main WinGLink database 
window. When individual projects are selected in IVM, the Projects 
window contains a single project. However, when an integrated project is 
selected, all projects which comprise the integrated project are listed: 

 
Consider, for example, the Projects window shown above for an 
integrated project. The [N], [S] and [E] buttons toggle on and off the 
station name, symbol and elevation, respectively. Project windows for 
other types contain similar options, e.g.[T] for toggling on and off profile 
traces (map documents only). 

Double-click the symbol to the left of the station type to open the Select 
Options dialog box to specify colors, fonts, text positions and other 
display properties.  

Color scale toolbar: 
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The Color Scale window shows the range scale for layers containing 
mesh and grid data. Color ranges are set and edited in IVM using the 
Range Editor as they are elsewhere in WinGLink. For full details on how 
to use this feature, please refer to the Common Functions chapter of the 
WinGLink manual.  

To Toggle the Color Scale Window on and off for a Given 
Layer: 
 1. Activate the grid layer by double-clicking the layer name in the 

Layer Navigator. 

 2. Right-click anywhere on the display window. 

 3. Click the Color Scale command from the Toolbars submenu. 

Other toolbars 

As mentioned above, different toolbars are available for different layer 
types. In principle, however, they all function in the same way as the 
Projects Window toolbar described earlier. Shown below are three 
toolbars available to layers containing well log data: 

 
Clicking the [S] button or checking the check boxes below the [S] button 
toggles the symbols for the respective value; enabling or disabling the 
checkboxes below the [V] button toggles the value display. Double-
clicking the icons to the right of the checkboxes opens the Select Options 
dialog box which provides options for setting various display options.  

Legends 
Layers containing information too detailed to be displayed in the Section 
window itself may also contain a legend window. For example, the 
pozo_lith Legend, shown below and in the Section window at the 
beginning of this section, contains a legend for the stratigraphy data for 
the respective well log stations.  

 

Note: Legends are automatically created when well log stations which 
include layer (stratigraphic) data are imported into IVM. Bear in mind, 
however, that automatically created legends contain only blank pattern 
blocks and the names of the individual layers.  

Fill patterns can be created for each of the items contained in a legend 
with the Pattern Editor, described later in this chapter.  
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Creating and Working with Layers 
Map and section documents may contain the following types of layers: 

• Grids 

• Stations 

• Profiles (maps only) 

• Cultural data 

• Interpretation areas 

Note: With the exception of cultural data and interpretation areas, which 
are created within the Maps and Sections editors themselves, all 
geophysical data must exist in the active WinGLink database in its final, 
processed form. No data processing is possible within the Interpreted 
Views and Montage program.  

While the Maps and Section editors both generally support the same layer 
types, the actual data which can be displayed in the two editors is, of 
course, quite different. The Maps editor is used to display horizontally 
distributed data, whereas the Section editor is used to display vertically 
distributed data. Despite this fundamental difference, the individual 
layers types are handled in the same way in both editors.  

A second major difference between the two document types is the 
availability of data. When creating a map document, you may select from 
all (horizontal) grids, i.e. all map data, and all station data contained in 
the active database. Section documents, on the other hand, may only 
contain meshes or grids created using stations located along the selected 
profile as well as any stations assigned to that profile. 

This section describes how to create and work with each of the layer 
types listed above. The differences between the two editors, i.e. what 
types of physical data can be represented in each of the layer types, will 
be indicated at the appropriate points.  

Grids  
Grid layers in the map and section documents may contain most types of 
gridded data stored in the active WinGLink database as follows: 

Map documents: all maps created in the WinGLink Maps program 
which are stored in the active WinGLink database can be placed on grid 
layers within a map document, e.g. elevations, gravity, apparent 
resistivity at depth, etc. 

Section documents: all section data stored in the active WinGLink 
database can be placed on grid layers within a section document. These 
include: 

• Sections extracted from 3D MT meshes (using X-Sections) 

• 2D MT meshes and grids (2D MT Inversion module: MT 
data) 

• 1D model images(Imaged Sections module, Vert: EM + MT 
data) 
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Creating a Grid Layer 
To create a grid layer in a new or existing document: 

 1. Right-click the mouse anywhere on the document window or 
right-click the document title in the Layer Navigator window to 
open a shortcut menu. Then position the mouse over the New 
Layer command to open the submenu shown below: 

 
Alternatively, you can open the layer-type submenu by clicking 
the Add Layer button in the main toolbar: 

 
 2. Click the Grid command; the Open Existing Grid dialog box 

opens: 

 
Listed in the upper half of the window are all projects contained 
in the active WinGLink database. Select a project by clicking it 
with the mouse. 
 
Listed in the lower left part of the window are the grids 
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available for the project selected in the upper half of the screen. 
Select a grid by clicking it with the mouse. 
 
Click the Show Preview checkbox at the bottom of the screen 
to display a preview of the selected grid in the lower right  
corner of the window. 
 
Note: When working with section documents, only grids 
created along the active profile are available for selection. 

 3. Click Open to create the grid. The new layer is automatically 
selected and assigned the lowest Z-order, i.e. is placed at the 
top of the layer stack, as can be seen in the Layer Navigator: 

 
 4. Reposition the layer in the Layer Navigator as desired by 

clicking the layer name with the mouse and dragging to a new 
position in the layer list. 

Working with Grid Layers 
The same display functions available to grids within the WinGLink 
modules which support grids are also available in IVM. The Range 
Editor window can be used here to redefine the range distribution of 
colors used in the mesh. The display properties of contour lines can be 
modified using the Contour Editor.  

To Open the Range Editor: 
 1. Activate the grid layer to be edited by double-clicking the layer 

name in the Layer Navigator or by right-clicking the layer name 
in the Layer Navigator and clicking the Edit command from 
the Layer Navigator shortcut menu. 

 2. Right-click the mouse anywhere on the document window to 
open the document window shortcut menu; select the Color 
Ranges command: 
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 3. The Range Editor window familiar from other WinGLink 
modules opens: 

 
For a detailed description on how to use the Range Editor, 
please refer to Chapter 5 of the WinGLink manual, “Common 
Functions”. 

To Open the Contour Editor: 
 1. Activate the grid layer to be edited by double-clicking the layer 

name in the Layer Navigator or by right-clicking the layer name 
in the Layer Navigator and clicking the Edit command. 

 2. Right-click the mouse anywhere on the document window to 
open the shortcut menu; select the Contour Lines command. 

 3. The Contour Lines window found elsewhere in WinGLink 
opens: 
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Note that the size of the labeling in current database units is 
specified in the Size field. 
 
For a detailed description on how to use the Contour Editor, 
please refer to Chapter 5 of the WinGLink manual, “Common 
Functions”. 

Showing/Hiding Fill Colors 
To show or hide fill colors, activate the grid layer, then either click the 

 button or right-click the mouse anywhere on the document window 
to open the shortcut menu; click the Display Options | Hide/Show 
Colors command: 

 
The Hide Color command toggles to Show Color when the colors are 
hidden.  

Showing/hiding contour lines 
To show or hide contour lines, activate the grid layer and click either the 

 button or right-click the mouse anywhere on the document window 
to open the shortcut menu; click the Display Options | Hide/Show 
Contours command: The Hide Contours command toggles to Show 
Contours when the contours are hidden.  

Changing the display quality 
Two display qualities are available for grid layers: draft and presentation. 
Presentation quality produces a more exact representation of the data and 
is, thus, more time intensive. To change the display quality, activate the 
grid layer and right-click the mouse on the document window to open the 
shortcut menu. Select the Display Options | Use Presentation 
Quality/Use Draft Quality command. The default presentation quality is 
Draft. The menu command changes between Use Draft Quality and Use 
Presentation Quality depending on the current selection.  
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Topography Shadowing 
A virtual light source can be directed onto elevation maps to generate 
shadows:

 

To toggle the light source on and off, use the shadow button:  
located in the toolbar.  

Note: The shadow button is only visible for elevation map grids.  

Stations 
Station layers are used to display station locations for a given project on 
an IVM document. Although some station data are displayed in the same 
way in both document types, there are some notable differences.  

First the similarities. It is possible to display for stations in both 
document types the station name, a station symbol and the station 
elevation. For most station types, these values can be toggled on and off 
using the Projects Window described earlier in this chapter.  

The value data associated with stations, e.g. resistivity, Bouguer 
anomaly, are, however, generally available only in map documents. This 
is due in large to the fact that maps are defined in WinGLink to be sets of 
horizontally distributed data. These sets of data consist of the value data 
which can be viewed in the WinGLink Maps module. While it is possible 
to interpolate between these values to create horizontal grids, even at 
depth, it is not yet possible to use WinGLink to transform the values at 
depth to vertical sections.  

Stations for earthquake projects (EQ) are plotted at true elevation. 

WinGLink considers sections, on the other hand, to be sets of vertically 
distributed data or models associated with a profile trace, for example 
well traces, 1D models or 2D models created along profile.  

Creating Station Layers 
Display differences aside, station layers are handled the same way in both 
map and section document types.  

To create a station layer: 

 1. Right-click the mouse anywhere on the document window or 
right-click the document title in the Layer Navigator window to 
open the shortcut menu. Then position the mouse over the New 
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Layer command to open the submenu; select the Stations 
command. 

 2. The Select Projects window opens: 

 
 

  Listed here are all projects contained in the database, the type 
and number of stations available for selection in each project.  

  Station layers created for map documents will contain all 
stations in the selected project. Station layers created for section 
documents, on the other hand, will contain only those stations 
positioned along the active profile. If there are no stations along 
the profile, na is listed in the Station column. 

  Select the desired project and click OK.  
 

 3. As with other layer types, reposition the station layer in the 
Layer Navigator with respect to other layers. if necessary by 
clicking the layer name with the mouse and dragging to a new 
position in the layer list. 

Working with Station Layers 
Station layers containing any of the data types supported in WinGLink 
have associated with them a Projects toolbar, which is used to set the 
appearance of intrinsic station properties on the screen (name, symbol, 
elevation as well as format and location of text labels): 

 
 

Depending on the type of data the station contains and the type of 
document, i.e. map or section, the station may also have associated with 
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it a Value Types window, which lists all values available for the stations:  

 
Select the check box(es) to the left of the value names to display the 
respective value(s). Click the [V] button located above the check boxes to 
display all values. Double-click the symbol to the left of the check boxes 
to open the Value Type Properties window for modifying the display 
properties of the value data, i.e. font size, text location with respect to the 
symbol, vector plots etc: 

 
The Value Types window is generally available only in map documents, 
the exception being well stations displayed in section documents. This 
exception aside, the values listed in the Value Types window correspond 
to the values available in the WinGLink Maps module. 

The function of the Label and Font tabs is straightforward. The function 
of the Vector Plot tab, shown above, is, however, worth a closer look. 
Using the options provided on this tab, vector arrows can be drawn for 
MT parameters which are expressed as complex quantities, e.g. tipper. 
Because the real and imaginary components of complex quantities are 
stored separately within WinGLink, the real portion of the vector must be 
linked to the imaginary portion. It is up to the user to link the correct real 
quantity to a given imaginary quantity. 

Use the radio buttons in the upper left corner to specify how the angular 
values are to be displayed: as segments, vectors (segments with 



 

25-20  •  Interpreted Views and Montage A guide to using WinGLink 

directional arrows), or not at all. Select the Hide Value check box to hide 
the measured value.  

The Module area of the Value Type Properties window contains options 
for specifying how the segments are displayed. The Fixed option 
(default) specifies that the directional arrow be displayed with a fixed 
length for all stations as specified in the Size field. By selecting the 
Linked option and selecting one of the values listed in the values field, it 
is possible to assign a magnitude to the directional quantity. In this way 
you can, for example, link the tipper magnitude at 1 sec. to the tipper 
strike angle at 1 sec, thereby constructing the vector quantity: 

 
When linking an angular quantity to a magnitude, the value specified in 
the Sizes field serves to “amplify” the magnitude value.  

The Vector Plot tab is available only for MT stations on Maps 
documents. Moreover, it is available only for the angular component of a 
given complex quantity.  

Changing projects 
The shortcut menu for station layers includes a command for changing 
projects: 

 
Clicking this menu command opens the Select Projects window shown in 
Step 2 of the Creating station layers section of this chapter. The project 
selected in the Select Projects window replaces the current project. This 
function can be useful when working with complex maps or sections 
containing cultural data or interpretation areas and you would like to 
create similar documents for various projects.  
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Profiles 
Profile layers are available only in map documents. As shown below, the 
display is similar to that seen in the WinGLink Maps module: 

 
When a profile layer is first created, all profiles in the active WinGLink 
database are plotted on the map document. The Projects Window, seen in 
the lower left above, can be used to toggle on and off the individual 
profile traces and profile names.  

Click the symbol to the left of the trace names to open the Profile 
Properties window, which can be used to modify text and profile display 
properties. 

Creating Profile Layers 
To create a profile layer, right-click anywhere on the document window 
or right-click the document title in the Layer Navigator window to open 
the shortcut menu. Then position the mouse over the New Layer 
command to open the submenu; select the Profile command. 

Cultural Data 
Cultural data layers are used to display local cultural features. Several 
display elements are available for this purpose: 

• Labels: text labels 

• Text boxes: text, with extended formatting options and the 
option to place a frame around the text. 

• Shapes: choose from rectangles and ovals; shapes may be 
assigned colors and/or filling patterns. 

• Polylines: may be assigned width and color; polyline 
definitions may also be exported to and imported from 
external files. May optionally be smoothed. 

• Free shapes: polygonal shapes. Shapes may be assigned 
colors and/or filling patterns. May optionally be smoothed. 
May be exported to and imported from external files. 

• Images: external bitmap images. Images may be resized and 
rotated. 
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• Symbols: select from rectangles, circles, crosses and arrows. 
Symbols may be assigned color, width and rotation. 

With the exception of the cultural data layer type in IVM, cultural data do 
not exist in any form elsewhere in WinGLink databases. These features 
must, therefore, be created manually using the set of tools provided for 
this purpose and described below. Cultural data layers are available in 
map documents as well as in section documents. 

Several cultural data elements may exist within a given cultural data 
layer. Thus, this layer type actually represents a document within a 
document. The Z-order of the individual elements within a cultural data 
layer can be modified, allowing you to position one element on top of 
another. A cultural data layer can also be stored in the active WinGLink 
database and reused in other IVM documents.  

Creating Cultural Data Layers 
To create a cultural data layer: 

 1. Right-click the mouse anywhere on the document window or 
right-click the document title in the Layer Navigator window to 
open a shortcut menu.  

 2. Then position the mouse over the New Layer command to 
open the submenu 

 3. Select the Cultural Data command. The Select Layer window 
opens: 

 
 4. Listed in this window are all cultural data layers contained in 

the active WinGLink database.  

 5. To create a new cultural data layer, select the <New> item in 
the Layer Name column and click OK. Likewise, an exiting 
layer can be inserted into the document by selecting the layer 
name and clicking OK.  

When inserting an existing cultural data layer into a document, you may 
insert either the original layer or a copy of it. If you select the Link to 
Original checkbox when inserting an existing layer into a cultural data 
layer, any change made to the layer will be reflected in other 
documents/layers which use the layer, provided they, too, use the layer in 
linked mode. If the Link to Original checkbox is not selected when 
inserting an existing layer into a document, a new cultural data layer is 
created and will be listed in the Select Layer window the next time a 
cultural data layer is created.  
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The names of linked cultural data layers are displayed in bold text in the 
Layer Navigator when the document is next opened.  

Note: To prevent confusion with layer names, when inserting an existing 
layer into a document without checking the Link to Original check box, 
it is recommended that you rename the layer in the Layer Navigator. The 
same name will otherwise be used for two different layers the next time 
the Select Layer window is opened. 

Instructions on how to create each of the cultural data types follow: 

Labels 

To create a new label: 

 1. Click the label button on the IVM toolbar: 

 
 2. The mouse pointer changes to a crosshair with a question mark. 

Click the mouse at the location on the document at which the 
label is to be inserted. 

 3. The Label Properties dialog box opens: 

 
 4. Enter the desired text in the text field. The text display 

properties can be edited by clicking the Abc… button in the 
upper part of the window: 

 



 

25-24  •  Interpreted Views and Montage A guide to using WinGLink 

In addition to standard text formatting features, the Text Format 
dialog box includes an option for rotating the label. 

 5. After entering the text and setting any formatting properties, 
click OK in the Label Properties dialog box to close the 
window. The label is positioned on the document at the desired 
location with the specified format properties. 

 

Text boxes 

To create a new text box: 

 1. Click the text box button on IVM toolbar: 

 
 2. The mouse pointer changes to a crosshair with a question mark. 

Click the mouse at the location on the document at which the 
text box is to be inserted. 

 3. The Text Properties window opens: 

 
While similar to the Label Properties window, the Text 
Properties window includes additional options for text 
alignment, drawing a frame around the text and adding 
transparency to the element. 
 
Enter the desired text in the text field. Formatting properties 
can be assigned to the text by clicking the Abc…option in the 
upper part of the window, which opens the same Text Format 
dialog box used for label elements. 

 4. After entering the text and setting any formatting properties, 
click OK in the Text Properties dialog box to close the 
window. The text is positioned on the document at the desired 
location with the specified format properties. 

Shapes 

To create a new shape: 

 1. Click the shape button on the IVM toolbar: 

 
 2. The mouse pointer changes to a crosshair with a question mark. 

Click and hold down the mouse at the location on the document 
at which the shape is to be inserted and, keeping the mouse 
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button depressed, drag the mouse to create a box of the desired 
size. 

 3. Upon releasing the mouse, a shape of the default type appears 
(rectangle). The shape properties can be edited by  
 - double-clicking the shape 
 - right-clicking the shape to open the shortcut menu; when 
open, select the Properties command. 
- clicking the Edit Object Properties button on the IVM 
toolbar: 

  
The Shape Properties dialog box opens: 

 
In the Color and Lines tab of the Shape Properties dialog box, 
set the display properties for the object and select the shape 
type (rectangle or oval). Click the Fill check box to enable the 
Fill button. The IVM fill feature, which is described in the 
Tools section of this chapter, can be used to fill the shape with 
a standard- or user-defined fill pattern. 
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 4. Click the Size tab to set size properties for the shape: 

 
The Height and Width fields are not active for shape objects. 
Positive rotation is counterclockwise about the upper left 
corner. 

Polylines 

To create a new polyline: 

 1. Click the polyline button on the IVM toolbar: 

 
 2. The mouse pointer changes to a crosshair with a question mark. 

Click the mouse at the location on the document at which the 
polyline is to begin. Move the mouse to the location of the next 
vertex and click again. Continue this procedure until the desired 
polyline has been created. Double-click the mouse to set the 
final vertex. 

 3. Immediately after setting the final vertex, the Polyline 
Properties window opens: 
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Set display properties as desired and click OK. The value 
entered in the width field specifies the border width in database 
units. 
Note: The IVM fill and pattern features are described in the 
Tools section of this chapter. The Use Pattern option in the 
Line Properties section of the window can be used to augment 
the defining line with a pattern, e.g. x marks, circles, triangles. 

 4. A polyline object can be scaled or resized by first selecting it 
with the mouse, then grabbing one of the yellow handles with 
the mouse pointer and pulling it to the desired size.  

Polylines can also be exported as external text files and then as well as 
reimported into other documents.  

To export a polyline: 

 1. Click the polyline object to select it.  

 2. Right-click the mouse on the document window to open the 
shortcut window: 

 
 
Select from 2D and 3D polylines. 2D polylines are defined by 
distance along the profile and depth and can be reimported into  
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other IVM documents. 3D polylines contain actual geographic 
coordinates and cannot be reimported. 

 3. Select the Export command to open the standard Windows 
dialog box for saving files. 

To import an external polyline definition: 

 1. Make certain that a Cultural Data layer is enabled for editing in 
the Layer Navigator. 

 2. Right-click the mouse on the document window to open the 
shortcut menu: 

 
 

 3. Click the Import Polyline command to open the standard 
Windows dialog box for opening files. Browse the directories 
until you have found the desired file, then click Open. 

 4. The WinGLink Import Wizard opens: 

 
The Import Wizard, which is described in detail in Chapter 3 of 
the WinGLink manual, guides you through the import process. 
After providing the requested information, the polyline data 
will be imported from the external file and the object created in 
the active cultural data layer. 

Closed polylines: 
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Closed polylines are similar to open cousins, the primary difference being 
that closed polylines automatically connect the last node to the first node, 
resulting in a closed element. 

To create a closed polyline: 

 1. Either click the Closed polyline button on the IVM toolbar: 

 
or right-click the mouse on the document window to open the 
shortcut menu and select the Free Shape command: 

 
 

 2. The mouse pointer changes to a crosshair with a question mark. 
As with polyline elements, click the mouse at the location on 
the document at which the free shape is to begin. Move the 
mouse to the location of the next node point and click again. 
Continue this procedure until the desired shape has been 
created. Double-click the mouse to set the final vertex and 
automatically connect the last vertex to the first vertex. 

 3. After setting the final vertex, the same properties window as for 
polylines opens. Set the properties as desired, then click the 
OK button.  

As with polylines, closed polylines can be exported to external files and 
reimported. Refer to the description of polylines above for details.  

Images 

External graphics files can be imported into cultural data layers. Most 
standard graphic formats are supported, including BMP, JPEG, GIF, 
PNG, TIFF, EXIF , WMF and EMF. Before they can be imported into 
IVM, however, they must first be copied into a folder named images 
which is created automatically by IVM the first time the images button is 
clicked. This folder is located in the same directory as the current 
database on your hard disk. Only images located in the images folder are 
available for import. 

To place an image in a cultural data layer: 

 1. Either click the images button on the IVM toolbar: 

 
or right-click the mouse on the document window to open the 
shortcut menu and select the Image command.  
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 2. The Select Image dialog box opens: 

 
This dialog box lists all images contained in the Image folder 
mentioned above. Select the desired image and click OK. 

 3. The mouse pointer changes to a crosshair with a question mark. 
Click the mouse at the location on the document at which the 
image is to be inserted. 

 4. Open the Shape Properties window by double-clicking the 
image or by using one of the other previously mentioned 
methods for opening property windows. The Shape Properties 
window consists of three tabs:  

 
In the Colors and Lines tab, only the options in the Fill 
Properties section of the tab are available. 
 
The Make transparent for color option is used to make a 
specific color or range of colors transparent. Enable this 
function by clicking the checkbox. Select the desired color by 
clicking the arrow button. You can specify the sensitivity of the 
transparency function with the Color Tolerance scale. With a 
low tolerance value (arrow to the left), only colors closely 
matching that in the color picker are made transparent. Higher 
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values, on the other hand, make a broader range of colors 
transparent. This function can be used, for example, to make 
the background of an image transparent. 

 
The options in the Size tab are used to specify image size in 
either absolute units or to scale the image to a relative size. The 
values entered in the upper set of Height and Width boxes set 
the image to the specified size, where the units are the same as 
those used in the document axes. The lower set of Height and 
Width boxes scales the image to the specified percent value.  
When the Lock aspect ratio checkbox is enabled, the height 
and width values change in proportion to one another, 
preventing the image from becoming distorted as the size is 
changed.  
 
When the Relative to original picture size checkbox is 
enabled, the scale values displayed are relative to the original 
image size, which is displayed at the bottom of the window. If 
not enabled, the scale values are relative to the current image 
size, i.e. size of the image when the Shape Properties window 
was opened.  
 
The Rotation option is not available for image elements. 
The origin of images is the lower-left corner.   
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You may set the position of the image to a specific value on an 
IVM document using the fields provided in the Position tab. 
The X-Coord and Y-Coord fields refer to the lower left and 
lower bottom corners of an image, respectively.  
 
If the Lock lower-left corner checkbox is enabled, the image 
location is fixed on the screen. While the image can still be 
resized, the position of the lower-left corner does not change. 

 5. Shape objects can be scaled or resized either by using the 
options provided in the Shape Properties dialog box or by using 
the mouse. To manually resize a shape element, select it by 
clicking with the mouse, then grab one of the yellow handles 
with the mouse pointer and pull to the desired size.  
 
Note: Options set in the Shape Properties window remain in 
effect when manually changing the image size and location. For 
example, when the Lock aspect ratio checkbox is enabled, the 
image proportions are retained when the image is resized with 
the mouse. 

Symbols 

To place symbol in a cultural data layer: 

 1. Either click the symbol button on the IVM toolbar: 

 
or right-click the mouse on the document window to open the 
shortcut menu and select the Symbol command.  

 2. The mouse pointer changes to a crosshair with a question mark. 
Click and hold down the mouse at the location on the document 
at which the symbol is to be inserted and, keeping the mouse 
button depressed, drag the mouse to create a box of the desired 
size. 

 3. As with shape elements, a symbol of the default type appears 
(arrow). The symbol properties can be edited by  
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 - double-clicking the symbol 
 - right-clicking the symbol to open the shortcut menu; when 
open, select the Properties command. 
- clicking the Edit Object Properties button on the IVM toolbar: 

 
 4. The Symbol Properties dialog box opens: 

 
 
Chose the symbol type from the dropdown list. Symbols 
currently available are: arrows, rectangles, circles and crosses. 
Set the remaining parameters as desired. Click OK. 

Working with Cultural Data Layers 
As mentioned earlier in this section, cultural data layers can themselves 
be considered a type of document. They may consist of multiple 
elements, each of which is located on a separate layer. They may be 
stored in the current WinGLink database and reused in other IVM 
documents.  

Z-order 
To change the Z-order of cultural data elements within a cultural data 
layer: 

 1. Click the cultural data element which is to be repositioned. 

 2. Right-click the mouse on the document window to open the 
shortcut menu. Position the mouse over the Order command 
and select either the Bring to Front or Send to Back 
command: 
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Bring to Front places an element on the top of the cultural data 
layer, Send to Back places an element on the bottom.  

Reusing cultural data elements 
Cultural data elements can be duplicated within a cultural data layer by 
using copy and paste functions. 

To create a copy of a cultural data element: 

 1. Click the cultural data element which is to be copied. 

 2. Right click the mouse on the document window to open the 
shortcut menu. Select the Copy command. 

 3. Again click the cultural data element which is being copied to 
select it. 

 4. Right click the mouse on the document window to open the 
shortcut menu. Select the Paste command. A copy of the data 
element appears on the document. 

Note: It is not possible to copy a cultural data element from one layer to 
another.  

Interpretation Areas 
Interpretation area layers are used to denote specific areas of interest on a 
map or section document. This layer type is similar to the cultural data 
layer type in that the layers can be saved in the WinGLink database and 
reused on other documents: 
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These layers consist of objects similar to the free shapes used in cultural 
data layers. Interpretation areas are drawn on a document in the same 
way as shapes. They are provided, however, with additional functionality. 
You can: 

• add, move or remove vertices 

• change the shape of an interpretation area by moving or 
deleting segments 

• assign colors and fill patterns 

• split interpretation areas and assign different properties 
(colors, fill patterns) to each part of the area 

• position interpretation areas within interpretation areas 

Creating Interpretation Areas 
To create an interpretation area layer: 

 1. Right-click the mouse anywhere on the document window or 
right-click the document title in the Layer Navigator window to 
open a shortcut menu. Then position the mouse over the New 
Layer command to open the submenu; select the 
Interpretation command. 

 2. The Select Layer window opens. Listed here are all 
Interpretation areas which are stored in the active WinGLink 
database: 

 
To create a new interpretation area layer, select the <New> 
item in the Layer Name column and click OK. Likewise, an 
existing layer can be inserted into the document by selecting the 
layer name and clicking OK.  
 
When inserting an existing interpretation area layer into a 
document, you may insert either the original layer or a copy of 
it. If you select the Link to Original check box when inserting 
an existing layer into an interpretation area layer, any change 
made to the layer will be reflected in any other documents / 
layers which use the layer, provided they, too, use the layer in 
linked mode. If the Link to Original check box is not selected 
when inserting an existing layer into a document, a new 
interpretation area layer is created and will be listed in the 
Select Layer window the next time an interpretation area layer 
is created. 
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 3. If creating a new interpretation area, IVM displays an info box 
instructing you to insert an interpretation area. Confirm by 
clicking OK. 

 4. The mouse pointer changes to a crosshair with a question mark. 
Click the mouse at the location on the document at which the 
interpretation area is to begin. Move the mouse to the location 
of the next vertex and click again. Continue this procedure until 
the desired interpretation area has been created. Double-click 
the mouse to set the final vertex and automatically connect the 
last vertex to the first vertex. 

Working with Interpretation Areas 
A set of commands are available for working with interpretation areas. 
These can be accessed either from the IVM toolbar or via the shortcut 
menu. The commands are available only when an interpretation area is 
the active layer. 

 

• Split an existing body  
Use this command to split an interpretation area into two 
parts. May be used successively to further subdivide an area. 

• Create a closed body  
Use this command to create a new body on the current 
interpretation area. New bodies must be entirely contained 
within an existing body and may not intersect any other 
bodies existing in the body into which the new body is being 
inserted. 

• Body union  
Use this command to unite two bodies. These may be either 
two halves of one body or a body enclosed with another. The 
two bodies to be united must be clicked. The entire area will 
take the properties of the second body which is clicked.  

• Move vertex  
Use this command to drag a vertex to a new position. 

• Move segment  

• Delete vertex  

• Delete segment  

After clicking any of the above command buttons or after selecting one 
of the corresponding shortcut menu commands, IVM is in edit mode. The 
respective command remains active until you: 

• Click a different command button. 

• Right-click the mouse on the document window to open the 
shortcut menu and select the Exit Edit command. 
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• Activate a different layer in the Layer Navigator. 

• Create a new layer. 

GEOTiff Maps 

What are GEOTiffs? 
The GEOTiff specification provides a mechanism which can be used to 
embed georeferencing information in TIFF images. By incorporating a 
series of tags in a TIFF image, it is possible to correctly position a map, 
for example, onto a given coordinate system. While WinGLink cannot 
yet be used to create GEOTiff images, images created using other 
software packages can be correctly positioned onto map documents in the 
IVM program.  

For details on the GEOTiff specifications, see: 
http://remotesensing.org/geotiff/spec/geotiffhome.html 

Numerous third-party software houses have developed and sell software 
packages which can be used to generate GEOTiff images. 

Creating GEOTiff Map Layers 
As the name implies, this type of layer can be inserted only Map 
documents only. Theses layers are created much in the same way as other 
layers:  

To create a station layer: 

 1. Right-click the mouse anywhere on the document window or 
right-click the document title in the Layer Navigator window to 
open the shortcut menu. Then position the mouse over the New 
Layer command to open the submenu; select the GEOTiff Map 
item: 

 
 2. The GEOTiff selection window opens. All files with a .TIF or 

.TIFF extension which are located in the images folder located 
in the same directory as the current database are listed. Note, 
however, that only .TIF images which fulfill the GEOTIFF 
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specifications may be inserted into a GEOTiff Map layer: 

 
 3. After clicking OK, a progress window opens indicating that the 

georeferencing data are being read from the tiff file. Once 
complete, the image is positioned at the correct coordinates on 
the map.  

Tools: Pattern and Category Editors 

The Pattern Editor 
The pattern editor is used to create and edit fill patterns. Theses patterns 
can be used, for example, to fill shapes used in cultural data layers or as 
fill patterns to describe layers of vertically distributed data. Patterns 
created in the fill editor are available in the property windows of all 
elements which support fill patterns, both in IVM and in other WinGLink 
modules. In the main WinGLink modules, this feature available only for 
sections which contain well courses, e.g. X-Sections.  

To open and use the Pattern editor: 

 1. Select the Tools | Pattern Editor command to open the Pattern 
editor: 
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 2. To create a new pattern, position the mouse over the Editing 
window, then click and hold down the left mouse button. Slide 
the mouse across the edit window to create a pattern. You may 
alternatively click individual squares to create a pattern. When 
finished, click the save button.  

 3. To edit an existing pattern, open the Select Pattern dropdown 
list. Make any changes to the pattern, then click the Save button 
to overwrite the pattern with your changes, or Save As… to 
save your changes to a new pattern.  

Note: The only color available in the pattern editor is red. When using 
patterns as a fill, you may, however, select both foreground and 
background colors. 

 

The Category Editor 
The Category Editor is available in IVM as well as the X-Sections, 2D 
Inversion and Well Editor modules. The categories are centrally stored in 
the database. Thus, regardless of the program in which categories are 
edited or new categories created, the modifications are reflected 
throughout the database.  

Once categories, or types of layers,  have been created, any time another 
layer of that type is encountered in a section within the database, 
WinGLink automatically performs filling.  

To Assign Fill Patterns to Layer Data: 
 1. On the Tools menu of the X-Sections window, select the 

Category Editor command to open the Category Editor: 

 
Displayed in the Category frame are all existing categories. 
Categories are created automatically when importing layer data 
into WinGLink and can also be created using the Add New 
button located at the bottom of the left column.  
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The elements in the Item frame are the description elements 
contained in layer-data files which were linked to the given 
category type during import. New items can be created using 
the New button located in the upper right corner of the 
Category Editor.  

 2. Select a category and item with the mouse. The current pattern 
type is displayed in the Pattern Type dropdown box.  

 3. Click the arrow at the right end of the Pattern Type dropdown 
box to open a box containing all available fill patterns. Choose 
back color and fore color for the filling using the provided 
drop-down boxes.  

 4. The Pattern Editor, which can be opened using either the button 
provided in the Category Editor or by selecting the Tools | 
Pattern Editor command on the main menu, can be used to 
create new patterns.  
 

The Import function, which is called up using the Import button in the 
Category Editor, provides a function for importing entire categories from 
other databases. If you import a duplicate category, the Category Editor 
can be used to merge the two categories together.  

 
Upon closing the Category Editor, well courses are filled with the 
appropriate fill patterns: 
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The IVM Plates Module: Preparing Documents for 
Printing 

After either map or section documents have been created and saved in 
Interpreted Views and Montage (IVM) they exist within the current 
WinGLink database as independent objects. Using the IVM Plates 
module, these documents can be combined with other IVM display 
elements, e.g. scales, legends, text boxes, or even other maps or sections 
to annotate documents for plotting. Once completed, plate documents can 
be sent to either an installed printer or to a file (CGM or EMF). 

Getting Started with the Plates Module 
To open the Plates module, select the Document | Go To Plate Mode…  
menu option from either the Map or Section window in IVM: 
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The yellow area  in the center of the can be thought of as the layout area: 
documents, legends, texts etc. are printed as they are positioned in this 
area.  

The size of the layout area, which is identical to the page size, can be set 
by selecting the Plate | Page Setup command. In the Page Setup dialog 
box which opens, select from a range of standard paper sizes. The page 
size is reflected in the plate axes and the size of the layout area. 

To Display a Document Object on a Plate: 
 1. Right-click the mouse anywhere in the layout area to open a 

shortcut menu: 

 
 

 2. Position the mouse over the New command to open a 
secondary menu containing all display elements. Click the 
desired type to select it. 

 

 3. Depending on the type of element selected, the mouse pointer 
may change to a crosshair, indicating that you are to use the 
mouse to create the area on the plate into which the element is 
to be inserted, or you may be prompted to select an image.  
 

 4. To insert a map or section document, select the Document 
command. The mouse switches to a crosshair with a question 
mark. Position the mouse pointer at the intended location of one 
of the document corners; click the left mouse button and drag 
the mouse across the screen, creating a black-framed box in the 
process. When the box is approximately the correct size, release 
the mouse. The box changes to a blue-framed box with an x 
though it. This box may be repositioned by clicking the mouse 
anywhere within its boundaries and dragging it to a new 
location. It may also be resized by clicking any of the yellow 
handles and pulling to a new location on the screen. 
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 5. After releasing the mouse, the Open Document window opens.  

 
Select the desired document and click the Open button.  
 
Note: The most recently viewed documents are listed in the 
Recent tab. All other IVM map and section documents 
contained in the current WinGLink database are available for 
selection in the respective Map and Section tabs.  
 

 6. The document appears on the screen in the boundaries defined 
by the blue-framed box in Step 4. The document may be 
repositioned or resized using the same methods described in 
Step 4. 

Adjusting Document Properties 
Depending on the size of the defining rectangle, the document may not be 
displayed in its entirety. The view area, as well as other document display 
properties, can be adjusted in the Document Properties window. This 
window can be opened by double-clicking the document: 
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The View area tab is available for both map and section documents. For 
section documents, the two center tabs are Distances and Depths; for map 
documents they are Metric coordinates and Geographic coordinates. Use 
the settings in the two center tabs to set display features such as font, 
grids, colors and frames. The Pattern printing options tab contains 
options for scaling the size of any patterns used in the document. The 
Axes Legends tab, which is available for Section documents only, can be 
used to set legend texts and other display parameters.  

Note: In order to display the axis legends, the View tickmark 
checkboxes in the Distances and Depths tabs of the Document Properties 
window need to be enabled. 

To adjust the view area: 

Use the four fields on the sides of the preview window and the scale 
field(s) to adjust the display area. Note, however, that the function of 
these fields varies depending on the selection states of the Keep scale 
and Keep frame dimensions check boxes. Maps documents contain only 
one scale field; section documents contain scale fields for both the 
horizontal and vertical scales.  
 
If the Keep scale and Keep frame dimension checkboxes are selected, 
changes to the view area fields serve to “pan” the document within the 
bounding rectangle. Changes to the scale fields zoom in or out on the 
document (sections only), effectively adjusting the vertical exaggeration. 
Click the Fit to Frame button to automatically center the document in 
the bounding rectangle. 
 
If the Keep frame dimension checkbox is not selected, scale is 
maintained as the view area fields are changed. The size of the bounding 
rectangle is, however, changed. Click the Fit to Frame button to 
automatically center the document in the bounding rectangle. 

If the Keep scale checkbox is not selected, the bounding rectangle 
remains a fixed size. Changes to any of the view area fields are reflected 
in the scale fields in the lower right corner. Likewise, changes made to 
the scale fields are reflected in the view area fields. Click the Fit to 
Frame button to fit the entire document in the bounding rectangle.  

 

Other Display Elements 
The other types of display elements which can be added to a plate are 
typically associated with a single document. For example, a Scale Box 
display element reflects the scaling used for a specific Document 
element.  

To create (non-document) display elements and assign them to specific 
document elements: 

 1. As with document elements, right-click the mouse anywhere in 
the layout area to open a shortcut menu: 
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 2. For example, to position a legend for layer data contained in a 
section, i.e. well data, select the New | Legend | Layer Data 
command from the shortcut menu: 

 
 

 3. After selecting a display element, the mouse switches to a 
crosshair with a question mark. Use the same procedure as was 
used to position a new document element on the screen to 
create a box into which the legend (or other display element) is 
to be placed. 

 4. Immediately after releasing the mouse, an info box opens 
indicating that the element has not yet been linked to a 
document: 
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The Link Document Info message box serves only to inform 
you that the element must be linked to a document before it can 
be filled with the appropriate information. The lower box, 
which contains the text “No Document Linked”, defines the 
rectangle into which the element will be placed once the 
element has been linked to a document.  

 5. Position the mouse within the boundaries of the new box and 
right-click the mouse to open a shortcut menu: 

 
 
Select the Link to Doc command. 

 6. The mouse pointer changes to a plain crosshair. Now, select the 
document with which the given display element is to be 
associated by clicking the document with the mouse. If the 
document supports the element, it should now be displayed 
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correctly on the screen: 

 
 7. The display properties, i.e. text color/size, frame width etc., for 

each element can be modified by selecting the element with the 
mouse, then right-clicking to open the shortcut menu. Select the 
Properties menu item to open the Properties window, which 
contains standard formatting options. You may alternatively 
double-click a display element to open the Properties window. 
 
Elements which are not supported by the document to which 
they are linked are displayed as an empty, white box. These can 
be deleted by right-clicking the element and selecting the 
Delete command from the shortcut menu. 

Other display elements which must be linked to documents include: 

• scale box: provides information about scaling, and, for 
section documents, information about vertical exaggeration 

• color box: displays the same color range information as is 
displayed in the original document (color range window) 

• legend: layer data: provides a visual link between fill types 
and layer names for vertically distributed data 

• legend: symbols:  provides a visual link between symbols 
used to indicate measurement points for numerical data and 
the corresponding symbol names for vertically distributed 
data, i.e. temperature or pressure measurement points along 
well courses 

The remaining display elements, e.g. title box and frame, are for 
document-independent annotation purposes and, thus, are not associated 
with a specific document.  

Printing Plates 
Plates created within the IVM plates module are printed much as any 
other document would be in a standard Windows program. One notable 
difference, however, is the fact that documents can be printed to files of 
types EMF and CGM.  

To print to a file or to a printer other than your default printer: 
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 1. On the Plate menu, select the Printer Setup option to open the 
Printer Setup dialog box: 

 
 2. To print to a file, click the Print to File checkbox in the 

Options area of the screen, then select the type of file to which 
you would like to print.  

 3. To change other printing options, e.g. printer name, print range, 
proceed as you would with any other Windows program.  

 4. To send the plate to the selected printer or file, select the Plate | 
Print command. 

Important: 
When printing to EMF of CGM files, note the following: Although 
output is not sent to a physical printer, the paper properties of the printer 
selected in the Printer section of the Printer Settings dialog are used. Each 
output file can be considered to be a page of printer output. Because the 
entire output is sent to a single file, however, you must ensure that the 
paper size selected for the printer is large enough for the entire print area, 
i.e. fits within the red border which defines the first page of output in the 
Print Preview screen. Any information outside of the first page will be 
clipped in the output file. 
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26:  Appendix A: TGF files 

The TFG Format 
In order to import vertically distributed data, including lithologic data, 
into WinGLink, they must be contained in either columnar text files or in 
TFG-format files. This description describes the TGF specification and 
how to work with TGF files. 

The TGF format is an expandable data format specified by Geosystem for 
the purpose exchanging geophysical data across applications. A given 
TGF file may contain station data for one or more stations, e.g. name and 
coordinates, as well as data values for one or more values, e.g. 
temperature and density.  

TGF files may also link to other TGF files. In this way it is possible to 
create a batch file of sorts. For example, the top-level file might contain 
station data and links to several files containing different value types, e.g. 
temperature, pressure and density. 

Organizing Station Data in TGF-Format Files  
TGF files are organized by block using markup tags in a way similar to 
those used in standard markup languages such as HTML. Within the tags, 
data are organized primarily as tabular data. 

Example of a TGF file structure: 
<TGF100> 
; this is a comment 
 
<TAG1=param1 param2> 
 (user data…) 
<TAG1> 
 
</TAG2> 
 (user data…) 
</TAG2> 
 
<TAG2> 
 (user data…) 
</TAG2> 
 
<TAG_A> 
 (user data…) 
</TAG_A> 
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<INCLUDE="Stations.tgf"> 
 
<END> 
 

 
The file MUST begin with the string <TGF100>. The 100 indicates 
version 1.00 of the file format, allowing for future changes. 

A TGF file consists of a series of <TAG>…</TAG> pairs, which 
surround user data. All opening and closing tags, i.e. <TAG> and 
</TAG>, must stand alone on a line. Opening tags may contain 
parameters, i.e. <TAG= param1>. 

Every TGF file must end with an <END> tag. Anything after this tag is 
ignored. 

There are two types of tags:  

 1. Multi-line tags, which act as data containers, primarily of 
tabular data 
Example: 
<DATA=STAT_COORDS> 
… 
</DATA> 

 2. Single-line tags, which are used for less complex data. No 
ending </TAG> is used for this tag type. 
Example: 
<INCLUDE="stations.tgf"> 

Valid Tags 
TGF100 

File type/version, must be on the first line. Without this tag the file will 
be rejected. 

Example: 
<TGF100> 

… 

… 

(rest of file) 

 
WAIT 

This tag instructs the importing program to stop interpretation of the file 
until the user acknowledges a message displayed on the screen.  

Example: 
<WAIT=Press a key to continue> ; this will wait for 
user 
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DATA=NAME 

This is a general user data/table container. The type of data is specified 
by the name. These are multi-line tags and must be formatted as follows:  

• One or more spaces or tabs must separate user data columns. 

• The decimal separator is "." (dot); no thousands separator is 
allowed. 

• Numbers can be expressed in scientific notation. 

• Text data must be enclosed in " " (quotation marks). 

• Blank lines are ignored. 

 
DATA=STAT_COORDS 

Defines a group of stations 

Table column definition is: 

 1. "Station name" 

 2. X  (northing) [Km] 

 3. Y (easting) [Km] 

 4. Elevation [m] 

Example: 
<DATA=STAT_COORDS> 

; This table builds station locations 

"st 01" 34.456 21.451 500.2 

"st 02" 31.456 13.455 534.7 

"st 03" 24.456 43.552 400.9 

"st 04" 14.461 65.952 840 

"st 05" 74.556 28.457 510 

</DATA> 

 
DATA=VSAMPLE_TYPES 

Defines a table of vertical sample names, with their attributes, and unit of 
measure and number of decimals to display. 

Table column definition is: 

 1. NAME  

 2. Unit 

 3. Ndec 

Example: 
<DATA=VSAMPLE_TYPES> 

; This section defines the names of used vertical 
vector types 
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"Resistivity" "rho"   3 

"Temp"  "C"   2 

"Pressure"  "Kpa/cm"  3 

</DATA> 

 
DATA=VSAMPLE 

Defines a vertical sample, its sample type and the reference for Z 
coordinate. 

ZMODE="Elev"  means Z = 0 at sea level, positive upward 

ZMODE="Depth"  means Z = 0 at station surface, positive downward 

STATION="Name"  name of station to which station is to be associated 

STYPE="Name"  join sample to sample type "name" 

Table column definition is: 

 1. Z [m] 

 2. value [unit of vector type, if any] 

Example: 
<DATA=VSAMPLE> 

ZMODE="Depth" ;depth or elev 

STATION="st 02" 

STYPE="Resistivity"  

122.34  45.223 

234.23 167.332 

455.43 123.23 

1120.34 145.223 

1234.23 171.332 

1457.43 231.23 

2126.34 252.223 

2634.23 167.332 

2795.43 283.23 

3120.34 458.223 

3234.23  676.332 

3455.43 532.23 

</DATA> 

 

<DATA=VSAMPLE> 

ZMODE="Depth"  

STATION="st 02" 

STYPE="rho"  
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122  48.223 

238 117.332  

457 123.23 

1100 175.223 

1234 171.332  

1437 231.23 

2128 212.223 

2654 117.332  

</DATA> 
 

INCLUDE 

This tag allows the interpretation of another file before continuing with 
the current one. 

It is useful for keeping homogenous data in separate files. 

Processing will continue with the external file and will resume execution 
from the next line 

Included files cannot call each other (circular reference). If "file A" 
includes "file B" then "file B" can't include "file A" 

Be careful! 

If the included/called file has some tag present also in the calling file, the 
data of the last tag read will be kept. 

The include tag can be in any part of the file, but must be outside of other 
tags. 

Example: 
; External links to other files 

<INCLUDE="stations.tgf"> ;file stations.tgf will be 
read and.. 

<INCLUDE="vectors.tgf"> ; then file vectors.tgf 

 
END 

This tag ends interpretation of file. It must be present  

Example: 
… 

… 

<END>  

 

These lines are ignored 

These lines are ignored 

These lines are ignored 

These lines are ignored 
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These lines are ignored 

(Physical end of file) 

Importing TGF Files into WinGLink 
TGF data are imported into WinGLink using the Importing station data 
command located in the main Database window. 

To import TGF files into WinGLink:  

 1. On the File menu of the Database window, select Importing 
station data, then specify External Files. 

 2. Next, select the project into which the data are to be imported. 
For vertical data, the project must be of type Vertically 
Distributed Data [VD], for wells of type Wells [WL] 

 3. In the <Files of Type> box, select TGF Files. 

 4. Browse the directories until you find the file(s) to be imported. 

 5. Select the name of each file to be imported 

 6. Click Next. 

 7. Click each of the stations which are to be imported. 

Note: If no stations are listed, either no stations are contained in your 
TGF file or your file is not conformant with the TGF specifications. 
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